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Change history
October 2025

Added the following information:

Fleet Management

Updated information about unavailability of Local Agent x86 installer package.

September 2025

Added the following information:

Print Management

Added information on creating assignment with Lexmark Print Management Client 
3.6.0.
Added information on advanced hybrid storage assignment.

Fleet Management

Added information on assigning configuration to Lexmark printers enrolled through a 
Fleet Agent, Native Agent, and Printer Agent.

August 2025

Added the following information:

Fleet Management

Updated information on Local Agent installer package.
Solution Quota Manager

Added information on managing the distribution of quotas in child organizations.

September 2025

Added the following information:

Print Management

Added information on creating assignment with Lexmark Print Management Client 
3.6.0.
Added information on advanced hybrid storage assignment.

Fleet Management

Added information on assigning configuration to Lexmark printers enrolled through a 
Fleet Agent, Native Agent, and Printer Agent.

August 2025

Added the following information:

Print Management
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Added information on Lexmark Print Management Client 3.6.x.
Fleet Management

Added information on importing variable settings file for creating a configuration.
Solution Quota Manager

Added information on managing the distribution of quotas in child organizations.
Solution Center

Added information on Advanced Match for Redaction.

June 2025

Added the following information:

Account Management

Updated instructions on setting up a federation.
Print Management

Added information on client policies.

May 2025

Added the following information:

Fleet Management

Added information on assigning and deploying speed upgrade.
Print Management

Updated information on Organizational settings page.
Analytics

Added information on Full Data Export report in Analytics 2.0.
Updated information on generating Organization, User, and Department level reports.

April 2025

Added the following information:

Fleet Management

Updated information on Importing Settings bundle.
Analytics

Added information on All Organization Report and Single Organization Report.
Solution Center

Updated information on Solution Center eSF application.

March 2025

Added the following information:

Solution Center

Added information on Solution Center eSF application.
Added information on supported printer models for Cloud Solution Center.

Analytics
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Updated information on generating reports.

January 2025

Added the following information:

Print Management

Added information on Advanced Hybrid.
Added information on Offline print.

Solution Center

Added information on Solution Center.
Scan Management

Updated information on scan file size.

December 2024

Added the following information:

Fleet Management

Updated information on creating a configuration.

Print Management

Updated information on LPMC version 3.5.0 or later.

November 2024

Added the following information:

Account Management

Updated information on additional claims.
Analytics

Updated information on feedback function.

October 2024

Added the following information:

Account Management

Updated information on adding optional claims.
Updated information on deleting organization.
Updated information on copying organization ID.

September 2024

Added the following information:

Fleet Management

Added information on scheduling recurring tasks.
Added information on new Cloud Fleet Management roles.

Analytics
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Added information on categorization of Cloud Fleet Management Reports and Cloud 
Print Management Reports.

July 2024

Added the following information:

Account Management

Updated information on setting up attributes and claims.
Print Management

Updated information on Lexmark Print Management Client.

June 2024

Added the following information:

Fleet Management

Added information on managing filters.
Updated information on creating a notification.

April 2024

Added the following information:

Fleet Management

Added feature on updating applications and firmware for all organizations.
Solution Quota Manager

Added information on Solution Quota Manager.

March 2024

Added the following information:

Account Management

Added information on configuring Microsoft Entra ID with SAML Federation.
Print Management

Updated information on the Organizational Settings page.
Fleet Management

Added information on assigning and enforcing conformance.
Analytics

Added information on the Print Summary report.

February 2024

Added the following information:

Fleet Management

Added support for configuration versioning.
Added support for importing printer settings from VCC files.

December 2023
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Added the following information:

Fleet Management

Updated information on adding applications while configuring printer settings.
Added information on Apps management.

Print Management

Updated information on Direct Print

November 2023

Added the following information:

Fleet Management

Updated information on configuring a printer settings
Scan Management

Updated information on scan destination
Translation Assistant

Updated source and target languages in Translation Assistant.

September 2023

Added the following information:

Account Management

Configuring Azure Active Directory (AD) with OIDC Federation
Fleet Management

If you have the Fleet Management Administrator role in all partner organizations and 
have child organization access, then you can update agents across multiple 
organizations.
Updated information on Policy type.

Print Management

Added information on printing on a specific day and time
Added information on viewing details of a print policy
Updated information on Lexmark™ Print Management Client

Analytics

Added information on the Print Outlier report

August 2023

Added the following information:

Print Management

The Lexmark Mobile Print application is now known as the Lexmark Print application.
Scan Management

Box connector support
Update on the known limitations

Translation Quota
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Added the following custom roles:

Translation Assistant Administrator
Translation Assistant User
Solutions Quota Administrator

Added information on the following Translation Quota cards:

My Translation Quota Remaining
Translation Pages Remaining
Translation Distribution Status

June 2023

Added the following information:

Fleet Management

Updating applications through the Printers page
Failed printer registration in the Printer Eligibility Status

Lexmark Cloud Services Infrastructure

Added URLs for North American data center and European data center
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This section summarizes the new features, improvements, and other updates to Lexmark Cloud Services.

October 2025 release
Fleet Management

While downloading installer package for Local Agent, you can no longer download the 32-bit 
version. Only the Windows x64 installer package for Local Agent is downloaded. For more 
information, see Downloading the Local Agent on page 122.

September 2025 release
Print Management

With the release of LPMC 3.6.0 version, you can create assignment with printer allotment 
and user assignment. The rule-based printer assignment and user assignment helps to 
create allotment with specific printers and for specific users. For more information, see Using 
Direct Print on page 204.
You can now create advanced hybrid storage assignment for organization, cost center, 
personal, and department. For more information, see Creating advanced hybrid storage 
assignments on page 219. Using the advanced hybrid storage assignment list, you can view, 
edit, or delete these assignments. For more information, see Using the advanced hybrid 
storage assignment list on page 220.

Fleet Management

You can now assign configuration to Lexmark printers enrolled through a Fleet Agent, Native 
Agent, and Printer Agent. For more information, see Assigning a configuration on page 157.

August 2025 release
Print Management

Lexmark Print Management client has a new update in the version 3.6.x. For more 
information, see Downloading the Lexmark Print Management Client on page 184.

Fleet Management

While creating a configuration, you can configure printer settings by importing a variable 
settings file. For more information, see Creating a configuration on page 146.

Solution Quota Manager

While creating a distribution for child organization, you can set the Distribution Duration to 
either Perpetual or Custom. This allows you more flexibility for setting quotas for the various 
services as well as setting the billing cycle. For more information, see Managing the 
distribution of quotas in child organizations on page 292.

Solution Center

What's new
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You can now configure custom text for redaction with an Advanced Match option. This 
feature works on the principle of regular expressions (regex). For more information, see 
Creating a solution workflow on page 224.

June 2025 release
Account Management

Updated instructions for setting up a federation. For more information, see Configuring 
Lexmark Cloud Services on page 90.

Print Management

Client policies are rules that govern how LPMC behaves that you can assign and enforce to 
users and groups based on organization, department or cost center and personal. For more 
information, see Creating client policies on page 190.

May 2025 release
Fleet Management

Use speed kit upgrade feature to increase the pages per minute output of your printer. You 
can just use the upgrade code to upgrade your printer. For more information, see Assigning 
and deploying speed upgrade on page 155.

Print Management

The various organizational settings are now grouped under broad categories to help users 
navigate through the various organizational settings. For more information, see Configuring 
organizational settings on page 170.

Analytics

Full Data Export report is now available in Analytics 2.0. In Analytics 2.0, this report is 
available only for Cloud Print Management reports. For more information, see Accessing the 
Analytics web portal on page 244.

For Organization, User, and Department level reports, you have now the option to select 
either Analytics 1.0 or Analytics 2.0. For more information, see Generating reports on page 
273.

April 2025 release
Fleet Management

Import Settings bundle feature allows you to import Printer Settings and Login Methods. 
On importing the VCC file, you can either import Printer Settings or Login Methods or 
both. For more information, see the "Importing settings bundle" section in Creating a 
configuration on page 146.

Analytics

Availability of Cloud Solution Center Reports help users to get organization-based and user- 
based reports in the form of All Organization Report and Single Organization Report 
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respectively. All Organization report provide organization-based reports for actions like 
Translation, Redaction and OCR. For more information on All Organization Report, see 
Accessing the All Organization report on page 280. Single Organization Report provides 
user-based reports for action like Translation, Redaction and OCR. For more information on 
Single Organization Report, see Accessing the Single Organization report on page 281.

Solution Center

For Solution Center eSF application, certain values in the printer must be set for data 
validation. For more information, see Installing the application on page 232.

March 2025 release
Solution Center

Solution Center eSF application available on Lexmark printers and multifunction products 
(MFPs).  It allows users to view and execute workflows that have been configured through 
the Lexmark Cloud Services portal. The Solution Center eSF application does not create or 
customize solutions. For more information on Solution Center eSF application, see Installing 
the application on page 232. For more information on supported printer models, see 
Supported printer models for Solution Center on page 57.

Analytics

On the Analytics 2.0 page, you can view the reports based on your user role. The reports are 
categorized into Cloud Print Management Reports, Cloud Fleet Management Reports, and 
Cloud Solution Center Reports. For more information, see Accessing the Analytics web 
portal on page 244.

January 2025 release
Print Management

The Offline Print feature is a way to allow users to print even when there are connectivity 
issues with the Lexmark Cloud Services. The feature acts as a perfect alternate to hybrid 
cloud services or direct print. For more information, see Using Offline Print on page 209.
Advanced hybrid storage feature uses additional storage locations for their print jobs without 
letting the print job move out of the customer network. This feature stores the user's print job 
in alternate storage locations outside of their workstation. For more information, see 
Understanding advanced hybrid storage on page 210.

Solution Center

Solution Center is an application that lets you create or customize your workflows depending 
on your roles in an organization. Using Solution Center, you can create a solution to capture, 
process, and route a document. For more information, see Overview on page 223.

December 2024 release
Fleet Management

While creating a configuration, you can now configure Login Methods for printers with eSF 
version 5.0 or later. For more information, see Creating a configuration on page 146.
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Print Management

LPMC 3.5.0 release supports the previous configuration.xml files and converts them for you 
to the new JSON format on installation. For more information, see Installing the Lexmark 
Print Management Client.

November 2024 release
Account Management

You can view all the required and additional claims listed under the Attributes & claims 
section. For more information, see Setting up attributes and claims on page 87.

Analytics

You can provide your valuable feedback about reports by clicking Feedback on the right side 
of the screen in any generated report. For more information, see Accessing the Analytics 
web portal on page 244.

October 2024 release
Account Management

Users who are members of a Child Organization Access Group that has the Organization 
Administrator role can create and delete child organizations. For more information, see 
Deleting organizations on page 95.
The Organization page now has a copy button beside the organization ID. For more 
information, see Overview on page 61.
While configuring claims, you must click Home > Enterprise applications to include the 
additional claims. For more information, see Configuring claims on page 77.

September 2024 release
Fleet Management

You can schedule recurring tasks and configure them according to the requirement. 
Recurring tasks can only be created for individual organization. For more information, see 
Managing tasks on page 166.
In Cloud Fleet Management, the Fleet Management Viewer role has some basic roles like 
viewing the list of printers, printer details page, and applications. For more information, see 
Understanding roles on page 62.

Analytics

On accessing Analytics 2.0, you can view that reports are categorized into Cloud Fleet 
Management Reports and Cloud Print Management Reports. For more information, see 
Accessing the Analytics web portal on page 244.

July 2024 release
Account Management
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For setting up attributes and claims, the navigation to initiate the process has changed. On 
the SAML‑based Sign‑on page, in the Attributes & Claims section, click Edit to start with. For 
more information, see Setting up attributes and claims on page 87.

Print Management

To be able to use the LPMC version 3.4.x, make sure that you have installed 
Microsoft .NET Framework version 6.2 or later. For more information, see Installing the 
Lexmark Print Management Client.

June 2024 release
Fleet Management

On the printer listing page, you can save searches or filters. You can create, modify, and 
delete the saved filters. For more information, see Managing filter groups on page 126.
You can create a notification policy for Fleet Agents. On creating a policy, recipients are 
notified when the conditions of the policy are met. For more information, see Creating a 
notification policy on page 158.

April 2024 release
Fleet Management

Cloud Fleet Management offers remote device monitoring and management. For more 
information, see "Fleet Management" chapter.

Solution Quota Manager

Solution Quota Manager manages distribution of pages and sets quotas for organizations 
and users. For more information, see "Solution Quota" chapter.

March 2024 release
Account Management

Network administrators can configure Microsoft Entra ID for Security Assertion Markup 
Language (SAML) federation with the Lexmark Cloud Services. For more information, see 
"Configuring Microsoft Entra ID with SAML Federation" group.

Fleet Management

You can assign a configuration to a printer. Once you assign a configuration, you can check 
conformance, and if required, you can enforce the assigned configuration. For more 
information, see "Performing configuration policy conformance and enforcement" group.

Print Management

On the Organizational Settings page ,you can now enable e‑mail submission. For more 
information, see Configuring organizational settings.

Analytics

You can now access the Print Summary report to understand the printing trends in your 
organization. The key performance indicators are also available for department and user 
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level. The report also provides valuable insights into the printing pattern of your organization 
or department. For more information, see Understanding the Print Summary report on page 
277.

February 2024 release
Fleet Management

In Lexmark Cloud Services, you can now use configuration versioning to ensure that only 
published versions are deployed, set as default, or applied as configuration policies. You can 
also deploy draft configurations to a single device for testing before publishing. For more 
information, see Managing configurations on page 153.
While creating a configuration, you can now import printer settings from existing VCC files. 
For more information, see Creating a configuration on page 146.

December 2023 release
Fleet Management

While creating a configuration, you can modify the pluggable authentication module to make 
Cloud Authentication the main authentication application. For more information, see Creating 
a configuration on page 146.
In Lexmark Cloud Services, you can manage all the applications installed in various enrolled 
printers. To access the Apps page, from the Fleet Management web portal, click Printers > 
Apps. For more information, see Managing installed applications on page 141.

Print Management

From the Fleet Management portal, we recommend updating the Printer name (optional) 
field on the Printer details page. It is not mandatory to update this field. For Direct Print, if 
you want to change the print queue name as it appears to the end user, then enter a value in 
the Printer name (optional) field. If no value is entered, then the print queue appears as the 
default or custom prefix followed by the IP address of the printer. For more information, see 
Using Direct Print.

November 2023 release
Fleet Management

While creating a configuration, you can configure various printer settings. For more 
information, see Creating a configuration on page 146.

Scan Management

You can now select Dropbox as one of the scan destinations. For more information, see 
Managing scan destinations on page 239.

September 2023 release
Account Management
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You can now configure Azure AD federation to enable OpenID Connect (OIDC) federation 
with the Lexmark Cloud Services. For more information, see "Configuring Azure Active 
Directory (AD) with OIDC Federation" group.

Fleet Management

If you have the Fleet Management Administrator role in all partner organizations and have 
child organization access, then you can update agents across multiple organizations. For 
more information, see Updating agents for multiple organizations on page 105.
While creating a supplies notification policy, you can select several options from the Policy 
type. For more information, see Creating a notification policy on page 158.

Print Management

In the Print Policy, you can now configure the time and date during which printing is to be 
allowed. You can also see the policy details by clicking a particular policy. For more 
information, see Creating and assigning print policies on page 177.
You can enable automatic updates for Lexmark Print Management Client. For more 
information, see Enabling automatic updates for Lexmark Print Management Client.
To manage Lexmark Print Management Client, you can check for updates, identify the 
version, and log out from the Lexmark Print Management Client. For more information, see 
"Managing the Lexmark Print Management Client" group.

Analytics

You can access the Print Outliers report to view information related to printing patterns in an 
organization. Using this report, you can also access department‑level or user‑level 
information. For more information, see Understanding the Print Outliers report on page 274.

August 2023 release
Translation Assistant

You must have available translation quota to use Translation Assistant. You must have the 
applicable user roles to use the Translation Quota cards and distribute or edit translation 
quota for users and cost centers or departments.

Print Management

Lexmark Mobile Print application is now known as Lexmark Print application.
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Understanding Lexmark Cloud Services
Lexmark™ Cloud Services is a fully featured and integrated cloud-based website that supports access, 
configuration, and management of the Print Management solution. The following web portals provide capabilities 
that support a complete Print Management experience:

Account Management—Supports the management of users and their access to the system.

Assign organizational roles.
Manage access control and user identity.
Import and register user badges.
Configure system permissions.

Fleet Management—Supports the discovery, configuration, and management of printers.

Initiate printer discovery and enrollment.
Enroll printers on the Lexmark Cloud Services website.
Manage and deploy configurations on printers in the Lexmark Cloud Print 
Management and the Lexmark Cloud Print Management Hybrid environments.
Configure printers to communicate with the cloud server continuously for configuration 
updates and apply configuration changes automatically.
Create tags, and then assign them to printers.
Customize the printer listing view.
Monitor the status of printer supplies and alerts.
Track the page counts.
Update the printer firmware levels.
Deploy applications and settings files.
Add files to the resource library.
Send notifications to the printer control panel.
Send email notifications for toner levels and printer information.
Customize a printer home screen.

Print Management—Supports management of print queues, delegates, and user quotas.

Manage the Lexmark Cloud Print Management print queues.
Delegate print jobs.
Define and assign department, cost center, and user quotas.
View user quota status.
Configure document retention.
Configure organizational policies.
Configure print policies.
Manage the Lexmark Cloud Print Management Hybrid print queues.
Create and download the Lexmark Print Management Client installation package.
Download the Lexmark Cloud Print Management for Chrome extension.

Scan Management—Supports management of scanning documents, scan destinations, and 
scan settings.

Configure Scan Management settings.
Create scan destinations using the Microsoft OneDrive, SharePoint, Google Drive™, 
Box, and Dropbox cloud service providers.

Overview
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Customize scan settings for each scan destination.
Solution Center—Lets you create or customize your workflows depending on your roles in 
an organization.

Create a solution workflow.
Using the solution from the Lexmark Cloud Services portal.
Using the solution from a printer.

Analytics—Supports reporting on usage and printer activity.

Generate reports.
Export custom reports for a specific organization or user.
Generate a full data export that lets users customize a date range that can be monthly 
or up to 31 days for report generation.

This document provides instructions on how to configure, use, and troubleshoot the website.
This document is intended for partner administrators and organization administrators. For more information on 
the features available for users, see the Lexmark Cloud Services User’s Guide.
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1.

2.

3.

 

Accessing the Lexmark Cloud Services 
dashboard

From a web browser, depending on your Lexmark Cloud Services agreement, go to either 
https://na.cloud.lexmark.com or https://eu.cloud.lexmark.com.
Type your e‑mail address and password.

Note: If the system is configured to have federated access, then you are redirected to the 
login page of your organization.

Click Log In.

Available options

Depending on the role or roles that are assigned to you, one or more cards appear on the Lexmark Cloud 
Services dashboard. These cards are links to services within the Lexmark Cloud Services web portals or to 
reports or other information.

To access the dashboard or open another Lexmark Cloud Services portal, click  on the upper-right corner of 
the page.

Managing the dashboard
The dashboard provides quick access to the web portals and the cards that contain usage and status information. 
You can create and customize up to 10 dashboards, and each dashboard can contain up to 24 cards. The 
dashboard view is customizable. You can add, hide, move, or rename the cards.

The available web portals and cards depend on your assigned role. For more information on the roles, see 
Understanding roles on page 62.

The following screenshots are examples of the dashboards for the different user account roles.

Note: Refresh the cards by clicking . The cards on the dashboard automatically refresh after every five 
minutes.

Getting started

https://na.cloud.lexmark.com
https://eu.cloud.lexmark.com
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1.
2.
3.
4.

Organization administrators can add cards that are specific to the organization, such as active users and printers. 
They can also add cards showing their own print usage, Fleet Agent status. printer communication status, and 
fleet status.

Partner administrators can add cards that are specific to a particular partner organization. For example, cards can 
show their top customers based on print usage.

Users can view their own printer usage.

Creating a dashboard

Note: You can create up to 10 dashboards.

From the dashboard, click Actions.
Click Create Dashboard.
Type a unique dashboard name.
Click Create.
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2.
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2.
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4.

1.

2.
3.

•
•

1.
2.
3.
4.
5.
6.

1.
2.

Setting a default dashboard

Note: You cannot delete a dashboard that is set as default.

From the dashboard, click the dashboard menu, and then select the dashboard that you 
want to set as default.
Click Actions › Set as Default.
Click Set as Default.

Renaming a dashboard

From the dashboard, click the dashboard menu, and then select the dashboard that you 
want to rename.
Click Actions › Rename Dashboard.
Type the new dashboard name.
Click Rename.

Deleting a dashboard

From the dashboard, click the dashboard menu, and then select the dashboard that you 
want to delete.
Click Actions › Delete Dashboard.
Click Delete Dashboard.

Managing cards

Add cards

Notes

You can add up to 24 cards.
The dashboard view is not updated automatically when the user is given access to a new 
web portal. The web portal card must be added manually.

From the dashboard, click Actions.
Click Add Card.
Select a card type.
Update the card name.
If you are a partner administrator, then select an organization.
Click Add Card.

Edit cards

From the dashboard, click Actions.
Click Edit Cards.
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3.

◦
◦
◦
◦

4.

Do any of the following:

Add cards.
Edit the card properties.
Move cards.
Delete cards.

Note: You can switch to a different dashboard when editing cards, and all changes made 
in the dashboards are saved.

Click Done.

Change the view

Mouse over the Change View menu, and then select the number of columns.
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Deployment readiness checklist
You have any of the following web browsers to access the Lexmark™ Cloud Services 
website and its web portals:

Microsoft Edge version 125 or later
Mozilla Firefox version 126 or later
Google Chrome™ version 126 or later
Apple Safari version 17 or later

You have any of the following operating systems to run or install some Lexmark Cloud 
Services applications:
Lexmark Print Management Client

Windows 11
Windows 10
macOS version 14 or later
Ubuntu version 22.04 LTS

Note: To be able to use the LPMC version 3.4.x, make sure that you have installed 
Microsoft .NET Framework version 4.6 or later. To be able to use the LPMC version 3.5.x, 
make sure that you have installed Microsoft .NET Framework version 4.8 or later.

Printer Enrollment Tool

Windows 11
Windows 10
macOS version 13 or later
Ubuntu version 22.04 LTS
Windows server 2016
Windows server 2019
Windows server 2022

Note: For computers running on Windows operating systems, Windows .NET Framework 
v4.6.2 must be installed.

Fleet Agent

Windows Server 2016
Windows server 2019
Windows server 2022
Windows 11
Windows 10
Ubuntu 22.04 LTS
Debian 11
Red Hat Enterprise Linux 8

Note: Fleet Agent 32‑bit is no longer supported by any operating system.

Preparing for configuration
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Note: Select the agent or agents that fit the environment of your organization and the 
printers to manage. For more information, see Choosing an agent on page 101.

If you use the Fleet Agent to discover and add printers to the Fleet Management portal, then 
the server must have the following specifications:

1GHz dual‑core processor
2GB RAM or greater
32GB storage capacity or greater

Note: The Fleet Agent requires 12GB of storage.

The printers are configured properly so that they can be discovered and enrolled in the 
system.

There are no unresolved errors, such as paper jams or incorrect email configuration.
The date and time are configured correctly.
The HTTP and HTTPS ports are turned on.
The SNMP community strings are configured correctly.
The SNMP v3 must be enabled but there is no need to configure it.
The printer firmware is the latest version. For information on viewing the printer 
firmware version, see Viewing the printer firmware version on page 58.
The network and firewall or proxy settings in the printer are configured correctly.
The firewall or proxy settings are configured to allow printers to communicate with 
Lexmark Cloud Services.
Translation Assistant and Cloud Scan cannot coexist with Device Quotas application. 
Having these applications installed in the printer with Device Quotas causes an Invalid 
user error.

Note: To use Translation Assistant and Cloud Scan, make sure that you have 
disabled the Device Quotas application in your printer.

Notes
For more information, see the Embedded Web Server Administrator's Guide for the 
printer.
For more information on resolving printer errors, see the printer User’s Guide.

Solution Center

Make sure that the printers are supported. For more information on supported printers, see 
Supported printer models for Solution Center on page 57.
The printer firmware is running on 081.xxx or later.
The printer is enrolled in Lexmark Cloud Services.
Lexmark Cloud Services accounts have been set up for all users.
Solution Center is enabled for your organization.

Firewalls and proxy servers
If a firewall or proxy server is used, then the host names listed below must be added to the Allow List. All Cloud 
communications use port 443. Add the following host names to make sure that the printer can communicate with 
Cloud Fleet Management.
Hosts for the EU data center
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Function Used by Host

Identity Provider All customers idp.eu.iss.lexmark.com

Identity Provider All customers login.microsoftonline.com

Identity Provider All customers lexmarkb2ceu.b2clogin.com

Identity Provider All customers lexmarkb2c.b2clogin.com

Identity Provider All customers b2ccustomizationsprodsa

.blob.core.windows.net

API All customers api.eu.iss.lexmark.com

APIS All customers apis.eu.iss.lexmark.com

CFM All customers eu.iss.lexmark.com

CFM All customers prod-westeu-lex-cloud-iot

.azure-devices.net

CFM Native Agent only apis.iss.lexmark.com

CFM Native Agent only iss.lexmark.com

CFM Native Agent only prod-lex-cloud-iot.azure- 
devices.net

CFM Native Agent only global.azure-devices- 
provisioning.net

CFM All customers prodwesteulexcloudk8s54

.blob.core.windows.net

CCS All customers ccs.lexmark.com

CDN All customers ccs-cdn.lexmark.com

CPM CPM only prodwesteulexcloudk8s199

.blob.core.windows.net

Hosts for the U.S. data center

Function Used by Host

Identity Provider All customers idp.us.iss.lexmark.com

Identity Provider All customers login.microsoftonline.com

Identity Provider All customers lexmarkb2c.b2clogin.com
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Function Used by Host

Identity Provider All customers b2ccustomizationsprodsa

.blob.core.windows.net

API All customers api.us.iss.lexmark.com

APIS All customers apis.us.iss.lexmark.com

CFM All customers us.iss.lexmark.com

CFM All customers prod-lex-cloud-iot.azure- 
devices.net

CFM Native Agent only apis.iss.lexmark.com

CFM Native Agent only iss.lexmark.com

CFM Native Agent only global.azure-devices- 
provisioning.net

CFM All customers prodlexcloudk8s239

.blob.core.windows.net

CFM All customers prodlexcloudk8s239.iss.lex 
mark.com

CCS All customers ccs.lexmark.com

CDN All customers ccs-cdn.lexmark.com

CPM CPM only prodlexcloudk8s19

.blob.core.windows.net

Printer models information

Supported printer models

Cloud Fleet Management

Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
B2338

X ✔ ✔ X

Lexmark 
B2865

X ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
B3340

X ✔ ✔ ✔

Lexmark 
B3442

X ✔ ✔ ✔

Lexmark 
C21323

✔ ✔ X ✔

Lexmark 
C2240

✔ ✔ ✔ ✔

Lexmark 
C2325

X ✔ ✔ X

Lexmark 
C2326

X ✔ ✔ X

Lexmark 
C3224

X ✔ ✔ ✔

Lexmark 
C3326

X ✔ ✔ ✔

Lexmark 
C3426

X ✔ ✔ ✔

Lexmark 
C3426dw

X ✔ ✔ X

Lexmark 
C4150

✔ ✔ ✔ ✔

Lexmark 
C6160

✔ ✔ ✔ ✔

Lexmark C748 ✔ ✔ X ✔

Lexmark C792 ✔ ✔ X ✔

Lexmark C796 ✔ ✔ X ✔

Lexmark 
C9235

✔ ✔ ✔ ✔

Lexmark C925 ✔ ✔ X ✔

Lexmark C950 ✔ ✔ X ✔

Lexmark 
CS310dn

X ✔ X ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
CS331

X ✔ ✔ ✔

Lexmark 
CS410d

X ✔ X ✔

Lexmark 
CS421

X ✔ ✔ ✔

Lexmark 
CS431dw

X ✔ ✔ ✔

Lexmark 
CS510de, 
CS517de3

✔ ✔ X ✔

Lexmark 
CS521

X ✔ ✔ ✔

Lexmark 
CS622

✔ ✔ ✔ ✔

Lexmark 
CS720, 
CS725, 
CS727, CS728

✔ ✔ ✔ ✔

Lexmark 
CS748

✔ ✔ X ✔

Lexmark 
CS820, CS827

✔ ✔ ✔ ✔

Lexmark 
CS921, 
CS923, CS927

✔ ✔ ✔ ✔

Lexmark 
CS921de

✔ ✔ ✔ ✔

Lexmark 
CS923de

✔ ✔ ✔ ✔

Lexmark 
CX310dn

X ✔ X ✔

Lexmark 
CX331

X ✔ ✔ ✔

Lexmark 
CX331adwe

X ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
CX410, 
CX4173

✔ ✔ X ✔

Lexmark 
CX421

X ✔ ✔ ✔

Lexmark 
CX431

X ✔ ✔ ✔

Lexmark 
CX431adw

X ✔ ✔ ✔

Lexmark 
CX510de, 
CX517de3

✔ ✔ X ✔

Lexmark 
CX522, 
CX522de

✔ ✔ ✔ ✔

Lexmark 
CX622, 
CX622ade, 
CX625, 
CX625ade, 
CX625adhe

✔ ✔ ✔ ✔

Lexmark 
CX725, 
CX725ade, 
CX727

✔ ✔ ✔ ✔

Lexmark 
CX730de, 
CX735de

✔ ✔ ✔ ✔

Lexmark 
CX820, 
CX820de, 
CX825, 
CX825de, 
CX827, CX860

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
CX920, 
CX920de, 
CX921, 
CX821de, 
CX922, 
CX922de, 
CX923, 
CX923dte, 
CX923dxe, 
CX924, 
CX924dte, 
CX924dxe, 
CX927, 
CX931dse, 
CX931dtse

✔ ✔ ✔ ✔

Lexmark 
M1246

X ✔ ✔ ✔

Lexmark 
M1342

X ✔ ✔ ✔

Lexmark 
M31503

✔ ✔ X ✔

Lexmark 
M3250

✔ ✔ ✔ ✔

Lexmark 
M51553

✔ ✔ X ✔

Lexmark 
M51633

✔ ✔ X ✔

Lexmark 
M51703

✔ ✔ X ✔

Lexmark 
M5255

✔ ✔ ✔ ✔

Lexmark 
M5265

✔ ✔ ✔ ✔

Lexmark 
M5270

✔ ✔ ✔ ✔

Lexmark 
MS310dn

X ✔ X ✔

Lexmark 
MS312dn

X ✔ X ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
MS315dn

X ✔ X ✔

Lexmark 
MS321dn

X ✔ ✔ ✔

Lexmark 
MS410d

X ✔ X ✔

Lexmark 
MS415dn

X ✔ X ✔

Lexmark 
MS510dn

X ✔ X ✔

Lexmark 
MS610dn

X ✔ X ✔

Lexmark 
MS710dn

X ✔ X ✔

Lexmark 
MS711dn

X ✔ X ✔

Lexmark 
MS810dn

X ✔ X ✔

Lexmark 
MS811dn

X ✔ X ✔

Lexmark 
MS911de

✔ ✔ X ✔

Lexmark 
T654dn

X X X X

Lexmark 
X544dn

X X X X

Lexmark 
MB2236adw

X ✔ ✔ ✔

Lexmark 
MB2236adwe

X ✔ ✔ ✔

Lexmark 
MB2338

X ✔ ✔ ✔

Lexmark 
MB2442

✔ ✔ ✔ ✔

Lexmark 
MB2546

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
MB2650

✔ ✔ ✔ ✔

Lexmark 
MB2770

✔ ✔ ✔ ✔

Lexmark 
MB3442

X ✔ ✔ ✔

Lexmark 
MC2535

✔ ✔ ✔ ✔

Lexmark 
MC2640

✔ ✔ ✔ ✔

Lexmark 
MC3224dwe

X ✔ ✔ ✔

Lexmark 
MC3224adwe

X ✔ ✔ ✔

Lexmark 
MC3224i

X ✔ ✔ ✔

Lexmark 
MC3326

X ✔ ✔ ✔

Lexmark 
MC3326i

X ✔ ✔ ✔

Lexmark 
MC3426

X ✔ ✔ ✔

Lexmark 
MC3426adw

X ✔ ✔ ✔

Lexmark 
MC3426i

X ✔ ✔ ✔

Lexmark 
MS331

X ✔ ✔ ✔

Lexmark 
MS421

X ✔ ✔ ✔

Lexmark 
MS431

X ✔ ✔ ✔

Lexmark 
MS521 dn

X ✔ ✔ ✔

Lexmark 
MS610de3

✔ ✔ X ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
MS621

X ✔ ✔ ✔

Lexmark 
MS622

✔ ✔ ✔ ✔

Lexmark 
MS725

X ✔ ✔ ✔

Lexmark 
MS810de, 
MS812de3

✔ ✔ X ✔

Lexmark 
MS821

X ✔ ✔ ✔

Lexmark 
MS821n, 
MS821dn

X ✔ ✔ ✔

Lexmark 
MS823

X ✔ ✔ ✔

Lexmark 
MS823n, 
MS823 dn

X ✔ ✔ ✔

Lexmark 
MS825

X ✔ ✔ ✔

Lexmark 
MS825dn

X ✔ ✔ ✔

Lexmark 
MS822, 
MS826

✔ ✔ ✔ ✔

Lexmark 
MS911de3

✔ ✔ X ✔

Lexmark 
MX321adn

X ✔ ✔ ✔

Lexmark 
MX331adn

X ✔ ✔ ✔

Lexmark 
MX410de

✔ ✔ X ✔

Lexmark 
MX417de3

✔ ✔ X ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
MX421

✔ ✔ ✔ ✔

Lexmark 
MX431

X ✔ ✔ ✔

Lexmark 
MX431adn

X ✔ ✔ ✔

Lexmark 
MX510de, 
MX511de, 
MX517de3

✔ ✔ X ✔

Lexmark 
MX521de, 
MX522

✔ ✔ ✔ ✔

Lexmark 
MX610de, 
MX611de, 
MX611dhe, 
MX617de3

✔ ✔ X ✔

Lexmark 
MX622ade

✔ ✔ ✔ ✔

Lexmark 
MX6500, 6500

✔ ✔ X ✔

Lexmark 
MX710, 
MX711, 
MX717, 
MX7183

✔ ✔ X ✔

Lexmark 
MX721, 
MX722, 
MX725

✔ ✔ ✔ ✔

Lexmark 
MX810, 
MX811, 
MX8123

✔ ✔ X ✔

Lexmark 
MX822, 
MX826

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
MX910de, 
MX911, 
MX912 3

✔ ✔ X ✔

Lexmark T656, 
TS6564,5

X X X ✔

Lexmark X548 ✔ ✔ X ✔

Lexmark 
X651, X652, 
X654, X656, 
X6584,5

X ✔ X ✔

Lexmark 
X734, X736, 
X7384,5

X ✔ X ✔

Lexmark 
X746, X748

✔ ✔ X ✔

Lexmark X792 ✔ ✔ X ✔

Lexmark 
X860, X862, 
X8644,5

X ✔ X ✔

Lexmark 
X9255

✔ ✔ X ✔

Lexmark 
X950, X952, 
X954

✔ ✔ X ✔

Lexmark 
XC21323

✔ ✔ X ✔

Lexmark 
XC2235, 
XC2240

✔ ✔ ✔ ✔

Lexmark 
XC2326

X ✔ ✔ ✔

Lexmark 
XC4140, 
XC4150

✔ ✔ ✔ ✔

Lexmark 
XC4143

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
XC4240

✔ ✔ ✔ ✔

Lexmark 
XC6152, 
XC6153

✔ ✔ ✔ ✔

Lexmark 
XC6153de

✔ ✔ ✔ ✔

Lexmark 
XC8155, 
XC8160, 
XC8163

✔ ✔ ✔ ✔

Lexmark 
XC9225, 
XC9235

✔ ✔ ✔ ✔

Lexmark 
XC9245, 
XC9255, 
XC9265

✔ ✔ ✔ ✔

Lexmark 
XM1140, 
XM11453

✔ ✔ X ✔

Lexmark 
XM1242, 
XM1246

✔ ✔ ✔ ✔

Lexmark 
XM1342

X ✔ ✔ ✔

Lexmark 
XM31503

✔ ✔ X ✔

Lexmark 
XM3250

✔ ✔ ✔ ✔

Lexmark 
XM5163, 
XM51703

✔ ✔ X ✔

Lexmark 
XM5263, 
XM52703

✔ ✔ X ✔

Lexmark 
XM5365, 
XM5370

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
XM7155, 
XM7162, 
XM7163, 
XM71703

✔ ✔ X ✔

Lexmark 
XM7263, 
XM72703

✔ ✔ X ✔

Lexmark 
XM7355, 
XM7370

✔ ✔ ✔ ✔

Lexmark 
XM7355b

✔ ✔ ✔ ✔

Lexmark 
XM91453

✔ ✔ X ✔

Lexmark 
XM9155, 
XM91653

✔ ✔ X ✔

Lexmark 
XS651, 
XS652, 
XS654, 
XS656, XS658

X X X ✔

Lexmark 
XS748

✔ ✔ X ✔

Lexmark 
XS796

✔ ✔ X ✔

Lexmark 
XS860, 
XS862, XS864

X X X ✔

Lexmark 
XS925

✔ ✔ X ✔

Lexmark 
XS950, XS955

✔ ✔ X ✔

Lexmark 
CX635

✔ ✔ ✔ ✔

Lexmark 
CX532

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark 
CS632

✔ ✔ ✔ ✔

Lexmark 
CS531

X ✔ ✔ ✔

Lexmark 
XC2335

✔ ✔ ✔ ✔

Lexmark 
C2335

X ✔ ✔ ✔

Lexmark 
MX632

✔ ✔ ✔ ✔

Lexmark 
MX532

✔ ✔ ✔ ✔

Lexmark 
MS632

✔ ✔ ✔ ✔

Lexmark 
MS631

X ✔ ✔ ✔

Lexmark 
MS531

X ✔ ✔ ✔

Lexmark 
XM3350

✔ ✔ ✔ ✔

Lexmark 
M3350

✔ ✔ ✔ ✔

Lexmark 
MC53x

X ✔ ✔ ✔

Lexmark 
MC63x

X ✔ ✔ ✔

Lexmark 
XS53x

X ✔ ✔ ✔

Lexmark 
XS63x

X ✔ ✔ ✔

Lexmark 
MX432adwe

✔ ✔ ✔ ✔

Lexmark CX83 
3

✔ ✔ ✔ ✔
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Printer models Cloud Fleet Management

Printer Agent Fleet Agent1 Native Agent2 Local Agent

Lexmark CX95 
0, CX951, 
CX961, 
CX962, CX963

✔ ✔ ✔ ✔

Lexmark CX73 
7

✔ ✔ ✔ ✔

Lexmark 
MX953

✔ ✔ ✔ ✔

Lexmark XC93 
35, XC9445, 
XC9455, 
XC9465

✔ ✔ ✔ ✔

Lexmark XC83 
55

✔ ✔ ✔ ✔

Lexmark XC95 
25, XC9535

✔ ✔ ✔ ✔

Lexmark XC96 
35, XC9645, X 
C9655

✔ ✔ ✔ ✔

Lexmark CS96 
3e

✔ ✔ ✔ ✔

Lexmark 
XC9465

✔ ✔ ✔ ✔

Lexmark CS73 
9

✔ ✔ ✔ ✔

Lexmark CS73 
5

✔ ✔ ✔ ✔

Lexmark CS73 
7

✔ ✔ ✔ ✔
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Cloud Scan Management, Cloud Print Management, 
Authentication method, and Cloud Print Release

Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
B2338

X X X X X X

Lexmark 
B2865

X X X X X X

Lexmark 
B3340

X X X X X X

Lexmark 
B3442

X X X X X X

Lexmark 
C21323

X ✔ ✔ ✔ ✔ X

Lexmark 
C2240

X ✔ ✔ ✔ ✔ X

Lexmark 
C2325

X X X X X X

Lexmark 
C2326

X X X X ✔ ✔

Lexmark 
C3224

X X X X X X

Lexmark 
C3326

X X X X X X

Lexmark 
C3426

X X X X X X

Lexmark 
C3426d 
w

X X X X X X

Lexmark 
C4150

✔ ✔ ✔ ✔ ✔ X

Lexmark 
C6160

✔ ✔ ✔ ✔ ✔ X

Lexmark 
C748

✔ ✔ ✔ ✔ ✔ X



Preparing for configuration

43

Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
C792

✔ ✔ ✔ ✔ ✔ X

Lexmark 
C796

✔ ✔ ✔ ✔ ✔ X

Lexmark 
C9235

X ✔ ✔ ✔ ✔ X

Lexmark 
C925

X ✔ ✔ ✔ ✔ X

Lexmark 
C950

X ✔ ✔ ✔ ✔ X

Lexmark 
CS310dn

X X X X X X

Lexmark 
CS331

X X X X X X

Lexmark 
CS410d

X X X X X X

Lexmark 
CS421

X X X X X X

Lexmark 
CS431d 
w

X X X X ✔ ✔

Lexmark 
CS510de 
, 
CS517de 
3

X ✔ ✔ ✔ ✔ X

Lexmark 
CS521

X X X X X X

Lexmark 
CS622

X ✔ ✔ ✔ ✔ X

Lexmark 
CS720, 
CS725, 
CS727, 
CS728

X ✔ ✔ ✔ ✔ X

Lexmark 
CS748

X ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
CS820, 
CS827

X ✔ ✔ ✔ ✔ X

Lexmark 
CS921, 
CS923, 
CS927

X ✔ ✔ ✔ ✔ X

Lexmark 
CX310dn

X X X X X X

Lexmark 
CX331

X X X X ✔ ✔

Lexmark 
CX331ad 
we

X X X X ✔ ✔

Lexmark 
CX410, 
CX4173

X X X X X X

Lexmark 
CX421

X X X X X X

Lexmark 
CX431

X X X X ✔ ✔

Lexmark 
CX431ad 
w

X X X X ✔ ✔

Lexmark 
CX510de 
, 
CX517de 
3

X ✔ ✔ ✔ ✔ X

Lexmark 
CX522, 
CX522de

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
CX622, 
CX622ad 
e, 
CX625, 
CX625ad 
e, 
CX625ad 
he

✔ ✔ ✔ ✔ ✔ X

Lexmark 
CX725, 
CX725ad 
e, CX727

✔ ✔ ✔ ✔ ✔ X

Lexmark 
CX730de 
, 
CX735de

✔ ✔ ✔ ✔ ✔ X

Lexmark 
CX820, 
CX820de 
, CX825, 
CX825de 
, CX827, 
CX860

✔ ✔ ✔ ✔ ✔ X

Lexmark 
CX920, 
CX920de 
, CX921, 
CX821de 
, CX922, 
CX922de 
, CX923, 
CX923dt 
e, 
CX923dx 
e, 
CX924, 
CX924dt 
e, 
CX924dx 
e, 
CX927, 
CX931ds 
e, 
CX931dt 
se

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
M1246

X X X X X X

Lexmark 
M1342

X X X X X X

Lexmark 
M31503

X ✔ ✔ ✔ ✔ X

Lexmark 
M3250

X ✔ ✔ ✔ ✔ X

Lexmark 
M51553

X ✔ ✔ ✔ ✔ X

Lexmark 
M51633

X ✔ ✔ ✔ ✔ X

Lexmark 
M51703

X ✔ ✔ ✔ ✔ X

Lexmark 
M5255

X ✔ ✔ ✔ ✔ X

Lexmark 
M5265

X ✔ ✔ ✔ ✔ X

Lexmark 
M5270

X ✔ ✔ ✔ ✔ X

Lexmark 
MS310d 
n

X X X X X X

Lexmark 
MS312d 
n

X X X X X X

Lexmark 
MS315d 
n

X X X X X X

Lexmark 
MS321d 
n

X X X X X X

Lexmark 
MS410d

X X X X X X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MS415d 
n

X X X X X X

Lexmark 
MS510d 
n

X X X X X X

Lexmark 
MS610d 
n

X X X X X X

Lexmark 
MS710d 
n

X X X X X X

Lexmark 
MS711d 
n

X X X X X X

Lexmark 
MS810d 
n

X X X X X X

Lexmark 
MS811d 
n

X X X X X X

Lexmark 
MS911d 
e

X ✔ ✔ ✔ ✔ X

Lexmark 
T654dn

X X X X X X

Lexmark 
X544dn

X X X X X X

Lexmark 
MB2236 
adw

X X X X X X

Lexmark 
MB2236 
adwe

X X X X ✔ ✔

Lexmark 
MB2338

X X X X X X

Lexmark 
MB2442

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MB2546

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MB2650

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MB2770

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MB3442

X X X X X X

Lexmark 
MC2535

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MC2640

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MC3224 
dwe

X X X X ✔ ✔

Lexmark 
MC3224 
adwe

X X X X ✔ ✔

Lexmark 
MC3224i

X X X X ✔ ✔

Lexmark 
MC3326

X X X X x x

Lexmark 
MC3326i

X X X X ✔ ✔

Lexmark 
MC3426

X X X X x x

Lexmark 
MC3426 
adw

X X X X ✔ ✔

Lexmark 
MC3426i

X X X X ✔ ✔

Lexmark 
MS331

X X X X X X

Lexmark 
MS421

X X X X X X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MS431

X X X X X X

Lexmark 
MS521 
dn

X X X X X X

Lexmark 
MS610d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MS621

X X X X X X

Lexmark 
MS622

X ✔ ✔ ✔ ✔ X

Lexmark 
MS725

X X X X X X

Lexmark 
MS810d 
e, 
MS812d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MS821

X X X X X X

Lexmark 
MS821n, 
MS821d 
n

X X X X X X

Lexmark 
MS823

X X X X X X

Lexmark 
MS823n, 
MS823 
dn

X X X X X X

Lexmark 
MS825

X X X X X X

Lexmark 
MS825d 
n

X X X X X X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MS822, 
MS826

X ✔ ✔ ✔ ✔ X

Lexmark 
MS911d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MX321a 
dn

X X X X X X

Lexmark 
MX331a 
dn

X X X X ✔ ✔

Lexmark 
MX410d 
e

✔ X ✔ ✔ ✔ X

Lexmark 
MX417d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MX421

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX431

X X X X ✔ ✔

Lexmark 
MX431a 
dn

X X X X ✔ ✔

Lexmark 
MX510d 
e, 
MX511d 
e, 
MX517d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MX521d 
e, 
MX522

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MX610d 
e, 
MX611d 
e, 
MX611d 
he, 
MX617d 
e3

X ✔ ✔ ✔ ✔ X

Lexmark 
MX622a 
de

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX6500, 
6500

X ✔ ✔ ✔ ✔ X

Lexmark 
MX710, 
MX711, 
MX717, 
MX7183

X ✔ ✔ ✔ ✔ X

Lexmark 
MX721, 
MX722, 
MX725

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX810, 
MX811, 
MX8123

X ✔ ✔ ✔ ✔ X

Lexmark 
MX822, 
MX826

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX910d 
e, 
MX911, 
MX912 3

X ✔ ✔ ✔ ✔ X

Lexmark 
T656, 
TS6564,5

X ✔ ✔ ✔ ✔ X

Lexmark 
X548

X ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
X651, 
X652, 
X654, 
X656, 
X6584,5

✔ ✔ ✔ ✔ ✔ X

Lexmark 
X734, 
X736, 
X7384,5

X ✔ ✔ ✔ ✔ X

Lexmark 
X746, 
X748

X ✔ ✔ ✔ ✔ X

Lexmark 
X792

X ✔ ✔ ✔ ✔ X

Lexmark 
X860, 
X862, 
X8644,5

X ✔ ✔ ✔ ✔ X

Lexmark 
X9255

X ✔ ✔ ✔ ✔ X

Lexmark 
X950, 
X952, 
X954

X ✔ ✔ ✔ ✔ X

Lexmark 
XC21323

X ✔ ✔ ✔ ✔ X

Lexmark 
XC2235, 
XC2240

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC2326

X X X X ✔ ✔

Lexmark 
XC4140, 
XC4150

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC4143

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC4240

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
XC6152, 
XC6153

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC6153d 
e

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC8155, 
XC8160, 
XC8163

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC9225, 
XC9235

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XC9245, 
XC9255, 
XC9265

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM1140, 
XM11453

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM1242, 
XM1246

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM1342

✔ X X X ✔ ✔

Lexmark 
XM31503

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM3250

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM5163, 
XM51703

X ✔ ✔ ✔ ✔ X

Lexmark 
XM5263, 
XM52703

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM5365, 
XM5370

✔ ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
XM7155, 
XM7162, 
XM7163, 
XM71703

X ✔ ✔ ✔ ✔ X

Lexmark 
XM7263, 
XM72703

X ✔ ✔ ✔ ✔ X

Lexmark 
XM7355, 
XM7370

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM7355 
b

✔ ✔ ✔ ✔ ✔ X

Lexmark 
XM91453

X ✔ ✔ ✔ ✔ X

Lexmark 
XM9155, 
XM91653

X ✔ ✔ ✔ ✔ X

Lexmark 
XS651, 
XS652, 
XS654, 
XS656, 
XS658

X ✔ ✔ ✔ ✔ X

Lexmark 
XS748

X ✔ ✔ ✔ ✔ X

Lexmark 
XS796

X ✔ ✔ ✔ ✔ X

Lexmark 
XS860, 
XS862, 
XS864

X ✔ ✔ ✔ ✔ X

Lexmark 
XS925

X ✔ ✔ ✔ ✔ X

Lexmark 
XS950, 
XS955

X ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
CX635

✔ ✔ ✔ ✔ ✔ x

Lexmark 
CX532

✔ ✔ ✔ ✔ ✔ X

Lexmark 
CS632

X ✔ ✔ ✔ ✔ X

Lexmark 
CS531

X X X X ✔ ✔

Lexmark 
XC2335

✔ ✔ ✔ ✔ ✔ X

Lexmark 
C2335

X X X X ✔ ✔

Lexmark 
MX632

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX532

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MS632

X ✔ ✔ ✔ ✔ X

Lexmark 
MS631

X X X X ✔ ✔

Lexmark 
MS531

X X X X ✔ ✔

Lexmark 
XM3350

✔ ✔ ✔ ✔ ✔ X

Lexmark 
M3350

X ✔ ✔ ✔ ✔ X

Lexmark 
MC53x

X X X X ✔ ✔

Lexmark 
MC63x

X X X X ✔ ✔

Lexmark 
XS53x

X X X X ✔ ✔

Lexmark 
XS63x

X ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark 
MX432a 
dwe

✔ ✔ ✔ ✔ ✔ X

Lexmark  
CX833

✔ ✔ ✔ ✔ ✔ X

Lexmark  
CX950, 
CX951, 
CX961, 
CX962, 
CX963

✔ ✔ ✔ ✔ ✔ X

Lexmark  
CX737

✔ ✔ ✔ ✔ ✔ X

Lexmark 
MX953

✔ ✔ ✔ ✔ ✔ X

Lexmark  
XC9335, 
XC9445, 
XC9455, 
XC9465

✔ ✔ ✔ ✔ ✔ X

Lexmark  
XC8355

✔ ✔ ✔ ✔ ✔ X

Lexmark  
XC9525

XC9535

✔ ✔ ✔ ✔ ✔ X

Lexmark  
XC9635

XC9645

XC9655

✔ ✔ ✔ ✔ ✔ X

Lexmark  
CS963e

X ✔ ✔ ✔ ✔ X

Lexmark 
XC9465

X ✔ ✔ ✔ ✔ X

Lexmark  
CS739

X ✔ ✔ ✔ ✔ X

Lexmark  
CS735

X ✔ ✔ ✔ ✔ X
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Printer 
models

Cloud 
Scan 
Manage-

ment6

Cloud 
Print 
Manage-

ment

Authentication method Cloud 
Print 
ReleaseBadge User ID PIN

Lexmark  
CS737

X ✔ ✔ ✔ ✔ X

1 The Fleet Agent also discovers Lexmark and third‑party printers that are not listed on this table. In these 
printers, only data collection is supported. Depending on the Management Information Base (MIB) 
implementation, third‑party printers may have different levels of data collection capabilities.

2 Make sure that the firmware is updated to the latest version before enrolling the printer. For more information, 
see Updating printer firmware from the Embedded Web Server on page 58.

3 If these printer models are managed using the Fleet Agent, then sending notifications to the control panel is not 
supported.

4 You cannot deploy applications and configurations to these printer models using the Fleet Management web 
portal.

5 These printers do not support automatic print release.

6 Printers with eSF version 5.0 or later and printers with eSF version 4.0 or earlier require updated firmware to 
support Cloud Scan Management. To find the current firmware version in your printer, see . For information on 
updating firmware in your printer, see Updating printer firmware from the Embedded Web Server on page 58. 
Viewing the printer firmware version on page 58

Supported printer models for Solution Center

The following printer models support Solution Center:

Lexmark 
CX532adwe

Lexmark CX922de Lexmark CX960dse Lexmark 
MX722ade

Lexmark 
CX635adwe

Lexmark CX923dte Lexmark CX961dse Lexmark 
MX722adhe

Lexmark CX522 Lexmark CX923dxe Lexmark 
CX961dtse

Lexmark 
MX822ade

Lexmark CX622ade Lexmark CX924dte Lexmark CX962dse Lexmark 
MX822adxe

Lexmark 
CX622adhe

Lexmark CX924dxe Lexmark 
CX962dtse

Lexmark 
MX826ade

Lexmark CX625ade Lexmark CX930dhe Lexmark CX963dse Lexmark 
MX826adxe

Lexmark 
CX625adhe

Lexmark CX931dse Lexmark 
CX963dxse

Lexmark 
MX931dhe

Lexmark CX725 Lexmark 
CX931dtse

Lexmark 
MX432adwe

Lexmark MX953g
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1.

◦

◦

2.
3.

1.

Lexmark CX730de Lexmark 
CX942adhe

Lexmark 
MX522adhe

Lexmark MX953se

Lexmark 
CX735adhe

Lexmark 
CX943adtse

Lexmark 
MX532adwe

Lexmark 
MX963dse

Lexmark CX820 Lexmark 
CX944adtse

Lexmark 
MX622ade

Lexmark XC9525

Lexmark CX825 Lexmark 
CX944adxse

Lexmark 
MX622adhe

Lexmark XC9535

Lexmark CX833dse Lexmark CX950g Lexmark 
MX622adthe

Lexmark XM3350

Lexmark 
CX833dxse

Lexmark CX950se Lexmark 
MX632adwe

Lexmark XM5370

Lexmark CX860 Lexmark CX951g Lexmark 
MX721ade

Lexmark XM7355

Lexmark CX921de Lexmark CX951se Lexmark 
MX721adhe

Lexmark XM7370

Viewing the printer firmware version
To view firmware version on printers that support the latest interface, from the printer home screen, swipe right, 
and then touch Printer Info.

Open a web browser, and then type the printer IP address in the address field.

Notes
View the printer IP address on the printer home screen. The IP address appears as 
four sets of numbers separated by periods, such as 123.123.123.123.
If you are using a proxy server, then temporarily disable it to load the web page 
correctly.

Click Settings › Reports › Device › Device Information.
Take note of the Base value.

Updating printer firmware from the Embedded 
Web Server

Depending on the firmware version, you may need to update the firmware before enrolling the printer.

Using the update button

Open a web browser, and then type the printer IP address in the address field.
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◦

◦

2.
3.
4.
5.

1.

◦

◦

2.
3.
4.
5.
6.

1.

◦

◦

2.

Notes
View the printer IP address on the printer home screen. The IP address appears as 
four sets of numbers separated by periods, such as 123.123.123.123.
If you are using a proxy server, then temporarily disable it to load the web page 
correctly.

Click Device.
Scroll down, and then click Firmware Update.
Depending on your printer model, click Check for updates or Check for updates now.
If an update is available, then click Install now.

The printer restarts automatically after the update.

Using the firmware flash file (.fls)

Before you begin, make sure that you have downloaded the firmware and saved it on your computer or flash 
drive.

Open a web browser, and then type the printer IP address in the address field.

Notes
View the printer IP address on the printer home screen. The IP address appears as 
four sets of numbers separated by periods, such as 123.123.123.123.
If you are using a proxy server, then temporarily disable it to load the web page 
correctly.

Click Device.
Scroll down, and then click Firmware Update.
In the Update Firmware from File section, click Browse.
Search, and then select the .fls file.
Click Upload.

The printer restarts automatically after the update.

Viewing the Embedded Solutions Framework 
(eSF) version
The Embedded Solutions Framework (eSF) defines and identifies the software architecture for each touch‑screen 
printer generation. Application navigation, configurations, features, and capabilities vary in the different eSF 
versions.

Open a web browser, and then type the printer IP address in the address field.

Notes
View the printer IP address on the printer home screen. The IP address appears as 
four sets of numbers separated by periods, such as 123.123.123.123.
If you are using a proxy server, then temporarily disable it to load the web page 
correctly.

Depending on your printer model, do either of the following:
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Click Settings > Reports > Device > Device Information. Take note of the 
Embedded Solutions value.
Click Reports > Device, and then from the Embedded Solutions section, take note of 
the Framework value.
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Overview
Use the Account Management web portal to create organizations, and to organize and manage the users and the 
features that they are permitted to access. The web portal also lets you register and manage badges, passwords, 
and PINs for nonfederated organizations. For an organization that is federated to a separate identity provider, the 
web portal lets you configure an authentication provider.

Using the Account Management web portal, you can create and manage the following:

Organization—Represents the overall account for a specific customer. Some features of the 
Lexmark Cloud Services website can be managed at the organizational level. A System 
Administrator or a Partner Administrator can create an organization. An organization 
administrator must be assigned to manage the organization and its users.

Note:

To copy an organization ID, on the Organization Information page, click 
beside the organization ID.
The Organization Information page also displays the list of services that a 
particular organization is entitled to. To view the list of active services, on the 
Organization Information page, expand Active Lexmark Cloud Services.

Group—A collection of users that can be managed with a common set of roles or 
permissions.
Child Organization Access Group—A group that can be used to manage an organization 
that has multiple child organizations. Members of this group have access to all child 
organizations based on the roles assigned to the group.
User—An individual who has access to the Lexmark Cloud Services website. Permissions 
differ among roles, such as between an ordinary user and an organization administrator with 
full administrative privileges. Each user is a member of a specific organization. A user can 
also be a member of one or more groups.

Access to the features of the website is managed through the assignment of roles or permissions. Roles can be 
assigned at the organization, group, or individual user level. The organization administrator is responsible for 
determining which roles to assign and at what level. For more information on the roles, see Understanding roles 
on page 62.
Understanding Lexmark Cloud Services users

Partner administrators—They are responsible for setting up the customer environment. 
Partner administrators can create organizations that represent specific customers.

Partner administrators can do the following:

Create customer organizations.
Delete customer organizations.
Generate reports.

Organization administrators—They are responsible for managing printers and user access 
to Lexmark Cloud Services. Most employees with this role have technical knowledge, such 
as system administrators or IT professionals.

Account Management
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Organization administrators can do the following:

Manage the organization and its users.
Manage user roles within the organization.
Manage the printers within the organization.
Configure authentication providers.
Set the organization password requirements.
Configure the printer login.
Manage configurations.
Generate reports.

Users—They can access Lexmark Cloud Services and use the Print Management and 
Analytics web portal features. These users do not have administrative privileges.

Accessing the Account Management web portal
Open a web browser, access the Lexmark Cloud Services dashboard, and then do either of the following:

From the dashboard, click the Account Management card.

Note: If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then click 
Account Management.

Understanding roles
Roles are used to establish administrative permissions, and to manage access to specific features of the website. 
Roles can be assigned at the organization, group, or user level.

Note: The following roles are applicable only if the organization is entitled to the particular solutions. For 
example, if an organization is entitled to a Scan Management solution, then the Scan Management 
Administrator or Scan Management User role is applicable.

System roles

System roles are predefined roles.

Help Desk—Views users, badges, groups, applications, and organization information.
Organization Administrator—Manages the organization and its users.
Partner Administrator—Manages customer organizations and their users.

Note: This role is a special role for Lexmark resellers that create child organizations. 
Partner administrators can manage the child organizations that they have created under 
their parent organization. You can assign this role only to members of the Child 
Organization Access Group.

User—Views and manages your own account information. This role is the default role.
User Administrator—Manages users in the organization.

Note: The User Administrator can view and create users, groups, and badges, but can 
view only organization information.
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Fleet Management roles

File Service Administrator

Accesses the file management system when paired with the Fleet Management 
Administrator role.
Enrolls printers in Cloud Fleet Management.

Note: This role is required in order to download the printer log files that are requested 
from the Fleet Management web portal.

Fleet Management Administrator

Discovers printers in a network.
Enrolls printers in Cloud Fleet Management.
Manages and deploys configurations to printers.

Fleet Management Reporting Analyst—Accesses only the Fleet Management reporting 
data.

Note: This role does not let you enroll printers in their organization.

Fleet Management Viewer

Basic view role for Cloud Fleet Management.
Views the printers list and the printer details page without any rights to perform 
actions.
Views installed applications without any rights to perform actions.
Accesses only the Standard and Quick views.

Note: Accounts enrolling printers of child organizations in Cloud Fleet Management must be added as 
member of a Child Organization Access Group. They must also be assigned the Partner Administrator, 
Fleet Management Administrator, and File Service Administrator roles.

Print Management roles

Print Release Management Administrator

Manages the organizational settings of Cloud Print Management.
Manages the print queue of other users.
Assigns delegates.
Sets quotas for individuals and user groups.
Modifies document retention settings and other organizational print settings.
Generates and downloads the default and custom Lexmark Print Management Client 
and Universal Print Driver packages.

Print Release Management Reporting Analyst

Accesses only the Cloud Print Management reporting data.
Generates organizational Cloud Print Management reports but cannot release or 
submit print jobs.

Print Release Management User—Submits, views, and manages your own print jobs. This 
role is the basic user role for Cloud Print Management.
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Note: The Print Release Management User must be assigned to any user that requires 
access to Print Release basic features. Users can manage their own print queue and 
delegate their own print jobs to other users. If the organizational settings allow, then users 
can also download the default print driver packages.

Print Management Guest User—Unregistered users who can submit print jobs through 
email only.

Hybrid Print Management roles

Hybrid Print Management Administrator

Manages the organizational settings of Hybrid Print Management.
Manages the print queue of other users.
Sets quotas for individuals and user groups.
Modifies document retention settings and other organizational print settings.
Generates and downloads the default and custom Lexmark Print Management Client 
and Universal Print Driver packages.

Hybrid Print Management User—Views and manages your own print jobs. This role is the 
basic user role for Hybrid Print Management.

Direct Print Management roles

Direct Print Management Administrator

Manages configuration and access for Direct Print users.
Channel partners who manage printers in the customer organizations must be 
members of a Child Organization Access Group. The group must have the Direct 
Print Management Administrator role assigned to it.

Direct Print Management User—Submits print jobs via Direct Print.

Scan Management roles

Scan Management Administrator—Enables and manages scan destination across the 
organization.
Scan Management User—Uses the scan-to-destinations feature.

Translation Assistant roles

Translation Assistant Administrator—Manages Translation Assistant settings.
Translation Assistant User—Uses Translation Assistant for the entitled organization.

Solution Center roles

Solution Center Administrator—Creates personal and shareable solutions with their own 
organization.

Note: A Solution Center Administrator who is also a Partner Administrator can create and 
share solutions with child organizations.

Solution Center Advanced User—Creates personal solutions.
Solution Center User—Executes solutions.

Solution Quota roles

Solutions Quota Administrator—Uses the Solution Quota web portal to manage solution 
quota configurations for the organization.
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Redaction Assistant roles

Redaction Assistant User—Uses Redaction Assistant for the entitled organization.

Announcement Center roles

Announcement Center Author Admin—Manages and writes announcements for the 
Announcement Center.

Organization administrator

Managing the organization

This topic outlines the required tasks that the organization administrator must do when setting up the organization 
for the first time.

Assign organization roles.

All users in the organization inherit the roles assigned at the organization level. Assign only 
the roles that are applicable at end‑user level, such as the Print Release Management User 
role. For more information on the roles, see Understanding roles on page 62.

For an organization that has multiple child organizations, create a Child Organization Access 
Group, and then assign the group roles.

A Child Organization Access Group can be used to manage user access to all the child 
organizations. For more information, see Managing the Child Organization Access Group on 
page 66.

Create groups within the organization, and then assign the group roles.

Groups can be created to manage the users in the organization and establish a common set 
of roles. Members of the group inherit the roles and permissions that are assigned to a 
group. For more information, see Managing groups on page 67.

Set the password requirements.
Create users, import users, or configure the authentication provider to generate users 
automatically.

The Account Management web portal lets you create individual users. For organizations with 
many users, a batch import can be done using a CSV file. For more information, see 
Managing users on page 69.

Add users to a group.
Assign user roles.

The organization administrator can also do the following:

Configure an authentication provider.
Configure the printer login.
Manage badges and PINs.
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Managing the Child Organization Access Group

This feature is available only in organizations that have been enabled for the creation of child organizations. From 
the parent organization, you can create the Child Organization Access Group, assign group roles, and add 
members. The members have access to all child organizations based on the roles assigned to the group.

This feature lets you manage user access to multiple child organizations easily. For example, if the Child 
Organization Access Group is assigned with the Fleet Management Administrator role, then all the members in 
that group are fleet management administrators in all the child organizations.

From the Account Management web portal, select the parent organization.
Click Groups.
From the Child Organization Access tab, do any of the following:

Create a group

Click Create Group or Create, and then type a unique group name.

Note: We recommend naming the group as Child Organization Access Group to 
distinguish it from the regular groups created from the Groups feature. For more 
information on creating regular groups, see Managing groups on page 67.

Click Create Group.

Delete groups

Select one or more groups, and then click Delete.

Note: You can also search for groups using the search bar.

Click Delete Groups.

Add members to a group

Click a group name.
From the Members tab, click Add Members or Add, and then select one or more users.

Note: You can also search for groups using the search bar.

Click Add Members.

Remove group members

Click a group name.
From the Members tab, select one or more users, and then click Remove.
Click Remove Members.
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Assign group roles

Note: All users in the group inherit all the roles assigned to the group.

Click a group name.
From the Group Roles tab, click Assign Roles or Assign.
Select one or more roles.

Note: For more information, see Understanding roles on page 62.

Click Assign Roles.

Remove group roles

Click a group name.
From the Group Roles tab, select one or more roles, and then click Remove.
Click Remove Roles.

Assigning organization roles

Organization roles are specific roles assigned to an organization. For more information, see Understanding roles 
on page 62. All users that belong to the organization inherit the organization roles. For example, if an organization 
is assigned with the Print Release Management User role, then all users in the organization can use the Cloud 
Print Management feature.

From the Account Management web portal, click Organization > Organization Roles.
Click Assign, and then select one or more roles.
Click Assign Roles.

Removing organization roles

From the Account Management web portal, click Organization > Organization Roles.
Select one or more roles, and then click Remove.
Click Remove Roles.

Understanding the password requirements

Passwords must be at least 8 characters long and contain the following:

A lowercase character
An uppercase character
A number (0–9)
A special character (~ ! @ # $ % ^ & * _ - + = ` | \ ( ) { } [ ] : ; " ' < > , . ? /)

Managing groups

A group is a collection of users that can be managed with a common set of roles or permissions.
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The following groups are predefined, and are assigned with specific roles:

Admin—This group consists of roles with organizational administrator rights.
Fleet Management Admins—This group consists of members with role for Fleet 
Management Administrator, File Service Administrator, and Fleet Management Reporting 
Analyst.
Fleet Management Viewers—This group consists of members with role for Fleet 
Management Viewer and File Service Administrator.
Help Desk—This group consist of members who can view users, badges, groups, 
applications, PINs, and organization information.
Reporting—This group consists of members with role of reporting analysts.

From the Account Management web portal, click Groups.
Do any of the following:

Create a group

Click Create, and then type a unique group name.
Click Create Group.

Delete groups

Deleting a group does not delete the users from the organization. The users are disassociated from the group, 
and then the group is removed from the system.

Select one or more groups, and then click Delete.

Note: You can also search for groups using the search bar.

Click Delete Group or Delete Groups.

Add members to a group

Click a group name.
From the Members tab, click Add Members, and then select one or more users.

Note: You can also search for users using the search bar.

Click Add Members.

Remove group members

Click a group name.
From the Members tab, select one or more users, and then click Remove.
Click Remove Members.
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Assign group roles

All users in the group inherit all the roles assigned to the group.

Click a group name.
From the Group Roles tab, click Assign Roles or Assign.
Select one or more roles.
Click Assign Roles.

Remove group roles

Click the group name.
From the Group Roles tab, select one or more roles, and then click Remove.
Click Remove Roles.

Managing users

Create a user

From the Account Management web portal, click Users.
Click Create.
Type the email address, first name, last name, and display name of the user.
Type the department and cost center name where the user belongs.
Set the password manually, or email a link to the user to change the password.
Click Create User.

Edit a user

From the Account Management web portal, click Users.
Click a user email address.
Do any of the following:

Edit the personal information.
Change the user password.
Assign user roles.
Register a badge.
From the Printer Login section, click Edit beside Badge Login.
Add the user to a group.
Set the user PIN.

Note: This setting is available only when the printer login is set to PIN Login or 
Badge + PIN as second factor. The PIN generation must be set to Administrator 
manually set.

From the Printer Login section, click Set PIN or Reset PIN.
Enter the PIN, and then click Generate PIN.
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Delete users

Select one or more users, and then click Delete.

Notes
You can also search for users using the search bar.
The activities of a deleted user are still shown in the Analytics web portal, but the 
name and email address are removed from all the reports.

Click Delete Users.

Import users

The Import feature lets you create, update, and delete multiple users in an organization using a CSV or TXT file. 
You can also create user groups, and then assign a user to those groups.

Note: The import log is sent to your email address.

Click Import Users  or Import, and then browse to the CSV or TXT file.
If necessary, email a link to the user to change the password.
Click Import Users.

Sample CSV format

EMAIL,OPERATION,PASSWORD,FIRST_NAME,LAST_NAME,DISPLAY_NAME,SHORTNAME,GROUPS, 
CUSTOM_ATTRIBUTES,COST_CENTER,DEPARTMENT 
jdoe@company.com,CREATE,,John,Doe,Johnny,jdoe,Group 1,"{'key1':'value1','key2':'value2'}" 
llane@company.com,UPDATE,password2,Lois,Lane,Lois,llane,, ckent@company.com,DELETE,,,,,,,

The import file header line must be the following and is case‑sensitive: 
EMAIL,OPERATION,PASSWORD,FIRST_NAME,LAST_NAME,DISPLAY_NAME,SHORTNAME,GROUPS,CUST 
OM_ATTRIBUTES,COST_CENTER,DEPARTMENT

Line values and their conditions

EMAIL—Required for all users. EMAIL values that are in uppercase in the file are converted 
to lowercase before the operation is performed. For example, JDOE@company.com is 
converted to jdoe@company.com.
OPERATION—Required for all users.
Valid OPERATION values

CREATE—Creates a user identified by the EMAIL value with the corresponding 
properties on the line.
UPDATE—Updates the existing user identified by the EMAIL value with the 
corresponding properties on the line. You can use the [delete] action string to remove 
the first name, last name, display name, and short name.
DELETE—Deletes the existing user identified by the EMAIL value.

PASSWORD—Not required for any OPERATION, and can be empty only when “E-mail a link 
to change the password” option is selected when importing.

Note: Enable the “E-mail a link to change the password” option only when importing files 
with the CREATE operation.
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FIRST_NAME—Not required for any OPERATION, and can be empty. The first name of the 
user. For example, John.
LAST_NAME—Not required for any OPERATION, and can be empty. The last name of the 
user. For example, Doe.
DISPLAY_NAME—Not required for any OPERATION, and can be empty. The name of the 
user that is sometimes used in display prompts or log reports. The DISPLAY_NAME value 
can be the full name with middle initial or any string. For example, John A. Doe. The 
DISPLAY_NAME value is not directly associated with the FIRST_NAME and LAST_NAME 
values.
SHORTNAME—Not required for any OPERATION, and can be empty. The SHORTNAME 
value is used when the organization has a shortname string that also identifies the user in 
the organization. For example, jdoe.
GROUPS—Not required for any OPERATION, and can be empty. Separate multiple groups 
by using commas and enclosing them in double quotation marks. For example, 
"Group1,Group2,Group3". GROUPS values that do not exist in the organization are created, 
and then added to the organization automatically.

Note: A group name must not contain the following characters: ! @ # $ % ^ & * ; + ? / \ [ ]. 
If these characters are used, then they are replaced with an underscore (_).

CUSTOM_ATTRIBUTES—Not required for any OPERATION, and can be empty. The 
CUSTOM_ATTRIBUTES value is a specially formatted JSON string for user metadata that is 
stored with the user. The value must be enclosed in double quotation marks. For example, 
"{'key1':'value1','key2':'value2'}"
COST_CENTER—Not required for any OPERATION, and can be empty. The 
COST_CENTER value is used for quota assignments and cost‑center‑level reporting in the 
Analytics web portal.
DEPARTMENT—Not required for any OPERATION, and can be empty. The DEPARTMENT 
value is used for quota assignments and department‑level reporting in the Analytics web 
portal.

Notes

All lines must have the same number of values as the header, including the commas. 
Follow empty values with commas. For example, jdoe@company.com,DELETE,,,,,,,
The file size must not exceed 1MB.
Importing a file with CREATE and UPDATE operations with more than one group 
assignment can take a few minutes.
If any line value contains a comma, such as the names, password, groups, or custom 
attributes, then the value must be enclosed in double quotation marks. For example, 
llane@company.com,UPDATE,"pass,word2",Lois,Lane,"Lois,Lane",llane,"Group1,Group2" 
,

Assigning user roles

Assigning user roles gives a particular user access to a particular task or function that is not appropriate to assign 
as a group or organization role. Groups or organizations that the user belongs to do not inherit the user role. For 
more information, see Understanding roles on page 62.

From the Account Management web portal, click Users, and then click the user e-mail 
address.
From the Assigned Roles section, click Edit.
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From the User Roles tab, click Assign, and then select the roles.
Click Assign Roles.

Removing user roles

For more information, see Understanding roles on page 62.

From the Account Management web portal, click Users, and then click the user e-mail 
address.
From the Assigned Roles section, click Edit.
Select one or more roles, and then click Remove.
Click Remove Roles.

Configuring Microsoft Entra ID with OIDC 
Federation

Configuring Microsoft Entra ID federation for OIDC 
overview

This document provides guidance for network administrators on configuring Microsoft Entra ID to enable OpenID 
Connect (OIDC) federation with the Lexmark Cloud Services. For more information, contact the Lexmark 
Professional Services team.
Prerequisites

Before you begin, make sure that you have administrator access to the following portals:

Microsoft Entra ID
Lexmark Cloud Services

Understanding federation

After implementing OIDC for federation, when accessing the Lexmark Cloud Services portal for the first time, 
users are prompted to enter their email address. They are then redirected to their identity provider (IDP) to 
complete the login procedure.

Registering a web application

From the Azure portal, navigate to the Microsoft Entra ID.
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In the Manage section, select App registrations.
Click New registration.

Provide a name for the application.
Select the supported account types for the application registration.

Microsoft only – Single tenant—All user and guest accounts within your directory 
can use the application or API. Select this option if your target audience is internal to 
your organization.
Any Azure AD directory – Multitenant—Users with work or school accounts from 
Microsoft, including Office 365 users, can use the application or API. Select this option 
for business or educational customers and to enable multitenancy.
Any Azure AD directory – Multitenant and personal Microsoft accounts—Users 
with work or school accounts, as well as personal Microsoft accounts, can access the 
application or API. These users include Office 365 users and individuals using services 
like Xbox and Skype. Select this option to target a wide range of Microsoft identities 
and enable multitenancy.
Personal Microsoft accounts only—Allows access only to personal Microsoft 
accounts used for services like Xbox and Skype. Select this option to target the 
broadest range of Microsoft identities.

In the Redirect URL menu, select Web.
Type the redirect URL or reply URL for your portal in the provided text box.
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Note: The authorization server routes the user to the redirect URL after successfully 
authorizing and granting an authorization code or access token.

The redirect URL must begin with the scheme https unless you use a localhost redirect 
URL.
The redirect URL is case-sensitive. Its case must match the URL path of your running 
application.
Make sure that the redirect URL includes or excludes the trailing forward slash 
according to your application.
The redirect URLs for U.S. and EU regions are as follows:

US—https://lexmarkb2c.b2clogin.com/lexmarkb2c.onmicrosoft.com/oauth2/ 
authresp
EU—https://lexmarkb2ceu.b2clogin.com/lexmarkb2ceu.onmicrosoft.com/oauth2/ 
authresp

Select Register.

Creating a client secret

The client secret, also referred to as the application password, allows your application to exchange an 
authorization code for an access token

From the Manage section, select App registrations.
Select the application that you created (for example, OIDC Test 1).

https://lexmarkb2c.b2clogin.com/lexmarkb2c.onmicrosoft.com/oauth2/authresp
https://lexmarkb2ceu.b2clogin.com/lexmarkb2ceu.onmicrosoft.com/oauth2/authresp
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In the Manage section, select Certificates and secrets.

Click New client secret.

Provide a description.
Set an expiry date.
Click Add.

Save the client secret for later use in this guide.
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Enabling implicit grant and hybrid flows

From the Manage section, select App registrations.
Select the application that you created (for example, OIDC Test 1).
In the Manage section, select Authentication.

In the Implicit grant and hybrid flows section, select ID tokens.
Click Save .

Note: IdP initiated flow is not supported.

Retrieving the application (client) ID

From the Microsoft Azure navigation menu on the upper‑left corner of the page, select 
Microsoft Entra ID.
In the Manage section, select App registrations.
Select the application that you created (for example, OIDC Test 1).
In the Essentials section, duplicate the application (client) ID.
Save this ID for later use in this guide.
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Retrieving the OpenID Connect metadata document

From the current screen, select Endpoints.

In the Endpoints section, locate OpenID Connect metadata document.
Save the URL for later use in this guide.

Configuring claims

From the Azure portal, navigate to the Microsoft Entra ID.
In the Manage section, select App registrations.
Select the application that you created (for example, OIDC Test 1).
In the Manage section, select Token configuration.

Click Add optional claim.

Under Token type, select ID.
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From the list that appears, select the claims that you want to add.

You can select three claims and four additional claims based on the preferences and 
business use cases.

Required claims:

email
family_name
given_name

Click Add.

To include additional claims, click Home › Microsoft Entra ID.

Note: If you use additional claims, then make sure that you set the acceptMappedClaims 
property to true in the application manifest. For more information, see Updating manifest 
to support custom claims on page 80.

On the navigation pane, click Manage › Enterprise applications › select your application.
From the Manage menu, click Single Sign-on.
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In the Attributes & Claims section, click Edit.
On the Attributes & Claims page, click Add new claim.
On the Manage claim page, do the following:

Note:
If you want to add additional Attributes & Claims, then on the Manage claim page, 
you may add Badge, PIN, Costcenter, and Department as additional optional claims.
For more information on setting up claims and attributes, see Setting up attributes 
and claims on page 87.

In the Name field, type Badge.

Note: In this example, we are adding Badge as one of the additional claims.

Select Attribute as the source.
From the Source attribute menu, select the user.employeeid.

Note: For the Source attribute menu, you can select according the requirement. In 
this example, as we are adding Badge as one of the additional claims, so we have 
used user.employeeid as the Source attribute.

Click Save.

Click x on the top right to close.
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Note:
On the Manage claim page, repeat the steps for adding each additional claim.
If you are using a different identity provider, make sure that the claims are named 
exactly as shown.

From the menu that appears, select Turn on the Microsoft Graph email, profile 
permission (required for claims to appear in the token), and then click Add.

Note: The selected claims appear under your application.

Updating manifest to support custom claims

For single tenant apps, you can set the acceptMappedClaims property to true in the application manifest. This 
allows an application to use claims mapping without specifying a custom signing key.

Warning
Do not set the acceptMappedClaims property to true for multi-tenant apps. This can allow malicious actors to 
create claims-mapping policies for your application.

Open your application from App Registrations.
From the navigation menu, select Manifest.
Update the property acceptMappedClaims to true.
Click Save.

Configuring Lexmark Cloud Services

Log in to Lexmark Cloud Services.
From the navigation menu on the right side of the screen, select Account Management.
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If necessary, select your organization, and then click Next.

In the Organization section, select Authentication Provider.

Click Configure on Authentication Provider.

From the Authentication Provider Type menu, select OIDC.
Enter the required information copied from Azure AD:

Client ID (Application client ID)
Client Secret (Client secret value)
Well-known URL (OpenID Connect metadata document URL)

Note: The Domains field allows Lexmark Cloud Services to automatically establish 
a new user account after the user logs in. Listing each organization's domain is not 
required. If no domain is set, then the new users must be manually added to the 
organization before they log in.

Click Configure Authentication Provider.
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Note: Once authentication configuration is completed, you will receive an email on 
configuration status. In case of configuration failure, contact your Lexmark representative.

Testing a federation

Note: Do not log out or close the current browser until the federation is successfully set up and verified.

From the same workstation, open an incognito browser window or a different browser 
window.
From a different workstation, open a new browser window.
Log in to Lexmark Cloud Services from either workstation.

Instead of the default Lexmark Cloud Services login page, you are directed to your IDP.

Log in with your credentials.
Validate the claim details in the My Account page of Lexmark Cloud Services.
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Configuring Microsoft Entra ID with SAML 
Federation

Configuring Microsoft Entra ID federation for SAML 
overview

This section is intended to help network administrators configure Microsoft Entra ID for Security Assertion Markup 
Language (SAML) federation with the Lexmark Cloud Services. For more information, contact the Lexmark 
Professional Services team.
Prerequisites

Before you begin, make sure that you have administrator access to the following portals:

Microsoft Azure portal
Lexmark Cloud Services

Understanding the user experience for CIAM 
organization

After federation with SAML is complete, first‑time users must provide their email address in the Lexmark Cloud 
Services portal. Then they are redirected to their identity provider to complete the login process.
If the user has never signed into their identity provider, they are prompted for their username and password. On 
completing that sign-in process, the user is then redirected back to the Lexmark Cloud Services portal.

Configuring Microsoft Entra ID

The screenshots may vary depending on the latest release
Creating an enterprise application

Log in to the Microsoft Azure portal.
Select Microsoft Azure.

Select Microsoft Entra ID.
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In the Manage section, click Enterprise applications > New application.

Click Create your own application.

On the Create your own application window, in the What’s the name of your app? field, type 
the name of your new enterprise application.
Select Integrate any other application you don’t find in the gallery (Non-gallery).
Click Create.
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Setting up basic SAML configuration

The screenshots may vary depending on the latest release

Select Microsoft Azure.
Select Microsoft Entra ID.
In the Manage section, click Enterprise applications.
Select the application that you have created.

On the application overview page, in the Getting Started section, select Set up single sign 
on.

Select SAML.
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In the Basic SAML Configuration section, click Edit.

In the Basic SAML Configuration window, do the following:

In the Identifier (Entity ID) section, click Add Identifier.
In the Add identifier field, depending on your location, type either of the following entity 
IDs:

For EU: https://lexmarkb2ceu.b2clogin.com/LexmarkB2CEU.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam
For US: https://lexmarkb2c.b2clogin.com/LexmarkB2C.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam

In the Reply URL (Assertion Consumer Service URL) section, click Add reply URL.
In the Add reply URL field, depending on your location, type either of the following 
reply URLs:

For EU: https://lexmarkb2ceu.b2clogin.com/LexmarkB2CEU.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam/samlp/sso/assertionconsumer
For US: https://lexmarkb2c.b2clogin.com/LexmarkB2C.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam/samlp/sso/assertionconsumer

Click Save.

Note: IdP initiated flow is not supported.
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Setting up attributes and claims

The screenshots may vary depending on the latest release

On the SAML‑based Sign‑on page, in the Attributes & Claims section, click Edit.

Delete the additional claims. To delete additional claims, click   for that particular claim, 
and then click Delete.
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Note: Repeat this step to delete all the additional claims.

Click Add new claim.
Add the following required claims and their respective source attributes:

Claim Name Source Attribute

Unique User Identifier (Name ID) user.userprincipalname

Email user.mail

Givenname user.givenname

Surname user.surname

Note: To add the above mentioned required claims, repeat the following steps for each 
claim

On the Attributes & Claims page, click Add new claim.
On the Manage Claim page, in the Name  field, type the name of the required claim.
Leave the Namespace field blank.
For the Source, select Attribute.
From the Source attribute menu, select the appropriate attribute.

Setting up optional attributes and claims

On the Attributes & Claims page, click Add new claim.
On the Manage Claim page, in the Name  field, type the name of the additional claim.
Leave the Namespace field blank.
For the Source, select Attribute.

Note: You can either select a user attribute or apply a transformation to the user attribute 
before setting it as a claim.

From the Source attribute menu, select the appropriate attribute.
Click Save.

Note:
Repeat the above steps to add each additional claim
If you are using a different identity provider, make sure that the claims are named 
exactly as shown.

Make sure that all the required and additional claims are listed in the Attributes & Claims 
section.
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Downloading certificates and copying URLs

The screenshots may vary depending on the latest release.
After adding your claims, do the following steps:

On the SAML‑based Sign‑on page, in the SAML Certificates section, click Download to 
download the Certificate (Base64).
Copy and retain the App Federation Metadata Url.
In the application setup section, copy and retain the values for Login URL and Logout URL.

Notes

Lexmark SAML federation with ADFS currently does not support token encryption.
The App Federation Metadata Url, Login URL, and Logout URL are required for 
configuring the Lexmark Cloud Services portal.

Assigning groups and users

The screenshots may vary depending on the latest release
Depending on the Azure configuration, you are required to either assign users to the new enterprise application, 
or specify that user assignment is not required.

Select Microsoft Azure.
Select Microsoft Entra ID.
In the Manage section, click Enterprise applications.
Select the application that you created.
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On the application overview page, in the Getting Started section, select Assign users and 
groups.

In the Manage menu, select Properties.

On the Properties page, in the Assignment required? section, select Yes or No.

Configuring Lexmark Cloud Services

The screenshots may vary depending on the latest release.

Log in to Lexmark Cloud Services.
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From the navigation menu on the right side of the screen, select Account Management.

If necessary, select your organization, and then click Next.

From the Organization menu, select Authentication Provider.

Click Configure on Authentication Provider.

From the Authentication Provider Type menu, select SAML.
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Note: The Domains field allows Lexmark Cloud Services to establish a new user account 
after the user logs in. Listing each organization domain is not required. If no domain is set, 
then the new users must be manually added to the organization before they log in.

In the SAML Authentication Provider section, select either With Metadata URL or Without 
Metadata URL.

Note: We recommend selecting With Metadata URL for a shorter process.

With Metadata URL

If you want to configure the SAML Authentication Provider section with Metadata URL, then perform the following 
steps:

In the SAML Authentication Provider section, select With Metadata URL.

In the SAML Metadata URL (Required) field, paste the App Federation Metadata Url that you 
have previously copied and retained.
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Note: For more information on App Federation Metadata Url, see Downloading certificates 
and copying URLs on page 89

.
Click Configure Authentication Provider.

Without Metadata URL

If you want to configure the SAML Authentication Provider section without Metadata URL, then perform the 
following steps:

In the SAML Authentication Provider section, select Without Metadata URL.

In the Identity provider entity ID (Required) field, depending on your location, type either of 
the following:

For EU: https://lexmarkb2ceu.b2clogin.com/LexmarkB2CEU.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam
For US: https://lexmarkb2c.b2clogin.com/LexmarkB2C.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam

Note: The URLs must be same to the URLs entered in Microsoft Entra ID.

Enter the required information copied from Azure AD:.

SSO target URL (Required)
SSO Logout URL (Required)
Certificate (Required)

Note: Make sure that you include the header and the footer for the certificate.

Click Configure Authentication Provider.

Note: Once authentication configuration is completed, you will receive an email on 
configuration status. In case of configuration failure, contact your Lexmark representative.
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Note: Make sure that you do not exit the Lexmark Cloud Services portal or allow the portal to time out. It is 
time to test your SAML connection, and you may be unable to log in to correct any problems discovered during 
testing. For more information on testing the federation, see Testing a federation on page 94.

Testing a federation

The screenshots may vary depending on the latest release.

Note: Do not log out or close the current browser until the federation is successfully set up and verified.

From the same workstation, open an incognito browser window or a different browser 
window.

Note: The browser should be opened in either private or incognito mode.

From a different workstation, open a new browser window.
Log in to Lexmark Cloud Services from either workstation.

Depending on your location, use either of these URLs:

For EU: https://lexmarkb2ceu.b2clogin.com/LexmarkB2CEU.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam
For US: https://lexmarkb2c.b2clogin.com/LexmarkB2C.onmicrosoft.com/ 
B2C_1A_TrustFrameworkBase_ciam

Note: The user is prompted to log in to Azure rather than to Lexmark Cloud Services.

Check their My Account page to verify the details.

Partner administrator
Partner administrators can use the Account Management web portal to create child organizations.



Account Management

95

1.
2.

3.

1.
2.

◦

◦

3.

◦
◦

4.
5.

Creating an organization

Partner administrators can set up their customer’s environment using the Child Organizations feature.

Note: The Partner Administrator role is required in creating child organizations.

From the Account Management web portal, select the parent organization.
Click Create, and then type a unique organization name.

Note: Special characters are not supported.

Click Create Child Organization.

Deleting organizations

Deleting an organization deletes all the users, groups, applications, and badges that are associated with the 
organization.

From the Account Management web portal, select the parent organization.
Click the name of the child organization, you want to delete.

Notes
You can delete only one child organization at a time. Use this feature with caution. 
When you delete an organization, all the users, groups, applications and badges 
that are associated with the organization are also deleted.
You can also search for child organizations using the search bar.

On the Organization Information page, click Delete Organization.

Note: Delete Organization remains deactivated for the following reasons:
If the organization is in pending deletion state
If the organization has MPS Express enabled

On the Delete Organization window, click Continue.
On the Delete Organization window, type the name of the child organization to be deleted, 
and then click Delete.

Note: Only users who are members of a Child Organization Access Group that has the 
Organization Administrator role can create and delete child organizations.



Account Management

96

1.

2.

◦
◦
◦

3.

1.

2.
3.
4.

5.

1.

◦
◦

▪

▪

Managing printer logins

Configuring printer login

The Account Management web portal lets you configure the user authentication settings of the printers enrolled in 
your organization. Changing the settings in the Account Management web portal overrides the authentication 
settings that are configured on the printers.

Configure the standard authentication

You can set the printers to authenticate users using their permanent or temporary badge, a PIN, or user 
credentials.

From the Account Management web portal, click Organization › Printer Login 
Configurations.
Click Standard authentication, and then select one or more of the following:

Badge—Authenticate users using their permanent or temporary badge.
PIN—Authenticate users using a PIN.
Secure Login—Authenticate users using their user credentials.

Click Save Changes.

Configure Badge + PIN as second factor

You can configure the printers to authenticate users using both their permanent or temporary badge and a PIN.

From the Account Management web portal, click Organization › Printer Login 
Configurations.
Click Badge + PIN as second factor.
From the PIN Details section, configure the PIN details.
If necessary, to let users log in to the printers using their user credentials, select Secure 
Login.
Click Save Changes.

Configuring the PIN settings

From the Organization PIN Details section, do any of the following:

Specify the PIN length
Select a PIN generation option

Automatically generate and email—An automatically generated PIN is sent to 
the user’s e‑mail address.

If this setting is selected, an automatically generated PIN is sent to the user’s 
email address once the administrator or user Set or Reset the PIN, which will 
then trigger the email.
Administrator manually set—You can set the PIN manually from the Account 
Management web portal.
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For more information, see Managing users on page 69.

You can also import the PINs using a CSV or text file. For more information, see 
Managing PINs on page 98.
User set—Users can set their own PIN manually.

Set the PIN expiration

Note: This feature is available only when the PIN generation option is set to 
Administrator manually set or User set.

Never expires—The default setting for the PIN expiration.
Expires after—Set the number of hours or days that the PIN can be used.

Click Save Changes.

Obtaining secure login code

Notes

The secure login code appears on the Generate Login Code page.
You can click Refresh to refresh the code. The login code automatically refreshes after 
every 15 minutes.
Use this login code to log into the printer. The login code cannot be reused.

Open a web browser, and then type the address of Lexmark Cloud Services server.

Note: Depending on the location of the data center, go to either https://us.iss.lexmark.com 
or https://eu.iss.lexmark.com.

Log in to the Lexmark Cloud Services website.
In the browser address field, replace the web address https://<env>.iss.lexmark.com with 
https://<env>.iss.lexmark.com/device.

Note: Depending on the location of the data center, <env> can be either us or eu. To 
determine the value of <env>, see the address on the browser address field.

Managing badges

The Account Management web portal lets administrators register badges to the system. If badges are not 
registered using the Account Management web portal, then users must register their badge when they first log in 
to the printer.

Organization administrators and user administrators can register a permanent or temporary badge on behalf of a 
user.

Register a badge

From the Account Management portal, click Users › Badge/PIN.
From the Badges tab, click Register Badge or Register, and then type the user e‑mail 
address, badge ID, and description.

https://us.iss.lexmark.com/
https://eu.cloud.lexmark.com/
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Notes
To make the badge ID visible, select Show badge ID.
To register the badge as temporary, select Temporary Badge. Temporary badges 
expire after 24 hours.
Federated users who have their badge numbers in the Active Directory are not 
prompted to register their badge.

Click Register Badge.

Delete badges

Select one or more badges, and then click Delete.

Note: You can also search for badges using the search bar. Make sure to type the 
complete e‑mail address or badge ID.

Click Delete Badges.

Import badges

For information on creating a CSV file, see Sample CSV formats on page 99.

Click Import Badges or Import, and then browse to the CSV or TXT file.
Click Import Badges.

Note: You can also register or delete badges for users. For more information, see Managing users on page 
69.

Managing PINs

Depending on the printer login configuration, organization administrators and user administrators can generate, 
delete, or import PINs on behalf of the users.

Notes

To access the Printer Login Configuration page, from the Account Management web 
portal, select an organization, and then click Organization > Printer Login 
Configuration.
If the PIN generation option is set to Automatically generate and email, then click 
Generate PIN. An automatically generated PIN is sent to the user’s e‑mail address.
If the PIN generation option is set to Administrator manually set, then enter the PIN, 
and then click Generate PIN.

From the Account Management web portal, select an organization.
Click Users > Manage Badge/PIN.
From the PINs tab, do any of the following:

To generate a PIN, click Generate, type the user email address, and then click 
Generate PIN.
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To delete PINs, select the users, and then click Delete › Delete PINs.
To import PINs, click Import PINs or Import, browse to the CSV or TXT file, and then 
click Import PINs.

Note:
For information on creating a CSV file, see Sample CSV formats on page 99.
The user accounts must exist before their PINs can be imported.

Sample CSV formats

Depending on the printer login configuration, the CSV format can be any of the following:
Badge only

BADGE,OPERATION,EMAIL,TEMPORARY,PIN 

20171a,CREATE,jdoe@company.com,true, 

20172b,CREATE,llane@company.com,true, 

20173c,DELETE,ckent@company.com,false,

PIN only

BADGE,OPERATION,EMAIL,TEMPORARY,PIN 

,CREATE,jdoe@company.com,,123456 

,CREATE,llane@company.com,,234567 

,DELETE,ckent@company.com,,345678

Badge and PIN

BADGE,OPERATION,EMAIL,TEMPORARY,PIN 

20171a,CREATE,jdoe@company.com,true,123456 

20172b,CREATE,llane@company.com,true,234567 

20173c,DELETE,ckent@company.com,false,345678

You can also change the order of the operations. For example, PIN only can be formatted as:
PIN only

PIN,OPERATION,EMAIL,BADGE,TEMPORARY 

123456,CREATE,jdoe@company.com,, 

234567,CREATE,llane@company.com,, 

345678,DELETE,ckent@company.com,,

Line values and their conditions

BADGE—The badge ID of the user. If a BADGE value contains commas, then the value 
must be enclosed in double quotation marks. For example, “20171a,2a,3a”

The value must not be empty when the printer login is set to Badge Login or Badge + PIN 
as second factor.
OPERATION—Required for all badges and PINs.

Valid OPERATION values

CREATE—Creates a badge identified by the BADGE value for the user specified by 
the EMAIL value.
DELETE—Deletes the existing badge identified by the BADGE value.

EMAIL—Required for the CREATE operation. Badge import does not create a user. The 
user must exist before a badge can be created. EMAIL values that are in uppercase are 
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converted to lowercase before the operation is performed. For example, 
JDOE@company.com is converted to jdoe@company.com.
TEMPORARY—Determines whether the badge is temporary or permanent. The 
TEMPORARY value is either true or false.
PIN—The PIN of the user. The value must not be empty when the printer login is set to PIN 
Login or Badge + PIN as second factor.

Notes

All lines must have the same number of values as the header, including the commas. For 
example, 20171a,DELETE,
The file size must not exceed 1MB.
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Overview
Cloud Fleet Management offers remote device monitoring and management. It minimizes disruption and 
eliminates estimations in maintaining a well-running fleet. Cloud Fleet Management automatically collects page 
counts, toner levels, and supplies status to provide a comprehensive view of your devices and how they are 
performing. It also lets you view device information and receive communications directly through the Cloud Fleet 
Management web portal. Calling and reporting meter readings or low supplies is unnecessary.
Printers must be enrolled in the Lexmark Cloud Services website before you can manage them. To enroll printers, 
you can use the Fleet Agent, Native Agent, Local Agent, or Printer Agent. The Native Agent is a firmware agent 
that allows Lexmark printers to communicate with Lexmark Cloud Services. The Fleet Agent is an application that 
runs on a server in the customer network. The Local Agent is an application that runs on a host computer. This 
agent type is used to enroll USB‑connected printers. The Printer Agent is an eSF application that runs on a 
printer.

Choosing an agent
Select one or more agents that fit the environment of your organization and the printers to manage from the 
following:
Fleet Agent

The Fleet Agent is an application that is configured and installed on an on‑site server or host computer with high 
availability. It enrolls one or more printers from Lexmark and third‑party manufacturers in Lexmark Cloud 
Services.

Requires a stable server or host computer with a constant Internet connection.
Supports data collection from all Lexmark printers. For more information, see Supported 
printer models on page 28.
Supports configuration for Lexmark printers with eSF version 2.0 or later.
Supports data collection only for third‑party printers.
The Fleet Agent scans the printers according to the interval set in the Refresh Printer 
Information Task setting of the Scheduled Tasks section. The data is sent to the Lexmark 
Cloud Services server only if there is an alert change or toner level decrement. The data is 
not sent to the cloud server if there is only a page count change. However, even if there are 
no alert changes or page count changes, the data is sent to the cloud server once every 24 
hours.

Native Agent

The Native Agent is a firmware agent that allows Lexmark Internet of Things (IoT)–ready printers to communicate 
with Lexmark Cloud Services. When enabled, it can enroll the Lexmark printer in Lexmark Cloud Services.

Supports data collection and configuration for Lexmark IoT‑ready printers. For more 
information on supported printer models, see Supported printer models on page 28.
Make sure that the printer firmware version is 075.272 or later.
Other printer applications and on-site software installations are not required.
Enroll printers using the following:

Printer Enrollment Tool (PET)
Cloud-based pre-enrollment
Printer-based enrollment

Fleet Management
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To enroll multiple printers with native agents simultaneously, use the Printer Enrollment Tool 
(PET). A pre-enrollment option is also available.

Printer Agent

The Printer Agent is an application configured and installed on a Lexmark printer to enroll that printer in Lexmark 
Cloud Services.

Requires running the Printer Enrollment Tool in a network‑connected computer to discover 
and enroll printers.
Supports data collection and configuration in Lexmark printers with eSF version 3.0 or later 
(touch‑screen models). For more information on supported printer models, see 
the .Supported printer models on page 28

Local Agent

The Local Agent is an application configured and installed on a host computer to enroll USB‑connected printers in 
Lexmark Cloud Services.

Supports data collection of the enrolled printers.
Configuration deployment is not supported in printers enrolled through Local Agent.
Does not support printer firmware update from Lexmark Cloud Services.
Does not support reporting devices in Analytics.

Notes

You cannot delete or deactivate an agent that is associated with printers that are enrolled 
in MPS Express or pending enrollment.
If managing Lexmark printers with eSF version 3.0 or later (touch‑screen models), then 
use either the Printer Agent or the Fleet Agent.
If managing touch‑screen or non‑touch‑screen models with firmware version 075.272 or 
later, then you can use Native Agent.
If managing a group of Lexmark printers that include models that the Printer Agent, and 
Native Agent do not support, then use the Fleet Agent.
If managing a group of Lexmark and third‑party printers, then use the Fleet Agent.
In the printer listing page, you can filter printers based on agent type.
You can use only one agent to manage a printer.
You can use the Native Agent, Fleet Agent, Printer Agent, and Local Agent to manage your 
fleet of printers. However, multiple agents cannot manage a printer at the same time.
Local Agent supports Lexmark printers only.
Local Agent can be installed in the Microsoft Windows operating system only.

Accessing the Fleet Management web portal
Open a web browser, access the Lexmark Cloud Services dashboard, and then do either of the following:

From the dashboard, click the Fleet Management card.

Note: If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then click 
Fleet Management.
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Understanding the Agents tab
The Agents tab of the Fleet Management portal lets you manage the agents that you use to discover and enroll 
printers in Lexmark Cloud Services.
The Agents tab has three sections.

Printer Agents—Use this section to manage the Printer Agents that run on your printers.
Fleet Agents—Use this section to manage the Fleet Agents that run on a server or host 
computer.
Native Agents—Use this section to manage the Native Agents.
Local Agents—Use this section to manage the Local Agents.

Managing the Printer Agents section

From the Fleet Management web portal, select an organization.
Click Agents > Printer Agents.

Do one or more of the following:

Note: If no printer is enrolled, then enroll printers using the Printer Enrollment Tool. For 
more information, see Enrolling printers using the Printer Enrollment Tool on page 111.

To edit the agent settings, select an agent, and then click Edit Settings.
To update the Printer Agent, select an agent, and then click Update > Update agent 
version.

Note: We recommend updating the Printer Agent to the current version to support 
all Cloud Fleet Management features.

To update the printer administrator credentials for the agent, select an agent, and then 
click Update > Update agent access credentials.

Notes
This setting is also available when enrolling printers. For more information, 
see Enrolling printers using the Printer Enrollment Tool on page 111.
You can also update the agent credentials using the Embedded Web Server. 
For more information, see Accessing the Printer Agent on page 113.

To download the Printer Enrollment Tool, click Download PET.
To view printer agents with a specific status, click Agent Status, and then select a 
status filter.
To view printer agents that require version update, click Update Available > Yes.

Managing the Fleet Agents section

From the Fleet Management web portal, select an organization.
Click Agents > Fleet Agents.
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Do one or more of the following:

Note: If no agent is listed, then create a Fleet Agent. For more information, see Creating a 
Fleet Agent on page 114.

To create another Fleet Agent, click Create Fleet Agent.
To change the settings of a Fleet Agent, click the name of the Fleet Agent.
To update the Fleet Agent in your server, select a Fleet Agent, and then click Update > 
Fleet Agent.
To update the Fleet Agent with the latest supported printers, select a Fleet Agent, and 
then click Update > Printer support library.
To view Fleet Agents with a specific status, click Agent Status, and then select a 
status filter.
To view Fleet Agents that require update, click Agent Update > Yes.
To view Fleet Agents that require supported printers library update, click Library 
Update > Yes.

Managing the Native Agents section

From the Fleet Management web portal, click Agents > Native Agents.

Do one or more of the following:

Note: If no agent is listed, then enroll printers. Depending on the firmware version, enroll 
printers using either the Printer Enrollment Tool or the Native Agent enrollment process. 
For more information, see either "Using the Native Agent" section or Enrolling printers 
using the Printer Enrollment Tool on page 111.

To enroll a supported printer with a printer‑generated enrollment code, click 
Enrollment > Enroll Printer, and then type the enrollment code.
To pre‑enroll a supported printer, click Enrollment > Pre‑enroll > Pre‑enroll printers.

To view the enrollment code, click Enrollment > Pre‑enroll.

Note: Lexmark Cloud Services assigns one pre‑enrollment code for your 
fleet.

To update the printer administrator credentials, select a printer, and then click Update 
Access Credentials.
To view Native Agents with a specific status, click Agent Status, and then select a 
status filter.

Managing the Local Agents section

From the Fleet Management web portal, click Agents > Local Agents.
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Do one or more of the following:

Note: If no local agent is listed, then download, install, and activate it.

To view the activation code, click Activation Code > Generate activation code.

Note: You can set the number of agents that can be code‑activated.

To filter local agents based on their status, click Agent Status, and then select a 
status.
To identify local agents that have available updates, click Updates Available > Yes.
To update a local agent, select the agent, and click Update.

Updating agents for multiple organizations
The Agents tab of the Fleet Management portal also lets you update Printer Agents, Fleet Agents, and Local 
Agents across multiple organizations. If you have the Fleet Management Administrator role in all partner 
organizations and have child organization access, then you can update agents across multiple organizations.

Note: You cannot include Native Agents while updating agents across multiple organizations.

To update one or more types of agents across multiple organizations, do the following:

From the Fleet Management web portal, select All organizations, and then click Next.
Click the Agents tab.
Click the various types of agents tab as required, and then select one or more agents from 
each of the types.

Notes
Updating agents across all organizations is not supported for Native Agents.
On the agents page, in the Organization column, you can view the organization to 
which each of the agents belong to.

Click Update.

Note: On updating agents across multiple organizations, it creates a bulk action task. For 
such bulk action tasks, the task status page shows Multiple in the Organization column. 
On clicking the Task ID of a bulk action task, you can view the page listing with all the 
printers, their respective organization, and their single organization Task ID.

Updating applications for all organizations
From the Fleet Management web portal, select All organizations, and then click Next.
From the printer listing page, select Communicating.

Note: A list of all printers communicating from all the organizations appears.
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Select the IP address of all the connected printers, and then click Apps.
Update the applications.
To check the status of the update, click the Task tab.

Note: You can filter the list of organizations and track the specific tasks for each 
organization.

Updating the firmware for all organizations
From the Fleet Management web portal, select All organizations, and then click Next.
From the printers tab, click filter, and then select Firmware Update.
From the list of printers, select Communicating.
From the list of printers, select the IP address of all the connected printers, and then click 
Configure.
Select Update Firmware.

Note: You can choose when the firmware update starts. You can start it immediately or 
schedule it.

To check the status of the update, click the Task tab.

Notes
You can filter the list of organizations and track the specific tasks for each 
organization.
Updating agents across multiple organizations creates a bulk action task. For such 
bulk action tasks, the task status page shows Multiple in the Organization column. 
Click the task ID of a bulk action task to view the page listing with all the printers, 
their respective organizations, and their single‑organization task ID.

Adding printers

Implementation outline

The following workflow shows the general process for setting up printers in the Fleet Management web portal:

Using the Printer Enrollment Tool

Log in to the Lexmark Cloud Services website.
Download and run the Printer Enrollment Tool.
Discover the printers in your network.
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Enroll the printers.
The printers are shown in the Fleet Management web portal.

Notes

For printers with firmware version 074.xx or earlier, the system installs the Printer Agent 
application in the printer. The Printer Agent polls the Lexmark Cloud Services website 
regularly to monitor configuration changes or other requests.
For printers with firmware version 075.xx or later, the system uses the Native Agent to 
communicate with Lexmark Cloud Services.
For more information on the firmware version, see Viewing the printer firmware version on 
page 58.

Using the Fleet Agent

Log in to the Lexmark Cloud Services website.
Create a Fleet Agent, and then download it.
Run and activate the Fleet Agent.
Discover and enroll printers.

Note: The Fleet Agent uses an open connection to Lexmark Cloud Services.

Using the Native Agent

Note: This workflow applies only to supported printers with firmware version 075.xx or later preinstalled in the 
factory. Printers manufactured in late 2019 or later that are not preinstalled with version 075.xx in the factory 
must be later upgraded to version 075.xx or later. For more information on supported printer models, see 
Supported printer models on page 28.

Log in to the Lexmark Cloud Services website.
Pre‑enroll the printers.
From the Embedded Web Server or the printer control panel, enter the enrollment code to 
complete the enrollment.
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Notes

One enrollment code per organization is assigned for all supported printers.
To skip the pre‑enrollment process, obtain the enrollment code from the Embedded Web 
Server. For more information, see Enrolling printers from the Embedded Web Server on 
page 121.

Using the Local Agent

Log in to the Lexmark Cloud Services website.
Download the Local Agent.
Run and install the Local Agent.
Get the activation code from the Lexmark Cloud Services website and activate the Local 
Agent.

Note: When installed and activated, the Local Agent automatically enrolls the printers connected through USB.

After enrollment, the enrolled printers are listed on the Fleet Management web portal home page. The IP 
addresses appearing on the Fleet Management home page are the IP addresses of the host computers.
From the Fleet Management web portal, you can create and deploy printer configurations, view printer 
information, and request printer logs.

Note: You cannot create and deploy configurations, and request printer logs for printers enrolled through Local 
Agent.

Using the Printer Enrollment Tool

Downloading the Printer Enrollment Tool

Use the Printer Enrollment Tool (PET) to discover and enroll printers in the Lexmark Cloud Services website. 
Depending on the printer firmware version, the PET installs the Printer Agent application in the printer or uses the 
Native Agent.

From the Fleet Management web portal, do one of the following:

If you are enrolling devices in Lexmark Cloud Services for the first time, then you can 
download the PET by following the steps:

Click Use Printer Agent > Download PET.
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Click Agents > Printer Agents > Download Printer Enrollment Tool.

Click Agents > Native Agents > Enroll Printer > use the Printer Enrollment Tool.

If you already have some devices enrolled, then you can download the PET by following the 
steps:

Click Printer > Enroll printer using > Printer agent > Download PET.

Click Printer > Enroll printer using > Native agent > Enrollment > Download PET.

Click Agents > Printer Agents > Download PET.

Click Agents > Native Agents > Enrollment > Download PET.
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Accept the End-User License Agreement (EULA).
Extract the zipped folder, and then locate the Printer Enrollment Tool launcher.

Configuring the Printer Enrollment Tool settings

The Printer Enrollment Tool is configured with the default settings. In some instances, there may be differences in 
the customer environment that require changes to the default configuration.

Run the Printer Enrollment Tool launcher.
A new browser window opens. Type the same e‑mail address and password used to connect 
to the Lexmark Cloud Services website, and then click Log In.

Note:
If you are already logged into Cloud Fleet Management, the new browser opens 
with the E-mail field already auto-filled with the details of the logged in user. Click 
Next to log in.
If there is any update available for the Printer Enrollment Tool, you have to update 
before proceeding further. For more information on updating the Printer Enrollment 
Tool, see "Updating the Printer Enrollment Tool" section.

Click  on the upper‑right corner of the page.
From the Discover and enroll native agent-capable printers using menu, select either Printer 
agent or Native agent.

Notes
Native agent is selected by default.
Use Native agent to enroll IoT-capable printers, when enrolling printers of different 
models.
Use the Printer agent to enroll eSF-capable printers, which are not IoT-capable.

Specify the printer discovery and printer enrollment timeouts.
From the Logging detail section, select either Summary or Detailed.

Note: Click View current log to view the current log details.

In the SNMP Settings menu, select a version.

Note: The Printer Enrollment Tool uses mDNS for discovery. The SNMP settings are 
applied only when mDNS is disabled on the devices that are being discovered.
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For Versions 1 and 2c, select a community string type. To set a custom community 
string, select Custom value, and then type the string.
For Version 3, select a security level, an authentication mode, and a privacy type.

From the Community String section, select ‘public’ or Custom value.

Note: Enter the strings in the Custom value field.

Click Save Settings.

Updating the Printer Enrollment Tool

Run the Printer Enrollment Tool launcher.
Type the same e‑mail address and password used to connect to the Lexmark Cloud 
Services website, and then click Log In.
On the Update Available window, click Download New Version.

Note: The Update Available window appears only if there is a new version available.

On the Downloading Update window, click Close Application.

Note: The update is downloaded in ZIP format.

Locate the ZIP folder, and extract the zipped folder.
Run the Printer Enrollment Tool launcher.
Type the same e‑mail address and password used to connect to the Lexmark Cloud 
Services website, and then click Log In.

Enrolling printers using the Printer Enrollment Tool

The printers must be enrolled in the Lexmark Cloud Services website before you can manage them.

Run the Printer Enrollment Tool launcher.

Note: For more information, see Downloading the Printer Enrollment Tool on page 108.

Type the same e‑mail address and password used to connect to the Lexmark Cloud 
Services website, and then click Log In.
If you are managing multiple child organizations, then select an organization.

Note: If only one organization is assigned to your account, then it is preselected.

Click Next, and then from the Printer Discovery section, select a discovery type.
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To search for all printers in your local network, select Search local network.
To search for a specific IP address, subnet, range, or fully qualified domain name 
(FQDN), select Advanced search.

Notes
The entries are not saved after the Printer Enrollment Tool is closed. To save 
your advanced search list, click Export. The list is saved in a CSV format.
To use an existing CSV file, click Import.

Click Discover Printers.

Notes
If the settings are configured with SNMP v3 with authentication, then you are 
prompted for the SNMP credentials
If a firewall prompt appears, then click Allow access.

View the information, and then close the Printer Discovery dialog box.
From the Printer Enrollment section, select one or more printers.

Notes
Printers from the Enrolled tab can be re‑enrolled. Re‑enroll the printer when it is not 
responding, or when the printer must be unenrolled from a different organization and 
enrolled in the current organization.
The Printer Enrollment Tool discovers Fleet Agent–managed printers, but they 
cannot be selected for enrollment.
The Printer Enrollment Tool discovers Native Agent–managed printers, but Native 
devices, enrolled in the current organization, cannot be selected for enrollment.
Depending on the firmware version, the printer may be enrolled using either the 
Printer Agent or Native Agent. For more information, see the Agent Type column.
We recommend using Lexmark Cloud Services to unenroll printers from their current 
organization before enrolling them in a new organization.

Click Enroll Printers.
In the Authentication for Secured Printers dialog box, do either of the following:

For secured printers, select the authentication type, enter the printer credentials, and 
then click Apply Credentials.
For unsecured printers, click Skip This Step.

Note: Some printer models may have different authentication credentials configurations. 
Make sure that the authentication type set during enrollment in the Printer Enrollment Tool 
matches the authentication type configured in the printer. If the authentication types do not 
match, then the printer is not enrolled.

Close the Printer Enrollment Tool.
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Notes

Printers that have down‑level firmware cannot be enrolled. The firmware on those printers 
must be updated manually. For more information, see Updating printer firmware from the 
Embedded Web Server on page 58.
The enrollment process may take a few minutes to complete.
The enrolled printers are added to the printer list on the main page of the Fleet 
Management web portal.
It may take a few minutes for the enrolled printers to appear in the Fleet Management web 
portal.

For more information on the unenrolled printers, click .

Accessing the Printer Agent

The Printer Agent can be accessed from the printer’s Embedded Web Server. You can view the enrollment status 
of the printer and poll for new events immediately without waiting for the polling interval to elapse.

Note: To access the printer Embedded Web Server, make sure that you are on the same network as the 
printer.

From the Fleet Management web portal, click Printers.
From the printers list, click the printer identifier.

Note: For more information on setting the printer identifier, see Managing views on page 
128.

From the Identification section, click Open the printer’s Embedded Web Server (EWS).
Depending on your printer model, from the Embedded Web Server, click Applications or 
Apps.
Click Printer Configuration Agent.
Do either of the following:

Click Poll Now to poll for new updates.
Click Test Agent Connection to check the following:

Network connectivity between the Printer Agent and Lexmark Cloud Services
Login access to the printer
Function access controls and permissions

Click Update Credentials to provide login credentials for secured printers.

Note: We recommend running the Test Agent Connection to make sure that the agent 
can communicate to the Lexmark Cloud Services. If a connectivity issue is encountered, 
then see the Troubleshooting section.
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Editing a printer agent

From the Fleet Management web portal, click Agents > Printer Agents.
Select one or more agents, and then click Edit Settings.
Set the polling interval and the log level.
Click Save Settings.

Updating the Printer Agent

Make sure that the printer has no unresolved errors, has no pending jobs, is in ready state, and is not being used.

From the Fleet Management web portal, click Agents > Printer Agents.
Select one or more agents, and then click Update > Update agent version.
Click Continue.

Using the Fleet Agent

Creating a Fleet Agent

The Fleet Agent discovers and enrolls printers in the Lexmark Cloud Services website.

Note: The Fleet Agent requires a server with high availability and constant Internet connection.

From the Fleet Management web portal, do either of the following:

Click Use Fleet Agent > Create Fleet Agent.

Click Agents > Fleet Agents > Create Fleet Agent.

Type a unique name and description.
From the Discovery Criteria tab, do one or more of the following:

To prevent the Fleet Agent from taking over the management of enrolled printers, 
disable Transfer management of discovered printers that are already enrolled 
through another agent.
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Notes
If the setting is enabled, then polling information from the Printer Agent is 
stopped.
The Printer Agent application remains in the printer.

To search for all printers in your local network, set Search Type to Search Local 
Network.
To search for or exclude a specific IP address, subnet, range, or fully qualified domain 
name (FQDN), set Search Type to Advanced search. Do one or more of the 
following:

From the Include tab, click Add Discovery Criteria to Include, and then type 
the printer information.
From the Include tab, click Import, and then browse to the csv or txt file.

Notes
To view a sample file, click Download sample file.
To overwrite the existing IP address, subnet, range, or FQDN in the 
discovery criteria, enable Overwrite existing "included" discovery 
criteria.

From the Exclude tab, click Add Discovery Criteria to Exclude, and then type 
the printer information.
From the Exclude tab, click Import, and then browse to the csv or txt file.

Notes
To view a sample file, click Download sample file.
To overwrite the existing IP address, subnet, range, or FQDNs in the 
discovery criteria, enable Overwrite existing "excluded" discovery 
criteria.

You can also export or delete discovery criteria. From either Export or Import tab, 
select one or more addresses, and then click either Export or Delete.
Select an SNMP profile.

From the SNMP Profile tab, create an SNMP profile. Do the following:
Click Create, and then type a unique profile name.
Select an SNMP version.

Notes
For Versions 1 and 2c, type a community name.
For Version 3, select a security level, an authentication mode, and a privacy 
type.

Set the discovery timeout and number of retries.
Click Create SNMP Profile.

From the Scheduled Tasks tab, set the Printer Discovery Task and Refresh Printer 
Information Task intervals.
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Notes
The Fleet Agent discovers and enrolls printers based on the Printer Discovery Task 
interval
The Fleet Agent scans the printers according to the interval set in the Refresh 
Printer Information Task setting of the Scheduled Tasks section. The data is sent to 
the Lexmark Cloud Services server only if there is an alert change or toner level 
decrement. The data is not sent to the cloud server if there is only page count 
change. However, even if there are no alert changes or page count changes, the 
data is sent to the cloud server once every 24 hours.

From the Other Settings tab, configure the Log level and Network utilization delay settings.

Notes
Setting the Network utilization delay value below 250 (default) may impact the 
network performance. We do not recommend setting the value to zero.
The larger the delay, the longer the discovery takes to complete.

Click Create Agent.

Downloading the Fleet Agent

Before you begin, make sure that you have created a Fleet Agent. For more information, see Creating a Fleet 
Agent on page 114.

From the Fleet Management web portal, click Agents > Fleet Agents.
Click the Fleet Agent name, and then click Installation Package > Download.

Note: To send the installation package link using e‑mail, click Installation Package > 
Email, and then type an e‑mail address.

Select an installation package type, and then click Download Package.

Notes
Take note of the activation code.
The activation code is valid for 72 hours. If it expires before activating the agent, 
then generate a new activation code. From the Fleet Management portal, click 
Agents > Fleet Agents > select a Fleet Agent > Generate activation code.

Installing the Fleet Agent

Make sure that the Fleet Agent server and the printers are on the same network. The Fleet Agent also requires a 
server or host computer with high availability.

From a server or host computer, run the Fleet Agent installation package.
Accept the End-User License Agreement (EULA).
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Enter the port number.

Notes
The default port number is 80.
If port 80 is not available, then enter any available port, such as 8080 or 8088.

Click Finish to close the installation window, and launch the Fleet Agent on a web browser.

Note: The Launch Lexmark Fleet Agent in Your Browser option is selected by default.

From the Fleet Agent page in the browser, enter the activation code.
If necessary, select Use Proxy Settings, and then provide the proxy information.
Click Continue, and then, if necessary, type an agent password.

Note: If you provided an agent password, then the password is required to access the 
installed Fleet Agent.

Select Discover and enroll printers immediately after activating this agent.

Note: The printers are automatically discovered and enrolled after activating the agent.

Click Activate Agent.

Note: You can change the security setting, proxy settings, or agent password later by clicking  on the 
upper‑right corner of the Fleet Agent home screen. For more information, see Configuring the Fleet Agent 
server settings on page 117.

Configuring the Fleet Agent server settings

From a server or host computer, open the Fleet Agent. Do either of the following:

Click the Fleet Agent shortcut.
Open a web browser, and then type localhost.

Note: If the Fleet Agent uses a port other than port 80, then type localhost:x , where 
x is the port number.

From the home screen, do one or more of the following:

To configure the proxy settings, click  > Proxy Configuration.

To protect the Fleet Agent with a password, click  > Create Password.

To allow remote access to this Fleet Agent, click  > Update Security Setting.
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Note: In the security setting, the Allow local host access only (Recommended) 
option is selected by default. This option prevents other computers on the network 
from accessing the Fleet Agent. Clear the option to grant access to other computers 
on the network.

Managing a Fleet Agent

From the Fleet Management web portal, click Agents > Fleet Agents.
Click a Fleet Agent, and then do one or more of the following:

To edit the Fleet Agent, click Edit Agent. For more information, see Editing the Fleet 
Agent on page 118.
To initiate printer discovery and enrollment, click Discover & Enroll Printers.
To download the installation package, click Installation Package > Download.
To refresh all printer information before the scheduled refresh task, click More > 
Refresh all printer information.
To deactivate the Fleet Agent, click More > Deactivate Agent.
To delete the Fleet Agent, click More > Delete Agent.
To request Fleet Agent logs, from the Log section, click Request.

Note: It may take time for the logs to generate and make them available for 
download.

Editing the Fleet Agent

If there are changes to your discovery criteria, task schedule, log level, or server delay settings, then edit the 
Fleet Agent.

From the Fleet Management web portal, click Agents > Fleet Agents.
Click the agent name, and then click Edit Agent.
Configure the settings, and then click Save Changes.

Updating the Fleet Agent

From the Fleet Management web portal, click Agents > Fleet Agents.
Select one or more Fleet Agents, and then click Update > Fleet Agent.
Click Continue.

Using the Native Agent

Pre‑enrolling printers

These instructions apply only to printers with firmware version is 075.xx or later preinstalled in the factory.
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Note: To determine the printer firmware version, see Viewing the printer firmware version on page 58.

From the Fleet Management web portal, do one of the following:

If no devices are enrolled:

Click Agents > Native Agents > Pre‑enroll Printers.

If devices are already enrolled:

Click Agents > Native Agents > Enrollment > Pre‑enroll > Pre‑enroll printers.

From the Pre‑enroll Printers dialog, do one of the following:

Select Manually input serial number, type the printer serial number, and then press 
Enter.
Select Import printer serial number from file, and then browse to the CSV or TXT 
file.

Note: To receive the enrollment code and the complete enrollment instructions using 
e‑mail, type your e‑mail address.

Click Pre‑enroll Printers > Enrollment > Pre‑enroll.
Copy the organization’s enrollment code.

Note: For pre‑enrolled devices, complete the enrollment process either from the Embedded Web Server or 
from the printer control panel.

Completing the printer enrollment from the Embedded Web Server

From the Embedded Web Server, do one of the following:
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Click Settings > Cloud Services > Cloud Services Enrollment.
Click Settings > Lexmark Cloud Services > Cloud Fleet Management.

Note: Make sure that Enable communication with Lexmark Cloud Services is selected.

In the Enrollment Code field, enter the enrollment code, and then click Enroll Printer.

Completing the printer enrollment from printer control panel

From the printer home screen, do one of the following:

Touch Settings > Cloud Services > Cloud Services Enrollment.
Touch Settings > Lexmark Cloud Services > Cloud Fleet Management.

From the Enable communication with Lexmark Cloud Services menu, touch On.
In the Enroll Printer field, enter the enrollment code, and then touch OK.

Enrolling printers from the printer control panel

These instructions apply only to the following conditions:

You have not pre‑enrolled the printer.
You have not enrolled the printer using the Native Agent.
The printer is manufactured and shipped with firmware 075.001 or later.
The recommended firmware is 081.215 or later.

Note: To determine the printer firmware version, see Viewing the printer firmware version 
on page 58.

From the printer home screen, do one of the following:

Touch Settings > Cloud Services > Cloud Services Enrollment.
Touch Settings > Lexmark Cloud Services > Cloud Fleet Management.

Note: To make the Cloud Services Enrollment option available, click Security > Device 
Management > Cloud Services Enrollment.

From the Enable communication with Lexmark Cloud Services menu, touch On.
From the Get Enrollment Code menu, touch Get Code, copy the enrollment code, and then 
touch OK.
From the Fleet Management web portal, do one of the following:

Click Use Native Agent, enter the enrollment code, and then click Enroll Printer.
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Click Agents > Native Agents > Enroll Printer, enter the enrollment code, and then 
click Enroll Printer.

Enrolling printers from the Embedded Web Server

These instructions apply only to the following conditions:

You have not pre‑enrolled the printer.
You have not enrolled the printer using the Native Agent.
The printer is manufactured and shipped with firmware 075.001 or later.
The recommended firmware is 081.215 or later.

Note: To determine the printer firmware version, see Viewing the printer firmware version 
on page 58.

From the Embedded Web Server, do one of the following:

Click Settings > Cloud Services > Cloud Services Enrollment.
Click Settings > Lexmark Cloud Services > Cloud Fleet Management.

Note: To make the Cloud Services Enrollment option available, click Security > Device 
Management > Cloud Services Enrollment.

Select Enable communication with Lexmark Cloud Services, and then click Refresh.
Click Get Enrollment Code, and then take note of the code.
From the Fleet Management web portal, do one of the following:

Click Use Native Agent > Enroll Printer, enter the enrollment code, and then click 
Enroll Printer.
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Click Agents > Native Agents > Enroll Printer, enter the enrollment code, and then 
click Enroll Printer.

Removing pre‑enrolled printers

From the Fleet Management web portal, do either of the following:

Click Agents > Native Agents > Enrollment > Pre‑enroll > Remove pre‑enrolled 
printers.
Click Printers > Select a specific printer > Remove pre‑enrolled printers.

Click Remove.

Note: To remove an enrolled printer, see Unenrolling printers on page 141.

Using the Local Agent

Downloading the Local Agent

From the Fleet Management web portal, do either of the following:

Click Use Local Agent.

Click Agents > Local Agents.

Click Download Agent.
Select Generate activation code.
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Notes
Take note of the activation code.Agents Local AgentsActivation CodeGenerate 
activation code.
You can set the number of agents to be activated by the code.

Click Download Agent.

Note: This downloads the Windows x64 installer package.

To accept the End User License Agreement (EULA), click Accept and Download.

Installing the Local Agent

Unzip the installation package.
From the host computer, run the Local Agent installation package.
Accept the End-User License Agreement (EULA).
Click Finish to close the installation window.
From the Start menu, launch the Lexmark Local Agent application, and then enter the 
activation code.
Click Activate Agent.

Note: After activation, the Local Agent starts collecting the details about the USB‑connected printers. These 
printers get automatically enrolled in the Lexmark Cloud Services web portal.

Silent activation for Local Agent

Silent activation is used for mass installation of Local Agent.

Unzip the installation package.
Open the LocalAgentConfig.ini file.
Under the [IOT_HUB] block, add the CS_ACTIVATION_CODE parameter.
Enter the activation code generated from Lexmark Cloud Services as the value of the 
parameter.

Sample code:

[IOT_HUB] 

   CS_ACTIVATION_CODE=ab23ftcd-12dt-edte-123hdtdk-ttrbd

Perform the installation steps. For more information, see Installing the Local Agent on page 
0.

file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/installing-the-local-agent-v54430066.htm
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Refreshing printer information using the Local Agent

You can refresh printer information using the Local Agent. The printer must be communicating with the Local 
Agent through USB, and the Local Agent must be sending the printer information to Lexmark Cloud Services.

From the Fleet Management web portal, select the Printers tab.
From the Filters menu, click Agent Type > Local.
Select a printer.
Click Printer > Refresh printer information.

Notes

Clicking Refresh printer information creates a task. To view the status of the task, click 
Tasks > Status.
To know the details about a failed task, click the task ID, and then click the Failed 
hyperlink under the Status column.

Editing the Local Agent

You can edit the local agent to configure it, deactivate it, or delete it.

From the Fleet Management web portal, click Agents > Local Agents.
Click the name of the local agent, and then do any of the following:

Edit an agent

To edit a local agent, click Edit Agent.
From the Log Level menu, select either Summary or Detailed.
From the Polling interval menu, set the interval at which the Local Agent sends data to 
the cloud server.
Click Save Changes.

Deactivate an agent

To deactivate a local agent, click Deactivate Agent.
Click Deactivate Agent.

Delete an agent

To delete a local agent, click Delete Agent.
Click Continue.

Editing multiple local agent settings from the Local Agents tab

From the Fleet Management web portal, click Agents > Local Agents.
Select one or more local agents.
Click Edit Settings.
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Note: If any of the selected local agents is not communicating, then a warning appears. 
Click Continue to apply the settings for the communicating agents only.

rom the Log Level menu, select either Summary or Detailed.
rom the Polling interval menu, set the interval at which the Local Agent sends data to the 
cloud server.

Note: If you select multiple local agents, then by default, the log level value is Detailed 
and the polling interval value is 180.

Click Save Changes.

Notes

A task is created in the Task inventory. The Local Agent must be connected to the cloud 
server to complete this task.
If any of the local agents is not communicating, then the task gets completed with errors. 
The configuration settings apply to the communicating agents only.

Updating the Local Agent

From the Fleet Management web portal, click Agents > Local Agents.
From the Updates Available menu, select Yes.
From the list that appears, select one or more Local Agents, and then click Update.

Notes
You can also update the agent by clicking the agent name and then Update agent 
version in the Identification section.
A task is created in the Task inventory. The Local Agent must be connected to the 
cloud server to complete this task.

Requesting log collection for a Local Agent

From the Fleet Management web portal, select the Agents tab.
Click an activated Local Agent.
From the Log section, click Request.

Note: An Upload local agent logs task is created.

Click Download to download the log file.

Notes
The log file is downloaded in ZIP format.
The information included in the log files depends on the settings of the Local Agent.
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Sample log file:

Thursday,January27 06:20:02 : tid=6936 :  

UninstallLPMAService(139) : error=1060 

Thursday,January27 06:21:13 : tid=10636 : LPMAMain(352) :  

Lexmark Local Agent Service is started  

Thursday,January27 06:24:57 : tid=10636 : LPMAMain(360) :  

Lexmark Local Agent Service is stopped  

Thursday,January27 06:25:51 : tid=7024 : LPMAMain(352) :  

Lexmark Local Agent Service is started  

Thursday,January27 06:27:06 : tid=7024 : LPMAMain(360) :  

Lexmark Local Agent Service is stopped  

Thursday,January27 06:27:11 : tid=14108 : LPMAMain(352) :  

Lexmark Local Agent Service is started  

Thursday,January27 11:41:08 : tid=3984 : LPMAMain(352) :  

Lexmark Local Agent Service is started  

Saturday,January29 01:45:02 : tid=4100 : LPMAMain(352) :  

Lexmark Local Agent Service is started 

Managing enrolled printers

Accessing the aggregate printer data view

The aggregate view shows all the enrolled printers of the Lexmark partner and all printers of the partner’s 
customers. This feature is available only to partner administrators who are members of a Child Organization 
Access group which has the Fleet Management Administrator role.

Note: If you have the Fleet Management Administrator role in all partner organizations and have child 
organization access, then you can update agents across multiple child organizations. For more information, 
see Updating agents for multiple organizations on page 105.

From the Fleet Management web portal, in the Select Organization page, click All 
organizations (view only).
Do any of the following:

Export the printer data. For more information, see Exporting fleet information on page 
141.
Customize printer data shown using the left pane filters or the Views feature.
View and manage printers of the individual child organizations. From the Organization 
column, click the organization name. This link redirects you to the individual 
organization’s Fleet Management web portal.

Managing filter groups

You can save searches or filters in the printer listing page for repetitive use.
Creating a filter group
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From the Fleet Management web portal, select an organization.
On the printer listing page, select one or more filters.
Click Save.
In the Create Filter Group window, in the Filter group name field, type the name of the group, 
and then click Save.

Note: After creating one or more filter groups, you can view the groups under the Select filter group menu.

Modifying an existing filter group

From the Fleet Management web portal, select an organization.
On the printer listing page, from the Select filter group menu, select the filter group that you 
want to modify.
Modify the existing filters.

Note: To modify an existing filter group, you can add more filters, remove existing filters, 
or do both.

Click Save.
In the Create Filter Group window, click Save to save the changes.

Note: To modify the name of a filter, type the name of the filter group in the Filter group 
name field, and then click Save.

Deleting an existing filter group

From the Fleet Management web portal, select an organization.
On the printer listing page, from the Select filter group menu, select the filter group that you 
want to delete.
Click Delete.
In the Delete Filter Group window, click Delete.

Changing the printer listing view

For more information, see Managing views on page 128.

From the Fleet Management web portal, click Printers.
Click Views, and then select a view.

Note: The selected view becomes the default view, and does not change when you log 
out from Lexmark Cloud Services.

Using Quick View
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From the Fleet Management web portal, click Printers.
Click Views.
From the Quick View tab, in the Column 1 (printer identification) menu, select the identifier 
column.
From the Additional columns section, select the information that you want to show as a 
column.
Click Apply.

Note: Quick views are not saved. The default view is applied when the user logs in again in Lexmark Cloud 
Services.

Managing views

You can customize the information that appears in the printer listing page. The following views are system 
generated. These views can be copied, but cannot be edited or deleted.

Configurations—Shows configuration-related information such as last configuration, 
availability of firmware update, current firmware version, and last communication.
Meters—Shows the Days to Replace column for supply items, which is calculated based on 
usage and predicts when the supply item must be replaced.
Operations—Shows the serial number, model information, manufacturer, agent version, 
communication status, and task-related details for the printers.
Standard—Shows standard information like model number, attached tags, asset tags, and 
supply alerts.
Supplies—Shows the scan, copy, and fax counts. If you are using a color printer, then the 
copy count also distinguishes between mono and color counts.
Supplies coverage—Shows supply-related information like lifetime coverage of each of the 
cartridge colors.
Managed—Shows the printers that are managed by Lexmark, the supplies delivery contacts, 
and the business names.

Creating a view

From the Fleet Management web portal, click Printers › Views.
Click Create view.
Type a unique view name.
In the Column 1 (printer identification) menu, select the identification type.
From the Available columns section, select the information that you want to show as a 
column, and then click >.

Note: You can also add or remove columns from the Selected columns list by clicking 
and dragging the column into or out of the list.

To rearrange the column order, click ˄ or ˅.
Click Create View.

Note: The created view is applied automatically, and becomes the default view.
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Editing a view

Click Manage views.
Click a view name, and then configure the settings.
Click Save Changes.

Note: You cannot edit system-generated views. The view that is created from this page 
does not become the default view.

Deleting views

Click Manage views.
Select one or more views, and then click Delete.
Click Delete Views.

Note:
You cannot delete system-generated views.

If the current view is deleted, then the Standard system-generated view becomes the 
default view.

Views are shared across child organizations, and a default view is stored for each user. If 
user A uses a view and user B deletes the view, then user A defaults back to the Standard 
system-generated view.

Copying a view

Click Manage views.
Select a view, and then click Copy.
Configure the settings.
Click Create View.

Viewing printer information

From the Fleet Management web portal, click Printers.
From the printers list, click the printer identifier.

Notes
In the default view, the IP address is the printer identifier. For more information on 
setting the printer identifier, see Managing views on page 128.
To update the printer information, click Refresh Information.
To view the report on printer hardware statistics, click View Report.
To restart the printer, click Restart.
To show a notification on the printer control panel, click Notifications. For more 
information, see Sending notifications to the printer control panel on page 132.
To remove the printer from your organization, click Unenroll.
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View the following printer information:

The date and time of the last poll or sync
The date and time that the printer was last restarted
The current printer status
Scan, copy, and fax counts

Note: The Meters section of the printer details page includes information related to 
scan, copy, and fax page counts.

Note: In the printer listing page, you can include columns on color and mono copy 
count, total copy count, total scan count, and total printed fax count.

The current supplies status

You can create and customize the dashboard to view printer alerts and printer 
status by adding the Printer Communication Status card. Click the links on this 
card to access Cloud Fleet Management. You can view details about printers 
that are not communicating, agents that are not communicating, and agents that 
need credentials.
The printer listing page features several important information related to Days to 

Replace.
Predictions are available for toner cartridges, and photoconductors.
The prediction is available for devices that are sending their data to Lexmark 
Cloud Services. The prediction date is based on the last data that were 
uploaded to the cloud.
No prediction data appears if there is no communication between the printer and 
Lexmark Cloud Services or if the Printer Agent version is outdated. Make sure 
that you update the Printer Agent to version 3.0 or later for this feature to work. If 
your device is enrolled with Native IoT Agent, make sure that you update to the 
latest firmware version.
Prediction for Days to Replace runs once a day, and is supported for Lexmark 
printers only. For a newly enrolled printer, it may take up to 48 hours for a 
prediction to be available.
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The Supplies section of the printer details page features a Days to Replace 
column for supply items. The values in the Days to Replace column are 
calculated based on usage and predicts when the supply item must be replaced. 
The prediction is available for all assets managed by Printer Agent, Fleet Agent, 
Native IoT Agent, and Local Agent in the Cloud Fleet Management.

The printer identification information

To view and configure the printer using the Embedded Web Server, click Open 
the printer’s Embedded Web Server (EWS).
To change the asset tag, location, contact information, printer name, and 
description, click Edit.

The printer lifetime page counts

Note: Printers reporting through a Fleet Agent now include blank pages in their 
mono page counts.

The printer firmware version

Note: To update the firmware version, click Update available. This option appears 
only when a firmware update is available. For more information, see Updating the 
printer firmware on page 139.

The installed applications

Note: You can start, stop, or uninstall applications. For more information, see 
Managing applications on page 136.

The agent information
The printer logs

To generate a log, click Request > Request Log.
You can request History Log, Embedded Solutions Log, Security Log, Fax Log, 
Last 10 Fax Logs, Last 10 Fax Error Logs, GZIP Logs, and MIB Walk.
Use MIB Walk for investigating missing data from non-Lexmark printers. This 
option is available only for printers reporting through a Fleet Agent.

The event history information, such as the event type, date, time, duration, and status

Understanding diagnostic events

When the diagnostics events functionality is enabled for a partner fleet, Cloud Fleet Management services start 
collecting health data from printers regularly. This data is used to predict future failure and service actions to 
avoid printer downtime and avoid end‑customer impact.
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Note: The diagnostic events functionality is available only on request from Lexmark. This feature is not 
available for all.

Notes

Diagnostic events are generated when there is a printer‑related or supply‑related alert. 
Even if the alert that triggered the event is resolved, the diagnostic event appears in the 
Cloud Fleet Management portal until expiry. If the alert is not resolved until the expiry, a 
new diagnostic event is triggered for the same alert.
The printer listing page features a Diagnostic event column with warning links to the 
details.
The printer details page also lists all the diagnostic events generated by the alerts. You 
can view the details about the diagnostic events in the Status section of the printer details 
page.

Viewing supplies and printer alerts

View errors and warnings about the printers and their supplies from the printer listing page.

From the Fleet Management web portal, click Printers.
From the printer listing page, view the supplies and printer alerts using the following:

Supply Alerts and Printer Alerts filters on the left navigation pane
Supplies view
Custom view containing the Supply Alerts and Printer Alerts columns

Note: To view more information about the alert, click the error or the warning from the Supply Alerts and 
Printer Alerts columns.

Sending notifications to the printer control panel

You can set any of the following notifications to appear on the printer control panel:

Service has been scheduled
Toner cartridge delivered
Toner cartridge ordered
Toner cartridge shipped

The notification appears on the printer control panel for 48 hours, or until the user clears it or another notification 
is sent.

Note: This feature is available only in some printer models. For more information, see Supported printer 
models on page 28.

From the Fleet Management web portal, click Printers.
Select one or more printers.
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Note: You can also configure individual printers using the printer information page. For 
more information, see Viewing printer information on page 129.

Click Printer > Send notification to panel.
Select a notification.
Click Send Notification.

Clearing notifications

From the Fleet Management web portal, click Printers.
Select one or more printers.
Click Printer > Clear notification.
Click Clear Notification.

Note: Clearing notifications only clears the messages sent from Cloud Fleet Management.

Creating tags

A tag is a custom text that you can assign to printers. When you filter a search using a tag, only printers with that 
tag are shown.

From the Fleet Management web portal, click Printers > Tags > Create tag.
Type a unique tag name.
Click Save.

Assigning tags to printers

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Tags, and then select one or more tags.

Note: If no devices are selected, then the available tags are disabled.

Click Apply.

Using file import to tag printers

Users can import multiple IP addresses or serial numbers of associated printers in an organization and assign 
single or multiple tags to them. This feature helps users later identify and group devices in the portal based on 
customer requirements.

From the Fleet Management web portal, click Printers.
From the Tags menu, select Tag printers using file import.
From the Tag Printers Using File Import dialog box, do the following:
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Type the name of the tag in the Search text box, or select one or more tags from the 
list.
Click Choose File to browse to the file that contains the printer serial numbers or IP 
addresses.

Notes
The file size must not exceed 200KB.
The file must be in TXT or CSV format.
The file must have either IP Address or Serial Number as the header. The 
headers are not case‑sensitive.
The file must have relevant data along with the required header.
The file must have valid IP addresses.
The file must not have blank lines.

Sample data for IP Address header

 

IP Address 

10.195.2.10 

10.4.5.100 

10.194.8.182

Sample data for Serial Number header

 

Serial Number 

50621094752gk 

502706946HRCD 

DUNES104SRL23

Click Tag Printers.

Notes
If the list of IP addresses contains printers from both inside and outside the 
organization, then the Tag Printers Results Summary dialog box appears. The 
dialog box shows the number of printers that are tagged (inside the organization) 
and not tagged (outside the organization).
If the list of IP address contains printers only from the organization, then the Tag 
Printers Results Summary dialog box does not appear.
Even if a printer is already tagged, you can still add more tags to it.

Removing assigned tags

From the Fleet Management web portal, click Printers.
Select one or more printers.
Click Tags, and then clear one or more tags.
Click Apply.
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Managing tags

From the Fleet Management web portal, click Printers.
Click Tags > Manage tags.
Do either of the following:

To delete tags, select one or more tags, and then click Delete.
To edit a tag, click a tag name, edit the tag, and then click Save.

Updating agent access credentials

If the enrolled printer communication status is Agent needs credentials, then update the agent access credentials.

Note: If the printers are managed using the Printer Agent, then the agent access credentials can be updated 
using the Embedded Web Server. For more information, see Accessing the Printer Agent on page 113.

The following steps are only applicable for Fleet Agent.

From the Fleet Management web portal, select a printer.
Click Printer > Update agent access credentials.
Select the authentication type for the printer administrator account, and then provide the 
credentials.
Click Update Credentials.

Deploying files to printers

You can upload VCC bundles (.zip), UCF settings files (.ucf), and eSF application files (.fls) to printers.

The Virtual Configuration Center (VCC) is a feature component of the device firmware that assists in managing 
device settings. It allows users to export settings from one device and then import that settings package into a 
different device. A user can also export a settings bundle, edit that package, and then import the modified settings 
bundle to a new device.

You can export or import a UCF file using the application interface.

Notes

The file size must not exceed 50MB. For VCC bundles, the file size must not exceed 
32MB.
Firmware flash files are not supported.
File and configuration deployment are not supported in some printer models. For more 
information, see Supported printer models on page 28.

From the Fleet Management web portal, click Printers.
Select one or more printers.
Click Configure > Deploy apps and settings file, and then browse to the file.
Click Done.
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Notes
To cancel the file upload, click Cancel.
VCC bundles support settings files, certificates, licenses, and eSF applications. 
However, we do not recommend deploying eSF applications through VCC bundles.
If the deployment of a VCC bundle fails, then update the printer information to make 
sure that Lexmark Cloud Services contains the latest information. From the printers 
list, select one or more printers, and then click Printer > Refresh printer 
information.
After configuring a device, you can export the configuration file (VCC or UCF files) 
and then import it in Lexmark Cloud Services to deploy it to printers. The passwords 
which are part of the configuration file get stripped during export. You must edit the 
configuration file manually to add the passwords before importing them to Lexmark 
Cloud Services.

Managing applications

The Fleet Management web portal lets you manage the applications that are installed on the printers. 
Applications can be started, stopped, updated, or uninstalled.

Managing applications from the printer details page

From the Fleet Management web portal, click Printers.
From the printers list, click the printer identifier.

Note: For more information on setting the printer identifier, see Managing views on page 
128.

From the Installed Applications section, select one or more applications.
Do any of the following:

To start the applications, click Start > Start App.
To stop the applications, click Stop > Stop App.
To remove the applications, click Uninstall > Uninstall App.
To update the applications, click Update > Update.

Notes

Build-in application, or applications that came with the printer, cannot be removed or 
uninstalled using Lexmark Cloud Services.
Only started applications can be stopped, and only stopped applications can be started.

Managing applications from the printer listing page

From the Fleet Management web portals, select two or more printers.
Click Apps, and then do any of the following:
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Start applications

Click Start > Continue.
From the Start Apps window, select one or more applications.
Click Start Apps.

Stop applications

Click Stop > Continue.
From the Stop Apps window, select one or more applications.
Click Stop Apps.

Update applications

Click Update > Continue.
From the Update Apps window, select one or more applications.
Click Update Apps.

Uninstall applications

Click Uninstall > Other apps > Continue.
Do either of the following:

To uninstall Cloud Print Management applications, click Cloud Print 
Management.
To uninstall specific applications, click Other apps, and then select one or more 
applications.

From the Uninstall Apps window, select one or more applications.
Click Update Apps.
Click Uninstall Apps.

Notes

Build-in application, or applications that came with the printer, cannot be removed or 
uninstalled using Lexmark Cloud Services.
Depending on the printer model, applications may have different names but perform the 
same function.

Configuring the printer proxy settings

If the organization is using an authenticated proxy server for communication, then configure the proxy server 
settings and credentials in the printer Embedded Web Server.

Note: The proxy credentials setting is available only in some printer models.

From the Embedded Web Server, do either of the following:

Note: For more information on identifying the printer eSF version, see Viewing the 
Embedded Solutions Framework (eSF) version on page 59.

For printers with eSF version 5.0 or later

Click Apps > App Framework Configuration.
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From the Framework Configuration section, clear Use printer’s proxy settings.
From the HTTPS: section, type the proxy server host name or IP address.
From the Proxy Credentials section, type the user name and password.
Save the settings.

For printers with eSF version 4.0 or earlier

Depending on your printer model, do any of the following:

Click Settings > Apps > Apps Management > System > Configure.
Click Settings > Device Solutions > Solutions (eSF) > System > Configure.
Click Settings > Embedded Solutions > System > Configure.

Clear Use printer’s proxy settings.
From the HTTPS section, type the proxy server host name or IP address.
From the Proxy Credentials section, type the user name and password.
Save the settings.

Customizing the printer home screen

Note: Make sure that the printer firmware is updated to the latest version. Also, make sure that you have 
updated to the latest version Printer Agent or Fleet Agent.

From the Fleet Management web portal, click Printers.
Click the printer IP address, and then from the Home Screen section, do one or more of the 
following.

To view the current application arrangement, click View home screen.
To restore the default home screen view, click Restore.
To customize the home screen applications, do the following:

Click Customize, and then do one or more of the following:

To add an application, click , select an application, and then click Add.

Note: To search for an application, in the Search field, type the 
application name.

To move up an application, select an application, and then click .
To move an application as first in the list, select an application, and then 
click .
To move down an application, select an application, and then click .
To move an application as last in the list, select an application, and then 
click .
To move an application to another page, select an application, and then 

click .
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Note: When the application is moved to another page, the application is 
added at the bottom of the destination page.

To add a space between two applications, click  > ‑BLANK SPACE‑ > 
Add, and then move the space to its location.

Notes
You can move the space the same way you move the 
applications.
While using Solution Composer in older Lexmark models, some 
workflows may appear at the end of the eSF applications list in 
the printer home screen. The home screen has the correct 
placement of the workflow, but Customize Home Screen and 
View Home Screen show the workflows at the end of the list. This 
issue is due to a firmware limitation so currently, there is no 
solution.

To hide an application from the home screen, select an application, and 
then click .
To manage the application on the succeeding page, click Other Pages.
To restore the default home screen, click  > Reset.

Click Save Home Screen.

Notes
Depending on your printer model, each home screen page can have up to 4, 
8, 10, or 15 items. An item can be an application or a space.
If the number of items exceeds the limit, then the items are added on the 
succeeding page.
You can add ‑BLANK SPACES‑ to fill in a page, and have an application 
move to the succeeding page.

Updating the printer firmware

You can update the firmware version of the printers in your organization. The Fleet Management web portal uses 
a product service that communicates with Lexmark Cloud Services to check for new firmware releases. The 
system checks for firmware updates daily. When a new firmware version is found, it is compared against the 
actual firmware installed on the printers, and then the firmware status is updated.
Using the printer listing page

From the Fleet Management web portal, click Printers.
Select one or more printers.
Click Configure > Update firmware.
In the Update Firmware dialog, do either of the following:

Note: The Update Firmware dialog shows the number of printers that have firmware 
updates available.

Select Now.
Select Specific date and time.
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Make sure that Specific date and time is selected.
In the Scheduled task name field, type the name of the task.
Configure the start date and start time.
Select the time zone.
In the Task window section, configure the time window for starting the task of all 
the selected printers.

Click Update Firmware.

Notes

The task window guarantees that no new firmware update jobs are submitted after the 
window expires. However, if an existing firmware update job started before the end of the 
window, then it will not be stopped and will be allowed to complete.
Any firmware update job that gets launched in the specified window will expire.
If you are updating firmware for many printers, then make sure that the task window is 
large enough.
When you schedule a firmware update, a task is created. You can view the details of the 
task in the Tasks section.

Using the printer details page

From the Fleet Management web portal, click Printers.
Click the printer IP address.
From the Firmware section, click Update available.

Note: This setting is available only when a firmware update is available.

Click Update Firmware

Exporting eSF application versions

Using this feature, administrators can export a report listing all the eSF applications installed and corresponding 
versions for a fleet. The fleet can be from a single organization or all organizations. Customers can 
determine eSF application version for an entire fleet and use Cloud Fleet Management to update 
the eSF applications or bundle.

From the Fleet Management web portal, click Printers.
From the Export to CSV menu, select Export the installed application versions.

Note: You can open the CSV file in Microsoft Excel. The sheet contains static columns listing the versions of 
the various applications installed in the fleet. The report contains all the applications that the device reported to 
the Lexmark Cloud Services.
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Unenrolling printers

From the Fleet Management web portal, click Printers.
Select one or more printers, and then click Printer > Unenroll printers.
Click Unenroll printers.

Notes

Unenrolled printers are removed from the Fleet Management web portal printer listing.
If the printer is enrolled using the Fleet Agent and is online, then unenrolling the printer 
removes it from the printer listing page. On the next scheduled Fleet Agent discovery, the 
printer is enrolled again. To remove the printer from the printer listing page permanently, 
delete the printer from the Include tab or exclude the printer from the discovery criteria.
If the printer is enrolled using the Local Agent, then unenrolling the printer removes it from 
the printer listing page. On the next scheduled polling, the printer is enrolled again. To 
remove the printer permanently, unenroll the printer from the printer listing page or printer 
details page. Also, unplug the device from the Local Agent host computer.
If the printers are enrolled using the Printer Agent, then the Printer Agent remains installed 
on the unenrolled printers.
Any configuration that is deployed remains installed after unenrolling the printers.
If Cloud Print Management applications are installed, then they remain installed and 
continue to work after the printer is unenrolled.
Unenrolling of printers cannot be stopped. For more information, see Managing tasks on 
page 166.

Exporting fleet information

From the Fleet Management web portal, select a view, or filter the printer information.
Click Export to CSV.

Note: This feature exports all information present in the current view and current filters that are applied.

Apps Management

Managing installed applications

In Lexmark Cloud Services, you can manage all the applications installed in various enrolled printers. To access 
the Apps page, from the Fleet Management web portal, click Printers > Apps.

In the Apps page, you can use the following filters:

Available—Filters the applications that have available updates.
No update available—Filters the applications that have no updates.
Required—Filters the applications that require immediate update.
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To export the application report in CSV format, click Export App Version.

Notes

In the Apps page, the Printers column shows the number of printers that have the 
applications installed.
The Built‑in On Printers column shows the number of printers that have the applications 
already built‑in.
The App Update column shows whether an application has an available update. It also 
shows if an application requires an immediate update.
The Printers With Update column shows the number of printers that have an update 
available or require an immediate update.

Managing an application from the Apps page

From the Apps page, select an application.
From the applications details page, select one or more printers.

Note: The application details page lists the printers where the application is installed.

Do any of the following:

Start—Starts the application.
Stop—Stops the application.
Uninstall—Uninstalls the application.
Update—Updates the application.
Export to CSV— Exports the report of the application in CSV format.

Notes
In the application details page, the App Update column shows whether an 
associated printer has an available update. It also shows whether a printer requires 
an immediate update.
The Installed Version column shows the version number of the application installed 
in a particular printer.
The App Update Version column shows the version number of the available 
application update.
The Minimum Version column shows the minimum version of an application 
required by the printer.

Using a mobile device

Accessing the Cloud Fleet Management portal

You may access the portal using one of the following supported mobile web browsers:

Apple Safari version 13 or later
Google Chrome version 83 or later
Samsung Internet version 9.2 or later
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From your mobile device, open a supported web browser.
Access the Lexmark Cloud Services website.
Type your e‑mail address and password.

Note: If the system is configured to have federated access, then you are redirected to the 
login page of your organization.

Tap Fleet Management, and then, if necessary, select an organization.

Navigating the home page

Note: Some features of the Fleet Management portal are not available on the mobile version. To enable all 
features, view the portal on a web browser for desktop.

To change the organization, depending on the screen size, tap either Select Organization 
or  > Select Organization.

Note: This feature is available to Partner Administrators and Organization Administrators 
that manage multiple organizations.

To view all managed printers, do one of the following:

Tap Managed Printers.
Depending on the screen size, tap either Printers or  > Printers.

To view printers with communication errors, tap Communication Errors.
To view printers with alerts, tap Printer Alerts.
To view printers with supply alerts, tap Supply Alerts.
To view printers that require firmware updates, tap Firmware Updates.
To send your comments or suggestions, depending on the screen size, tap either Feedback 
or  > Feedback.
To view the desktop version of the portal, depending on your web browser, do one of the 
following:

On the upper‑left corner of the display, tap   > Request Desktop Website.
On the lower‑right corner of the display, tap   > Request Desktop Site.

Managing printers

From the Cloud Fleet Management portal, tap Managed Printers.

Notes
The mobile device screen resolution determines the number of columns shown.
Rotating your mobile to landscape, depending on the screen size, shows up to eight 
columns.
To sort the printer list, tap the column name.

To configure the information to show for each column, tap .
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Tap a printer, and then tap Details.

To narrow down the list, do one of the following:

In the Search field, type a printer IP address, and then tap .

Tap , and then select one or more filters.

Do one or more of the following:

View printer identification, communication status, page counts, and event history.
Refresh the printer information.
Reboot a printer.
View printer and supply alerts.
Send a panel notification. From the Panel Notifications section, select a notification, 
and then tap Send Notification.
Clear panel notifications.
View agent information. For printers that are managed using a Fleet Agent, tap Go to 
Fleet Agent to manage the Fleet Agent. For more information, see Managing Fleet 
Agents on page 144.

Managing Fleet Agents

From the Cloud Fleet Management portal, tap  > Fleet Agents.

To narrow down the list, do one of the following:

In the Search field, type a Fleet Agent name, and then tap .

Tap , and then select one or more filters.

Tap a Fleet Agent, and then tap Details.
Do one or more of the following:

View agent status, version information, agent settings, and system host.
To initiate printer discovery and enrollment, tap Discover & Enroll Printers.
To update the Fleet Agent or the printer support library, from Version Information 
section, tap Update Available > OK.

Note: The Update Available button shows only if an update is available.

View printer discovery schedule.
View event history.

Updating the firmware

From the Cloud Fleet Management portal, tap Firmware Updates.
Tap the printer, and then tap Details.
From the Identification section, tap Update Firmware > Update Firmware.
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Managing resources and configurations

Adding files to the resource library

The resource library is a collection of firmware files, UCF files, printer settings, and applications that are imported 
to Fleet Management. These files can be associated with one or more configurations.

From the Fleet Management web portal, click Configurations.
Click Resource Library > Create or Create Resource.
Type the resource name and description.
Select the resource type.

UCF file

Click Choose File, and then browse to the file.
Settings bundle

Click Choose File, and then browse to the file.
Firmware

Type the URL link or the build name, and then click Verify.

Note: To obtain the URL link or the build name, contact the Lexmark Customer 
Support Center.

Imported app

Click Choose File, and then browse to the file.

Click Create Resource.

Managing the Resource Library

Editing a Resource

Note: You cannot edit resources that are assigned to a configuration.

From the Fleet Management web portal, click Configurations › Resource Library.
Click a resource name, and then edit the name or description.
Click Save Changes.

Deleting Resources

Note: You cannot delete resources that are assigned to a configuration. If the configuration that references the 
resource is deleted, then the resource can be deleted.

From the Fleet Management web portal, click Configurations › Resource Library.
Select one or more resources, and then click Delete.
Click Delete Resources to confirm.
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Downloading Resources

Note: To view resources by type, click Type, and then select the resource type.

From the Fleet Management web portal, click Configurations › Resource Library.
To download an application resource, click the resource name, and then click Download the 
imported app for this resource.
To download printer settings, click the resource name, and then click Download the 
Settings bundle for this resource.

Creating a configuration

A configuration is composed of firmware, applications, and printer settings (UCF or settings bundle) that can be 
deployed to a printer or a group of printers. When you create a configuration, that new configuration is universal 
and could apply to all printer models. Lexmark Cloud Services determines what elements of a component apply 
to each printer model, except for settings files that are deployed to all printer models.

From the Fleet Management web portal, click Configurations > Configurations, and then 
click Create or Create Configuration.
Type a unique configuration name and description.
Do any of the following:

Add firmware

To use the recommended firmware for all printer models, from the Firmware tab, select 
Update all models to the recommended firmware version.
To use firmware from the resource library, click Select Firmware, select one or more 
firmware resources, and then click Select Firmware.

Note: For more information, see Adding files to the resource library on page 145

To upload firmware, do the following:

Click Upload Firmware.
Type the resource name and description.
Type the URL or the build name, and then click Verify.

Note: To obtain the URL or the build name, contact the Lexmark Customer Support 
Center.

Click Upload Firmware.
Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.
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You can set the firmware component to Update all models to the recommended firmware version and also 
contain one or more specific firmware resources. A specific firmware resource applies only to a small set of 
printers. When using multiple firmware resources, the following behaviors can be observed:

If a configuration contains only the Update all models to the recommended firmware 
version setting, then printers with firmware older than the recommended level are updated. 
Printers with firmware at the recommended version or newer are not updated.
If, aside from the setting, a configuration also contains specific firmware resources, then all 
printers that match the models in the specific firmware are updated. All other printers are 
updated to the recommended firmware version.
If a configuration contains only specific firmware resources, then all printers that match the 
models in the specific firmware are updated. All other printers are not updated.

Note: If a specific firmware resource is a downgraded version, then all the eSF applications are removed. The 
built-in applications are restored to the requested down-level firmware. The Printer Agent is also deleted, and 
the printer must be enrolled again in Cloud Fleet Management.

Add applications

To add applications, do the following:

From the Apps tab, click Select Apps.
Select one or more applications, and then click Next.

Notes
To view the information about the application, click More Info.
If Cloud Scan Management and Translation Assistant are coexisting along 
with Card Authentication, then these applications must be selected in the 
Card Authentication permissions. This action makes the applications 
accessible from the printer control panel.
When creating a configuration for Cloud Print Management, Translation 
Assistant, or Cloud Scan Management applications, make sure that you 
configure the Pluggable Authentication Module setting properly. If the printer is 
not managed by another authentication application, then enable this setting. 
This action allows Cloud Authentication to be used as the main authentication 
application that manages the printer security.
If the printer has another authentication application managing its security, then 
make sure to disable the Pluggable Authentication Module setting.
The Cloud Print Management applications may not work with some 
authentication applications. For more information on the limitations, see the 
Cloud Authentication Readme File.

Click Done.
If necessary, click the application name, and then configure the application settings.

Note: Some application settings cannot be modified from the Fleet Management 
web portal. To configure these settings manually, access the configuration page for 
the application from the printer Embedded Web Server. For more information, see 
the Administrator’s Guide for the application. If you select Cloud Print Management, 
then you must configure the Pluggable Authentication Module setting to make Cloud 
Authentication as the primary authentication application.

Expand Cloud Print Management settings.
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rom the Basic settings section, select Enable pluggable authentication 
module.

Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

To upload applications, do the following:

From the Apps tab, click Upload App.
Type the resource name and description.
Click Choose File, and then browse to the file.
Click Upload App.
Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

Add printer settings files

To use printer settings from the resource library, do the following:

From the Printer Settings Files tab, click Select Settings File.
Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

To upload printer settings, do the following:

From the Printer Settings Files tab, click Upload Settings File.
Type the resource name and description.
Select a resource type.
Click Choose File, and then browse to the file.
Click Upload Settings File.
Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
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Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

Note: To change the order of the settings deployment, drag the setting up or down the list. This function is 
applicable only for settings in a nondeployed configuration.

Configure printer settings

Importing Variable Settings File

From the Variable Settings File menu, select Import.

Notes
From the Variable Settings File menu, you can also Export or Remove an existing 
CSV file.
To export, from the Variable Settings File menu, select Export. This downloads the 
existing CSV file in your local folder.
To remove, from the Variable Settings File menu, select Remove, and then click 
Remove File. This disables all the settings that was configured by the CSV file.

Browse for the CSV file, and click Open.
On successful import, the Printer Settings section displays a summary of the CSV file, 
which includes Total asset records, Total variables, and Asset Identifier.

Notes
If the CSV file is not valid, then the Import Variable Settings CSV File. window 
displays the validation results. The window provides a detailed information about 
each of the errors.
If a variable setting is deployed to a setting of a printer which is not mentioned in the 
CSV file, then the particular setting will have the default value activated.
If you try to import a variable setting CSV file in a configuration which already has 
one, any missing column is flagged on the Import New Variable Settings CSV file 
window. You may Cancel the import or Turn Off and Continue with the import of 
the new CSV file.
On selecting Turn Off and Continue, the setting for the particular column head is 
reverted to the default value.
A single configuration only supports one CSV file. If you have more than one CSV 
file with different assets, we recommend you to merge the CSV files and import a 
single one.
If variable settings is selected and the printer is included in the CSV file, then the 
variable settings will be deployed successfully. However, if the same configuration is 
deployed to a printer, not listed in the CSV file, then the system will apply the value 
that was manually appended in the Printer Setting field instead.

Navigate to the particular settings, and select it.

Note: You can configure one or more settings using the CSV file.

Click  for the particular setting.
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Note: If the CSV file is not imported successfully, then  remains disabled.

From the Select a variable setting from the list menu, select a value, click Continue.

Notes
Before selecting a value, we recommend you to click  for a particular setting to 
learn about the default value and the value range.
The drop-down list features the name of the column-head of the CSV file.
The CSV file must either have a column head named as IPADDRESS, 
HOSTNAME, or SERIALNUMBER. These column heads acts as asset identifier. 
Each subsequent column in the header row of the variable file is a user‑defined 
replacement variable setting name. The name must only consist of alphabet, space, 
underscore, and hyphen.
On selecting a value from the drop-down list, you are actually mapping the value of 
the column to a particular IPADDRESS or SERIALNUMBER, HOSTNAME of a 
printer.

Sample CSV file for variable settings

Consider a scenario in which for Asset Tag setting, you select control from the Select a 
variable setting from the list menu. In this scenario, the printer with the IPADDRESS 
10.199.96.231 will have Kip1 as the Asset Tag.
Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

Creating a configuration without importing a Variable Settings File

To modify the printer settings according to the requirements of the configuration, do the 
following:

From the Printer Settings tab, select .
Expand the settings category to navigate to a particular setting.

Note: To search for a particular setting, type the name of the setting in the search 
box. The search result shows all the paths in the tree that navigate to the particular 
string.

Select or enter the values for the settings.

Note: To view the summary of the modified settings, click .
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Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note: To cancel the configuration, click Cancel.

Login Methods

Note:

For Login Methods, the minimum recommended version of Fleet Agent must be 2.1.7 or 
later.
The Login Methods settings are supported by printers with eSF version 5.0 or later.

From the Login Methods tab, select Activate Login Methods.
Click Public Permissions.

In the Public Permissions  section, configure the following:

Note: You must create at least one login method before removing Public Access 
Controls.

Function Access—Select the printer functions to be given access.
Administrative Menus—Select the administrative features to be given access.
Device Management—Select the device management features to be given 
access.
Apps—Select the printer applications to be given access.

Click Local Methods.
In the Local Methods  section, configure the following:

Add Login Methods—From the Add Login Methods menu, select any of the 
following:

Note: Configure each of the following as required.

Username and Password
Username
Password
Pin

Add New Group
You can add a new group and provide access controls as per the 
requirement.
To edit an existing group, click the name of the group name.
To delete an existing group, click  for that particular group.

Click Network Methods.
In the Network Methods  section, configure the following:

Add Login Methods—From the Add Login Methods menu, select any of the 
following:

Note: Configure each of the following as required.
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LDAP—Configure the following:
Setup Name
Required User Input
Server Address
Server Port
Permissions

LDAP+GSSAPI (Kerberos required)—Configure the following:
Setup Name
Server Address
Server Port
Permissions

Kerberos 5—Select any of the following and configure accordingly:
Generate Simple Kerberos File
Import Kerberos File
Disable Reverse IP Lookups
Kerberos Permissions

Click Other Methods.
In the Other Methods  section, configure the following:

Cloud Authentication—Selects cloud authentication as the authentication 
method for the groups.
Card Authentication—Selects card authentication as the authentication method 
for the groups.

Click Additional Settings.
In the Additional Settings  section, configure the following:

Set Default Login Methods
Login Restrictions
Miscellaneous

Click Accept.

Note: Click Reset to Default to restore the values to default values.

Do either of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.

Note:
To cancel the configuration, click Cancel.
For more information on each of the settings, see Embedded Web Server 
Administrator's Guide.
For Login Methods, make sure the firmware version is 2.1.x or later.

.

If a configuration contains only the Update all models to the recommended firmware 
version setting, then printers with firmware older than the recommended level are updated. 
Printers with firmware at the recommended version or newer are not updated.
If, aside from the setting, a configuration also contains specific firmware resources, then all 
printers that match the models in the specific firmware are updated. All other printers are 
updated to the recommended firmware version.
If a configuration contains only specific firmware resources, then all printers that match the 
models in the specific firmware are updated. All other printers are not updated.
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Note: If a specific firmware resource is a downgraded version, then all the eSF applications are removed. The 
built-in applications are restored to the requested down-level firmware. The Printer Agent is also deleted, and 
the printer must be enrolled again in Cloud Fleet Management.

Importing a settings bundle

You can import a settings bundle that contains information on Printer Settings or Login Methods, or both.

On the Create Configuration page, click Import Settings Bundle.
Select either of the following sources:

File upload—Choose a settings bundle from your disk.

Note: The file must be in ZIP format.

Resource Library—Select a settings bundle from the Resource Library.

Note: For more information on adding resources to the resource library, see Adding 
files to the resource library on page 145

Click Continue.
The bundle is validated, and the Import Settings Bundle window categorizes information 
based on the type of configuration.

Note:
Only new settings and existing settings with a different value will be imported to the 
configuration.
For Login Methods, only new settings and existing settings with different values are 
imported.
Settings that are unsupported or have invalid values are not imported. Click the links 
to view the detailed reports.
For each type of configuration, you can click the messages to view the reports.
Based on the validation, you can clear Printer Settings or Login Methods to 
exclude it from the configuration.

Click Import Settings Bundle.

Note: If the settings bundle that you export from the Embedded Web Server contains invalid account details 
with special characters, then Lexmark Cloud Services will exclude these user details during the import 
process.

Managing configurations

From the Fleet Management web portal, click Configurations.
Click Configurations.
To delete configurations, select one or more configurations, and then click Delete > Delete 
Configurations.

Note: Deleting configurations does not remove them from printers to which they are 
already deployed.

To copy a configuration, do the following:



Fleet Management

154

a.
b.
c.

d.

e.
f.

g.

◦

◦

5.

6.

◦
◦
◦
◦

1.
2.
3.

a.
b.
c.

▪

▪

▪

Select a configuration, and then click Copy.
Type a unique configuration name.
Select the organization where you want to copy the configuration to.

Note: This setting is available only when you are managing multiple organizations.

Select Edit configuration after copy.

Note: This setting is available only when you are copying to the same organization.

Click Copy Configuration.
Configure the settings.
Click Save Changes.

Notes
Deployed configurations cannot be edited, but can be copied and saved as a new 
editable configuration.
If a configuration contains resources, such as firmware, applications, and settings 
files, and is copied to the same organization, then those existing resources are 
used. If the configuration is copied to a different organization, then those resources 
are copied to the destination organization.

To set a default configuration, select a configuration, and then click Set as Default. The 
default configuration is assigned to newly enrolled printers automatically. To remove the 
configuration as the default configuration, select the configuration, and then click Remove 
Default.
On the Configurations page, view the following columns:

Last Editor—Shows the user who last edited the configuration
Latest Published Version—Shows the latest published version of the configuration.
Publisher—Shows the name of the user who published the configuration.
Date Published—Shows the date when the configuration was published.

Editing or copying a published configuration

From the Fleet Management web portal, click Configurations.
Select the configuration that you want to edit or copy.
Do either of the following:

Create a draft

Click Create New Draft > Create New Draft
Edit the details.
Do any of the following:

Save as Draft—Save a draft version of the configuration. A configuration in its 
draft status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.
Delete

Note: To cancel the configuration, click Cancel.
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Copy a configuration

Click Copy Configuration.
From the Copy Configuration window, type the name of the configuration and select 
the configuration of the organization that you want to copy.
Click Copy Configuration.
If necessary, from the new configuration page, edit the details.
Do any of the following:

Save as Draft—Save a draft version of the configuration. A configuration in draft 
status cannot be deployed to a printer.
Publish—Publish a configuration. In the Publish Configuration window, type the 
version notes, and then click Publish Configuration.
Delete

Note: To cancel the configuration, click Cancel.

Deploying configurations to printers

Deploying a configuration to printers sends the configuration to the cloud server, and updates the printer during 
the next scheduled poll or sync.

Note: Configuration deployment may not be supported in some printer models. For more information, see 
Supported printer models on page 28.

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Configure > Deploy configuration.
From the Deploy Configuration window, select a configuration, and then click Deploy 
Configuration.

Notes

You can only deploy the published configurations.
The list of configurations is sorted according to the last modified date, with the most recent 
configurations listed at the top of the list.
Published configurations cannot be edited, but can be copied and saved as a new draft.
When a configuration is deployed, there is an implicit order of deployment to the printer. 
Firmware is deployed first. Applications are deployed second, in the same order that they 
appear in the configuration. Settings files are deployed last, in the same order that they 
appear in the configuration.
If the configuration contains applications and the organization is using an authenticated 
proxy server, then configure the printer proxy server settings. For more information, see 
Configuring the printer proxy settings on page 137.

Assigning and deploying speed upgrade

You can upgrade the speed of your printer (pages per minute) by purchasing a speed upgrade kit. Apart from 
upgrading the speed, all other functionalities remain the same.
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Notes

Firmware version 230.347 or later is required.
To access the speed upgrade feature, you have to be a partner administrator and a Fleet 
Management administrator.
Fleet Agent version 2.1.18 or later is supported.
Upgrading the speed is not supported by Local Agent.

The following speed upgrades are available:

25 ppm > 35 ppm
35 ppm > 45 ppm
35 ppm > 55 ppm
45 ppm > 55 ppm

From the Fleet Management web portal, click Printers, and then select one printer.
Click Configure > Assign and deploy speed upgrade.

Note: If your printer does not meet the requirements of a speed upgrade, you may 
encounter one or more of the following error messages:

Agents need credentials
Agent is not communicating
The printer does not support the task
The agent does not support the task
Printer Firmware out of date. Update before continuing.
The printer does not supports the task because it is managed or pending 
management.
<Fleet, Native, Printer> agent out of date

On the Deploy Speed Upgrade window, in the Upgrade code field, enter the code, and 
then click Next.

Notes
To access the speed upgrade code, contact your Lexmark representative.
In the Deploy Speed Upgrade window, you can view the serial number and model 
name of the printer that you are upgrading.
When you click Next, the Deploy Speed Upgrade window also displays upgrade 
details like new model name and new speed.

Click Deploy.

Notes

After deployment, a task is created. The task appears as Speed upgrade under the Type 
column.
To view more details about the task and the code, click Speed upgrade under the task 
type.
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Performing configuration policy conformance 
and enforcement

Assigning a configuration

You can assign a configuration to one or more printers.

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Configure > Assign Configuration.
In the Assign Configuration window, search for the configuration, and then click Assign 
Configuration.

Notes
You can assign configuration only to Lexmark printers enrolled through a Fleet 
Agent, Native Agent, and Printer Agent.
The Fleet Agent must be version 1.3.49 or later. The Native Agent firmware must be 
version 230.216 or later. The Printer Agent must be version 4.1.4 or later.
After assigning a configuration, you can see the name of the configuration under the 
Assigned Configuration column.

Unassigning a configuration

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Configure > Unassign Configuration.
From the Unassign Configuration window, click Unassign Configuration.

Checking the conformance of a printer

You can check the conformance of a printer against an assigned configuration.

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Configure > Check conformance.

Note: A task is created. The Status column shows the result of the conformance check.

Enforcing assigned configuration

If a conformance check fails, then you can still enforce an assigned configuration to one or more printers.

From the Fleet Management web portal, click Printers, and then select one or more printers.
Click Configure > Enforce assigned configuration.
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Note: A task is created. The Status column shows the result of the conformance check.

Managing notifications

Creating a notification policy

You can create notification policies for printers. Users receive an email when the policy requirement is met. The 
notification email includes printer toner details, asset tag, fleet agent information, and other relevant details.

From the Fleet Management web portal, click Notifications > Notification Policies.
Select Supplies, Printer Information, or Fleet Agents.

For supplies

On the Notification Policies page, click Create.
Configure the following:

In the Policy name field, type the name of the policy.
In the Policy type menu, select one of the following:

Toner
Fuser
Transfer Module
Waste Toner Bottle
Maintenance Kit
Photoconductor

In the “Notify when percentage remaining is of” section, set the percentage at 
which the notification is sent.
In the Applies To section, select either of the following:

All printers in this organization—Apply the policy to all printers in the 
organization.
Only printers with specific tags—Apply the policy to printers with 
specific tags applied from Cloud Fleet Management.

In the “Apply the policy to printers with the following tags” field, type 
the tags, and then click Add.

In the “Notify the following email addresses when the conditions of this policy 
are met” field, type the recipient email addresses, and then click Add.

Notes
Make sure that the email address is valid.
You can type an email address from outside your organization.

In the “Additional information to include in the email notification (Optional)” field, 
type the additional information that you want to include in the email.
Select Include notification data in a .json file as an attachment to include the 
JSON file in the email.

Click Create Policy.
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Note: The JSON file attached to the notification email helps partners to use email 
processing automation to process the attachment for any existing workflow.

For printer information

On the Notification Policies page, click Create.
Configure the following:

In the Policy name field, type the name of the policy.
In the Policy type menu, select Last data refresh or Last communicated.
In the “Notify when data has not been refreshed after” or “Notify when a printer 
has not communicated for” section, set the number of days to send the 
notification.
In the Applies To section, select either of the following:

All printers in this organization—Apply the policy to all printers in the 
organization.
Only printers with specific tags—Apply the policy to printers with 
specific tags applied from Cloud Fleet Management.

Note: You can add up to 10 tags.

In the “Notify the following email addresses when the conditions of this policy 
are met” field, type the recipient email addresses, and then click Add.

Notes
You can add up to 10 email addresses.
Make sure that the email address is valid.
You can type an email address from outside your organization.

In the “Additional information to include in the email notification (Optional)” field, 
type the additional information that you want to include in the notification email.
Select Include notification data in a .csv file as an attachment to include the 
CSV file in the notification email.

Click Create Policy.

Notes
Policies related to printer information are executed during the daily batch process.
The body of the notification email can contain information about 15 printers only. For 
more than 15 printers, download the CSV file that is attached with the notification 
email.
For notifications for more than 15 printers, the CSV file is attached to the notification 
email, even if the user has not selected the “Include notification data in a .csv file as 
an attachment” option.

For fleet agents

On the Notification Policies page, click Create.
Configure the following:

In the Policy name field, type the name of the policy.
In the Policy type menu, select Last communicated.
In the “Notify when an agent has not communicated for” section, set the number 
of days to send the notification.
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In the “Notify the following email addresses when the conditions of this policy 
are met” field, type the recipient email addresses, and then click Add.

Notes
You can add a maximum number of 10 email addresses.
Make sure that the email address is valid.
You can type an email address from outside your organization.

In the “Additional information to include in the email notification (Optional)” field, 
type the additional information that you want to include in the notification email.
Select Include notification data in a .csv file as an attachment to include the 
CSV file in the notification email.

Click Create Policy.

Duplicating a notification policy

On the Notification Policies page, select an existing notification policy.
Click Duplicate.
On the Create Notification Policy page, enter the details.

Note: For more information on configuring the notification policy, see Creating a 
notification policy on page 0.

Click Create Policy.

Note: Apart from the policy name, make sure that you edit other details on the Create Notification Policy page. 
You cannot create a duplicate of an existing policy just by changing the policy name and keeping the other 
deciding parameters the same.

Deleting a notification policy

On the Notification Policies page, select the policy that you want to delete.
Click Delete > Delete Policy.

Viewing the notification history

Notification history is a rolling 30-day history of all email notifications sent to a particular organization.

From the Fleet Management web portal, click Notifications > Notification History.
Select Supplies or Printer Information.
Use the following filters for the notification history.

For supplies

Model
Policy Type
Supply

file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/creating-a-notification-policy-v59546481.htm
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For printer information

Policy Type
Model

Note: You can search for notifications using the printer serial number, asset tag, and email address.

Understanding MPS Express

Adding printers to MPS Express

MPS Express is a program that allows partners to sign up with Lexmark for consumables maintenance. For more 
information on Managed Print Services offerings, contact your Lexmark representative.
Before you begin, make sure that:

The printers are enrolled in Lexmark Cloud Services. For more information on fleet 
management and enrolling printers, see "Fleet Management" chapter.
The printers meet the eligibility criteria for MPS Express. For more information on eligibility 
criteria, see Adding printers to MPS Express on page 0.

Scenario 1: The Child Organization does not have the MPS Express entitlement

The child organization is created for MPS Express.
The child organization is not yet entitled to MPS Express.

Solution
Entitle the child organization to MPS Express. For more information, see Adding printers to MPS Express on 
page 0.
Scenario 2: The supply delivery contact does not exist

Child organization is entitled to MPS Express.
No existing supplies delivery contact.

Solution
Create a supplies delivery contact and assign it to the appropriate printers. For more information, see Adding 
printers to MPS Express on page 0.
Scenario 3: The supplies delivery contact is not yet assigned

Child organization is entitled to MPS Express.
Required supplies delivery contact exists.
Supplies delivery contact not assigned to printers.

Solution
Assign a supplies delivery contact to the appropriate printers. For more information, see Adding printers to MPS 
Express on page 0.
Entitle child organization to MPS Express

entitling-child-organization-mps-server

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Account Management card.

file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/adding-printers-to-mps-express-v59215695.htm
file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/adding-printers-to-mps-express-v59215695.htm
file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/adding-printers-to-mps-express-v59215695.htm
file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/adding-printers-to-mps-express-v59215695.htm
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Note: If the card is not visible on the dashboard, then click  on the upper‑right corner of 
the page, and then click Account Management.

Select the parent organization which contains the child organization, and then click Next.
Click the Child Organizations tab.
Click the child organization name that you want to entitle to MPS Express.

Note: For more information on managing child organization, see Managing the Child 
Organization Access Group on page 66.

From the Organization menu, click Organization Entitlements.
Select MPS Express, and then click Save Changes.

Important Note: You cannot undo organization entitlement to MPS Express. Contact your 
Lexmark Customer Operations Specialist or MPS Offer Manager to remove the MPS 
entitlement from a child organization.

Managing contacts

manage-contact-mps

From the Fleet Management web portal, click Printer > Managed Print Services > Manage 
Contacts.
On the Contacts page, do any of the following:

Create a contact

On the Contacts page, click Create.
Complete the contact details form, and then click Create Contact.

Import a contact

On the Contacts page, click Import.

Note: If there are no existing contacts, then click Import Contacts.

From the Import Contacts window, click Choose File to browse for the contact file.
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Notes
The contact file must be either a CSV or a TXT file. Even if the file is a TXT 
file, the data must be in CSV format.
You can download the sample file to view the format.
The contact file must have all the columns and in the same sequence as 
mentioned in the sample file. If there is no data for a particular column, then 
you can leave it blank. Do not delete any column.
The data for each of the columns must be valid. For instance, the Country 
code must not have any symbols. It only supports numerics. If you are using a 
text editor to edit the CSV file, then you must enclose data within " " to insert a 
comma in between. For instance, if you want to insert a comma between two 
values which are A and B, then it must be “A, B”. This is not required if you 
are using a spreadsheet to edit the data as spreadsheet saves the file in the 
applicable format.
In a single file, you can import a maximum of 300 contacts.
You must save the CSV file in UTF8 format to handle different non-ASCII 
characters.

Click Import Contacts.

Note: If the data in the contact file is valid, then the Import Contacts Results window 
displays Contacts imported Contacts are added one after another in sequence. 
Depending on the number of contacts, the upload process can take several minutes 
to complete.

Error messages

If the data in the contact file is not valid, an Import Contacts Results window appears. 
This window displays the error messages. On clicking the error messages, you can get 
the details of the error. The following are the types of errors messages:

Contacts already exists—Shows the row number, first name, and last name of 
each contact that already exists in the organization.
Contacts not imported—Shows the row number range of the contacts that are 
not imported because of either System error or Import canceled.

System error—Occurs when there is an error incurred by the system.
Import canceled—Occurs when the user cancels the upload process.

Contacts with missing or invalid information—Shows the row number, 
column, and reason for not importing the contact.

Edit a contact

On the Contacts page, click the name of an existing contact.
Edit the contact information.
Click Update Contact.

Duplicate a contact

On the Contacts page, select a contact.
Click Duplicate.
Click Create Contact.

Delete a contact

On the Contacts page, select a contact.
Click Delete.
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Click Delete Contact.

Note: You cannot delete a contact that is assigned to a printer.

Create and assign a supplies delivery contact

create-and-assign-supply-delivery-contact-list

From the Fleet Management web portal, select one or more printers.
Click Printer > Managed Print Services > Create and assign new supplies delivery 
contact.
In the Create and Assign Supplies Delivery Contact window, enter the name, contact 
information, and shipping address details of the new contact.
Click Create and Assign.

Assign supplies delivery contact

assign-supply-delivery-contact

From the Fleet Management web portal, select one or more printers.
Click Printer > Managed Print Services > Assign supplies delivery contact.
In the Assign Supplies Delivery Contact window, search for the contact name.

Note: You can filter or search by business name or city.

Select the contact from the search results.
Click Assign Contact.

Add printers to MPS Express

From the Fleet Management web portal, select one or more printers.
Click Printer > Managed Print Services > Add to MPS Express.

Printer Eligibility Status

The eligibility information is provided:

Eligible—Shows the number of printers eligible for MPS Express.

Note: You can add printers only if their status is Eligible. Printers with any other 
eligibility status cannot be added to the MPS Express program.

Printer already managed—Shows the number of printers that are already managed.
Printer pending management—Shows the number of printers that already have a 
pending management request.
Printer failed registration—Shows the number of printers that failed to register with 
Lexmark Cloud Services. You must contact Lexmark Technical Support for assistance.
Model not supported—Shows the number of printer models that are not supported. 
For help, contact your Lexmark Customer Operations representative.
Lifetime page count exceeds maximum allowed—Shows the number of printers 
which have exceeded the maximum lifetime page count limit to qualify for MPS 
Express. For help, contact your Lexmark Customer Operations representative.
Lifetime page count missing—Shows the number of printers with an unknown 
lifetime page count. These printers are missing a lifetime page count value for verifying 
eligibility for MPS Express. To fix this issue, you can update the associated agent or 
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the printer firmware, or unenroll and re-enroll the printer. If the lifetime page count is 
still missing, contact Lexmark Technical Support for help.
No supplies delivery contact assigned—Shows the number of printers which have 
no supplies delivery contact assigned.
Associated with down‑level fleet agent—Shows the number of printers which have 
lower versions of fleet agent than the required version. You must upgrade your Fleet 
Agent from the agents tab before adding these printers to the MPS Express program.

Note: On clicking the printer eligibility statuses, you can view the serial numbers and 
models of the non‑eligible printers.

Click Continue.
Accept the terms of service.
Click Add to MPS Express.

Notes

In the printer listing page, you can use the Business name, Lexmark Managed, and 
Supplies Delivery Contact columns for information related to entitled organizations. You 
can also enable all these columns by selecting the Managed view from the Views menu.
If you are part of the parent organization, then you cannot access Add to MPS Express. 
You can only add printers to MPS Express which are enrolled in a child organization. 
Please create a supplies delivery contact and assign to the printer, and try enrolling into 
MPS Express again.

Important Note: You cannot undo MPS Express enrollment. Contact your Lexmark Customer Operations 
Specialist to delete or unenroll printers.

Limitations of unenrolling printers managed by MPS 
Express

From the Cloud Fleet Management portal, you cannot unenroll printers that are already enrolled in MPS Express 
or have a pending enrollment request.
You also cannot delete or deactivate agents that have enrolled these printers.

What happens if you try to unenroll MPS Express managed 
printers from the printer listing page?

From the printer listing page, if you try to unenroll a combination of MPS Express and MPS Express (Pending) 
printers, an error message appears. If you try to unenroll a combination of MPS Express, MPS Express 
(Pending), and unmanaged printers, then the task will be completed with an error. Only the unmanaged printers 
will be unenrolled. You can find more details about the error by clicking the Task ID.

The printer listing page features a Lexmark Managed column that identifies printers that are already enrolled in 
MPS Express or have a pending enrollment request. Printers that are already enrolled in MPS Express are 
identified as MPS Express. Printers that are pending enrollment are identified as MPS Express (Pending).
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What happens if you try to unenroll MPS Express managed 
printers from the printer details page?

From the printer details page, you cannot unenroll printers that are already enrolled in MPS Express or have a 
pending enrollment request.

Notes

The printer details page of a printer that has the Lexmark Managed status of either MPS 
Express or MPS Express (Pending) will not have the Unenroll option.
The printer details page also identifies the printer as Lexmark Managed and MPS Express 
or MPS Express (Pending).

What happens if you try to unenroll MPS Express managed 
printers from the agents tab?

If an agent is associated with MPS Express or MPS Express (Pending) printers, then the agent details page 
shows the number of MPS Express managed printers associated with the agent. This feature helps you to identify 
an agent that is associated with MPS Express or MPS Express (Pending) printers. You cannot delete or 
deactivate these agents.

Note: You cannot unenroll a printer by deleting it from the Add Discovery Criteria to Include section of the 
agents details page. The printer will still appear on the printer listing page, but will have a noncommunicating 
status. To get the printer communicating, add its IP address in the Add Discovery Criteria to Include section 
of the agents details page.

Even if an agent is uninstalled at the operating system level, the printer listing page will still retain the managed 
printer’s details.

Managing tasks
Tasks are any printer management activities performed in the Fleet Management web portal, such as 
configurations deployment. The Tasks page shows information on the running tasks and the completed tasks. A 
task can contain one or more jobs.
From the Fleet Management web portal, click Tasks.
Understanding the task status

Completed—All jobs are successfully completed or stopped.
Completed with info—All jobs are successfully completed.
Completed with warning—All jobs are completed, but some have warnings.
Completed with errors—A combination of successfully stopped and failed jobs.
Failed—At least one job has failed or expired.
Printer is not communicating—The jobs are not submitted because the printer cannot 
communicate with the Fleet Management web portal. For more information, see The printer 
is not communicating with the agent on page 298.
Not supported—The jobs are not supported in the printer.

Viewing the task information

From the Tasks page, click the task ID.
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Do either of the following:

To filter the list according to the job status, click Status, and then select one or more 
statuses.

Pending—The job is waiting for the Printer Agent to respond. The default 
timeout for undelivered jobs is one week. The job expires automatically after the 
timeout has elapsed.
In progress—The job is ongoing. The default timeout for in‑progress jobs is 24 
hours. The job expires automatically after the timeout has elapsed.
Completed—The job is successfully executed.
Failed—The job is unsuccessful.
Stopped—The user stopped the job while it is in the Pending state.
Expired—The job exceeded the timeout.

To export the list, click Export to CSV.

Note: Only the filtered jobs are exported.

Stopping tasks

Do either of the following:

Stop a task.

From the Tasks page, click Stop beside the task status.

Notes
Only pending tasks for a printer can be stopped.
Unenrolling of printers cannot be stopped.

Stop individual jobs.

From the Tasks page, click a task ID, and then click Stop beside the job status.

Note: Only pending jobs can be stopped.

Scheduling tasks

Scheduling recurring tasks can be done only for performing configuration policy conformance and enforcement. 
For more information on performing configuration policy conformance and enforcement, see "Performing 
configuration policy conformance and enforcement" group.

Note: While selecting an organization, if you select an individual organization, only then you can create a 
recurring task.

From the Fleet Management web portal, click Tasks > Schedule.
On the Schedule page, click Create.
On the Create Scheduled Task page, configure the following:

In the Name field, type the name of the task.
From the Task type menu, select Check conformance or Enforce assigned 
configuration.
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From the Run task for these printers menu, select any of the following:

All printers—Creates a task for all printers.
Tags—Creates a task for the printers grouped under the selected tags.

Note: Make sure that you select the tags, and then click Save. For more 
information on tags, see Assigning tags to printers on page 133.

Filter group—Creates a task for the printers under the selected group.

Note: Make sure that you select the filter group, and then click Save. You can 
select one filter group only. For more information on filter groups, see 
Managing filter groups on page 126.

In the Date and Time section, configure the following:

Start date—Set the start date for the recurrence task.
End date—Set the end date for the recurrence task.
Start time—Set the start time for the recurrence task.
Select time zone—Select the time zone according to which the start date, end 
date, and start time work.

In the Recurrence section, select one of the following:

Once—The task is executed only once as configured in the Date and Time 
section.
Daily—The task is executed once daily during the entire duration, as configured 
in the Date and Time section.
Weekly—This task is executed on specified days of a week. You can select one 
or more days in a week. The weekly recurrence continues for the duration and 
time, as configured in the Date and Time section.
Monthly—The task is executed once every month and continues as configured 
in the Date and Time section. For the monthly option, you can set the exact date 
on which the task is executed every month. You can also specify the exact day 
of a month on which the task is executed every month. Make sure that when you 
specify a date or a day, that particular day, or date is covered within the duration, 
specified in the Date and Time section.

Click Save.

Notes

After a task is created, you can view it on the Schedule page. Click the  icon to view 
task details like task name, task type, number of impacted printers, and schedule details. 
The icon appears for recurring tasks only.
To edit a scheduled task, click the task name, and then you can edit the task details on the 
Edit Scheduled Task page. After editing the details, click Save.
On the Schedule page, you can also view details such as the frequency of the task and 
the last run time.
On the Schedule page, you can filter tasks by type, submitter, and organization.
To delete a task, under the Actions column, click  > Yes.
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Overview

Note: The screenshots may vary depending on the latest release.

Use the Cloud Print Management web portal to do the following:

Configure organizational policies.
Define and assign user quotas.
Manage print queues.
Delegate print jobs.
Download the Lexmark Print Management Client for Windows, macOS, and Ubuntu 
operating systems.
Create a custom Lexmark Print Management Client package.
Download the Lexmark Cloud Print Management for Chrome web browser extension.
View user quota status.

The Print Management web portal also works with the following applications:

Print Release (eSF application)—An enterprise‑grade printing solution for managing print 
jobs from the printer. For more information, see the Print Release Administrator’s Guide.
Lexmark Print Management Client—A computer application for submitting print jobs 
securely to Cloud Print Management.
Lexmark Print—An application for sending documents directly to network‑connected 
Lexmark printers and servers from a mobile device running on the Android™ platform or iOS 
operating system. For more information, see the Lexmark Print User’s Guide for your mobile 
device.
Lexmark Cloud Print Management for Chrome—A browser extension that lets users send 
print jobs to Cloud Print Management using the Chrome OS™ operating system.

Accessing the Print Management web portal
Open a web browser, access the Lexmark Cloud Services dashboard, and then do either of the following:

From the dashboard, click Print Management.

Note: If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then click 
Print Management.

Administrative tasks
The Administration tab is available to Cloud Print Management administrators. This feature lets you configure the 
print job delegation, e‑mail submission, quotas, print job retention, and print job history.

Print Management
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Configuring organizational settings

On the Organizational Settings page, you can configure the features related to Print Management.

From the Print Management web portal, click Administration > Organizational Settings.
To configure features related to print clients, expand Print Clients, and then configure the 
following:

Note: The  icon appears beside the group and setting that you are updating. If there is 
an invalid input or error on the page, then the same icon is also displayed

Access—This section lets you configure access to the Print Clients page. The Enable 
Print Clients page setting lets you navigate to the Print Clients page. For more 
information, see Downloading the Lexmark Print Management Client.
Update—This section lets you configure automatic update for installed print clients. 
The Enable automatic updates for installed print clients setting lets users 
configure the Lexmark Print Management Client for automatic updates to the latest 
version when available. In this section, you can also configure the exact timing for the 
update. For more information, see Enabling automatic updates for Lexmark Print 
Management Client.

Advanced Hybrid Storage—The Enable advanced hybrid storage setting lets you 
create advanced hybrid storage options. You can keep a maximum of three copies of a 
job, apart from the default copy on the submission workstation. There is no limitation 
on the number of storage devices, but the number must be greater than the selected 
number of copies. In this section, you can also choose between Windows, Linux, and 
Optra as the hybrid job storage type.

Notes
Depending on the selected hybrid storage type, the Client Overview page 
features only the relevant storage devices. For instance, if you select 
Windows from the hybrid storage type, then the storage list features only the 
Windows storage devices.
Changing the value of the previously saved Hybrid Job Storage Type notifies 
the administrator that the existing Advanced Hybrid Storages and Storage 
Assignment are deleted.
For more information on advanced hybrid storage, see Understanding 
advanced hybrid storage on page 210.

To configure features related to print jobs, expand Print Jobs, and configure the following:
Delegation—The Enable print job delegation setting lets you delegate print jobs to 
other users, allowing them to release the jobs for you. For more information, see 
Managing delegates on page 182.

Enable delegate e‑mail notification—Sends an email notification to a delegate 
when the delegate is added or removed. If an expiry date is set for the particular 
delegate, then the email contains the information related to the expiry date and 
time as well.

Release:
Enable changing the number of copies before release—Lets you change the 
number of copies before releasing a print job. For more information, see 
Releasing print jobs using the eSF application on the printer on page 198.

This feature requires the following versions of the Print Release eSF application:
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For e‑Task v5 or later: 5.10.x or later
For e‑Task v4 or earlier: 2.6.x or later

Enable print and keep—Lets you retain a print job in the print queue after 
releasing it.

This feature requires the following versions of the Print Release eSF application:

For e‑Task v5 or later: 5.10.x or later
For e‑Task v4 or earlier: 2.6.x or later

Enable automatic print release—Lets you release print jobs automatically after 
logging in to a printer. For more information, see Printing jobs using automatic 
print release on page 199.
Keep print job file names for reporting—Lets you store the file name of a print 
job for organizational reporting.
List and auto‑release oldest print jobs first —Lets you show and release the 
print jobs in order from oldest to newest.

Update the eSF applications to the following version to use this feature:

For eSF version 5 or later:

Cloud Authentication version 5.6.30
Print Release version 5.10.19
Device Usage version 2.4.19

For eSF version 4 or earlier:

Cloud Authentication version 2.6.23
Print Release version 2.6.24
Device Usage version 2.4.19

Retention—From the Print Job Retention section, specify the length of time before 
released and unreleased jobs are deleted.

Note: You can configure the duration for Print Job Retention by specifying the 
number of days or hours.

History—From the Print Job History section, specify the period of the print job 
history.

Notes
You can configure the duration for Print Job History by specifying the number 
of days or hours.
You can view the print job history information from the Print Job History tab. 
For more information, see Viewing the print job history on page 183.
This setting determines the included dates when generating the history of 
submitted print jobs. The specified period has no association with the 
Analytics web portal.

To configure email submission related settings, click Email Submission, and configure the 
following:

Enable e‑mail submission —Lets you email documents to Lexmark Cloud for 
release. For more information, see Sending print jobs using e-mail on page 193. The 
email address appears next to the Enable e‑mail submission option.
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Notes
The email address is linked to the environment that you are logged in to.
The email address also appears as a banner on the Print Queue page.
In the E-mail documents to the following custom address field, type an 
organization‑specific username.
The email address is <organization‑specific username>@print.lexmark.com.
When email submission is enabled for the first time, the email address can 
take up to 24 hours to be available.
A notification appears when the email address becomes accessible for users 
to submit print jobs.

Enable e-mail body submission—Lets you submit the email body to Lexmark 
Cloud for release. To enable email body submission, you must enable email 
submission.

Note: If Enable e‑mail body submission is not selected, only the email 
attachment is printed.

Allow guests to use e‑mail submission—Lets unregistered guest users email 
their documents to Cloud Print Management. To allow guest print submission, 
you must enable email submission. For more information, see Configuring the 
Guest Print feature on page 199.

Limit the number of pages allowed per job—Lets you set the maximum 
number of pages allowed per job for unregistered guest users.

Note: Each attachment in the email is treated as an individual job. The 
body of the email is also treated as an individual job.

Assign guests to cost center or department—This feature lets you assign 
guests to a specific cost center or department for applying quotas and reporting. 
From the Assign guests to cost center or departmentmenu, select any of the 
following:

Do not assign—Use this option if you are not assigning guests to any 
cost center or department.
Cost center—Type the name of the cost center.
Department—Type the name of the department.

To configure features related to quotas, click Quotas, and then configure the following:
Print Quotas—The Enable print quotas setting lets you set printing quotas. You can 
define the default quota for the organization, or set a custom quota.

To configure features related to policies, expand Policies, and then configure the following:
Print—The Enable print policies setting lets you create and assign print policies to 
the users and groups in your organization.

Cost center or personal—Lets you create a policy, and then assign it to cost 
centers or individual users.
Department or personal—Lets you create a policy, and then assign it to 
departments or individual users.
Personal only—Lets you create a policy, and then assign it to individual users.

Note: For more information on creating and assigning print policies, see 
Creating and assigning print policies on page 177.
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Client—The Enable client policy setting lets you create rules to manage Print Clients 
for an organization.

To configure features related to print assignments, click Print Assignments, and configure 
the following:

Enable print assignments—Lets you create, edit, and delete print assignments that 
specify printers to which a user may print in this organization.
From the Use print assignment with menu, select any one of the following:

Direct Print— Enables the Direct Print feature for departments, cost centers, 
and users. This feature allows you to track jobs that are sent to network 
attached printers, enrolled in Cloud Fleet Management.

Note: For more information on creating a direct print package, see Using 
Direct Print on page 204.

Offline Print—Lets you send print jobs even when connectivity to Lexmark 
Cloud Service is lost. Print analytics data is held in the client workstation until 
connection to the Lexmark Cloud Service is restored.
Direct and offline print—Lets you utilize the capabilities of both Direct Print 
and Offline Print.

Note: For more information on Offline Print, and Direct and Offline Print, see  Using 
Offline Print on page 209.

To configure Universal Print, click Universal Print Integration, and configure the following:
Enable Universal Print—This feature registers the Cloud Print Management as a 
Microsoft Universal Print (MUP) virtual printer in the Microsoft Entra ID.

Printer name—In the Printer name field, type the name of the Cloud Print 
Management virtual printer.
Printer share name—In the Printer share name field, type the printer share 
name.

Note: The printer name and printer share name can be the same, but the 
printer share name must be unique.

Before enabling Universal Print Integration with Cloud Print Management, make sure that the 
following prerequisites are met:

The operating system of the client workstation must have Windows 10 version 1903 or 
later.
For macOS, the client workstation must have version 13.3 or later.
The organization is federated, with users registered on Microsoft Entra ID.
The client machine is configured and connected to the Microsoft Entra ID tenant.

You must set up MUP beyond the actual federation setup with Lexmark Cloud Services and 
make sure that the Azure tenant has a valid MUP subscription.

The user setting up the virtual printer from the Cloud Print Management portal must 
have the Printer Administrator role in Azure.
Setting up Cloud Print Management and MUP integration involves more activities 
beyond the virtual printer setup. You must fetch the Azure tenant details so that they 
can be mapped to a Lexmark Cloud Services organization ID. To copy an organization 

ID on the Organization Information page, click  beside the organization ID.
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For more information on the permission required for the user, go to https:// 
learn.microsoft.com/.
The Lexmark Universal Print application must have the following administrator 
permissions granted:

User.Read,Organization.Read.All
PrintJob.ReadBasic / PrintJob.Read / PrintJob.ReadBasic.All

Notes
After Universal Print is enabled, and if Azure administrator rights are available, a 
shared printer is created in the MUP tenant of Microsoft Entra ID. With Microsoft 
Entra ID administrator rights available, save the changes and select an 
administrative account.
The printer name and printer share name are automatically created in the MUP 
tenant of Microsoft Entra ID. The printer registration process takes a few minutes to 
complete.
In Analytics, the submission type is reported as Microsoft Universal Print.

Click Save Changes.

Sharing the registered printer to allow access to users

From the Universal Print Microsoft Entra ID portal, select the registered printer.
Click Access control.
Enable Allow access to everyone in my organization.
Click Share Printer.

Defining quotas

You can create quota definitions, and then assign them to specific departments, cost centers, or users.

This feature is available only when quota assignment is enabled in the organizational policies. For more 
information, see Configuring organizational settings.

From the Print Management web portal, click Administration > Quota Definitions.
Do any of the following:

Set a fixed quota

Click Create, and then type a unique quota definition name.
In the Specify quota limits menu, select Same limits for each month.
Specify the total quota for each month.

Allow unlimited printing
Set custom quota—Specify a printing limit.
Disable all printing

https://learn.microsoft.com/en-us/graph/api/organization-get?view=graph-rest-1.0&tabs=http#permissions
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Notes
You can also allow, disallow, or set a color printing limit.
The color printing limit is part of the total quota limit. If this limit is reached, then 
users can no longer print in color but can still use the remaining total quota for black 
and white printing.

Click Create Quota Definition.

Set a custom quota for each month

Click Create, and then type a unique quota name.
In the Specify quota limits menu, select Custom limits for each month.
Select one or more months.
Click Set Quota Limits, and then specify the quota.

Allow unlimited printing
Set custom quota—Specify a printing limit.
Disable all printing

Notes
You can also allow, disallow, or set a color printing limit.
The color printing limit is part of the total quota limit. If this limit is reached, then 
users can no longer print in color but can still use the remaining total quota for black 
and white printing.

Click Set Quota Limits.
Click Create Quota Definition.

Setting the default quota for the organization

The default quota applies to all users in the organization, unless a custom quota is assigned to the department, 
cost center, or individual user. The custom quota overrides the default quota.

Click  beside Default Quota.
Set a fixed quota or a custom quota for each month.

Assigning quotas

This feature is available only when quota assignment is enabled in the organizational policies.  For more 
information, see Configuring organizational settings.

Note: The available tabs may vary depending on the organizational settings. If the setting is only allowing 
quota assignments by Personal only, then no other tabs are available. 

Assigning a cost center quota

Note: The Cost Center tab is available only when the policy is set to assign quotas by Cost center or personal.
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From the Print Management web portal, click Administration › Quota Assignments .
From the Cost Center tab, click Assign Quota.
Type the cost center name.

Note: The cost center name must match a cost center found in Account Management for 
the organization.

Select a quota definition.
Click Assign Quota.

Assign a department quota

Note: The Department tab is available only when the policy is set to assign quotas by Department or personal.

From the Print Management web portal, click Administration › Quota Assignments.
From the Department tab, click Assign Quota.
Type the department name.

Note: The cost center name must match a cost center found in Account Management for 
the organization.

Select a quota definition.
Click Assign Quota.

Assign a user quota

From the Print Management web portal, click Administration › Quota Assignments.
From the Personal tab, click Assign Quota.
Type the user email address.
Select a quota definition.
Click Assign Quota.

Viewing user quota status

The User Quota Status feature shows you where the users are within their quota in a given month. Administrators 
can monitor and identify users who may be exceeding their quota.

Note: This feature is available only for Print Release Management administrators.

The user quota status table contains the following information:

User—The e‑mail address of the user.
Status—The status of a user’s quota.

OK (green circle check mark)—The user’s quota is between 11% and 100% for both 
their total quota and color quota.
Warning (yellow warning triangle)—The user’s quota is 10% or below for either their 
total quota or color quota.
Exceeded (red circle exclamation)—The user’s quota is 0 or below for either their 
total quota or color quota.
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Total Quota Remaining—The total print quota remaining for the user for both mono and 
color print jobs.
Color Limit Remaining—The amount of color printing left for the user.
Quota Definition—The quota definition that is assigned to a user.
Type—The category assigned to a user's quota. It can be Personal, Cost center, or Default.

From the Print Management web portal, click Administration > User Quota Status.
Do any of the following:

Filter the user quota status table by Quota Status, Quota Definition, and Assignment 
Type.

Export the user quota status table into a CSV file by clicking  on the 
upper‑right corner of the table.

Creating and assigning print policies

Policies are rules that you can assign and enforce to users and groups on Cloud Print Management. These rules 
are enforced for the specified users or groups on Cloud Print Management.

Note: Make sure to enable the print policy settings. For more information, see Configuring organizational 
settings on page 170.

From the Print Management portal, click Administration > Print Policies.

Note: You can modify the Default Print Policy by clicking . For more information, see 
Creating and assigning print policies on page 0.

Do any of the following:

Create a print policy

Click Create.

Note: If there is no existing print policy, then click Create Print Policy.

In the Policy name field, type the name of the policy.
Configure the settings:

Print Policy settings

Force color jobs to mono—Print mono jobs only.

Select Only jobs with at least a specific number of pages to set 
the minimum number pages to apply this policy.

Force jobs to use two-sided printing—Print on both sides.

file:////opt/aem/launcher/profiles/ditamaps/ditamap3254686153538509447/topics/creating-and-assigning-print-policies-v58736534.htm


Print Management

178

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

4.
◦

1.
2.
3.
4.

◦

1.
2.
3.

Two-sided printing—Select either Long edge binding or Short 
edge binding.
All print jobs—Set the minimum number of pages to apply this 
policy. Select Only mono jobs with at least a specific number of 
pages and Only color jobs with at least a specific number of 
pages.
Mono print jobs—Select Only mono jobs with at least a specific 
number of pages to set the minimum number of pages to apply this 
policy.
Color print jobs—Select Only color jobs with at least a specific 
number of pages to set the minimum number of pages to apply this 
policy.

Limit printing to specific days and times—Print only during specific 
days and times.

Select days—Select a day or days on which to allow printing.

All days—Allow printing on all days but only within a specific 
time. Set the values for Start time and End time.
Monday-Friday—Allow printing only on Mondays through 
Fridays within a specific time. Set the values for Start time 
and End time.
Custom—Allow printing on specific days. Set the values for 
Start time and End time for each of the specific days that you 
select.

Notes
If the value for the End time field is beyond 11:59 PM, the 
schedule will end the next day.
The Start time and End time refers to the user's local time 
on the printer.

Click Create Policy.
Duplicate a print policy

Select an existing policy,
Click Duplicate.
Type a unique name for the policy.
Click Create Policy.

Delete a print policy

Select an existing policy.
Click Delete.
Click Delete Print Policy.
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Notes

A print policy on page count does not apply to number of copies. For example, a policy 
may limit a user to three pages for a single print job. But the user can still print two copies 
of a two-page print job.
Cloud Print Management renders the job before the printer does, so cloud services cannot 
interpolate if the job is color or one‑sided. Hence, Lexmark Cloud Services renders any 
job uploaded to the portal as color and one‑sided and applies policies related to color and 
one‑sided printing.

Assigning a print policy

From the Print Management portal, click Administration > Print Policy Assignments.
Select Cost Center, Personal, or Department.

Note: The available tabs vary depending on the organizational settings. For more 
information, see Configuring organizational settings.

Assigning to a cost center or department

Select an existing cost center or department.

Note: You can also select a cost center or department by typing its name in the 
Cost center name field or Department name field in the Assign Policy window.

Click Assign Policy.
From the Select print policy menu, select the policy.
Click Assign Print Policy.

Assigning to a user

Select an existing user.

Note: You can also select a user by typing the email address of the user in the 
E‑mail field in the Assign Print Policy to User window.

Click Assign Policy.
From the Select print policy menu, select the policy.
Click Assign Print Policy.

Notes

To remove a print policy, select a print policy, and then click Remove Policy > Remove 
Print Policy.
To view or filter the cost center or department to which a print policy is assigned, from the 
Print Policy Assigned menu, select the policy.
User‑based policies override cost center‑ or department‑based policies.
To view the details of a print policy, click the item in the Select print policy.
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Obtaining the client ID and client secret

The Identity application containing the client ID and client secret of an organization is found in the Account 
Management page in the Cloud Services portal. A user account with the Organization Administrator role is 
required.

Note: The client ID and client secret are sensitive information. Do not share this information without 
appropriate consent.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Account Management card.

Note: If the card is not visible on the dashboard, then click  on the upper‑right corner of 
the page, and then click Account Management.

Select the organization, and then click Next.
Click the Applications tab.
In the Search applications field, type either Device Authentication, or Card Auth App, or CPM 
Advanced Hybrid Storage, and then press Enter.
From the Application Name list, click the application name.
Obtain the client ID and client secret from the OAuth Settings section.

Note: From the application page, in the Permission section, make sure that badges‑auth is listed under 
Scopes.

Managing print queues
The print queue shows the print jobs submitted to Cloud Print Management using the following submission 
methods:

Cloud Print Management—The print jobs are submitted to the Lexmark Cloud print queue.

Users can send print jobs using the following sources:

Web—The file is uploaded directly to the Print Management web portal.
LPMC—The print job is sent from the user's workstation using the Lexmark Print 
Management Client configured for Cloud Print Management.
Chrome Print Extension—The print job is submitted from the Google Chrome web 
browser.
Mobile—The print job is submitted from the Lexmark Print application.
E-mail—The print job is e-mailed to <organization‑specific user 
name>@print.lexmark.com.

Hybrid Print Management—The print jobs are held locally on the user’s workstation rather 
than being submitted to the Lexmark Cloud print queue. The print queue shows the print jobs 
being held for release on the workstation. The workstation uses the Lexmark Print 
Management Client that is installed in Hybrid mode to communicate with Cloud Print 
Management.

Note: From the print queue, you can also change the layout, paper, and finishing options. However, depending 
on the submission method, print driver settings, and document processor settings, some options may not be 
available.

From the Print Management web portal, click Print Queue.
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Click the Print Queue header.
Search for or select a user.
Do any of the following:

Upload files

Click Upload File.
Drag one or more files, or click Choose Files, and then browse to them.
Click Done.

Delete print jobs

Select one or more jobs.
Click Delete > Delete Print Jobs.

Set print settings for a specific print job

Click a print job.
If necessary, from the General section, type a description for the print job.
Do any of the following:

Note: Depending on the submission method, print driver settings, and document 
processor settings, some layout, paper, and finishing options may not be available.

Adjust the layout

Copies—The number of copies to be printed.
Collate—Keep the pages of a print job stacked in sequence, particularly when printing 
multiple copies of the job.
Two-sided printing—When you print on both sides of the paper, the paper flips either 
on the short‑edge or on the long‑edge side. To use the printer default setting, select 
Use printer setting.
Pages per side—Multiple pages of the document are printed on one side of the paper.
Orientation - Pages per side—The orientation of the pages when printing multiple 
pages per side (N-up).

Adjust the paper and finishing options

Paper size—The size of the paper.
Paper source—The tray that is the source of paper.
Paper type—The type of paper.
Output bin—The collection point for paper that has exited from the printer.
Staple—The stapling position in the paper.
Hole punch—The number of holes to be punched.
Fold—The way the paper is folded.
Change the quality—Select a color mode.

Click Save Changes.
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Set default print settings for all incoming print jobs

Click Set Default Print Settings.
Do any of the following:

Note: Depending on the submission method, print driver settings, and document 
processor settings, some layout, paper, and finishing options may not be available.

Adjust the layout

Copies—The number of copies to be printed.
Collate—Keep the pages of a print job stacked in sequence, particularly when printing 
multiple copies of the job.
Two-sided printing—When you print on both sides of the paper, the paper flips either 
on the short‑edge or on the long‑edge side. To use the printer default setting, select 
Use printer setting.
Pages per side—Multiple pages of the document are printed on one side of the paper.
Orientation - Pages per side—The orientation of the pages when printing multiple 
pages per side (N-up).

Adjust the paper and finishing options

Paper size—The size of the paper.
Paper source—The tray that is the source of paper.
Paper type—The type of paper.
Output bin—The collection point for paper that has exited from the printer.
Staple—The stapling position in the paper.
Hole punch—The number of holes to be punched.
Fold—The way the paper is folded.
Change the quality—Select a color mode.

Click Save Changes.

Uploading files to the Print Management web 
portal

From the Print Management web portal, click Print Queue.
Click Upload File, and then drag one or more files or browse to them.
Click Done.

Managing delegates
A delegate is a user who is allowed to print jobs by another user. For example, an administrative assistant can 
print jobs submitted by an executive.

This feature is available only when print job delegation is enabled in the organizational policies. For more 
information, see Configuring organizational settings.
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Notes

Delegates can view all print jobs submitted by another user, but can print only Cloud Print 
Management print jobs.
Delegates cannot print Hybrid Print Management print jobs.
Even if delegates are set up in Lexmark Cloud Services, devices that support Cloud Print 
Release cannot release delegated jobs. Delegated jobs can only be released on devices 
with the Cloud Print Management applications installed.

From the Print Management web portal, click Delegates.
Click the Delegates header.
Do either of the following:

Add delegates

Click Add.
Select a user.
From the Enable delegate expiration section, select either of the following:

Never expires—Do not set an expiry date for delegates.
Expires after—Set the number of days after which the delegates expire.

Click Add Delegate.

Remove delegates

Select one or more delegates.
Click Remove.

Note: To notify delegates about their addition, removal, and expiration, select Enable delegate e‑mail 
notification on the Organizational Settings page. For more information on enabling delegate e‑mail 
notification, see Configuring organizational settings.

Viewing the print job history
From the Print Management web portal, click Print Job History.
The print job history contains the following information:

Impressions—A side of a sheet of paper that contains toner.
Released From—Shows the printer IP address where the print job is released.
Job Name
Job Source
Color Mode—Shows whether the print job is monochrome or color.
Two‑Sided Printing—Shows whether the print job is printed on both sides of the paper.
Released—Shows when the print job is released.
Released By—Shows the delegate who released your print job. This column appears only 
when a delegate has released one of your print jobs.
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Downloading the Lexmark Print Management 
Client

Note: For more information on LPMC legacy versions, see Lexmark Print Management Client 3.4.0 or earlier 
Configuration Guide PDF or Lexmark Print Management Client 3.5.0 or later Configuration Guide PDF.

The Lexmark Print Management Client is a software package deployed to computers to provide secure release of 
print jobs.

You can download the Lexmark Print Management Client package configured for either of the following 
environments:

Before you begin, make sure that you always update your operating system to maintain optimal security and 
performance of your LPMC. Regular updates protect your system from the latest vulnerabilities and provide 
secured connections through encrypted data transfers.

Cloud Print Management—Print jobs are stored on the Lexmark Cloud print queue until 
they are released from a printer installed with the Print Release application.
Hybrid Print Management—Print jobs are stored on the user’s workstation or advanced 
hybrid storage until they are released from a printer installed with the Print Release 
application.
Direct Print—Print jobs are never held for release, but are sent and printed immediately to a 
configured printer.

From the Print Management web portal, click Print Clients.
From the Select client menu, select an operating system.
For ChromeOS™, iOS, and Android™ operating systems, select the link that appears, and 
then click Leave Site.
For Windows, macOS, and Ubuntu operating systems, do any of the following:

For the Cloud Print Management package type:
From the Select package type menu, select Cloud Print Management.
Click Download Client.

For the Hybrid Print Management package type:
From the Select package type menu, select Hybrid Print Management.
Click Download Client.

For the Direct Print Management package type:
From the Select package type menu, select Direct Print.
Click Download Client.

For the custom package type:
From the Select package type menu, select Custom Package.
Click Create Package.
From the Global Configuration Settings section, specify whether to show the 
print submission status notification.
If you have a Lexmark Cloud Print Management environment, then do the 
following:

From the Cloud Print Management section, select Enable Cloud Print 
Management.
From the Print queue name section, select Use default name [Cloud 
Print Management] or Set custom name.

If you have a Lexmark Hybrid Print Management environment, then do the 
following:

From the Hybrid Print Management section, select Enable Hybrid Print 
Management.

https://support.lexmark.com/content/dam/support/collateral/lexmark_solutions/cloud/print_management_client/pdf/Lexmark_PrintManagementClient_ConfigGuide_en.pdf
https://support.lexmark.com/content/dam/support/collateral/lexmark_solutions/cloud/print_management_client/v3-5-0/pdf/Lexmark_PrintManagementClient_ConfigGuide_en.pdf
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From the Print queue name section, select Use default name [Hybrid 
Print Management] or Set custom name.

Notes
For custom print queue names, type the name of the print queue in the 
Set custom name field. The print queue name must be at least three 
characters and must not include special characters.
By using the Set custom name option, you can name the print queue for 
users.

If you have a Lexmark Direct Print environment, then do the following:
From the Direct Print Management section, select Enable Direct Print.
Select Use default name [Direct Print Management] or Set custom 
name.

From the Print Driver Type section, select a print driver to include in the 
package.
From the Set Default Printer section, select which environment to use by 
default.
Click Create.
Download the package.

Installing the Lexmark Print Management Client
For Microsoft Windows operating system

From your computer, run the package.
Follow the instructions on the screen.

Notes
The executable files are saved in the Program Files folder.
For custom packages, the configuration file is included in the downloaded 
compressed file. Make sure that the installer and the configuration file are in the 
same folder.
The 3.6.0 release supports the previous configuration.xml files and converts them 
for you to the new JSON format on installation.
The configuration and the log files are saved in the %allusersprofile%\LPMC folder 
after installation.
To be able to use the LPMC version 3.6.x, make sure that you have installed 
Microsoft .NET Framework version 4.8 or later.

After the installation, you can access Lexmark Cloud Print Management, Lexmark Hybrid Print Management, or 
Lexmark Direct Print.

For macOS operating system software

From your computer, run the package.
Follow the instructions on the screen.
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Notes
When installing a Custom Package, if the installer requests access to a folder, 
select yes, so that the installer can access the configuration file.
The executable files are saved in the /Library/Lexmark/PrintManagementClient 
folder.
The configuration file, and the SSL certificates are saved in the /var/Lexmark/ 
PrintManagementClient folder.
The SSL certificates are saved in /var/Lexmark/PrintManagementClient/ 
TrustCerts.
The log file is saved in /var/Lexmark/PrintManagementClient/Logs as lpmc.log.
For the custom package, the configuration file is included in the downloaded 
compressed file. Make sure that the installer and the configuration file are in the 
same folder.
The 3.6.0 release supports the previous configuration.xml files and converts them 
for you to the new json format on installation.

Uninstalling LPMC for macOS operating system software

Open the terminal from /Library/Lexmark/PrintManagementClient folder.
Execute the sudo./uninstall.sh file.

For Ubuntu operating system

Note: For Ubuntu 20.04 or later, to make the LPMC SysTray icon visible, install AppIndicator and enable it in 
GNOME.

Download the package.
Unzip and run the .SH file.

Notes
Installation is not permitted without Sidecar.
The executable files are saved in the /usr/share/Lexmark/PrintManagementClient 
folder.
The configuration file is saved in the /etc/Lexmark/PrintManagementClient folder.
The SSL certificates are saved in /var/Lexmark/PrintManagementClient/ 
TrustCerts.
The log file is saved in /var/Lexmark/PrintManagementClient/Logs/lpmc.log.

Uninstalling LPMC for Ubuntu operating system

Open the terminal from /usr/share/Lexmark/PrintManagementClient folder.
Execute the uninstaller.sh with sudo or run the following:

sudo dpkg -r lexmark-print-management-client
sudo dpkg --purge lexmark-print-management-client
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Note: We recommend not running antivirus scans on the Lexmark/ 
PrintManagementClient and %allusersprofile%\LPMC folders and any of its subfolders. 
Antivirus scans may result in locking essential files, blocking access to 
configuration files, and preventing print job file creation.

Applying the driver configuration

For Windows operating system, the LPMC installer supports the use of LDC files from the Printer Driver 
Configuration Utility. During installation, the system looks for specific file names for the LDC files.

Notes

To apply a driver configuration when the LPMC is installed, save the LDC file in the same 
folder as the LPMC installer.
For Ubuntu and macOS, the LPMC installer does not support the use of LDC files.

Use the PrintQueueConfiguration.ldc file name for Cloud Print Management print queue, Hybrid Print 
Management print queue and for Direct Print Management print queue.

Sample LDC file

<?xml version="1.0" encoding="UTF-8"?> 

<ConfigurationProfiles> 

 <PrinterProfiles version="1.2"> 

 <PrinterProfile name="Lexmark Universal v2" version="1.0"> 

   <PrinterObject value="Cloud Print Management - PCLXL"></ 

PrinterObject> 

   <PrinterModel value="Lexmark Universal v2"></PrinterModel> 

   <DataStream value=""></DataStream> 

   <LongDescription value=""></LongDescription> 

   <ProfileData> 

    <PrinterProperties locksupport="global"> 

     <InstallableOptions> 

      <Trays> 

       <Tray2 value="Installed" locked="unlocked"></Tray2> 

       <Tray3 value="Installed" locked="unlocked"></Tray3> 

       <Tray4 value="Installed" locked="unlocked"></Tray4> 

       <Tray5 value="Installed" locked="unlocked"></Tray5> 

       <MPFeeder value="Installed" locked="unlocked"></MPFeeder> 

       <ManualEnvelope value="Installed" locked="unlocked"></ 

ManualEnvelope> 

       <ManualFeeder value="Installed" locked="unlocked"></ 

ManualFeeder> 

       <EnvelopeFeeder value="Installed" locked="unlocked"></ 

EnvelopeFeeder> 

       <RFIDTray value="Installed" locked="unlocked"></RFIDTray> 

      </Trays> 

      <DuplexUnit value="Installed" locked="unlocked"></DuplexUnit> 

      <Flash value="Installed" locked="unlocked"></Flash> 

      <HardDisk value="Installed" locked="unlocked"></HardDisk> 

      <Bins> 

       <Bin1 value="Installed" locked="unlocked"></Bin1> 

       <Bin2 value="Installed" locked="unlocked"></Bin2> 
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       <Bin3 value="Installed" locked="unlocked"></Bin3> 

       <Bin4 value="Installed" locked="unlocked"></Bin4> 

       <Bin5 value="Installed" locked="unlocked"></Bin5> 

       <Bin6 value="Installed" locked="unlocked"></Bin6> 

       <Bin7 value="Installed" locked="unlocked"></Bin7> 

       <Bin8 value="Installed" locked="unlocked"></Bin8> 

       <Bin9 value="Installed" locked="unlocked"></Bin9> 

       <Bin10 value="Installed" locked="unlocked"></Bin10> 

       <Bin11 value="Installed" locked="unlocked"></Bin11> 

       <Bin12 value="Installed" locked="unlocked"></Bin12> 

      </Bins> 

      <FinishingOptions> 

       <Offset value="Installed" locked="unlocked"></Offset> 

       <Staple value="Installed" locked="unlocked"></Staple> 

       <HolePunch value="Installed" locked="unlocked"></HolePunch> 

       <Fold value="Installed" locked="unlocked"></Fold> 

      </FinishingOptions> 

      <Fax value="Installed" locked="unlocked"></Fax> 

      <FaxOnly value="Installed" locked="unlocked"></FaxOnly> 

     </InstallableOptions> 

    </PrinterProperties> 

    <PrinterDefaults locksupport="all"> 

     <PostScript> 

      <PSPassthrough value="On" locked="unlocked"></PSPassthrough> 

     </PostScript> 

     <ImageCompression> 

      <JobImageCompression value="True" locked="unlocked"></ 

JobImageCompression> 

      <JobImageCompressionMethods value="JPEG" locked="unlocked"></ 

JobImageCompressionMethods> 

      <JobImageCompressionQualityValue value="90" 

locked="unlocked"></JobImageCompressionQualityValue> 

     </ImageCompression> 

    </PrinterDefaults> 

    <PrintingPreferences locksupport="none"> 

     <PostScript> 

      <PSPassthrough value="On"></PSPassthrough> 

     </PostScript> 

     <ImageCompression> 

      <JobImageCompression value="True"></JobImageCompression> 

      <JobImageCompressionMethods value="JPEG"></ 

JobImageCompressionMethods> 

      <JobImageCompressionQualityValue value="90"></ 

JobImageCompressionQualityValue> 

     </ImageCompression> 

    </PrintingPreferences> 

   </ProfileData> 

 </PrinterProfile> 

 </PrinterProfiles> 

</ConfigurationProfiles>

The LDC configuration must use the following value for the print queue:

<PrinterObject value="Print queue name"></PrinterObject>

"Print queue name" varies between Cloud Print, Hybrid Print, and Direct Print. You can also set a custom print 
queue name.
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You can also use the following generic values for the printer profile and printer model:

<PrinterProfile name="Lexmark Universal v2" version="1.0"> 

<PrinterModel value="Lexmark Universal v2"></PrinterModel>

Upgrading the LPMC version

User can select one of the following settings when upgrading to the latest version of LPMC:

Keep User Setting—To maintain your current settings, do the following:
Run the LPMC package installer with your existing configuration.json or 
configuration.xml file.
Place a copy of the configuration.json or configuration.xml file in the directory of 
the new LPMC package installer.

New User Setting—To modify the existing settings, do the following:
Download and edit the configuration.json or configuration.xml file.
Place the edited files in the same directory as the existing LPMC package installer.

Default Setting—If no configuration.json or configuration.xml file is attached to the 
LPMC installer package, then the default configuration settings provided by the downloaded 
LPMC installer package apply.

Notes

If the legacy version of LPMC is installed on your workstation, then you can upgrade to the 
latest version of LPMC (version 3.6.x).
Unreleased hybrid jobs are not retained. It is highly recommended not to have any 
pending jobs before the upgrade.
Enabling automatic updates is supported only in the latest version of LPMC.

Managing the Lexmark Print Management Client

Checking for updates for the Lexmark Print 
Management Client

From your computer, in the system tray or the menu bar, click the Lexmark Print 
Management Client icon.
Click Check for Updates.

Note: The LPMC service checks for updates every 4 hours after service restart.

Identifying the version of Lexmark Print Management 
Client

From your computer, in the system tray or the menu bar, click the Lexmark Print 
Management Client icon.
Click About Print Management Client.
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Identifying the version of Lexmark Print Management 
Client from the Client Status page

From the Print Management web portal, click Print Clients › Client Status.
Locate the LPMC version in the Client Version column.

Logging out from the Lexmark Print Management Client

Logging out from Lexmark Print Management Client deletes all Hybrid print jobs stored on your computer, making 
them no longer available for release. However, the print jobs that are already sent to the Lexmark Cloud print 
queue remain available.

Note: The following steps apply to Microsoft Windows, macOS, and Ubuntu operating systems.

From your computer, in the system tray or menu bar, right‑click the Lexmark Print 
Management Client icon.
Click Log out from Print Management.
Click Log out.

Note: After you log out, your authentication credentials are deleted. When you print again, you are prompted 
for your user credentials.

Managing client policies

Creating client policies

Client policies are rules that govern how LPMC behaves that you can assign and enforce to users based on 
organization, department or cost center and personal. These rules are enforced for the specified users or groups 
on Cloud Print Management.

Note: Make sure to enable the client policy settings. For more information, see Configuring organizational 
settings on page 170.

From the Print Management portal, click Print Clients › Client Policies .
Click the Definitions tab.
Click Create.

Note: If there is no existing client policy, then click Create Client Policy Definition.

On the Create Client Policy page, do the following:

In the Policy name field, type the name of the policy.
In the Description field, type a brief description of the policy.
From the Configure print client version update mode menu, select one of the 
following:

Set to the current version
Enable automatic updates of print client
Restrict print client from updating
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From the Print client update should occur menu, select one of the following:

Note: If you select Restrict print client from updating from the Configure print 
client version update mode menu, then this setting is unavailable.

As soon as possible
Within specific time period

Note: On selecting Within specific time period, make sure that you specify 
the Time period. The time period ranges from 1-7 days.

Click Create Policy.

Deleting a client policy

From the Print Management portal, click Print Clients › Client Policies.
Click the Definitions tab.
Select an existing policy.
Click Delete › Delete Policy.

Setting a default client policy

From the Print Management portal, click Print Clients › Client Policies .
Click the Definitions tab.
Select an existing policy.
Click Set as Default › Set as Default.

Removing a default client policy

From the Print Management portal, click Print Clients › Client Policies.
Click the Definitions tab.
Select the existing default client policy.
Click Remove Default › Remove Default .

Editing a client policy

From the Print Management portal, click Print Clients › Client Policies.
Click the Definitions tab.
Click the name of an existing client policy.
On the client policy page, edit the policy.
Click Save Changes.

Assigning client policies

From the Print Management portal, click Print Clients › Client Policies.
Click the Assignments tab.
Click Assign Policy.
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On the Create Assignment window, do the following:
From the Assign client policies by menu, select one of the following:
Cost center—Type the name of the cost center in the Cost center name field.

Note: If you select Cost center, then you can use only cost center and personal for 
the next assignments.

Department—Type the name of the department in the Department name field.

Note: If you select Department, then you can use only department and 
personal for the next assignments.

Personal—If you select Personal, then type the user's email address in the E- 
mail field.

Notes
If you select Personal, then you can continue using one of the 
categories until you select department and cost center.
While assigning a personal policy, you can add a user who is part of a 
cost center or department. If the same cost center or department is 
already assigned with a client policy, then the personal assignment 
overrides the cost center or department client policy.

From the Select client policy menu, select any of the available client policies.
Click Create Assignment.

Unassigning a policy

From the Print Management portal, click Print Clients › Client Policies.
Click the Assignments tab.
Select an existing assignment.
Click Unassign Policy › Unassign Client Policy

Using the policy assigned filter

From the Print Management portal, click Print Clients › Client Policies.
Click the Assignments tab.
From the Client Policy Assigned menu, select the client policy.

Using the views filter

From the Print Management portal, click Print Clients › Client Policies.
Click the Assignments tab.
From the Views menu, select any one of the following:

Assign policies by personal
Assign policies by cost center
Assign policies by department
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Assigning policy from the client status page

From the Print Management portal, click Print Clients › Client Status.
On the Client Status page, select a client.
Click Assign Policy.
From the Select a client policy to assign to selected clients menu, select an existing 
client policy.
Click Assign Policy.

Note: Assigning a client policy from the Client Status page overrides any existing policy for that particular 
client. The order of precedence for client policy are: Client assignment › Personal client policy › Cost 
center or department client policy › Default client policy.

Sending print jobs to Lexmark Cloud Services

Sending print jobs from your computer

Open a file or image.
Select the print option, and then select the Lexmark Cloud Services print release queue.
Click Print.
If prompted, type your e‑mail address and password.

Note: If you cannot authenticate within three minutes, then the session expires and the 
submitted job gets deleted.

Sending print jobs using e-mail

This feature is available only when e‑mail submission is enabled in the organizational policies. For more 
information, see Configuring organizational settings.

From your e-mail client, send the e-mail or attachment to the following:

For users of the North American data center, <organization‑specific user 
name>@print.lexmark.com.
For users of the European data center, <organization‑specific user 
name>@print.lexmark.com.

Sending print jobs from web portals

From the Print Management web portal, click Print Queue.
Click Upload File, and then drag one or more files or browse to them.
Click Done.
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Downloading the Lexmark Cloud Print Management for 
Chrome extension

Add the Lexmark Cloud Print Management for Chrome extension so that you can send print jobs to Cloud Print 
Management using the Chrome OS operating system.

From the Print Management web portal, click Print Clients.
From the Select client menu, select Chrome.
Click the Available in the Chrome Web Store link that appears.
Click Leave Site.
Using the Chrome OS browser, from the Chrome Web Store, add the Lexmark Cloud Print 
Management for Chrome extension.

Sending print jobs from the Chrome OS operating 
system

Note: For Chromebook™ computers and other computers running on the Chrome OS operating system, add 
the Lexmark Cloud Print Management for Chrome extension to your web browser. For more information, 
see Downloading the Lexmark Cloud Print Management for Chrome extension on page 194.

From the Google Chrome™ browser, open a file, image, or web page.
Select a print option, and then select Lexmark Cloud Print Management for Chrome.
If necessary, change the print settings. To change other settings, click More settings > 
Advanced settings, and configure the following:

Two‑sided printing—When you print on both sides of the paper, the paper flips either 
on the short‑edge or on the long‑edge side. To use the printer default setting, select 
Use printer setting.
Pages per side—Multiple pages of the document are printed on one side of the paper.
Pages per side orientation—The orientation of the pages when printing multiple 
pages per side.
Staple Location—The stapling position on the page.
Fold—The way the paper is folded.
Hole punch—The number of holes to be punched.
Paper source/tray—The paper source or the tray to be used for the print job.

Note: Depending on the printer model, these settings may vary.

Click Apply.
Click Print.

Note: In the LPMC Chrome extension, the document file cannot be previewed, and is unable to print using 

. This limitation is in Microsoft 365.
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Mobile printing

Adding a Lexmark Cloud Print Management server 
using a mobile device for version 3.x

This feature lets you send print jobs to the Lexmark Cloud Print Management using the Lexmark Print application 
version 3.x. For more information on sending print jobs using the Lexmark Print application, see Sending print 
jobs using a mobile device on page 195.

From your mobile device, launch the Lexmark Print application.
From the application home screen, tap Add a Device.
Tap Lexmark Cloud Print Management.
From the Data Center menu, select any one of the following:

Auto Detect—Set your data center automatically as determined by your location.
Americas—Use the North American data center as determined by your Lexmark 
Cloud Services agreement.
Europe—Use the European data center as determined by your Lexmark Cloud 
Services agreement.

Sending print jobs using a mobile device

For more information on the Lexmark Print application, see the Lexmark Print User’s Guide for your mobile 
device.
For devices using the Android platform

Launch the Lexmark Print application.
From the Print From section of the application home screen, tap a source, and then follow 
the instructions on the screen.

Note: If prompted, allow the application to access the camera and the storage.

Select the Lexmark Cloud Services queue.

Note: If prompted, log in to the server.

If necessary, change the print settings.

Tap .

For devices using the Apple iOS operating system

Launch the Lexmark Print application.
From the PRINT FROM section of the application home screen, tap a source, and then 
follow the instructions on the screen.

Note: If prompted, allow the application to access the camera and the photos.
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Select the Lexmark Cloud Services queue.

Note: If prompted, log in to the server.

If necessary, change the print settings.
Tap Print.

Sharing documents to the print queue server using your 
mobile device

For more information on the Lexmark Print application, see the Lexmark Print User’s Guide for your mobile 
device.
For devices using the Android platform

From your mobile device, select a document from the file manager.

Notes
Make sure that the mobile device supports the document file type.
Make sure that the printer supports the file type. For the list of supported file types, 
see the printer User’s Guide.

Share the document to Lexmark Print.
Select the Lexmark Cloud Services queue, and if necessary, change the print settings.

Tap .

For devices using the Apple iOS operating system

From your mobile device, select a document from the file manager.

Notes
Make sure that the mobile device supports the document file type.
Make sure that the printer supports the file type. For the list of supported file types, 
see the printer User’s Guide.

Tap  > Lexmark Print.
Select the Lexmark Cloud Services queue, and if necessary, change the print settings.
Tap Print.

Printing documents from your mobile device

For more information on the Lexmark Print application, see the Lexmark Print User’s Guide for your mobile 
device.
For devices using the Android platform

Launch the Lexmark Print application.
From the Print Release section, select the server.
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Note: If you are prompted to log in to the server, then type your credentials, and then tap 
LOGIN.

Select the user with jobs to print.
Select one or more jobs.

Note: To select all jobs, tap .

Tap .
Select the Lexmark Cloud Services queue, and if necessary, change the print settings.

Tap .

Notes

You can add a printer to the list.
To delete the selected jobs after printing, select Delete this Document after Printing.

For devices using the Apple iOS operating system

Launch the Lexmark Print application.
From the Print Release section, select the server.

Note: If you are prompted to log in to the server, then type your credentials, and then tap 
OK.

Select the user with jobs to print.
Select one or more jobs.

Tap .
Select the Lexmark Cloud Services queue, and if necessary, change the print settings.
Tap Print.

Notes

You can add a printer to the list.

To select all jobs, tap .
To delete the selected jobs after printing, select Delete from queue after printing.

Choosing an application for releasing print jobs
Automatic Print Release—Lets you release print jobs automatically after logging in to the 
printer. To use this feature, make sure that you enable Automatic Print Release from the 
Organizational Settings. For more information on enabling Automatic Print Release, see 
Configuring organizational settings.
Cloud Print Release—Lets you release print jobs from 2.8-inch touch-screen printers. For 
more information on configuring Cloud Print Release, see Configuring Cloud Print Release 
on page 201.
Print Release eSF application—Lets you release print jobs from 4.3-inch or bigger touch- 
screen printers.
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Guest Print—Lets guest users print documents without requiring the administrator to create 
an account in the organization. For more information on Guest Print, see Configuring the 
Guest Print feature on page 199.

Releasing print jobs using the eSF application on 
the printer

Use the Print Release eSF application to release print jobs from the printer. For more information, see the Print 
Release Administrator's Guide.

Note: Depending on your configuration, you may need to register at first use. Follow the instructions on the 
printer display.

From the printer home screen, touch the icon for the Print Release application.
Select one or more print jobs.

Note: To print the jobs that are delegated to you, touch . If necessary, select a user 
name, and then select the print jobs.

If necessary, change the print settings. Select a job, touch  beside the Print button, touch 
Change Print Settings, and then do any of the following:

Note: Depending on the submission method, print driver settings, and document 
processor settings, some layout, paper, and finishing options may not be available.

Touch Settings, and then adjust one or more of the following:

Number of copies
Color

Note: You cannot change black-and-white print jobs to color at the printer for 
some file formats.

Sides—Specify whether the print jobs are printed on one side only or on both 
sides of the paper.

Touch Finishing Options, and then adjust either of the following:

Staple—Specify whether to staple the printed jobs.
Hole punch—Specify whether to punch holes on the printed jobs.

Touch Print.

Note: For 4.3‑inch or bigger touch‑screen printers, use Print Release eSF applications to release print jobs. 
For 2.8‑inch touch‑screen printers, use the Cloud Print Release application to release print jobs. For more 
information on Cloud Print Release, see Configuring Cloud Print Release on page 201.
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Printing jobs using automatic print release
Automatic print release is an organizational setting that lets users release their print jobs automatically after 
logging in. This setting prevents users from interacting directly with the printer when releasing print jobs. If 
enabled, then all print jobs in the user’s queue are released. After authenticating, a message appears that lets 
you cancel the automatic print release function. To release one or more print jobs selectively, see Releasing print 
jobs using the eSF application on the printer on page 198.

Notes

Make sure that automatic print release is enabled. For more information, see Configuring 
organizational settings.
Only the print jobs of the authenticated user are released.
This setting applies only in Print Release.

Log in to the printer.
Do either of the following:

Tap Cancel to stop the automatic print release.
Wait for the printer to release all your pending print jobs.

Configuring the Guest Print feature
Guest Print is a feature that lets guest users print documents without requiring the administrator to create an 
account in their organization.
The guest composes an e‑mail from an e‑mail client, attaches the documents to be printed, and sends it to a 
predefined e‑mail address. An administrator or an organizational representative provides the e‑mail address that 
the guest can send their documents. After sending the e‑mail to the specified e‑mail address, the guest receives 
a confirmation e‑mail with a PIN. Using the PIN, the guest can proceed to the printer specified by the 
organizational representative, and print.

Notes

The guest must have an e‑mail client to be able to send the document.
A unique identifier is automatically created in the identity provider for guest print. This 
unique identifier can be used to generate reports related to guest print activity.
The supported file formats are CSV, DOC, DOCX, GIF, HTML, JPG, ODP, ODS, ODT, 
PDF, PPT, PPTX, RTF, TIFF, TXT, XLS, and XLSX. If a user attaches an unsupported file 
format, then the user receives an e‑mail indicating the supported formats.
Lexmark retains information related to the print job only but does not retain any 
e‑mail‑related information.
Each e‑mail attachment is treated as a separate print job.

Enabling Guest Print

From the Print Management web portal, click Administration > Organizational Settings.

Note: E‑mail submission must be enabled before enabling guest print submission. For 
more information on enabling e‑mail submission, see Configuring organizational settings.

From the General section, select Allow guests to use e-mail submission.
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Notes
Select Limit the number of pages allowed per job to set the maximum number 
pages to be printed per job. Jobs greater than a specified number of pages are not 
processed.
PIN authentication must be enabled for guest print submission to work. If PIN 
authentication is not enabled, then you are prompted to enable it. For more 
information on configuring PIN authentication, see Configuring printer login on page 
96.
You can assign guests to a specific cost center or department for applying quotas 
and reporting. For more information, see Configuring organizational settings.

Click Save Changes.

Notes

An organizational administrator can configure settings related to print job retention, PIN 
length, and PIN expiration. The organizational settings applies to the PIN received by the 
guest user.
The validity of the guest print job depends on the value set in Print Job Retention or “PIN 
Expires after,” whichever is lesser. For instance, if Print Job Retention is set as 6 hours 
and “PIN Expires after” as 7 hours, then the jobs get deleted after 6 hours.

Releasing guest print jobs

After receiving the PIN through e‑mail, the guest can proceed to the printer specified by the representative, and 
perform the following steps:

From the printer control panel, touch PIN Login.
Enter the PIN that you have received in your e‑mail, and then touch OK.
Touch Print Release.
Select the print job, and then touch Print.

Notes
If you send multiple print jobs, then all those print jobs are listed.
Each attachment is represented as an individual print job.
To print the body of the e‑mail, select Enable e‑mail body submission. If this 
option is enabled, then the body of the e‑mail is represented as an individual print 
job.
The number of pages allowed per print job depends on the organizational settings. If 
any of the print jobs exceeds the specified number of pages, then the job is not 
processed at all. For more information, see Configuring organizational settings.

Notes

In a scenario, where a Guest Print user sends two emails, they go to the same queue. If 
the PIN hasn't expired already, they'll get the same PIN in response to the second email 
submission. In such a case, a one-way hash of the email is stored permanently.
Before the ability to route later jobs to the same queue is lost, the account is retained for 
14 days.
Standard PIN expiration duration can be either configured for the organization or 14 days 
(when the user is deleted), whichever is sooner.
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Configuring Cloud Print Release
You can configure a printer for Cloud Print Release by deploying the configuration or by importing the settings 
through the printer EWS. Users can also manually edit the settings to configure Cloud Print Release.

Cloud Print Release is available in 2.8‑inch‑screen printers only. For more information on printers that support 
Cloud Print Release, see Supported printer models on page 28.

Notes

Cloud Print Release is available in printers with firmware version 075.287 or later. For 
more information, see Viewing the printer firmware version on page 58.
Users can use Cloud Print Release using a PIN or secure login code only. For more 
information on secure login code, see Configuring printer login on page 96.
Cloud Print Release releases all prints jobs in a print queue. Individual print job selection 
is not supported in Cloud Print Release.
Cloud Print Release does not support hybrid print jobs or delegated jobs.

Configuring Cloud Print Release using a settings 
bundle

Administrators can configure the server address, client ID, and client secret using a settings bundle.

From the Embedded Web Server, click Export Configuration › All Settings.

Note: The settings bundle is downloaded in ZIP format.

Extract the files from the ZIP folder.
Open the bundle.xml file with a text editor.
Modify the <deviceSettings> section of the settings bundle to:

<deviceSettings> 

 

<setting 

name="cloud.services.address">api.<env>.iss.lexmark.com</ 

setting> 

<setting name="cloud.services.client.id">CLIENT_ID_FROM_APP</ 

setting> 

<setting 

name="cloud.services.client.secret">CLIENT_SECRET_FROM_APP</ 

setting> 

</deviceSettings>

Notes
Depending on the location of the data center, the <env> can be us or eu. To 
determine the value of <env> , see the address on the browser address field.
For more information on getting the client ID for CLIENT_ID_FROM_APP and the 
client secret for CLIENT_SECRET_FROM_APP, see Obtaining the client ID and 
client secret on page 180.
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From the settings bundle, you can also modify the security_settings.xml to add Cloud Print 
Release in the Public permission section. To modify the security_settings.xml, open the file 
with a text editor.
Add the <name>cloud print release</name> line to the <public_permissions> section.

Sample Code for <public_permissions> section

<public_permissions> 

 

<name> cancel jobs</name> 

<name>change languages</name> 

<name>cloud connector management</name> 

<name>cloud print release</name> 

<name>cloud services enrollment</name> 

<name>cloud services menu</name>

Save the file.
Send the XML file into a ZIP folder.

Note: You can add this settings bundle to the resource library. For more information, see 
Adding files to the resource library on page 145

Deploy the settings bundle from the Lexmark Fleet Management portal, or import the 
settings in the printer by using the Embedded Web Server. For more information, see 
Deploying files to printers on page 135.

Configuring Cloud Print Release using the Embedded 
Web Server

Before you begin, in the Embedded Web Server, click Security.
From the Public section, click Manage Permissions.
Expand the Device Management section, and then select Cloud Print Release.

Note: The Cloud Print Release option is available only with appropriate firmware installed.

From the Embedded Web Server, click Settings › Cloud Services › Cloud Print Release.
In the Server Address field, type the address of the cloud server.

Note: The server address is https://api.<env>.iss.lexmark.com, where <env> can be us or 
eu. To determine the value of <env> , see the address on the browser address field.

Type the client ID and client secret.

Note: The client ID and client secret are organization‑specific. For more information, see 
Obtaining the client ID and client secret on page 180.

Click Save.
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Releasing print jobs using Cloud Print Release

Send print jobs to the Lexmark Cloud print queue. For more information on print queue, see 
Managing print queues on page 180.
From the printer that has the Cloud Print Release feature, in the printer home screen, touch 
Cloud Print Release.
Depending on the printer login configuration of your organization, log in to the printer using 
any of the authentication methods:

PIN only
Secure login code

Note: Cloud Print Release login is based on the printer login configuration set in Account 
Management by the organization administrator. For more information on configuring 
printer login, see "Managing printer logins" group.

Enter the PIN or secure login code, and click OK.
Wait for the printer to release all pending print jobs.

Note: Jobs that are successfully printed are deleted from the print queue. Jobs that are 
canceled or not successfully printed are not deleted from the print queue.

Printing jobs from third‑party printers using 
Cloud Print Management
For third‑party printers and Lexmark printers that are not Lexmark solutions enabled, customers can use the 
Third‑party Print feature to release print jobs using Cloud Print Management.
To enable third‑party printing using Cloud Print Management, Lexmark provides a bundle which includes the 
ELATEC badge reader and the ELATEC TCP3 device. The TCP3 devices are connected to the wall and the 
printer through an Ethernet cable. The device is also connected to the badge reader through USB.
API endpoints in the Lexmark Cloud Print Management are used by the ELATEC device to connect securely. The 
base firmware on the TCP3 device includes the specific API calls and open authorization workflows to connect to 
Cloud Print Management. The firmware on the TCP3 device must be version 3.0.3.1 or later.
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Notes

Hybrid jobs are not supported.
There are no file size limits as the jobs are not stored in the TCP3 device.
You can configure the maximum number of jobs allowed at one time. For instance, if the 
maximum number of jobs configured is 10, then the first 10 jobs submitted are printed. If 
there are more than 10 jobs in the queue, swipe your badge again to release the 
remaining print jobs.
Job submission through Lexmark Cloud Print Management portal using Lexmark 
Universal Print Driver does not modify the print output. However, job submission using 
Lexmark Universal Print Driver to a non‑Lexmark device may not yield the intended print 
output. The third‑party printer may interpret the print job commands incorrectly 
independent of the Cloud Print Management system. We recommend using the PostScript 
emulation driver if third‑party devices are to be used with Lexmark‑solutions‑enabled 
devices for release.
The TCP3 device does not report on metadata at the time of release. Relevant data like 
mono or color is captured at the time of submission.
ELATEC feeds the Lexmark Cloud Services with printer information like IP address and 
Serial Number of the third‑party printer. However, for the MAC address, it provides the 
MAC address of the ELATEC TCP3 device. Also, there is some information which the 
ELATEC TCP3 device is unable to retrieve from the third‑party printer. This information is 
marked as unknown in Lexmark Cloud Services.

For more information on configuring the ELATEC TCP3 device, see the TCP3 Configuration Guide.

Using the Mobile Enhanced Solutions

Understanding Mobile Enhanced Solutions for Print 
Management

Mobile Enhanced Solutions is a cloud‑based solution offered by Lexmark Cloud Services. It allows you to connect 
to your printers and perform cloud‑based tasks with a mobile phone or tablet. To use Mobile Enhanced Solutions, 
your printers must be managed with Cloud Fleet Management using the Native Agent. This action allows Lexmark 
Cloud Services to communicate with the printer using IoT commands. Also, your printer firmware must support 
Mobile Enhanced Solutions, and Mobile Enhanced Solutions must be enabled from the administrator options of 
the printer.

Note: Mobile Enhanced Solutions is available only in printers with 2.8-inch touch-screen displays.

Using Direct Print
The Direct Print feature helps to track jobs that are directly sent to Lexmark printers for users in Lexmark Cloud 
Services. Using Direct Print, these jobs do not go through a global queue and are not released through the Print 
Release application. When Lexmark Print Management Client (LPMC) is installed in a workstation, users 
submitting jobs must enter credentials. LPMC sends the user‑level data to the Lexmark Cloud Services portal. 
This data helps Lexmark Cloud Services to track print activities for users in Lexmark Cloud Services. The print job 
never leaves the customer network and is never held for release, but is sent and printed immediately to the 
designated printer. The Direct Print installation package includes a configuration XML (or JSON for LPMC 3.5.0 or 
newer) file that contains the printer profile information to ensure jobs are sent to the specified printers.

The Direct Print installation package includes a configuration XML file that contains the printer profile information 
to ensure jobs are sent to the specified printers.

https://publications.lexmark.com/publications/lexmark_solutions/Cloud/TCP3/pdf/TCP3_Configuration_Guide_en.pdf
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To let users select which printer to send their job directly, do the following:

Install the required settings in your workstation along with the LPMC software.
Assign the direct printers in the cloud.
Deploy the Direct Print configuration to the user workstation.

Direct Print can be used with cloud and hybrid submissions as well, allowing more flexibility in the allowable 
end‑user print endpoints and workflows.

Before you begin, make sure that:

Direct Print is enabled for the organization. For more information on enabling Direct Print, 
see Configuring organizational settings on page 170.
LPMC Windows version 2.3.1145.0 with proper configuration is available.
LPMC macOS version 3.3.0 or later in installed.
Ubuntu version 3.3.0 or later in installed.
Device Usage version 2.4.32 is installed.
The printer is enrolled in Cloud Fleet Management and is attached to a network.

For Lexmark eSF enabled printers, make sure that the Cloud Print Management 
application bundle is installed on the device.
For Lexmark eSF printer or a non-eSF printer, make sure that Lexmark Universal Print 
Driver must be installed with the LPMC.

The client workstation is connected to the network and access to port 9100 is enabled.
Direct Print roles are defined. For more information on defining roles, see "Organization 
administrator" group. The Direct Print roles are as follows:

Direct Print administrator

Provides access to Direct Print users
Create configurations using Cloud Fleet Management tags
Downloads configurations from Print Clients page

Direct Print user

Downloads personal Direct Print installation package from Print Clients page
Submits print jobs using Direct Print

Note: When the Direct Print feature is enabled by a Direct Print administrator, configuration settings become 
available. Depending on whether they set Direct, Offline, or Direct and offline feature, Print Release 
Administrator and Hybrid Print Administrator also have the rights to configure these features.

Creating a print assignment

Before you begin, make sure that Enable print assignments is selected on the Organizational Settings 
page. For more information on enabling Direct Print, see Configuring organizational settings on page 170.

You must have an administrator role in Cloud Print Management and Cloud Fleet Management to configure the 
Direct Print feature. To configure print assignments, you must create assignments. Assignments act as a bridge 
between a user and a set of printers. Creating an assignment helps a user or a group to use the Direct Print 
or Offline Print feature on a particular set of printers.

Note: From the Fleet Management portal, we recommend updating the Printer share name (optional) field 
on the Printer details page. It is not mandatory to update this field. If you want to change the print queue 
name as it appears to the end user, then enter a value in the Printer share name (optional) field. LPMC has 
a single direct print queue. If Printer Name is not configured in Cloud Fleet Management, then it displays 
Printer manufacturer and Model name.
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From the Print Management web portal, click Administration › Print Assignments.
Click Create.
On the Create Print Assignment page, do the following:

In the General section, do the following:
Assignment name—Type the name of the assignment.
Description—Type a brief description of the assignment.

In the Printer Allotment section, do the following:
Unassigned Printer Access—Select Enable unassigned printer access to 
allow users to print to printers that are not assigned to them.
Printer Assignment—In this section, you can add printers for the assignment 
based on various rules.

Notes
To add a rule for printer assignment, click Add Rule.
For the rule condition, you can select either And or Or.
You can configure rules based on following conditions: .

Assign by—For this condition, you can select Tag, Subnet, or 
IP.

For already created Print Assignments with tags, if new 
printers are added or existing printers are removed from 
that existing Tag, then the change does not take effect 
immediately. It may take up to 24 hours to take effect.
You can add multiple tags to each unique printer.
You can view the total number of unique printers that are 
tagged.

Operator—For this condition, you can select Equals, Not 
Equals, In, or Not In. The availability of these options depends 
on what you have selected in Assign by. For instance, if you 
select Tag in Assign by, then the Not Equals and Not In options 
are not available.
Identifier—In this text box, type the printer identifier depending 
on what you have selected in Assign by.

You can add multiple rules with And or Or conditions. Click Add to add 
a particular rule.

To delete a rule, click .

In the Printer Properties section, select Allow print settings changes to allow users 
to modify printer settings before printing. The users are defined in the User 
Assignment section.

Note: This option lets you modify the Default Print Settings.

In the User Assignment, select any one of the following:
Universal Assignment—This makes the printer assignment available to all 
users.
Custom Assignment—This helps to define rules to select users for assignment.

Click Save Changes.
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Notes
To add a custom rule or group for user assignment, click Add Rule or Add 
Group respectively.
For both rule and group conditions, you can select either And or Or, and a 
combination of both.
You can configure rules based on following conditions: .

Assign by—For this condition, you can select Subnet, Department, 
Cost center, or Personal.
Operator—For this condition, you can select Equals, Not Equals, In, 
and Not In.
Identifier—In this text box, type the user identifier depending on what 
you have selected in Assign by.

You can add multiple rules or groups with And or Or conditions. Click Add to 
add a particular rule or group.

To delete a rule or a group, click .

Note:

To edit an assignment, on the Print Assignments page, click , make the necessary 
changes, and then click Save Changes.
In a scenario, where assignments are created for cost center, department, default 
(organization), personal and client status, the following order of priority is applied.
Starting from the least, the order would be Default (Organization) ›  Cost Center/ 
Department  › Personal › Client Status.
For Print Assignments, essentially there is no conflict. If an user has multiple eligible 
assignments, then the printers across those assignments will be aggregated (union).

Downloading the Direct Print installation package

The download option is available only if Enable print assignments is selected, and Use print assignment with 
is set to Direct Print or Direct and offline print.

From the Print Management web portal, click Print Clients.
From the Select client menu, select an operating system.
From the Select package type menu, select Direct Print.
Click Download Client.

Sample configuration file (LPMC version 3.6.0 or later)

 

{ 

  "loggerSettings" : { 

    "loggingLevel" : "info", 

    "logIpAddresses" : false, 

    "redactPrivateInformation" : true 

  }, 

  "serverSettings" : { 
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    "apiVersion" : "3.0", 

    "idpServerUrl" : "https://idp.us.iss.lexmark.com", 

    "cpmServerUrl" : "https://apis.us.iss.lexmark.com/cpm" 

  }, 

  "directPrintSettings" : { 

    "queueName" : "Direct Print Management - PCLXL", 

    "loopbackPort" : 9169, 

    "printSettings" : [ ], 

    "allowSecurePrintOnly" : false, 

    "preferSecurePrintUsingPrintCryption" : false 

  }, 

  "uiSettings" : { 

    "authenticationMode" : "DefaultBrowser", 

    "displayNotifications" : true, 

    "displayConnectionErrorMessageBoxes" : true 

  }, 

  "certificateValidationSettings" : { 

    "certificateValidationSwitch" : true, 

    "certificateValidationDebugMode" : false, 

    "certificateRevocationMode" : 0 

  }, 

  "webProxySettings" : { 

    "enabled" : true, 

    "address" : "" 

  }, 

  "networkInterfaceSelectorSettings" : { 

    "prioritizeVirtualAdapters" : false, 

    "filterAutoIpAddresses" : false, 

    "subnetFilter" : { 

      "include" : [ ], 

      "exclude" : [ ] 

    } 

  }, 

  "scheduleSettings" : { 

    "ipChangeMonitorIntervalInSeconds" : 60, 

    "proxyCacheResetIntervalInSeconds" : 60 

  }, 

  "listenerPortSettings" : { 

    "universalServicePort" : 9443 

  }, 

  "driverName" : "Lexmark Universal v2 XL", 

  "defaultQueueName" : "Direct Print Management - PCLXL", 

  "printJobFileNameFormat" : "%d_%i.prn", 

  "userFolderDirectoryMode" : "Programdata" 

}

Note: For more information on configuration, see the Lexmark Print Management Client Configuration Guide.

Installing the Direct Print installation package

From the Direct Print installation package, run the Installer file.
Accept the End‑User License Agreement.
Click Install.
Click Finish.
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Using Offline Print
The Offline Print feature is a way to allow users to print even when there are connectivity issues with the Lexmark 
Cloud Services. This feature works with conventional Cloud, Hybrid, Direct print which requires connectivity to 
Lexmark Cloud but makes sure that users can continue printing even when connectivity to Lexmark Cloud 
Services is lost.

To use Cloud, Hybrid, or Direct print, uninterrupted connectivity to the cloud server is required. Unlike Cloud, 
Hybrid, or Direct print, Offline Print allows users to send print jobs without requiring connectivity to the cloud 
server. Moreover, the Offline Print feature also stores analytics data in the client workstation during offline mode, 
and then sends it to the cloud server, when connectivity to the cloud server is restored.

On initiating a cloud or hybrid print job during offline mode, the user has to select the printer destination. They can 
either select from the list of configured printers or directly enter the IP or Hostname of the printer. When printing to 
a direct print queue during offline mode, it proceeds normally. In Analytics, the print activity is reported as Offline 
Print.

Printing jobs using the printer hostname depends on the configured hostname resolution in the user’s network. 
Hostname resolution is the process of converting a hostname into an IP address. Depending on the hostname 
resolution, either hostname or hostname with domain works.

Prerequisites

Enable print assignments must be enabled on the Organizational Settings page, and 
Use print assignment with must be set to Offline Print or Direct and offline print. For 
more information on enabling print assignments, see Configuring organizational settings on 
page 170.
For submission from registered Lexmark Cloud Service, any combination of queues present 
on the workstation - cloud or hybrid or direct.
User must be currently logged into the LPMC.

User experience in different modes

The following scenarios are based on the assumption that Direct and offline print is enabled on the 
Organizational Settings page. For more information on creating print assignments, see the "Creating a print 
assignment" section in Using Direct Print on page 204.

For direct print submissions, the user’s workflow is not affected.
For cloud or hybrid submissions, the user experiences the following:

Users will be notified every time they print in offline mode.
If the administrator had created print assignments, the list of printers will be displayed 
for the user to select a printer to release the print job.
The user can also enter the IP address or hostname of the printer to release the print 
job.
The user can click Cancel to cancel the print activity.
If Lexmark Cloud Services connectivity is restored, then the user is notified about the 
restoration of normal print workflow.

In offline mode, analytics data is stored in the client machine until it can stream back to the 
cloud. The offline analytics data is sent to cloud server during the next print job after 
connection is restored.
Supported by Windows, Mac, and Ubuntu LPMC clients.
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Limitations

Mobile is not supported
Chrome extension is not supported
No prompt for Offline Print is shown while there is an ongoing job.
Offline Print job pages are not shown in Analytics 2.0.

Note: For offline printing to work, LPMC requires a prior download of settings from Lexmark Cloud Services. 
This download happens automatically every four hours or when you select Check for Updates from the 
system tray. The system tray icon shows your connection status.

Using Advanced Hybrid storage

Understanding advanced hybrid storage

Notes

To use advanced hybrid storage feature, your administrator must enable this feature. For 
more information, see Configuring organizational settings on page 170.
On enabling this feature, an application is created for your organization. This application 
credentials are needed in all storage devices where the service runs. To get the advanced 
hybrid storage application credentials, see Obtaining the client ID and client secret on 
page 180.
LPMC version 3.5.1 or later is required.

Advanced Hybrid Storage Feature

The advanced hybrid storage feature uses additional storage locations for print jobs without allowing them to 
move out of the customer network. This ensures that the user's print job remains within the network while being 
stored in locations outside their workstation.

Supported Storage Types:

Windows systems
Ubuntu systems
Optra Edge devices

Feature overview:

This feature is designed to ensure high availability of print jobs, even when the workstation from which the job is 
submitted is offline. Although the cloud server stores metadata like the job location, the actual print job is stored in 
a hybrid storage environment.

Administrator options:

Administrators can choose to create one to three additional replicas of their print job. However, they cannot select 
the specific device where the job is stored.

To ensure higher availability, the job is stored in alternate locations equal to the number of copies selected in the 
organization settings.

Print release process:

During a print release, the printer first checks the primary storage location (submission workstation) for the print 
jobs.
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If the primary location is unreachable, it then checks the alternate locations. When the print job is successfully 
released, it is removed from all storage devices.

Note:

For every storage client, you must reserve a certain amount of disk space so that the 
service has enough disk space for processing operations like Change print settings.
Storage services reserve the space based on the available disk space. The minimum 
reserved space is 20 GB.

Setting up Optra Edge devices

Before you begin, make sure that you register your Optra Edge devices in the Optra portal.

Note: For more information on registering Optra Edge devices, see https://optra.com/getting-started.

We recommend using VZ5000 models.

Go to www.portal.optra.com, and then log in.
Create a workflow using advanced hybrid storage skill from Optra market place.

Note:

For Optra, common and additional variables are required to be set as environment 
variables for the device.
For more information on the steps to set up an Optra Edge device, see User's Guide.

Setting up advanced hybrid storage for Windows and 
Ubuntu systems

Supported operating systems

Windows Server 2022 Datacenter (AMD64)
Ubuntu 22.04 (AMD64)
Ubuntu 24.04 (AMD64)

Installing the advanced hybrid package

Before you begin, you must enable the additional hybrid storage option from the Organizational Settings page. 
For more information, see Configuring organizational settings on page 170.

Depending on your requirement, get the Windows installation package or the Ubuntu 
installation package.

Notes
For more information on accessing the installation packages, contact your Lexmark 
representative.

Unzip the installation package.
Open the Windows PowerShell as an administrator.

https://optra.com/getting-started
https://login.optra.com/login?state=hKFo2SBFVHNSYk9nc3M2UjZWTWptNERyZlpyczVYM3E5UFVHOKFupWxvZ2luo3RpZNkgOV9GVzBoSjREaTBxcDBqMi16LUxtRTNWYWkxN1h2OEyjY2lk2SB5bDZGT3ViQ252TTZuVzZUa2xRYnNWOEUwbHlxTkNTcg&client=yl6FOubCnvM6nW6TklQbsV8E0lyqNCSr&protocol=oauth2&response_type=token%20id_token&redirect_uri=https://portal.optra.com/authorize&scope=openid%20profile%20email&nonce=fd1cb3a1-ca33-413f-8d80-81c5021c5599&auth0Client=eyJuYW1lIjoiYXV0aDAuanMiLCJ2ZXJzaW9uIjoiOS4yMC4yIn0=
https://optra.com/Optra%20User's%20Guide.pdf
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Run the installer script file with the following command line options:

For Windows and Ubuntu operating system:

$clientSecret = ConvertTo-SecureString "client_secret_value" -AsPlainText 
-Force$proxyPassword = ConvertTo-SecureString "proxy_password_value" 
-AsPlainText -Force
For Windows operating system—install.ps1

Basic installation:

& .\install.ps1 -DATA_CENTER "<data-center>" -CLIENT_ID "<client-id>" 
-CLIENT_SECRET $clientSecret

Advanced installation:

& .\install.ps1 -DATA_CENTER "<data-center>" -CLIENT_ID "<client-id>" 
-CLIENT_SECRET $clientSecret -JOB_PATH "<job-path>" -INSTALLATION_DIR 
"<install-path>" -SERVER_PORT "<server-port>" -ENABLE_HOSTNAME 
"<enable-hostname>" -DEVICE_NAME "<device-name>" -HTTPS_PROXY "http:// 
<proxy_host>:<proxy_port>" -PROXY_USER "<username>" 
-PROXY_PASSWORD $proxyPassword -LOG_REDACT_PRIVATE_INFORMATION 
"<log-redact-private-information>" -LOG_IP_ADDRESSES "<log-ip-addresses>"
For Ubuntu operating system—installer.sh

Basic installation:

bash installer.sh DATA_CENTER=<data-center> CLIENT_ID=<client_id> 
CLIENT_SECRET=<client_secret>

Advanced installation:

bash installer.sh DATA_CENTER=<data-center> CLIENT_ID=<client_id> 
CLIENT_SECRET=<client_secret> JOB_PATH=</path/to/store/jobs> 
INSTALLATION_DIR=</path/to/installation/ directory> 
PROXY_USER=<proxy_username> PROXY_PASSWORD=<proxy_password> 
LOG_REDACT_PRIVATE_INFORMATION=<log-redact-private-information> 
LOG_IP_ADDRESSES=<log-ip-addresses>

Notes
For more information on common variables, see Common variables.
For more information on additional variables related to Windows and Ubuntu, see 
Additional optional variables for Windows and Ubuntu.

Uninstalling advanced hybrid storage

For Windows operating system

Open Windows PowerShell in administrator mode.
Navigate to installation directory.
Make sure that the uninstall.ps1 file is present in the directory.
Execute the uninstall.ps1 file.

For Ubuntu operating system
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Open terminal.
Navigate to Installation Directory
Make sure that the uninstaller.sh file is present in the directory.
Execute the uninstaller.sh file with elevated access.

Upgrading advanced hybrid storage

For Windows operating system

Download the desired package.
Open the Windows PowerShell as an administrator.
Execute the install.ps1 file without any arguments.

For Ubuntu operating system

Download the desired package.
Open terminal.
Execute the installer.sh file without any arguments.

Understanding the installation parameter information

Common variables

Name Value Description

DATA_CENTER

Note: For Optra, instead 
of DATA_CENTER, set 
SPRING_PROFILES_ACTIVE.

Select one of the following 
that matches your data- 
center location:

us
eu

This variable is used by the 
application to connect to the 
data center where the 
Lexmark Cloud Services 
organization is located.

CLIENT_ID

Note: For Optra, instead 
of CLIENT_ID, set 
EDGE_CLIENT_ID.

From the Account 
Management portal, 
click Applications 
tab.
In the search bar, 
search for CPM 
Advanced Hybrid 
Storage.
Click the application 
name.
On the CPM 
Advanced Hybrid 
Storage page, in the 
OAuth Settings 
section, identify 
<client_ID> and 
<client_secret>.

The value is used to 
register and authenticate 
with the Cloud Print 
Management.
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Name Value Description

CLIENT_SECRET

Note: For Optra, instead 
of CLIENT_SECRET , set 
EDGE_CLIENT_SECRET.

Same as CLIENT_ID. Same as CLIENT_ID.

Optional variables

Name Value Description

SERVER_PORT Any port The application listens on 
this port. The default port is 
9443.

DEVICE_ID Custom device name of 
Windows or Ubuntu servers

Unique Identifier to identity 
a particular advanced 
storage device. The default 
value is server's hostname.

CLEAN_UP_SCHEDULE Cron expression This value determines how 
often the application checks 
to determine if a job should 
be removed from this 
storage device. The default 
value is 30 minutes.

ENABLE_HOSTNAME True or False The value determines 
whether the printer 
connects to this device 
using the host name or the 
IP address. The preferred 
and default value is False 
because due to network 
configurations, the host 
name may not be 
discoverable by the printer.

STATUS_SCHEDULE Cron expression The value is how often the 
application updates its 
information (IP, disk space, 
etc.) to Cloud Print 
Management. The default 
value is one minute.

LOG_REDACT

_PRIVATE_INFORMATION

True or False This value determines if we 
should remove private 
information from the 
logs. The default value is 
True.

LOG_IP_ADDRESSES True or False The value determines 
whether to log the IP 
addresses. The default 
value is False.
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Name Value Description

LOGGING_LEVEL

_COM_LEXMARK

DEBUG/ INFO/ ERROR/ 
WARN

The default value is INFO.

To change the logging level:

For Windows operating 
system:

From the installation 
directory, edit the 
value of the 
environment variable 
in lexmark-print- 
management- 
advanced-hybrid- 
service.xml..
Restart the service

For Ubuntu operating 
system:

Run lexmark-print- 
management- 
advanced-hybrid- 
service.
Run lexmark-print- 
management- 
advanced-hybrid- 
service .

Additional optional variables for Windows and Ubuntu

Name Value Description

JOB_PATH

Note: For Optra, 
JOB_PATH needs to be 
defined only if using 
external hard drive. For 
example, JOB_PATH = / 
media/sda1/jobs.

Fully qualified path to the 
directory where hybrid jobs 
are to be stored.

The following are the 
default values:

For Windows, the 
path is C: 
\ProgramData

\Lexmark\Hybrid\Jobs.
For Ubuntu, the path 
is /var/Lexmark/ 
Hybrid/Jobs.
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INSTALLATION_DIR Fully qualified path to the 
wanted installation 
directory.

The following are the 
default values:

For Windows, the 
path is C:\Program 
Files\Lexmark\Hybrid 
Storage Edge 
Service.
For Ubuntu, the path 
is /opt/Lexmark/ 
HybridStorageEdgeService.

DEVICE_NAME A name to uniquely identify 
each device where the 
service is running.

A unique identifier from 
Cloud Print Management to 
identity a particular device.
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Name Value Description

HTTPS_PROXY http:// 
<proxy_host>:<proxy_port> If the server is behind 

proxy, we will detect 
the system proxy. You 
can override the 
system proxy by 
setting the 
HTTPS_PROXY 
variable during 
installation.
You can also add or 
modify the proxy 
setting after 
installation.
In Windows: Update 
the HTTPS_PROXY 
variable in the 
lexmark-print- 
management- 
advanced-hybrid- 
service.xml file 
located in the 
installation folder.
For Ubuntu, perform 
the following steps:

Update the 
variable in the 
service 
manager.
Run sudo 
systemctl edit 
lexmark-print- 
management- 
advanced- 
hybrid-service.
Add the 
following lines:

[Service] 
Environment

="https_proxy=http://

<proxy_address>

:<proxy_port>".
Save and exit 
the editor.
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Name Value Description
Run sudo 
systemctl 
daemon-reload.
Run sudo 
systemctl 
restartlexmark- 
print- 
management- 
advanced- 
hybrid-service.

PROXY_USER If a proxy needs 
authentication, then it is 
encrypted and stored in a 
local file system.

PROXY_PASSWORD

DNS_TIMEOUT

Note: This is only 
required for Optra.

The default value is 3000 
ms.

if you observe intermittent 
failure to sync jobs, then set 
this variable.

Disabling storage clients

From the Cloud Print Management portal, click Print Clients > Client Status.
Click the Advanced Hybrid Storage Client tab.
Select one or more devices.
Click Disable > Disable Storage Client or Disable Storage Clients.

Deleting storage clients

From the Cloud Print Management portal, click Print Clients > Client Status.
Click the Advanced Hybrid Storage Client tab.
Select one or more devices.
Click Delete > Delete Storage Client or Delete Storage Clients.

Note: It may take some time for the deletion to take effect.

Configuring proxy settings

For Optra:

Connect the device to a computer through the USB device port to access the Embedded 
Web Server (EWS).
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Open a web browser, and in the Address field, type the IP Address of Optra device.
In the Password field, type the Optra serial number.
Click Proxy tab, and then enter the proxy information.

For Windows and Ubuntu:

The service is configured to read the proxy set at the system level for the user who installed the service.

Installing certificates

For Optra:

Installing certificates is not supported for Optra.

For Windows:

The advanced hybrid storage service uses the Windows-Root Trust Store. As a result, any certificates installed in 
Windows-Root trust store is honoured by the service.

For Ubuntu

From the Installation directory execute the script: update-ssl-proxy.sh.
From the Syntax, do the following:

Import—sh update-ssl-proxy.sh <cert_path> <alias> import
Delete—sh update-ssl-proxy.sh <cert_path> <alias> delete

Managing Advanced Hybrid storage assignments

Creating advanced hybrid storage assignments

Before you begin, make sure that Enable advanced hybrid storage on the Organizational Settings page is 
selected. For more information, see Configuring organizational settings on page 170.

From the Print Management web portal, click Print Clients › Client Overview.
Click the Advanced Hybrid Storage tab.
Select the Storage list view.

From the Device list, select one or more devices, and then click Create Assignment.
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On the Create Assignment window, from the Assign by menu, select any one of the 
following:

Organization—When an organizational advanced hybrid storage assignment is 
created, the Assign by menu no longer features the Organization option.
Cost Center—Type the name of the cost center in the Cost center name field.
Department—Type the name of the department in the Department name field.
Personal—Type the email ID of the member for whom the assignment is created.

Click Create Assignment.
To confirm the creation of each type of assignment, select Assignment list view.

Notes

In the Storage list view, you can disable advanced hybrid storage devices. Select one 
more devices, and then click Disable › Disable Storage Client.
In the Storage list view, you can delete advanced hybrid storage devices. Select one 
more devices, and then click Delete › Delete Storage Client.

If an assignment has only one storage client and that client is deleted, then the 
assignment is also deleted.
If an assignment has multiple storage clients and one is deleted, then only that 
client is removed. The assignment stays.
If a storage client is deleted but not part of any assignment, then nothing changes in 
the Assignment List page.

Using the advanced hybrid storage assignment list

Organizational Advanced Hybrid Storage Assignment

When you have created an Organizational Advanced Hybrid Storage Assignment, you can view it in the 
assignment list. On this list, you can view or delete the assignment.

To edit an Organizational Advanced Hybrid Storage Assignment, do the following:

In the Organizational Advanced Hybrid Storage Assignment section, click .
On the Edit Organizational Assignment window, you can add devices and remove the 
existing ones.
Click Save Changes.

To delete an Organizational Advanced Hybrid Storage Assignment, do the following:

In the Organizational Advanced Hybrid Storage Assignment section, click .
On the Delete Organizational Assignment window, click Delete Assignment.



Print Management

221

1.
2.

1.
2.
3.
4.

•

•

Note: This deletes the Organizational Advanced Hybrid Storage Assignment and 
unassigns all the assigned devices under the organization.

Cost center, department, and personal assignments

In the Assignment List section, you can view, delete, or edit advanced hybrid assignments. Click Views, and 
then filter the assignments by cost center, department, or personal.

Note: The Views filters are available only for the type of assignments you have created. For instance, if the 
assignment list does not have a personal advanced hybrid assignment, then the Assignment by personal 
option will not be available in the Views filter.

Deleting an assignment

In the Assignment List section, you can delete a cost center, department, or personal assignment.

To delete the assignment, do the following:

From the Assignment List, select one or more assignments.
Click Delete Assignment › Delete.

Editing an assignment

In the Assignment List section, you can edit a cost center, department, or personal assignment.

To edit an assignment, do the following:

From the Assignment List, select the assignment.
Click Edit Assignment.
On the Edit Assignment window, add or remove devices.
Click Save Changes.

Notes

You can use the Device Name filter to search for assignments associated with a particular 
device. The Device Name filter results are a subset of the Views filter. For example, an 
administrator may select Assignments by personal option in the Views filter, and a 
particular device in the Device Name filter. In that scenario, personal assignments 
associated with the particular device are listed.
If a user has multiple assignments, then their print job is mirrored to the storage with the 
most available disk space.
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Understanding various scenarios for advanced hybrid storage

Scenario 1

In this scenario, a storage device (Storage A) is assigned to a department (DPT) with multiple users (User 1 and 
User 2). In such case, the following happens:

Storage A is assigned to department DPT.
User 1 and User 2 both belongs to department DPT.
The print jobs for both User 1 and User 2 are stored in Storage A.

Scenario 2

In this scenario, a device is assigned to multiple storage locations. The various storage devices have different 
storage capacity. In this case, the following happens:

A storage device can be assigned to the Organization, Cost Center, Department and 
Personal at the same time but the print job will be saved based on:

Where the user is assigned
Which one has the most storage
The number of desired replicas.

If a user has multiple assignments (Organization, Cost Center, Department, Group, and 
Personal), their print job is mirrored to the storage with the most available disk space.
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Overview
Cloud Solution Center lets you create or customize your workflows depending on your roles in an organization. 
You can create a workflow to capture, process, and route a document. After selecting Solution Center card from 
the dashboard or from the  on the upper-right corner of the page, you can view a list of available solutions 
based on your role.

There is also a Solution Center eSF application available on Lexmark printers and multifunction products (MFPs). 
It allows users to view and execute workflows that have been configured through the Lexmark Cloud Services 
portal. For steps that are kept unlocked in the Lexmark Cloud Services portal, users can still edit or customize 
them through the eSF application.

Note: For more information on printer models that support Solution Center, see Supported printer models for 
Solution Center on page 57.

Flow chart of using Solution Center

Deploy the Solution Center eSF application to the fleet.
Create, and then share a solution workflow. For more information on creating a solution 
workflow, see Creating a solution workflow on page 224.
Use the Cloud Solution Center from the Lexmark Cloud Services portal. For more 
information on using a solution workflow, see Using the Cloud Solution Center on page 228.
Use the Solution Center application from the printer. For more information on using Solution 
Center application, see Accessing the application on page 233.

Solution Center Roles

Solution Center Administrator—Creates personal and shareable solutions with their own 
organization.

Note: A Solution Center Administrator who is also a Partner Administrator can create and 
share solutions with child organizations.

Solution Center Advanced User—Creates personal solutions.
Solution Center User—Executes solutions.

Solution Center
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To be able to use the various actions for Solution Center, the following roles are required:

Translation Assistant User—Uses Translations for the entitled organization.
Redaction Assistant User—Uses Redactions for the entitled organization.
OCR User—Uses Optical Character Recognition for the entitled organization.

Limitations

For more information on limitations of Solution Center, see Solution Center e6 ReadMe v1.1.1.

Creating a solution workflow

Note: You must have Advanced User role in an organization to create a solution.

Before you begin, make sure that the organization and its users have appropriate page allocations. For more 
information, see the "Solution Quota Manager" chapter.

From a web browser, access the Lexmark Cloud Services dashboard, and then do either of 
the following:

Click the Solution Center card.

Note: If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

Click  on the upper‑right corner of the page, and then click Solution Center.
Click Create.
In the Solution name field, type the name of the solution workflow.
In the Description (Optional) field, type a short description about the solution workflow.
Select Share with my organization to share this solution workflow with your organization.

Notes
If the solution workflow is not shared, then only the creator has the access to that 
workflow. So if the currently logged in user is not the creator, then that user cannot see the 
solution workflow.

Types of solution workflows

Personal—Only available for the creator of the workflow
Organizational—Available for all the users from the current entitled organization
Shared—Available for all the users of the specific child organization with which the 
solution is shared

From the Scan Settings section, click Edit Scan Settings.

Note: The Scan Settings are only applicable when the solution is run from the printer. 
The Scan Settings appear on the printer panel only if Show scan settings on the printer 
panel is enabled in Edit Scan Settings.

From the Steps section, click Add Step.

https://support.lexmark.com/content/dam/support/collateral/lexmark_solutions/solution_center/readme/Solution_Center_1.1.1.txt
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Notes
The steps must include at least one destination and can include one or multiple 
actions.
You can include up to 10 steps per workflow.
Solutions that are combinations of actions and destinations must end with a 
destination.

From the Add Step window, select the action and destination.

For Action items, select one or more of the following:

Extract Text using OCR—Optical Character Recognition (OCR) is a service used to 
extract text from a document that is converted to machine-readable format.

Note:
OCR is always executed first, regardless of the sequence in which it was 
added while creating the solution.
Using the OCR service consumes the OCR entitlement quota.

From the Select the output file type menu, select one of the following:

Portable Document Format (.pdf)
Word document (.docx)
Plain text (.txt)

.
Translate—Allows you to Upload a file in a source language and translate it to one or 
more target languages.

Note: The Translation Assistant service uses Microsoft Azure Cognitive Services.

Select the language of the document to translate.

Note: This feature detects the source language automatically by default. For 
more information on supported formats and languages, see Understanding 
Translation Assistant on page 282.

Select a target language.

Note:
Using the Translation Assistant service uses the Translation entitlement 
quota.
You can select up to five target languages.

Note: For more information on the translate action, see the "Translation Assistant" 
chapter.

Redact—Allows you to Censor part of a text for security purposes.

Note:
The redact action consumes Redaction quota.
The redact service uses Microsoft Azure Cognitive Services.

Select the language of the document to redact.
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Note: Make sure that the document format selected in Scan Settings is 
DOCX.

From the Select the information you want to redact from the file menu, 
configure the following:

Select Personally Identifiable Information (PII) to redact personally 
identifiable information.

Select the available PII or select from the available country‑based 
PII.

Note: For more on available PII, see Available country-based PII 
on page 228.

To move a selected PII between the Available PII and Selected PII 

lists, click  or , or drag it between the lists. You can also 
double‑click it and select an option.

Select Custom text to redact specific text from the file.

In the Specify custom text to redact field, type the text to be 
redacted.
From the menu, select Whole word only, Contains, Exact match 
or Advanced Match.

Notes
Select Whole word only to redact only a specific entire 
word.
Select Contains to redact both an entire word and any 
word that contains it.
Select Exact Match to redact words exactly as you 
capitalized them.
For Custom text, the maximum limit is 20 words.
For Advanced Match, the maximum limit is 512 
characters. Advanced Match works on the principle of 
regular expressions (regex), which are a way to define 
search operations based on a sequence of characters.

Regular expressions with trailing spaces and strings 
before or after the patterns are valid entries.
Depending on how the DOCX input file is parsed, the 
resulting regular expression for a particular text input 
may or may not match. This may result to some 
unredacted strings.

Click Add Text.
Insert Footer—To add a footer to the page, type the text in the Footer text field.

Note: Make sure that the document format selected in Scan Settings is DOCX.

For Destination items, select one or more of the following:

Email—Send the document to the specified email addresses.
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In the Send document to the following email addresses field, type the email 
addresses.

Note:
You can add up to 50 email addresses as long as their combined length 
does not exceed 255 characters.
The email addresses must be separated by commas.

If you want to receive a copy of the email, then select Send me a copy.

Note:
Selecting Send me a copy lets you run a solution even if the Send 
document to the following email addresses field is left blank.
You can also run a solution even without selecting Send me a copy if 
Send document to the following email addresses is unlocked.

Download—Download a copy of the document to your device.

Note: This step can be performed only from the Lexmark Cloud Services portal.

Send to Cloud Print Queue—Send the document to your Cloud Print Management 
queue.

Note: This option is available only to users who have the Print Management User 
role.

Print—Print the document.

Note: This step can be executed from a printer only.

Send to Cloud Storage—From the Send to menu, select the cloud storage provider.

Note: Cloud storage providers include Box, Dropbox, OneDrive, SharePoint, and 
Google Drive. You can select any of these storage providers from Solution Center 
Settings.

Click Create Solution.
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Note:

To add more than one action, click Add Step each time you select an action.

Click  to lock the values of the actions or destinations so that the values cannot be 
changed during execution. Make sure that you enter a value for the actions and 
destinations before you lock it.
If an action or a destination is not locked during execution, then the user is prompted to 
select a value from the available options.

Click  to unlock a value.
You can configure the storage providers and set account domains from the Solution 

Center Settings page. To access the Solution Center Settings page, click .
Users must have a Microsoft, Google, Box, or Dropbox account to access the cloud 
storage services.
For more information on managing scan destinations, see Managing scan destinations on 
page 239.
You may encounter error messages for the following reasons:

The selected account is signed out.
No cloud storage account is selected and all storage accounts are signed out.
The cloud storage account is disabled in global setting.
A duplicate folder is created.
A folder name exceeds the maximum length.
A path is invalid due to an inaccessible or deleted folder.

To add more than one destination, click Add Step each time you select a destination.

Using the Cloud Solution Center
On creating the solution workflow, users can run these solutions based on the entitlement.

On the Solutions page, you can use the Quotas menu to view the remaining quota for Translation, Redaction, 
and OCR.

Note:

To duplicate a solution, click .

To use a solution, click    to run a solution.

To delete a solution, click  .

To edit a solution, click .

Available country-based PII
The following are the country-based Personally Identifiable Information (PII) available for redact:
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General

Person
Phone Number
Organization
Address
Email
URL
IP
Date
Age
ABA routing number
SWIFT code
Credit card
International Banking Account Number (IBAN)

Argentina

Argentina National Identity (DNI) Number
Austria

Austria identity card
Austria tax identification Number
Austria Value Added Tax (VAT) Number

Australia

Australia bank account Number
Australian business Number
Australia Company Number
Australia driver’s license
Australia medical account Number
Australia passport Number
Australia tax file Number

Belgium

Belgium national Number
Belgium Value Added Tax (VAT) Number

Brazil

Brazil legal entity Number (CNPJ)
Brazil CPF Number
Brazil National ID card (RG)

Canada

Canada bank account Number
Canada driver’s license Number
Canada health service Number
Canada passport Number
Canada social insurance Number

Chile

Chile identity card Number
China

China Resident Identity Card (PRC) Number
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European Union (EU)

EU debit card Number
EU driver’s license Number
EU GPU coordinates
EU national identification Number
EU passport number
EU Social Security Number (SSN) or equivalent ID
EU Tax Identification Number (TIN)

France

France driver’s license Number
France health insurance Number
France national ID card (CNI)
France passport Number
France Social Security Number (INSEE)
France tax identification Number (NumeroSPI)
France Value Added Tax (VAT) Number

Germany

German Driver’s License Number
Germany Identity Card Number
Germany passport number
Germany Tax Identification Number
Germany Value Added Tax Number

Hong Kong

Hong Kong Identity Card (HKID) Number
Hungary

Hungary Personal Identification Number
Hungary Tax Identification Number
Hungary Value Added Tax Number

India

India Permanent Account Number (PAN)
India Unique Identification (Aadhaar) Number

Indonesia

Indonesia Identity Card (KTP) Number
Ireland

Ireland Personal Public Service (PPS) Number
Ireland Personal Public Service (PPS) Number v2

Israel

Israel National ID
Israel Bank Account Number

Italy

Italy Driver’s License ID
Italy Fiscal Code Italy
Value Added Tax Number

Japan
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Japan Bank Account Number
Japan Driver’s License Number
Japan “My Number” (personal)
Japan “My Number” (corporate)
Japan Resident Registration Number
Japan Residence Card Number
Japan Social Insurance Number (SIN)
Japan Passport Number

Luxembourg

Luxembourg National Identification Number (Natural persons)
Luxembourg National Identification Number (Non-natural persons)

Malta

Malta Identity Card Number
Malta Tax Identification Number

New Zealand

New Zealand Bank Account Number
New Zealand Driver’s License Number
New Zealand Inland Revenue Number
New Zealand Ministry of Health Number
New Zealand Social Welfare Number

Philippines

Philippines Unified Multi-Purpose ID Number
Portugal

Portugal Citizen Card Number
Portugal Tax Identification Number

Singapore

Singapore National Registration ID card (NRIC) Number
South Africa

South Africa Identification Number
South Korea

South Korea Resident Registration Number
Spain

Spain DNI
Spain Social Security Number (SSN)
Spain Tax Identification Number

Switzerland

Swiss Social Security Number AHV
Taiwan

Taiwan National ID
Taiwan Resident Certificate (ARC/TARC)
Taiwan Passport Number

United Kingdom

U.K. Driver’s License Number
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U.K. Electoral Roll Number
U.K. National Health Service (NHS) Number
U.K. National Insurance Number (NINO)
U.K. or U.S. Passport Number
U.K. Unique Taxpayer Reference Number

United States

U.S. Social Security Number (SSN)
U.S. Driver’s License Number
U.S. or U.K. Passport Number
U.S. Individual Taxpayer Identification Number (ITIN)
U.S. Drug Enforcement Agency (DEA) Number
U.S. Bank Account Number

Understanding the Solution Center eSF 
application

Getting started

Installing the application

Before you begin, make sure that you have checked the deployment readiness checklist for Solution Center. For 
more information on deployment readiness, see the "Solution Center" section in Deployment readiness 
checklist on page 25.

The installation and deployment of this application is done in Cloud Fleet Management. To install Solution Center, 
create a configuration and then deploy the configuration to the printer.

For more information on creating and deploying an application, see the following:

"Add applications" section in Creating a configuration on page 146 .
Deploying configurations to printers on page 155.

Make sure that values for the following information are set in the printer:

Device serial number
Device IP address
Device MAC Address
Device Model Name
TCP/IP hostname
TCP/IP domain name

Note: Absence of these information leads to application failure as these information are required for database 
validation.
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Using the application

Accessing the application

Viewing solutions

From the printer home screen, touch Solution Center.
From the Solutions List page, select any of the following:

Personal   

Organizational   

Shared    

Note: Some solutions may not appear. These are referred to as non-executable solutions, 
as they might involve steps that the printer is not able to execute. For example, the 
Download step is not supported in printers. A solution created in Cloud Solution Center 
that includes a Download step will not be visible in the Solution Center eSF application.

To view the details of a specific solution, touch  › View Details.

Note:

The details include solution name, description, type, steps, and default file name.
Relaunch the application to refresh the solution list.

Using a quick run

The quick run feature executes a solution immediately with all steps preconfigured and 
locked from the portal.
To run a solution using quick run, select a solution and then, click Next.

Viewing quotas

From the Solution Center, navigate to the Solutions List screen.
Click  › View Quotas.

The Quotas dialog shows the number of pages used.
If you have quotas for Translation, Redaction, and OCR, then the pages used for these 
actions appear.

Note: On the Quotas screen, you can also view the details about pages used in Translation, Redaction, and 
OCR.
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Navigating through the steps of the application

The Steps screen lets you navigate through steps. You can only modify settings that are 
unlocked in the portal.
On every step, fields can be disabled or enabled in the panel based on the unlock/lock 
settings configured in the portal. If a step is locked in the portal, the step screen does not 
appear on the panel.
Users must have the appropriate roles and access permissions to execute actions like 
Translations, Redactions, and OCR.

From the Solution Center, navigate to the Solutions List screen.
Select a solution, and then click Next.

Note:

The Steps screen shows the configured steps for each selected solution.
On the Steps screen, users can move through the steps by clicking the Next button, up to 
the Summary step.
Clicking the Next button on any step initiates validation for the current step. If there are 
validation issues, users cannot proceed to the next step until the issues are resolved.
You can navigate back to previous steps, if required.

Extracting text with OCR

Optical character recognition (OCR) lets you convert scanned documents into editable text.

From the printer home screen, touch Solution Center, and then select a workflow with an 
OCR step.
On the OCR step, select the output format from the list of options.

Note: Scan Settings on printer side offer limited options in terms of file extensions.

Click Next to apply the settings.

Translating a document

This step lets you scan a file in a source language and translate it to a target language.

Selecting languages

From the printer home screen, touch Solution Center, and then select a workflow with a 
Translate step.
On the Translate step, select the language of the document that you want to translate.
Select one or more target languages.

Note: You can select up to five target languages.
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Redacting information

The Redact feature lets you automatically remove any confidential information such as Personally Identifiable 
Information (PII) from documents.

Configuring redact

From the printer home screen, touch Solution Center, and then select a workflow with a 
Redact step.
On the Redact step, click Add Text to Redact.
Select any one of the following:

Preset—Select predefined redaction settings based on common PII types (for 
example, phone numbers, social security numbers) or specific country regulations.
Custom—Select custom text only if you want to redact specific texts from the file. Do 
any of the following:

In the Specify custom text to redact field, type the text to be redacted.
From the menu, select Whole word only, Contains, or Exact Match.

Note: If a solution created in the Lexmark Cloud Services portal, consists of 
Advanced Match, then you can only delete the custom text from the eSF 
application. You cannot edit or add custom text for Advanced Match from the 
eSF application.

Note:

Users can add up to 20 custom texts only.
If a solution includes a Redact step but does not include an OCR step, then the input file 
type must be DOCX.
If a solution includes both Redact and OCR steps, then the supported input file types are 
image files (such as JPEG or PNG) and PDF.

Sending emails

From the printer home screen, touch Solution Center, and then select a workflow with an 
Email step.
On the Email step, type the email address.
To receive a copy of the email, select Send me a copy.

Note:

The email address has a limit of 255 characters.
Users can proceed to the next step only if at least one email address is added.
If no email addresses are entered, the solution can still run if Send me a copy is enabled.



Solution Center

236

1.

2.
3.

•
•

1.

2.
◦
◦
◦
◦
◦

3.
◦

◦
◦

•
•
•
•
•
•

•

•

Adding a footer

From the printer home screen, touch Solution Center, and then select a workflow with an 
Footer step.
In the Footer field, type the text that you want to appear as the footer of the page.
Click Next to save changes.

Note:

Users can input up to 512 characters in the footer.
The input to the Footer step must be DOCX format.

Configuring cloud storage

The Cloud Storage feature allows you to send documents directly to various cloud platforms.

From the printer home screen, touch Solution Center, and then select a workflow with a 
cloud storage step.
Select a cloud platform from the following:

Microsoft OneDrive
Dropbox
Box
Google Drive
Microsoft SharePoint

Configure the following platform-specific settings:
For OneDrive, Box, and Dropbox, specify the destination folder by setting the Send To 
and Path options.
For Google Drive, set the Drive Name option.
For SharePoint, set the Site Name and Path options.

Note: An error message appears in the following scenarios:

The selected account is signed out.
No cloud storage is selected, and all storage accounts are signed out.
A cloud storage account is disabled in global settings.
A duplicate folder is created.
The folder name exceeds the allowed maximum length.
The path is invalid due to an inaccessible or deleted folder.

Using cloud print queue

The cloud print queue feature allows user to send print jobs directly to the Cloud Print 
Management queue.
Once a print job is uploaded to the cloud, it remains securely stored until the user releases it 
at a physical printer with Print Release application.
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Printing

The Print feature within the Solution Center allows users to print from a connected device.

Users can configure the number of copies to be printed directly from the printer panel.

Editing a file name or file type

Note: You can edit the file name and file type on the panel only if Allow entering a file name from the printer 
panel and Show scan settings on the printer panel are selected in the Lexmark Cloud Services portal, 
respectively.

From the printer home screen, touch Solution Center, and then select a workflow.
In the File screen, click the file name or file type to edit it, and then click OK.

Viewing a summary

From the printer home screen, touch Solution Center, and then select a workflow.
In the Summary screen, you can view the overview of all configured steps.

Executing the application

After configuring all the steps and completing the scan step, click Send to run the solution.

File size limits for scanned steps:

The general file size limit is 50MB.
If the solution includes a Translate step, then the file size limit is reduced to 40MB.
If the solution includes an Email step, then the file size limit is reduced to 25MB.
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Overview
Use the Cloud Scan Management web portal to do the following:

Configure Scan Management settings.
Create scan destinations using the Microsoft OneDrive, SharePoint, Google Drive™, Box, 
and Dropbox cloud service providers.
Customize scan settings for each scan destination.

The Scan Management web portal also works with the Cloud Scan application.
Cloud Scan is an eSF application that lets users scan documents using Lexmark™ printers to destinations set in 
the Lexmark Cloud Services by the Scan Management Administrator.

Note: This feature is available only in some printer models. For more information, see Supported printer 
models on page 28.

Accessing the Scan Management web portal
Open a web browser, and then do either of the following:

From the dashboard, click Scan Management.

Note: If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then click 
Scan Management.

Configuring the Scan Management settings
As an administrator, you can configure the Scan Management settings.

From the Scan Management web portal, click  on the upper‑right corner of the page.
Configure the following settings:

Enable Scan Management for your organization—Allow users to access Scan 
Management from Lexmark Cloud Services.
Allow users to create personal scan destinations—Allow users to create private 
scan destinations that only they can access.
Select at least one cloud storage provider for this organization—Select one or 
more of the following: Microsoft (SharePoint and OneDrive), Google (Google 
Drive), Box, and Dropbox.
Account domains associated with the cloud storage providers (Optional)— 
Specify the list of account domains supported by your organization for your users.

Scan Management
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Note: Make sure to select Enable Scan Management for your organization.

Enable option to choose folder from the printer panel—Allow users to select a 
folder from the control panel.

Click Save Settings.

Managing a cloud storage account
Make sure that you have a Microsoft, Google™, Box, or Dropbox account to create, edit, or use scan 
destinations.
Selecting an account

From the Scan Management web portal, do either of the following:

Click Cloud Storage Account > Select an account > Continue.

Note: Depending on the requirement, select an account from the Microsoft, Google, 
Box, or Dropbox section. This feature is available only if you are not logged in to an 
account.

Click Select an account > Continue.

Sign in to your account.

Changing an account

Note: This feature is available only if you are logged in to your account.

From the Scan Management web portal, click Cloud Storage Account.
From the Microsoft, Google, Box, or Dropbox section, click Change account.
Sign in to your account.

Forgetting an account

Note: This feature is available only if you are logged in to your account.

From the Scan Management web portal, click Cloud Storage Account.
From the Microsoft, Google, Box, or Dropbox section, click Forget this account > Forget 
Account.

Managing scan destinations
A scan destination is a cloud storage service to which a user can send scanned documents. A Scan Management 
Administrator enables and manages the scan destination in the Lexmark Cloud Services.

The following cloud storage services are used for scan destinations:

Microsoft OneDrive
Microsoft SharePoint
Google Drive™
Box
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Dropbox

Note: Make sure that you have a Microsoft, Google, Box, or Dropbox account to access cloud storage 
services and to manage scan destinations.

Creating a scan destination

From the Scan Management web portal, select either Organizational or Personal.

Notes
The Personal tab is available only if the administrator enables Allow users to 
create personal scan destinations. For more information, see Configuring the 
Scan Management settings on page 238.
If you want to create a private scan destination, then select Personal.

Click Create.
Configure the settings.

General

Scan Destination Name
Description (Optional)
Cloud storage service—Configure either of the following:

Google Drive

From the Drive name menu, select the destination Google Drive.
From the Scan location folder section, click Choose Folder > Select the 
folder > Choose Folder to select the destination Google Drive folder.

OneDrive—This option is private to each user's account, and the configuration 
is setting the structure for file storage in their account only. When an 
organizational OneDrive scan destination is executed, the path and folder 
structure is created on the user’s OneDrive account.

Notes
The administrator account does not have access to the user's folders.
The users of the configuration do not have access to the administrator’s 
account folders. When a user tries to access the Organizational profile 
from the control panel and then clicks the folder navigation icon, an 
error message appears. The user must select another folder in the drive 
to scan to that location.

From the Scan location folder section, click Choose Folder to browse to 
the scan destination folder.

Notes
If the folder structure does not exist, then it is created.
Administrators who need a structure beyond root drives can use 
the folder structure of their OneDrive account as a template.

Select the folder, and then click Choose Folder to select the destination 
OneDrive folder.

SharePoint
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From the Site or library name menu, select the destination SharePoint site 
or library.
From the Scan location folder section, click Choose Folder > Select the 
folder > Choose Folder to select the destination SharePoint folder.

Box

From the Scan location folder section, click Choose Folder to browse to 
the scan destination folder.
Select the folder, and then click Choose Folder to select the destination 
Box folder.

Note: Only personal scan destinations are supported in Box.

Dropbox

From the Scan location folder section, click Choose Folder to browse for 
the scan destination folder
Select the folder, and then click Choose Folder to select the destination 
Dropbox folder.

Note: Only personal scan destinations are supported in Dropbox.

Note: To discard a folder, click Cancel.

File name—Specify the file name for the scanned image.
Append a date-time stamp to the file name—Add the date and time to the name of 
the scanned file.
Allow entering a file name from the control panel—Let the user specify a file name 
before the scan job starts.
Show scan settings on the control panel—Show the scan settings before the scan 
job starts.
Allow changing the folder from the control panel—Let the user choose the folder 
from the control panel.

Scan Settings

Use default scan settings—Use the default printer settings.
Use custom scan settings—Configure the scan settings of the printer.

Note: Some settings are available only in some printer models.

Enable scan preview if supported by the printer
Color mode
Content type
Original size
Sides—Specify the page orientation of text and graphics when scanning a 
two‑sided document.
Resolution
File Format—Select the file format from TIFF, JPEG, and PDF.

Note: If Show Scan settings on the control panel is enabled, then you can 
change the file type.
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Enable custom scan job
Contrast

Click Create Destination.

Editing a scan destination

From the Scan Management web portal, in the list of scan destinations, select a scan 
destination.
Configure the settings.
Click Save Changes.

Deleting a scan destination

From the Scan Management web portal, in the list of scan destinations, select one or more 
scan destinations.
Click Delete > Delete Destination.

Sending scan jobs using the Cloud Scan 
application

Notes

You can scan to up to 50 destinations.
Only administrators can create destinations.
Scanning to multiple destinations is not supported.
If the Device Quotas application is running in your printer, then stop or uninstall it when 
scanning to a destination.

You can deploy scan configuration to printers. Administrators can deploy Cloud Scan Management configuration 
from the Cloud Fleet Management applications catalog so that the Cloud Scan and Cloud Authentication 
applications are installed to the printer. For more information on deploying configurations to printers, see 
Deploying configurations to printers on page 155.

Load a document into the automatic document feeder or on the scanner glass.
From the printer home screen, touch Cloud Scan.
Select a scan destination, and then touch Next.
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Notes
Make sure that you are logged in to your cloud account. If necessary, touch E‑mail 
to send instructions to your email on how to log in.
In some older printer models, some text may scroll very fast while navigating the 
scan details.
In some older printer models, some text may appear bigger for lengthy scan details.
In some models, the Scan Destination page and Scan settings page may display 
inconsistent translated text.
If the printer has hard drive, you can upload a JPEG file with a maximum file size of 
50MB.
For printers with eSF version 4.0 or earlier, Cloud Scan Management application 
performance is slower as compared to printers with eSF version 5.0 or later.

Type the file name, and then touch Next.

Notes
Make sure that Allow entering a filename from the control panel is selected on 
the Cloud Scan Management portal.
If needed, you can update the folder location in the panel.

If necessary, change the scan settings.

Notes
Make sure that Show scan settings on the control panel is selected on the Cloud 
Scan Management portal.
The maximum file size is 50MB.
If you want to scan a multi‑page document, then select Scan The Next Page.

Touch Send.
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Use the Analytics web portal to generate reports on usage and printer activity.

Accessing the Analytics web portal

Note: The screenshots may vary depending on the latest release.

Open a web browser, access the Lexmark Cloud Services dashboard, and then do either of the following:

From the dashboard, click the Analytics card.

Note: If the card is not available, then add the card. For more information, see Managing 
the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then click 
Analytics.

Notes

To access Analytics 2.0 from the Analytics web portal, click Check out the new Beta 
Analytics 2.0 here. On the Analytics 2.0 page, you can view the reports. The reports are 
categorized into Cloud Print Management Reports,  Cloud Fleet Management 
Reports, and Cloud Solution Center Reports. You can only access and generate 
reports based on your entitlement and user role.
If you have partner administrator rights, then you must select the organization to access 
Analytics 2.0.

Accessing the Full Data Export report

Full Data Export report is now available in Analytics 2.0. This report is available only for Cloud Print 
Management Reports.

To access the Full Data Export report, do the following:

From the Analytics web portal, click Check out the new Beta Analytics 2.0 here.
If accessing Analytics 2.0 for the first time, accept the terms of use.
Select the organization, and then click Next.
Click Full Data Export.
In the Full Data Export window, do the following:

From the Reporting Period menu, select the period for which you want the report.

Analytics
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Click Send Report.

Note: The report is sent to your email address.

Feedback

You can provide your feedback about reports by clicking Feedback on the right side of the screen in any 
generated report. On the Feedback window, you can rate your experience and provide your feedback. Click 
Submit to send your feedback.

Understanding reports
Reports can include dates up to two years before the current date.

Notes

An impression is a side of a sheet of paper that contains toner.
A page is a digital area where content is printed.
A sheet is a piece of paper.



Analytics

246

•

◦

◦

◦

◦

•

•

•

Report Level Report type Report items

Organization

Note: For Organization 
level report, you have the 
option of selecting either 
Analytics 1.0 or Analytics 
2.0.

Organization Overview— 
Shows an overview of the 
printer activities of the 
organization over the 
specified date range.

Total

Impressions— 
The total 
number of 
impressions 
that are printed.
Sheets—The 
total number of 
sheets that are 
printed.
Printed Jobs— 
The total 
number of 
printed jobs.
Total Jobs In 
Queue Now— 
The total 
number of jobs 
that are 
currently in the 
Lexmark Cloud 
Services print 
queue.

Printed / Deleted 
(Pages)—A graph 
that shows the 
number of pages that 
are printed and the 
number of pages that 
are deleted, based on 
the number of 
submitted pages. 
Pages that are 
deleted are expired or 
were removed 
manually.
Job Size (Number of 
Jobs)—A graph that 
shows a distribution 
of the job size based 
on the number of 
submitted pages for 
each job.
Paper Size (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper size.
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Department

Note: For Department 
level report, you have the 
option of selecting either 
Analytics 1.0 or Analytics 
2.0.

Department Overview— 
Shows an overview of the 
printer activities of the 
selected department over 
the specified date range.

Paper Type (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper type.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Print Usage 
(Impressions)—A 
graph that shows the 
daily print usage over 
the specified date 
range.
Submitted Jobs

Submission 
Methods 
(Pages)—A 
graph that 
shows the 
number of 
pages 
submitted per 
submission 
method, such 
as web 
browser, e-mail, 
or mobile 
device.
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Cost Center Cost Center Overview— 
Shows an overview of the 
printer activities of the 
selected cost center over 
the specified date range.

Document 
Type (Pages) 
—A graph that 
shows the 
number of 
pages 
submitted per 
job type, such 
as text or 
image.

Most Used Printers 
—A table that lists the 
printers with the 
highest usage. The 
list shows the last 
known IP address 
and model name of 
the printers, and are 
sorted based on the 
number of printed 
impressions.
Top Users—A table 
that lists the users 
with the highest 
usage. The list shows 
the user name and e- 
mail address of the 
users, and are sorted 
based on the total 
number of printed 
impressions per user.

Full Data Export Full Data Export—The 
feature allows users to 
select monthly or up to 31 
days of data in the custom 
date range for report 
generation. It sends an 
e‑mail with links to 
download reports with all 
user level transactional data 
captured by Cloud Print 
Management. The e‑mail 
contains links to download 
two reports, one for 
submission, and the other 
for release.
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Full Data Export Notes

The e‑mail is sent 
to the e‑mail 
address of the 
logged‑in user.
The e‑mail has 
information like the 
organization and 
duration for which 
the report is 
generated, and 
expiry time of the 
link.
The Full Data 
Export report in 
Analytics 2.0 also 
has information like 
last data sync time.
For 
PRINTJOBNAMES, 
the report supports 
English file names 
only. For more 
information on 
getting the correct 
file name for other 
languages, see 
Report does not 
show the correct 
file name on page 
309.
Full Data Export 
report is now 
available in 
Analytics 2.0. In 
Analytics 2.0, this 
report is available 
only for Cloud Print 
Management 
Reports. For more 
information on Full 
Data Export report 
in Analytics 2.0, 
see Accessing the 
Analytics web 
portal on page 244.

Total

Impressions— 
The total 
number of 
impressions 
that are printed.
Sheets—The 
total number of 
sheets that are 
printed.
Printed Jobs— 
The total 
number of 
printed jobs.
Total Jobs In 
Queue Now— 
The total 
number of jobs 
that are 
currently in the 
Lexmark Cloud 
Services print 
queue.

Printed / Deleted 
(Pages)—A graph 
that shows the 
number of pages that 
are printed and the 
number of pages that 
are deleted, based on 
the number of 
submitted pages. 
Pages that are 
deleted are expired or 
were removed 
manually.
Job Size (Number of 
Jobs)—A graph that 
shows a distribution 
of the job size based 
on the number of 
submitted pages for 
each job.
Paper Size (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper size.
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Report Level Report type Report items

User

Note: For User level 
report, you have the 
option of selecting either 
Analytics 1.0 or Analytics 
2.0.

User Overview—Shows an 
overview of the printer 
activities of the selected 
user over the specified date 
range.

Paper Type (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper type.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Print Usage 
(Impressions)—A 
graph that shows the 
daily print usage over 
the specified date 
range.
Submitted Jobs

Submission 
Methods 
(Pages)—A 
graph that 
shows the 
number of 
pages 
submitted per 
submission 
method, such 
as web 
browser, e-mail, 
or mobile 
device.
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Document 
Type (Pages) 
—A graph that 
shows the 
number of 
pages 
submitted per 
job type, such 
as text or 
image.

Most Used Printers 
—A table that lists the 
printers with the 
highest usage. The 
list shows the last 
known IP address 
and model name of 
the printers, and are 
sorted based on the 
number of printed 
impressions.
Top Users—A table 
that lists the users 
with the highest 
usage. The list shows 
the user name and e- 
mail address of the 
users, and are sorted 
based on the total 
number of printed 
impressions per user.
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Client Version Export Client Version Export— 
Downloads a report of every 
user's last print job 
submission details. The 
report captures submission 
through the LPMC or 
Google Chrome extension 
client only. The report also 
contains the version 
number of the client that is 
used during the last job 
submission.

Note: If a user uses two 
different versions of the 
same client, then the 
report captures only the 
latest version of the 
client.

Total

Impressions— 
The total 
number of 
impressions 
that are printed.
Sheets—The 
total number of 
sheets that are 
printed.
Printed Jobs— 
The total 
number of 
printed jobs.
Total Jobs In 
Queue Now— 
The total 
number of jobs 
that are 
currently in the 
Lexmark Cloud 
Services print 
queue.

Printed / Deleted 
(Pages)—A graph 
that shows the 
number of pages that 
are printed and the 
number of pages that 
are deleted, based on 
the number of 
submitted pages. 
Pages that are 
deleted are expired or 
were removed 
manually.
Job Size (Number of 
Jobs)—A graph that 
shows a distribution 
of the job size based 
on the number of 
submitted pages for 
each job.
Paper Size (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper size.
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Report Level Report type Report items
Paper Type (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper type.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Print Usage 
(Impressions)—A 
graph that shows the 
daily print usage over 
the specified date 
range.
Submitted Jobs

Submission 
Methods 
(Pages)—A 
graph that 
shows the 
number of 
pages 
submitted per 
submission 
method, such 
as web 
browser, e-mail, 
or mobile 
device.
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Report Level Report type Report items
Document 
Type (Pages) 
—A graph that 
shows the 
number of 
pages 
submitted per 
job type, such 
as text or 
image.

Most Used Printers 
—A table that lists the 
printers with the 
highest usage. The 
list shows the last 
known IP address 
and model name of 
the printers, and are 
sorted based on the 
number of printed 
impressions.
Top Users—A table 
that lists the users 
with the highest 
usage. The list shows 
the user name and e- 
mail address of the 
users, and are sorted 
based on the total 
number of printed 
impressions per user.

Sample Organization Overview report
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Sample User Overview report
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Report Level Report type Report items

Printer Printer Overview—Shows 
an overview of the Lexmark 
Cloud Services tracked 
usage of the selected 
printer, based on the printer 
serial number.

Total

Impressions— 
The total 
number of 
impressions 
that are printed.
Sheets—The 
total number of 
sheets that are 
printed.
Printed Jobs— 
The total 
number of 
printed jobs.
Users—The 
total number of 
users that are 
using the 
selected printer.

Job Size (Number of 
Jobs)—A graph that 
shows a distribution 
of the job size based 
on the number of 
submitted pages for 
each job.
Paper Size (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper size.
Paper Type (Pages) 
—A graph that shows 
the number of pages 
that are printed per 
paper type.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
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Note: This report 
appears only for 
color printers.

Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Print Usage 
(Impressions)—A 
graph that shows the 
daily print usage over 
the specified date 
range.
Scan Usage (Pages) 
—A graph that shows 
the total number of 
pages scanned per 
job type.

Note: This report 
appears only if the 
selected printer is 
an MFP.

Top Users—A table 
that lists the users 
with the highest 
usage. The list shows 
the user name and e- 
mail address of the 
users, and are sorted 
based on the total 
number of printed 
impressions per user.
Top Cost Centers— 
A table that lists the 
cost centers with the 
highest usage.
Top Departments—A 
table that lists the 
departments with the 
highest usage.
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Report Level Report type Report items

Print Job History—Shows 
the print jobs of the selected 
printer.

A table that lists all the print 
jobs of the selected printer. 
The list also shows the 
details per print job, such as 
the release time, 
impressions, page count, 
user, e‑mail address, 
department, and cost center 
where the user belongs.

Printer Supplies History— 
Shows the printer supplies 
used.

A table that lists the 
supplies used in the 
selected printer while it was 
enrolled in Lexmark Cloud 
Services.
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Report Level Report type Report items

Printer Printer Hardware 
Statistics—Shows the 
lifetime page counter 
information and the toner 
supply levels of the selected 
printer.

Total

Impressions— 
The total 
Lifetime Page 
Count of the 
selected printer 
over the 
specified date 
range.
Lifetime 
Impressions 
to Date—The 
most recent 
Lifetime Page 
Count of the 
selected printer.

Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that were 
printed over the 
specified date range.
Coverage Tiers—A 
chart that shows the 
tiered color usage. 
The amount of color 
toner on the page 
determines whether 
the page falls into the 
Highlight Color tier, 
Business Color tier, or 
Graphics Color tier.

Note: This report 
appears only in 
some printer 
models.
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Report Level Report type Report items
Lifetime 
Impressions to Date 
—A chart that shows 
the increasing 
Lifetime Page Count 
over the specified 
date range.
Cartridge Usage—A 
graph that shows the 
cartridge usage over 
the specified date 
range.

Sample Printer Overview report
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Report Level Report type Report items

Organization, Cost 
Center, Department

Usage Analysis—Shows a 
detailed report on the 
printer usage of the 
organization, or department 
over the specified date 
range. This report also 
shows some analysis on the 
fleet usage, such as 
potential savings and 
environmental impact.

Total

Number of 
Active Users— 
The total 
number of 
users that have 
printed or 
scanned.
Number of 
Active Printers 
—The total 
number of 
printers that are 
used in printing 
or scanning.
Impressions— 
The total 
number of 
impressions 
that are printed.
Sheets—The 
total number of 
sheets that are 
printed.
Number of 
Printed Jobs— 
The total 
number of 
printed jobs.

Printed / Deleted 
(Pages)—A graph 
that shows the 
number of pages that 
are printed and the 
number of pages that 
are deleted, based on 
the number of 
submitted pages. 
Pages that are 
deleted are expired or 
were removed 
manually.
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Report Level Report type Report items
Job Size (Number of 
Jobs)—A graph that 
shows a distribution 
of the job size based 
on the number of 
submitted pages for 
each job.
Submission 
Methods (Jobs)—A 
graph that shows the 
number of jobs 
submitted per 
submission method, 
such as web browser, 
e-mail, or mobile 
device.
Submission 
Methods (Pages)—A 
graph that shows the 
number of pages 
submitted per 
submission method, 
such as web browser, 
e-mail, or mobile 
device.
Duplex Usage

Duplex / 
Simplex 
Printers—A 
graph that 
shows the 
number of 
printers that 
have a two- 
sided printing 
feature, and the 
number of 
printers that 
can do only 
one-sided 
printing.
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Report Level Report type Report items
Impressions 
on Duplex / 
Simplex 
Printers—A 
graph that 
shows the 
number of 
impressions 
printed on 
printers that 
have a two- 
sided printing 
feature, and the 
number of 
impressions 
printed on 
printers that 
can do only 
one-sided 
printing.
Duplex / 
Simplex 
Usage 
(Impressions) 
—A graph that 
shows the total 
number of 
impressions 
printed as two- 
sided jobs and 
the total 
number of 
impressions 
printed as one- 
sided jobs.
Potential 
Savings—The 
number of 
sheets of paper 
that could be 
saved when all 
jobs are printed 
as two-sided 
jobs.

Color Usage
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Report Level Report type Report items
Color / Mono 
Printers—A 
graph that 
shows the 
number of color 
printers and the 
number of 
black‑and‑white 
printers that 
have printed or 
scanned.
Impressions 
on Color / 
Mono Printers 
—A graph that 
shows the 
number of 
impressions 
printed on color 
printers and the 
number of 
impressions 
printed on 
black‑and‑white 
printers.
Color / Mono 
Usage 
(Impressions) 
—A graph that 
shows the total 
number of color 
impressions 
and the total 
number of 
black‑and‑white 
impressions 
that are printed.
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Report Level Report type Report items

Organization, Cost 
Center, Department

Usage Analysis—Shows a 
detailed report on the 
printer usage of the 
organization, or department 
over the specified date 
range. This report also 
shows some analysis on the 
fleet usage, such as 
potential savings and 
environmental impact.

Top Users—A table 
that lists the users 
with the highest 
usage. The list shows 
the user name and e- 
mail address of the 
users, and are sorted 
based on the total 
number of printed 
impressions per user.

Most Used Printers 
—A table that lists the 
printers with the 
highest usage. The 
list shows the last 
known IP address 
and model name of 
the printers, and are 
sorted based on the 
number of printed 
impressions.
Least Used Printers 
—A table that lists the 
printers with the 
lowest usage. The list 
shows the last known 
IP address and model 
name of the printers, 
and are sorted based 
on the number of 
printed impressions.
Environmental 
Impact—The 
computed 
environmental impact 
based on the amount 
of printing done. This 
computation uses the 
Environmental Paper 
Network Paper 
Calculator version 
3.2.1. For more 
information, go to the 
Environmental Paper 
Network website.

Sample Usage Analysis report
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Report Level Report type Report items

Organization, Cost 
Center, Department, User

Printer Activity—Shows 
the summary of the print 
and scan activities of all the 
printers of the organization, 
department, or user.

Print Activity—A table that 
lists the printers and shows 
their last known IP address, 
model name, and serial 
number. The list also shows 
the total number of printed 
impressions, and the 
breakdown of the sources 
of the impressions.

Scan Activity—A table that 
lists the printers and shows 
their last known IP address, 
model name, and serial 
number. The list also shows 
the total number of scanned 
pages.
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Report Level Report type Report items

Organization, Cost 
Center, Department, User

Printer Activity Detail— 
Shows a detailed Printer 
Activity report. The list 
shows all the jobs and more 
information about each job.

When using Direct Print 
submission, if the printer 
does not have the correct 
version of Device Usage 
eSF application installed, 
then analytics data is not 
presented the same way as 
other user‑related print 
data. In this case, the data 
differs in the following ways:

The user print job 
details are displayed 
in the Printer Activity 
Detail report.
The IP address 
column shows 
<x.y.z.y>(Direct), 
where <x.y.z.y> is the 
IP address of the 
printer.
Page numbers and 
other metadata 
reflected for the print 
job details represent 
the user intent of the 
submission and may 
not represent the 
actual print output. 
For instance, a user 
may send a four‑page 
color job to a mono 
printer without the 
correct version of the 
eSF application. In 
this case, the job 
details show that a 
four‑page color job 
was printed.

Print Activity—A table that 
lists all the print jobs, and 
shows their owner 
information, time stamp, job 
type, and printer 
information. The list also 
shows the number of 
printed impressions on each 
print job with a breakdown 
of the sources of the 
impressions.

Scan Activity—A table that 
lists all the print jobs, and 
shows their owner 
information, time stamp, job 
type, and printer 
information. The list also 
shows the number of 
scanned pages.
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Report Level Report type Report items

Organization, Cost 
Center, Department

User Usage—Shows the 
print usage of all the users 
in the organization, 
department, or cost center.

Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of black 
and white 
impressions that are 
printed.
Print Activity—A 
table that lists all the 
users in the 
organization, 
department, or cost 
center, and the 
number of 
impressions printed 
per user.
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Report Level Report type Report items

Organization Customer Usage—Shows 
the print usage of all the 
child organizations.

Note: This report type is 
available only to partner 
administrators.

Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Print Activity—A 
table that lists all the 
child organizations, 
and shows the total 
number of 
impressions printed 
per child organization.
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Report Level Report type Report items

Organization Department Usage— 
Shows the print usage per 
department.

Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Print Activity—A 
table that lists all the 
departments in the 
organization, and 
shows the total 
number of 
impressions printed 
per department.
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Report Level Report type Report items

Organization Cost Center Usage— 
Shows the print usage per 
cost center.

Duplex / Simplex 
Usage 
(Impressions)—A 
graph that shows the 
total number of 
impressions printed 
as two-sided jobs and 
the total number of 
impressions printed 
as one-sided jobs.
Color / Mono Usage 
(Impressions)—A 
graph that shows the 
total number of color 
impressions and the 
total number of 
black‑and‑white 
impressions that are 
printed.
Print Activity—A 
table that lists all the 
cost centers in the 
organization, and 
shows the total 
number of 
impressions printed 
per cost center.

Organization Customer Usage Detail— 
Shows a detailed Customer 
Usage report containing the 
print and scan activities.

Note: This report type is 
available only to partner 
administrators.

Print Activity—A table that 
lists all child organizations, 
and shows the total number 
of impressions printed per 
child organization.

Scan Activity—A table that 
lists all child organizations, 
and shows the total number 
of scanned pages per child 
organization.
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Report Level Report type Report items

Organization Department Usage Detail 
—Shows a detailed 
Department Usage report 
containing the print and 
scan activities.

Print Activity—A table that 
lists all the departments in 
the organization, and shows 
the total number of 
impressions printed per 
department.

Scan Activity—A table that 
lists all the departments in 
the organization, and shows 
the total number of scanned 
pages per department.

Organization Cost Center Usage Detail 
—Shows a detailed Cost 
Center Usage report 
containing the print and 
scan activities.

Print Activity—A table that 
lists all the cost centers in 
the organization, and shows 
the total number of 
impressions printed per cost 
center.

Scan Activity—A table that 
lists all the cost centers in 
the organization, and shows 
the total number of scanned 
pages per cost center.

Organization Printer Hardware Detail— 
Shows the hardware 
statistics for all the printers 
in the organization.

A table that lists all the 
printers in the organization. 
The list includes the serial 
numbers, IP addresses, 
model names, asset tags, 
and page counts.

Organization Customer Printer 
Hardware Detail—Shows 
the hardware statistics for 
all the printers in all child 
organizations.

Note: This report is 
available only for partner 
administrators when the 
partner organization is 
selected.

A table that lists all the 
printers in all child 
organizations. The list 
includes the organization 
names, serial numbers, IP 
addresses, model names, 
asset tags, and page 
counts.
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Report Level Report type Report items

Organization Users A table that lists all the 
users of the organization 
defined in the Account 
Management web portal 
that existed during the 
selected date range of the 
report. The list includes the 
membership information for 
departments and cost 
centers, including when 
they were added or 
removed from departments 
or cost centers.

Organization, Cost 
Center, Department, User

Detailed Submitted Job 
Activity—Shows all the 
jobs submitted to Lexmark 
Cloud Services for print 
release by the selected 
organization, department, or 
user.

A table that lists all the 
documents submitted for 
print release and the user 
information for that 
document.

User Print Job History—Shows 
all the print jobs of the 
selected user.

A table that lists all the print 
jobs of the selected user. 
The list also shows the 
number of pages and 
impressions of the job, the 
job properties, and the 
printer used.

Generating reports
From the Analytics web portal, select a report level.

Notes
The Report Level options vary depending on your role.
A partner administrator and a Fleet Management Reporting Analyst can select from 
the list of customer organizations, and can generate reports at the organization 
level.
An organization administrator and a Print Release Management Reporting Analyst 
can select a specific user, cost center, or department within the organization. They 
can also generate their corresponding usage reports. These options are also 
applicable to the Print Release Management Administrator role.
Users can generate only their own usage reports.

Do either of the following:

For the User, Cost Center, Department, or Printer reports, do the following:

Type the user, cost center, department name, or printer serial number.
Select a report type.
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Select a date range.
For the Organization reports, select a report type and date range.

Note: To show users that were removed from the organization, cost center, or department, 
select Show Deleted Users.

Click Generate Report.

Notes

When you generate reports for an Organization, User, or Department, a confirmation 
message appears. Select either Continue with Analytics 1.0 or Go to Analytics 2.0.
You can also generate reports using the report cards from the dashboard.

Exporting reports
Do either of the following:

From the Analytics web portal, generate a report.
From the dashboard, click a card.

Click  on the upper‑right corner of the table that you want to export.

Notes

The report is saved in a CSV file.

To print the reports with a formatted layout, click .

Understanding the Cloud Print Management 
reports

Understanding the Print Outliers report

From the Analytics web portal, click Check out the new Beta Analytics 2.0 here.
Accept the acknowledgement terms.

Note: You have to accept the acknowledgement terms only when you are accessing 
Analytics 2.0 for the first time.

Select the organization, and then click Next.
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Notes
You must have the Print Management administrator role to access the Print Outlier 
report. If you are in a partner set‑up, then you can select a child organization.
You can set the time period for which you need the report. The maximum range is a 
one-year window within the prior two years.
By default, the outlier report shows top 30 departments or users in the relevant 
report. You can disable the Show Only Top 30 option to view all the departments or 
users in the reports.
If there are users not associated with any departments, then they are grouped under 
alias. The group is termed as No department associated.
The reports are now categorized into Cloud Print Management Reports, Cloud Fleet 
Management Reports, and Cloud Solution Center Reports.

From the report menu, select Print Outliers (beta).
On the Cloud Print Management Reports - Outliers (beta) window, do the following:

In the Report Options section, select Show deleted users to include deleted users in 
the report.
From the Reporting Period menu, select the time period for the report.

Click Generate Report

Key performance indicators report

On the top-left part of the screen, from the reports menu, you can select other reports to which you have access.

The key performance indicators for print usage include the following:

Total—Shows the total number of print impressions.
Color—Shows the total number of color print impressions.
One Sided, Multi Sheet—Shows the total number of one‑sided print impressions on two or 
more sheets. This data does not include single‑page print impressions.

Tree map report

The tree map shows the distribution of print impressions across departments under a particular organization or 
child organization. On clicking each of the departments in the tree map report, you can get the outlier details of 
that particular department. In the department outlier, on clicking each of the users, you can get the outlier details 
of a particular user.
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Print history

The graph shows the trend in total, colored, and one‑sided multi‑sheet print impressions across the organization.

Top departments in an organization

The section shows the list of departments and their corresponding print impressions. You can use the Total, Color, 
and One Sided, Multi Sheet tabs to view the respective print impressions in each category.

Note: You can search for a particular department by typing the name of the department in the Search 
Departments text field.

Top users in an organization

The section shows the list of users and their corresponding print impressions. You can use the Total, Color, and 
One Sided, Multi Sheet tabs to view the respective print impressions in each category.

Notes

You can search for a particular user by typing the name of the user in the Search Users 
text field.
You can view the top users in an organization and a department.
You can view each department in the list to view department level data. For instance, once 
you navigate to the department summary page, you can see the top users in that 
particular department.
You can click each username to view the user summary page. You can navigate back to 
the organization‑level data from the menu itself.
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Understanding the Print Summary report

If you are entitled to Cloud Print Management, then you can access the Print Summary report.

Note: The Print Summary report is updated every 24 hours and reflects all print activity up to that time.

From the Analytics web portal, click Check out the new Beta Analytics 2.0 here.
If you are accessing Analytics 2.0 for the first time, then accept the terms of use.
Select the organization, and then click Next.

Notes
You must have the Print Management administrator role to access the Print 
Summary report. If you are in a partner setup, then you can select a child 
organization.
You can set the period for which you need the report. The maximum range is a one- 
year window within the prior two years.
If there are users not associated with any departments, then they are grouped under 
alias. The group is termed as No department associated.
The reports are now categorized into Cloud Print Management Reports, Cloud Fleet 
Management Reports, and Cloud Solution Center Reports.

From the report menu, select Print Summary (beta).
On the Cloud print management Reports - Summary Report (beta) window, do the 
following:

In the Report Options section, select Show deleted users to include deleted users in 
the report.
From the Reporting Period menu, select the time period for the report.

Click Generate Report

Insights

On the top-left part of the screen, from the reports menu, you can select other reports to which you have access.
In the insights section, you can view the key highlights on print usage of an organization or a department. It not 
only highlights key printing patterns but also suggests a probable solution to increase efficiency.

Using the filters for key performance indicators

The key performance indicators for print usage can be filtered based on the following:

Impressions—Shows the total number of impressions. Filters the print usage report based 
on the side of a sheet of paper that contains toner.
Sheets—Shows the total number of sheets used. Filters the print usage report based on a 
physical piece of paper that contains one or two impressions.
Printed Jobs—Shows the total number of print jobs. Filters the print usage report based on 
the file or set of files submitted for printing.
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Key performance indicators report

The key performance indicators for print usage include the following:

One Sided, Multi Sheet—Shows impressions, sheets, or printed jobs in one‑sided printed 
jobs of two or more sheets.

For Impressions, the indicator shows the total number of one‑sided print impressions 
on two or more sheets out of the total number of impressions. The one‑sided print 
impressions data does not include single‑page print jobs.
For Sheets, the indicator shows the total number of sheets used for simplex printing 
against the total number of sheets used for printing. The data related to sheets used 
for simplex printing does not include single‑page print jobs.
For Printed Jobs, the indicator shows the total number of simplex print jobs against 
duplex print jobs.

Color—Shows impressions or printed jobs in color.

For Impressions, the indicator shows the total number of colored and mono 
impressions.
For Sheets, color sheets are not reported.
For Printed Jobs, the indicator shows total number of color print jobs against mono 
print jobs.

Deleted—Shows sheets or printed jobs that are deleted.

For Impressions, deleted impressions are not reported.
For Sheets, the indicator shows total number of deleted sheets against the total 
number of sheets used for printing.
For Printed Jobs, the indicator shows total number of deleted print jobs against the 
total number of print jobs. Here, print jobs are the ones that are submitted for print 
release. All print jobs may not be actually printed as some of them may be deleted 
before print release. Printed jobs are ones that were actually printed.

Client type and client mode

The Client Type chart shows the share for each type of Cloud Print Management submission types. For more 
information on various types of Cloud Print Management submission, see Managing print queues on page 180.

The Client Mode chart shows the share for each type of submitting and releasing print jobs. For more information 
on various types of submitting and releasing print jobs, see Overview on page 169.
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Notes

The Client Type and Client Mode charts can be filtered based on Impressions, Sheets, 
and Printed Jobs.
If any of the charts shows a certain share for Unspecified, then it signifies unavailability of 
data from the Cloud Print Management server.

Details about print jobs

The key performance indicators for print jobs can be viewed from the following:

Printed Jobs—Shows the total number of printed jobs in an organization.
Impressions/Printed Jobs—Shows the average number of impressions per print job in an 
organization.
Sheets/Printed Job—Shows the average number of sheets used per print job in an 
organization.
Largest Printed Jobs in Organization—Shows a list of users with the largest print jobs in 
terms of impressions or sheets. This data is available only if you select either the 
Impressions or the Sheets filter.

Details about printed job size and paper size

Printed Job Size—Shows the percentage of print jobs within a certain range of impression 
count.
Paper Size—Shows the percentage of print jobs using various paper sizes.

Top departments in an organization

The section shows the list of departments and their corresponding data. The data depends on the filter you have 
selected. It can be Impressions, Sheets, or Printed Jobs.

Note: You can click each department name to view the department summary page. You can navigate back to 
the organization‑level data from the menu itself.

Top users in an organization

The section shows the list of users and their corresponding data. The data depends on the filter you have 
selected. It can be Impressions, Sheets, or Printed Jobs.
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Notes

You can view the top users in an organization and a department.
You can view each department in the list to view department level data. For instance, once 
you navigate to the department summary page, you can see the top users in that 
particular department.
You can click each username to view the user summary page. You can navigate back to 
the organization‑level data from the menu itself.

Understanding the Cloud Solution Center reports

Accessing the All Organization report

In the All Organization report, you can access the relevant information for the parent and its child organization.

From the Analytics web portal, click Check out the new Beta Analytics 2.0 here.
If accessing Analytics 2.0 for the first time, accept the acknowledgment terms.
Select the organization, and then click Next.

Note: You must have the Cloud Solution Center administrator role for the parent and child 
organization. Additionally, you must have a child organization with Cloud Solution Center 
transactions to be able to generate the relevant report.

From the Select a Report menu, expand Cloud Solution Center Reports, and then click 
Solution Center Summary (beta).
On the Cloud Solution Center Reports - Summary (beta) window, do the following:

From the Reporting Period menu, select the period for the report.
Click Generate Report.

Understanding the All Organization report

The All Organization report contains the following information:

Usage Summary—Lists the total number of actions for Translations, Redactions, OCR, 
and Unique Printers. In the All Organization report, the total number for each of the actions 
include all the actions from each of the child organizations.
Export CSV—Exports a comprehensive report that includes data from all the child 
organizations. The report includes organization-based information for Usage Date, Action, 
Page Count, Department, Cost Center, User Email, and Client Type.

Note:
The report only includes Translation, Redaction, and OCR actions and their relevant 
page count. For all other actions, the Action or Page Count is reported as 
unknown.
For Client Type, the report indicates whether the action was performed from a 
printer or a browser.

Search Organization—In the All Organization report, type the name of the particular child 
organization to search information specific to it.
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The report categorizes page counts for Translation, Redaction, and OCR for each of the 
child organization. It also provides number of unique printers used to perform each of the 
actions for each of the child organization.

Note: You can click the name of the child organization to access the Single Organization 
report for the particular child organization.

Accessing the Single Organization report

In the Single Organization report, you can access the relevant information for the child organization to which you 
have access.

From the Analytics web portal, click Check out the new Beta Analytics 2.0 here.
If accessing Analytics 2.0 for the first time, accept the acknowledgment terms.
Select the organization, and then click Next.

Note: You must have the administrator role for the child organization to access the report.

From the Select a Report menu, expand Cloud Solution Center Reports, and then click 
Solution Center Summary (beta).
On the Cloud Solution Center Reports - Summary (beta) window, do the following:

From the Reporting Period menu, select the period for the report.
Click Generate Report.

Understanding the Single Organization report

The Single Organization report contains the following information:

Usage Summary—Lists the total number of actions for Translations, Redactions, OCR, 
and Unique Printers. In the Single Organization report, the total number for each of the 
actions include all the actions for each of the users in the child organization.
Export CSV—Exports a comprehensive report that includes data from all the users. The 
report includes user-based information for Usage Date, Action, Page Count, Department, 
Cost Center, User Email, and Client Type.

Note:
The report only includes Translation, Redaction, and OCR actions and their relevant 
page count. For all other actions, the Action or Page Count is reported as 
unknown.
For Client Type, the report indicates whether the action was performed from a 
printer or a browser.

Search User Email—In the Single Organization report, type the email ID of a user to search 
information specific to the user.
The report categorizes page counts for Translation, Redaction, and OCR for each of the 
users. It also provides number of unique printers used to perform each of the actions for 
each of the users.
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Understanding Translation Assistant
Translation Assistant is a subscription service offered by Lexmark Cloud Services. This solution allows you to 
upload a file in a source language and translate it to a target language. You can then download or email the 
translated file. For Customer Identity and Access Management (CIAM) organizations, subscribe to Cloud Print 
Management to send the translated file to your cloud print queue.

Note: Lexmark also offers the Translation Assistant eSF application. This application lets you scan a document 
in a source language and translate it to a target language. You can then print or email the translated document. 
For more information, see the Translation Assistant Administrator’s Guide.

Supported source file formats

PDF
CSV
HTML, HTM
XLF
MARKDOWN, MDOWN, MKDN, MD, MKD, MDWN, MDTXT, MDTEXT, RMD
XLSX, XLS
PPTX, PPT
DOCX, DOC
ODT
ODP
ODS
RTF
TSV, TAB
TXT

Notes

Some file formats may be converted during translation.
The maximum source file size is 40MB.
Translation Assistant supports adding a footer text to all pages of the translated files. If this 
feature is enabled, then the Translation Assistant supports only DOCX files.
If the source language is French Canadian, then DOCX files are not supported as an 
output file format.

Supported source and target languages

Afrikaans Fijian Kannada* Pashto* Sesotho

Albanian Filipino Kazakh Persian* Sesotho sa 
Leboa

Translation Assistant
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Amharic* Finnish Kinyarwanda Polish Lower Sorbian

Arabic* French Khmer* Brazilian 
Portuguese

Latin Swahili

Armenian* Canadian 
French

Korean Portuguese Swedish

Assamese* Galician Konkani Punjabi* Tahitian

Latin 
Azerbaijani

Georgian* Central 
Kurdish*

Queretaro 
Otomi

Tamil*

Basque German Northern 
Kurdish

Romanian Latin Tatar

Bangla* Greek Cyrillic Kyrgyz Russian Telugu*

Bashkir Gujarati* Lao* Latin Samoan Thai*

Latin Bosnian Haitian Creole Latvian Cyrillic Serbian Tibetan*

Bulgarian Hausa Lithuanian Latin Serbian Tigrinya*

Traditional 
Cantonese

Hebrew* Macedonian Slovak Tongan

Catalan Hindi* Malagasy Slovenian Turkish

Literary 
Chinese

Latin Hmong 
Daw

Latin Malay Arabic Somali Latin Turkmen

Simplified 
Chinese

Hungarian Malayalam* Spanish Ukrainian

Traditional 
Chinese

Icelandic Maltese Rundi Upper Sorbian

ChiShona Indonesian Maithili Russian Urdu*

Croatian Inuinnaqtun Maori Cyrillic Serbian Arabic 
Uyghur*

Czech Igbo Marathi* Latin Serbian Latin Uzbek

Danish Inuktitut Cyrillic 
Mongolian

Sindhi Vietnamese

Dari* Latin Inuktitut Traditional 
Mongolian*

Sinhala Welsh

Divehi* Lingala Myanmar* Slovak Xhosa

Dutch Luganda Nepali* Slovenian Yoruba

English Irish Norwegian Arabic Somali Yucatec Maya

Estonian Italian Nyanja Spanish Zulu
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Faroese Japanese Odia* Setswana Bhojpuri

Bodo Dogri Kashmiri

*Printing 
DOCX files is 
not supported 
in these 
languages.

Supported auto‑detect source languages

Translation Assistant can automatically detect the following languages on uploaded source documents:

Afrikaans Divehi Hebrew Central 
Kurdish

Persian Latin 
Swahili

Albanian Dutch Hindi Lao Polish Swedish

Arabic English Hungarian Latvian Brazilian 
Portuguese

Tahitian

Armenian Estonian Icelandic Lithuanian Romanian Thai

Bulgarian Finnish Indonesian Macedonia 
n

Russian Turkish

Catalan French Inuktitut Latin Malay Cyrillic 
Serbian

Ukrainian

Simplified 
Chinese

Georgian Irish Maltese Latin 
Serbian

Urdu

Traditional 
Chinese

German Italian Traditional 
Mongolian

Slovak Latin 
Uzbek

Croatian Greek Japanese Myanmar Slovenian Vietnames 
e

Czech Gujarati Khmer Norwegian Arabic 
Somali

Welsh

Danish Haitian 
Creole

Korean Pashto Spanish Yucatec 
Maya

Using Translation Assistant

Note: You must have the Translation Assistant User role in an organization that is subscribed to Translation 
Assistant.

Open a web browser, access the Lexmark Cloud Services dashboard, and then do either of 
the following:
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From the Lexmark Cloud Services dashboard, click the Translation Assistant card.

Note: The Translation Assistant card appears in the dashboard by default for new 
users. If the card is not available in the dashboard, then add the card. For more 
information, see Managing the dashboard on page 21.

From your current web portal, click  on the upper‑right corner of the page, and then 
click Translation Assistant.

Accept the terms of use.

Note: You must accept the terms of use every time you access the Translation Assistant.

Upload a source document.

Note: For more information, see Understanding Translation Assistant on page 282.

Select the source language of the source document.

Note: Translation Assistant detects the source language automatically by default. For 
more information, see Understanding Translation Assistant on page 282.

Select a target language.

Note: You can select up to five target languages.

Select how you want to receive your document.

To save the document to your local folder, click Download.
To send the document to your registered Lexmark Cloud Services email address, click 
Email.

Note: Some email services limit the file attachment size. If the file size of the 
document exceeds 10MB, then we recommend downloading it.

For CIAM organization, to send the document to your Lexmark Cloud Services Print 
Management queue, click Send to cloud print queue.

Note: You must be subscribed to Cloud Print Management to enable this option.

Click Translate File, and then wait for the translation to complete.

Note: For Send to cloud print queue, if the output is set to DOCX, some languages may 
print with garbage characters due to font limitations of the languages.

Appending a footer text to each translated page

Note: Only users with the Translation Assistant Administrator role can enable this feature. If this feature is 
enabled, then it applies to all Translation Assistant users in the organization. The footer only applies to the 
Translation Assistant web portal. It is not applicable to eSF application.
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From the Translation Assistant web page, click  on the upper‑right corner of the 
page.
Select Append footer text to each page of translated file.

Note: This option supports only DOCX files.

Type the footer text.
To translate the footer along with the document, select Translate the footer text.
Click Save Settings.

Translation Quota
You must have available translation quota to use Translation Assistant. Contact your administrator if you have 
exceeded your translation quota.

Managing the distribution of translation quotas in child 
organizations

Partner users that possess the Solutions Quota Administrator role in the Child Organization Access group can 
manage the distribution of translation quotas in child organizations.

Note: You cannot distribute more pages than you have purchased.

Distributing translation quotas to child organizations

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions tab, click Distribute Pages.
Type the name of the child organization, and then specify their translation quota.
If necessary, select the Send notification when distribution is nearly empty check box.
Click Distribute Pages.

Updating existing quota distributions

If a child organization runs out of their translation quota, partner organizations can edit the existing distribution of 
the child organization.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions page, click the name of the child organization in the Distribution 
column.
Click Edit, and then update the number of translation pages.
Click Save Changes.
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Using Solution Quota Manager to set translation quotas

If you are a Solutions Quota Administrator, then you can set the default translation quota for users. You can also 
set custom quotas for users and cost centers or departments. By default, all Translation Assistant users share the 
entire quota.

Note: Quota decrements may vary depending on the number of characters in a page. The system counts the 
number of characters, not the pages.

Set the default translation quota for users

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

Click Edit beside Default Quota.
From the Edit Default User Quota window, set the default translation quota for users, and 
then click Save Changes.

Set a custom translation quota for a user

The default quota applies to all Translation Assistant users in the organization, unless a custom quota is assigned 
to the department, cost center, or individual user. The user’s custom quota overrides the default quota of the 
organization, cost center, or department.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

From the Custom Quotas tab,  click Create.
From the Type list, select Personal.
Type the user’s email address, and then set their translation quota.

Note: Users must be registered in the organization before you can assign a custom quota 
to them.

Click Create Quota.

Note: You can click the Usage tab on the Quotas page to check the custom or default quota usage of the user. 
You can also use the Percent Remaining option to filter users and how much quota they still possess.

Set a custom translation quota for a cost center or department

The default quota applies to all users in the organization, unless a custom quota is assigned to the department, 
cost center, or individual user. The custom quota overrides the default quota.

Note: Custom quotas can be set only for either a cost center or a department, but not both. After setting the 
first custom quota for a cost center or department, you can no longer set the custom quota for the other option.
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Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

From the Custom Quotas tab,  click Create.
From the Type list, select Cost center or Department.
Type the name of the cost center or department, and then set its translation quota.
Click Create Quota.

Notes

You can edit existing custom quotas. To do so, click the name of the cost center or 
department from the Custom Quotas tab, set the translation quota, and then click Save 
Changes.
You can click the Usage tab on the Quotas page to check the custom or default quota 
usage of the users. You can also use the Percent Remaining option to filter users and how 
much quota they still possess.

Updating the child organization account

As a partner administrator, you can edit the translation quota of a child organization. You can also revoke or 
suspend their quota distribution.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions tab, click the name of the child organization in the Distribution column.
Click any of the following:

Edit—Edit the translation quota of the child organization.
Suspend—Pause the translation activities of an organization temporarily.
Resume—Resume the translation activities for a suspended organization.
Revoke—Cancel any available translation pages of an organization. Click Continue, 
type the name of the organization to confirm revocation, and then click Revoke.

Note: The translation quota or unused pages of the child organization are returned 
to the partner organization.
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Understanding Mobile Enhanced Solutions
Mobile Enhanced Solutions is a cloud‑based solution offered by Lexmark Cloud Services. It allows you to connect 
to your printers and perform cloud‑based tasks from your mobile device. If this solution is available on your 
multi‑function printer, you will see a QR code on the control panel. On scanning this QR code, the Lexmark Cloud 
Solutions authentication page opens. Once authenticated, you can access the Mobile Enhanced Solutions on 
your mobile device's web browser.

Note: Mobile Enhanced Solutions is available only in printers with 2.8-inch touch-screen displays.

Enabling Mobile Enhanced Solutions in the 
printer

Before you begin, make sure that your printer is running on firmware version 8.1, enrolled in Lexmark Cloud 
Services, and managed by the Native Agent.

Open a web browser, and then type the printer IP address in the address field.
From the Embedded Web Server, click Cloud Services.
Click Mobile Enhanced Solutions > Enable.

Note: This setting appears only if the printer is successfully enrolled and communicating 
with Lexmark Cloud Services.

Click Save.

Accessing Mobile Enhanced Solutions
Do either of the following:

From the printer screen, scan the QR code using your mobile device.
From the printer home screen, touch the Notification Center, then touch Access 
Mobile Enhanced Solutions, and then scan the QR code using your mobile device.

Note: Depending on your mobile device, a QR code scanner application may be required.

Log in using your Lexmark Cloud Services e‑mail address and password.

Note: Only one user can use Mobile Enhanced Solutions on a printer at a time.

Using My jobs
If you are a Cloud Print Management user, then My Jobs solution is available to you. My Jobs allow you to 
release print jobs from your Cloud Print Management print queue.

Mobile Enhanced Solutions
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Note: Before you begin, make sure that you have sent print jobs to your Lexmark Cloud Services print release 
queue. For more information, see the "Sending print jobs to Lexmark Cloud Services" group .

Releasing print jobs

From the application home screen, select the jobs that you want to print.
Tap Print Selected, and then wait for the print job to complete.

Notes
To print all jobs, tap Print All.
After the jobs are completed, the print jobs are automatically removed from the print 
queue.

Managing print jobs

From the application home screen, select the job that you want to manage.

Note: You can manage only one print job at a time.

Tap .
If necessary, change the print settings.
Tap Save.

Deleting print jobs

From the application home screen, select the jobs that you want to delete.
Tap .
From the Delete Selected Jobs window, tap Yes.

Note: After you are done releasing print jobs, you are encouraged to end your session. On ending your 
session, Mobile Enhanced Solutions get freed up for the next user.

Logging out of Mobile Enhanced Solutions

From the upper‑left corner of the screen, touch  .
Touch Log Out.
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Understanding the Announcement Center
The Announcement Center lets you view announcements about Lexmark Cloud Services features and other 
updates based on your user role. For Announcement Center, there are no settings available for administrators.

Viewing an announcement
You can view only the announcements that are applicable to your user role, and you cannot delete the 
announcements. If the announcement is not available in the language of your web browser, then you will see the 
announcement in English.

From your current web portal, click .

Note: The notification icon shows a badge indicating the number of unread 
announcements.

Click the announcement that you want to view.

Note: To view all announcements, click View All. Viewing all announcements lets you filter 
the read, unread, and high‑priority announcements.

Click Close.

Notes

The most recent announcements appear first. Expired announcements no longer appear.

High‑priority announcements are indicated with  .

Announcement Center
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Understanding the Solution Quota Manager
Solution Quota Manager is used to distribute pages and set quotas for organizations and users. You can set 
Unlimited quota for the various services. The billing is done based on usage.

Solution Quota

Managing the distribution of quotas in child 
organizations

Partner users who have the Solutions Quota Administrator role in the Child Organization Access group can 
manage the distribution of quotas in child organizations.

On the Quotas page, you can edit the default user quota. On the Distributions page, you can view the details 
about the billing cycle.
Distributing quotas to child organizations

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions tab, click Create Distribution.
In the Organization field, type the name of the child organization, and then select the 
organization from the suggestion list.

Notes
Partner Administrators must specify a child organization when creating distributions 
for these organizations. Quota Administrators do not need to specify a child 
organization if their organization has none.
You can specify the number of pages to be distributed for the services.

In the Distribution Duration section, select either of the following:

Note: By default, the Perpetual option is selected. If you want to select Custom, then you 
have to confirm the change by clicking Confirm Change.

Perpetual—On selecting Perpetual, you can configure the page limit without quota 
expiry date. The page limits remain active until exhaustion irrespective of the duration 
for which it is used. As a partner administrator, you can proceed with billing even if the 
page limit is not exhausted.

Note: By default, the Perpetual option is selected. If you want to select Custom, 
then you have to confirm the change by clicking Confirm Change.

Solution Quota Manager
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In the Page Limits section, you can configure Set Translation Page Limit, Set 
Redaction Page Limit, and Set OCR Page Limit.

Custom—On selecting Custom, you can set both the quota expiry date and the page 
limit. However, the distribution expires based on the time limit you have set even if you 
have pages remaining.

In the Expires On section, set the date of expiry.
In the Page Limits section, you can do the following:.

For Translation—You can either select Unlimited Translation Page or 
configure Set Translation Page Limit.
For Redaction—You can either select Unlimited Redaction Page or 
configure Set Redaction Page Limit.
For OCR—You can either select Unlimited OCR Page or configure Set 
OCR Page Limit.

If necessary, select Send notification when distribution is nearly depleted.

Notes
On selecting Send notification when distribution is nearly depleted, enter the 
email address in the text field. Click Add to add the email address.
You can add a maximum of ten email addresses.
On enabling this feature, a notification is sent to all the added email addresses 
when the distribution is about to be depleted.

Click Create Distribution.

Notes
Once a distribution is created, on the Distributions page, you can view the details 
of the distribution for each of the child organizations. The details include 
organization name, last modified, pages remaining, and expiry details.
The Expiration column specifically includes details like expiry date, if it is Custom. 
The column also mentions if it is Perpetual.
If you are logged in as partner administrator, then on the Distributions page, you 
can view details of the billing cycle.
If you navigate to the Quotas page of a child organization with Custom quota 
settings, then Distribution End Date is displayed.
If you navigate to the Quotas page of a child organization with Perpetual quota 
settings, then the Distribution End Date is not displayed.

Updating existing quota distributions

If a child organization runs out of their quota, then partner organizations can edit the existing distribution of the 
child organization.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions page, click the name of the child organization in the Distribution 
column.
Click Edit, and then update the number of pages for the existing solutions.
Click Save Changes.
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Using Solution Quota Manager to set quotas

If you are a Solutions Quota Administrator, then you can set the default quota for users. You can also set custom 
quotas for users and cost centers or departments.

Note: Quota decrements vary depending on the number of characters in a page. The system counts the 
number of characters, not the pages.

Set the default quota for users

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

Click Edit beside Default Quota.
From the Edit Default User Quota window, set the default quota for users, and then click 
Save Changes.

Note: You can also select Unlimited quota for each of the services.

Set a custom quota for personal

The default quota applies to all users in the organization, unless a custom quota is assigned to the department, 
cost center, or individual user. The user’s custom quota overrides the default quota of the organization, cost 
center, or department.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

From the Custom Quotas tab, click Create.
From the Type menu, select Personal.
Type the user’s email address, and then set the quota for the available solutions.

Note: Users must be registered in the organization before you can assign a custom quota 
to them.

Click Create Quota.

Note: To check the custom or default quota usage of the users, from the Quotas page, click the Usage tab. 
You can filter the user list for personal and default.

Set a custom quota for a cost center or department

The default quota applies to all users in the organization, unless a custom quota is assigned to the department, 
cost center, or individual user. The custom quota overrides the default quota.
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Note: Custom quotas can be set only for either a cost center or a department, but not both. After setting the 
first custom quota for a cost center or department, you can no longer set the custom quota for the other option.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Do either of the following:

Click the Solution Quota Manager card.
Click , and then click Solution Quota Manager.

From the Custom Quotas tab, click Create.
From the Type menu, select Cost center or Department.
Type the name of the cost center or department, and then set the quota for reach of the 
available solutions.
Click Create Quota.

Notes

To edit custom quotas, from the Custom Quotas tab, click the name of the cost center or 
department, set the quota, and then click Save Changes.
To check the custom or default quota usage of the users, from the Quotas page, click the 
Usage tab.

Updating the child organization account

As a partner administrator, you can edit the quota of a child organization. You can also revoke, resume, or 
suspend their quota distribution.

Open a web browser, and then access the Lexmark Cloud Services dashboard.
Click the Solution Quota Manager card.
From the Distributions tab, click the name of the child organization.
Click any of the following:

Edit—Edit the distribution quota of the child organization.
Suspend—Pause the translation, redaction, or OCR activities of an organization 
temporarily.
Resume—Resume the translation, redaction, or OCR activities for a suspended 
organization.
Revoke—Cancel any available translation, redaction, or OCR pages of an 
organization. Click Continue, type the name of the organization to confirm revocation, 
and then click Revoke.

Note: The distribution quota or unused pages of the child organization are returned 
to the partner organization.

Using the My Quota Pages Used card

The My Quota Pages Used card shows you the number of pages utilized against the given 
quota for your usage. If you have quotas for Translation, Redaction, and OCR, then the 
pages utilized for each of these solutions are shown.
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For Perpetual distribution, the card shows the date for Distribution expiration.
This quota can be shared with other users in the organization.

Using the Organization Distribution Status card

Only users with the Solutions Quota Administrator role can access this card.
This card shows the number of pages used against the total number of pages allotted to the 
organization. If your organization is entitled to Translation, Redaction, and OCR solutions, 
then the card shows the details for all the solutions.

For Perpetual distribution, the card shows the date for Distribution expiration.

Note:

For partner administrators, the card shows the pages used for your child organization as 
well as the overall page usage details of the main organization.
Click this card to access the Solution Quota Manager. For more information on adding/ 
editing cards, see the Managing cards section in Managing the dashboard on page 21.

.

Using the Organization Quota Status card

Only users with the Partner Administrator role can access this card.
This card shows the number of pages used by the child organization. If your organization is 
entitled to Translation, Redaction, and OCR solutions, then the card shows the details for all 
the solutions.
The card also shows the details about Current billing cycle and Upcoming billing cycle.
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Account Management troubleshooting

Cannot access the Account Management web portal

Make sure that the user roles are assigned appropriately
For more information, contact your organization administrator.
Contact the Lexmark Customer Support Center

User is prompted to re‑register badge

Make sure that the badge ID in the Account Management web portal is typed correctly
For more information, see Managing badges on page 97.

Make sure that the e-mail address is typed correctly
The e-mail address is case sensitive.

Make sure that the card reader is configured to read the characters correctly
The card reader must be able to read hex or decimal values. The card reader installed on the printer may be 
configured with a start delimiter or end delimiter, or set to remove characters. For more information, see the 
documentation for your card reader.
Make sure that new badges are registered

Cannot find badge when using the badges search box

Make sure to type the complete e‑mail address or badge ID

Fleet Management troubleshooting

Cannot access the Fleet Management web portal

Make sure that the user roles are assigned appropriately
For more information, contact your organization administrator.
Contact the Lexmark Customer Support Center

Printer is not enrolled

Make sure that the printer is in ready state
For more information, see Deployment readiness checklist on page 25.

Make sure that the authentication type set during enrollment matches the authentication type configured in the 
printer
Some printer models may have different authentication credentials configurations. For more information, see 
Updating agent access credentials on page 135.

Troubleshooting
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Printer enrollment fails

Try one or more of the following:

Make sure that the Dynamic Host Configuration Protocol (DHCP) setting is enabled and that 
the auto‑configuration of the Domain Name System (DNS) setting is allowed.
From the Embedded Web Server, click Settings › Network/PortsSettings › Ethernet and 
then, from the IPv4 section, select Enable DHCP.
If you use a static IP address, then make sure that you set the static IP address only after the 
DNS setting is auto‑configured
Make sure that the printer date and time settings match those of the network.
Make sure that correct printer credentials are provided in the Printer Enrollment Tool.
Make sure that sufficient access controls are enabled.
For printers with eSF version 5.0 or later, the following access controls must be enabled:

Access Controls group Access Control settings

Administrative Menus SE Menus

Device Management Remote Management

Device Management Firmware Updates

Device Management App Configurations

For printers with eSF versions 3.0 and 4.0, the following access controls must be enabled:

eSF version Access Controls group Access Control settings

eSF version 3.0 and 4.0 Administrative Menus SE Menus

eSF version 3.0 and 4.0 Device Management Remote Management

eSF version 3.0 and 4.0 Device Management Firmware Updates

eSF version 4.0 Device Management App Configurations

Note: For more information on identifying the printer eSF version, see Viewing the 
Embedded Solutions Framework (eSF) version on page 59.

Contact the Lexmark Customer Support Center.

Printer Agent update fails

Enroll the printer again
For secure printers, make sure that the correct printer credentials are provided during enrollment. For more 
information, see Enrolling printers using the Printer Enrollment Tool on page 111.

The printer is not communicating with the agent

Try one or more of the following:
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Make sure that the printer is connected to the network.
Make sure that the printer is not enrolled in another organization.

Unenroll the printer from the organization, and then enroll it again in the organization where 
you want it to be managed.
Make sure that the Printer Agent is installed and running.

Do either of the following:
If the Printer Agent is not installed, then enroll the printer using the Printer Enrollment 
Tool.
If the Printer Agent is stopped or disabled, restart or enable it in the Embedded Web 
Server.

Make sure that the printer network settings are updated.

Access the Embedded Web Server.
Depending on your printer model, click Applications or Apps.
Click Printer Configuration Agent › Test Agent Connection.

If the Test Agent Configuration button is missing, then enroll the printer again 
using the Printer Enrollment Tool.
If a Connection Failed! dialog with printer login error appears, then update the 
printer login credentials. Click Update Credentials, and then provide the printer 
administrator credentials.
If a Connection Failed! dialog with Internet connection error appears, then the 
printer network settings do not match the user network settings.

If a firewall is in place, then make sure that the Lexmark Cloud Services domains are 
allowed to use port 443.

The domains depend on the Lexmark Cloud Services data center. To determine the 
data center for your organization, use the web address of the login screen. For more 
information, see the Lexmark Cloud Services New and Changed Functionality 
document.

North American Data Center—The web address of the login screen starts with https:\ 
\idp.us.iss.lexmark.com.

idp.us.iss.lexmark.com
login.microsoftonline.com
lexmarkb2c.b2clogin.com
b2ccustomizationsprodsa.blob.core.windows.net
api.us.iss.lexmark.com
apis.us.iss.lexmark.com
us.iss.lexmark.com
prod-lex-cloud-iot.azure-devices.net
apis.iss.lexmark.com
iss.lexmark.com
global.azure-devices-provisioning.net
prodlexcloudk8s239.blob.core.windows.net
prodlexcloudk8s239.iss.lexmark.com
ccs.lexmark.com
ccs-cdn.lexmark.com
prodlexcloudk8s19.blob.core.windows.net

European Data Center—The web address of the login screen starts with https:\ 
\idp.eu.iss.lexmark.com.

https://www.lexmark.com/content/dam/lexmark/documents/user-guides/y2021/NA_US_New-and-Changed-Functionality_en-US.pdf
https:\\\\idp.us.iss.lexmark.com
https:\\\\idp.eu.iss.lexmark.com
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idp.eu.iss.lexmark.com
login.microsoftonline.com
lexmarkb2ceu.b2clogin.com
ilexmarkb2c.b2clogin.com
b2ccustomizationsprodsa.blob.core.windows.net
api.eu.iss.lexmark.com
apis.eu.iss.lexmark.com
eu.iss.lexmark.com
prod-westeu-lex-cloud-iot.azure-devices.net
apis.iss.lexmark.com
iss.lexmark.com
prod-lex-cloud-iot.azure-devices.net
prodwesteulexcloudk8s54.blob.core.windows.net
ccs.lexmark.com
ccs-cdn.lexmark.com
prodwesteulexcloudk8s199blob.core.windows.net
global.azure-devices-provisioning.net

Make sure that sufficient access controls are enabled.

For printers with eSF version 5.0 or later, the Lexmark_PCA_User account must have 
access to the Administrative Menus access control.

For printers with eSF versions 3.0 and 4.0, the Lexmark_PCA_User account must have to 
the following access controls:

eSF version Access Controls group Access Control setting

eSF versions 3.0 and 4.0 Administrative Menus Service Engineer Menus 
Remotely

eSF versions 3.0 and 4.0 Device Management Remote Management

eSF versions 3.0 and 4.0 Device Management Firmware Updates

eSF version 3.0 Device Management Configuration File Import / 
Export

Note: For more information on identifying the printer eSF version, see Viewing the 
Embedded Solutions Framework (eSF) version on page 59.

Contact the Lexmark Customer Support Center.

Printer cannot communicate with the Cloud Fleet 
Management portal after deployment

Try one or more of the following:

Make sure that the Dynamic Host Configuration Protocol (DHCP) setting is enabled and that 
auto‑configuration of the Domain Name System (DNS) setting is allowed.

From the Embedded Web Server, click Settings › Network/Ports › Ethernet, and then, from 
the IPv4 section, select Enable DHCP.



Troubleshooting

301

•

•

If you use a static IP address, then make sure that you set the static IP address only after the 
DNS setting is auto‑configured.
If a firewall is in place, then make sure that the Lexmark Cloud Services domains are 
allowed to use port 443.

The domains depend on the Lexmark Cloud Services data center. To determine the data 
center for your organization, use the web address of the login screen. For more information, 
see the Lexmark Cloud Services New and Changed Functionality document.

North American Data Center—The web address of the login screen starts with https:\ 
\idp.us.iss.lexmark.com.

Hosts for the U.S. data center
Function Used by Host

Identity Provider All customers idp.us.iss.lexmark.com

Identity Provider All customers login.microsoftonline.com

Identity Provider All customers lexmarkb2c.b2clogin.com

Identity Provider All customers b2ccustomizationsprodsa

.blob.core.windows.net

API All customers api.us.iss.lexmark.com

APIS All customers apis.us.iss.lexmark.com

CFM All customers us.iss.lexmark.com

CFM All customers prod-lex-cloud-iot.azure- 
devices.net

CFM Native Agent only apis.iss.lexmark.com

CFM Native Agent only iss.lexmark.com

CFM Native Agent only global.azure-devices- 
provisioning.net

CFM All customers prodlexcloudk8s239

.blob.core.windows.net

CFM All customers prodlexcloudk8s239.iss.le 
xmark.com

CCS All customers ccs.lexmark.com

CDN All customers ccs-cdn.lexmark.com

CPM CPM only prodlexcloudk8s19

.blob.core.windows.net

https://www.lexmark.com/content/dam/lexmark/documents/user-guides/y2021/NA_US_New-and-Changed-Functionality_en-US.pdf
https:\\\\idp.us.iss.lexmark.com
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European Data Center—The web address of the login screen starts with https:\ 
\idp.eu.iss.lexmark.com.

Hosts for the EU data center
Function Used by Host

Identity Provider All customers idp.eu.iss.lexmark.com

Identity Provider All customers login.microsoftonline.com

Identity Provider All customers lexmarkb2ceu.b2clogin.co 
m

Identity Provider All customers lexmarkb2c.b2clogin.com

Identity Provider All customers b2ccustomizationsprodsa

.blob.core.windows.net

API All customers api.eu.iss.lexmark.com

APIS All customers apis.eu.iss.lexmark.com

CFM All customers eu.iss.lexmark.com

CFM All customers prod-westeu-lex-cloud-iot

.azure-devices.net

CFM Native Agent only apis.iss.lexmark.com

CFM Native Agent only iss.lexmark.com

CFM Native Agent only prod-lex-cloud-iot.azure- 
devices.net

CFM Native Agent only global.azure-devices- 
provisioning.net

CFM All customers prodwesteulexcloudk8s54

.blob.core.windows.net

CCS All customers ccs.lexmark.com

CDN All customers ccs-cdn.lexmark.com

CPM CPM only prodwesteulexcloudk8s19 
9

.blob.core.windows.net

Make sure that the printer firmware is updated to support Transport Layer Security (TLS) 
version 1.2.
Contact the Lexmark Customer Support Center.

https:\\\\idp.eu.iss.lexmark.com
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Fleet Management tasks fail but the printer status is On 
schedule

Make sure that the current printer configuration task is completed before sending new tasks
Importing a configuration bundle to the printer may cause the printer to stop responding.

Cannot open the Fleet Agent application

Make sure that the server or browser allows connection to localhost
If the Fleet Agent uses a port other than port 80, then the browser must allow connection to localhost:x , where x 
is the port number.
Contact your administrator

Some printers are missing during discovery

Make sure that you can communicate to the printer
Open a web browser, and then type the printer IP address. If the printer Embedded Web Server appears, then the 
printer is online.
Make sure that the SNMP community strings are set correctly

The Printer Enrollment Tool freezes

Disable the proxy server of your web browser or operating system
For more information, see the documentation that came with your web browser or operating system.

Enable the "Bypass proxy server for local addresses" feature of your web browser or operating system
For more information, see the documentation that came with your web browser or operating system.

Cannot update printer credentials

Unenroll, and then enroll the printer again
Make sure that the correct printer credentials are provided during enrollment.

Make sure that the agent is updated
From the Fleet Management web portal, do either of the following:

Click Agents > Fleet Agents > select a Fleet Agent configuration > Update > Fleet Agent.
Click Agents > Printer Agents > select a printer agent > Update > Update agent version.

Make sure that the Lexmark_PCA_User account is added to the Admin group
For more information, contact your Lexmark representative.

Make sure that the permissions and function access controls for the Admin group are configured correctly
Depending on your printer model, the following permissions and function access controls are required:

Import / Export All Settings or Configuration File Import / Export
Apps Configuration
Security Menu
SE Menu
Firmware Updates
Remote Management

Note: For more information, see the Embedded Web Server Administrator's Guide for the printer.
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A blank space appears on the display, and an 
application ID appears in Customize Home Screen and 
View Home Screen

Restore the home screen to defaults settings Run the eSF applications

A blank space appears on the display when adding a 
hidden function in Customize Home Screen

Restore the home screen to defaults, and do not include the hidden item Remove ‑BLANK SPACE- in the home 
screen, and apply new layout

Non–Cloud Authentication eSF application does not 
work if Cloud Authentication is installed with Idle 
Screen enabled (using Translation Assistant or Cloud 
Scan Management)

Try one or more of the following:

Make sure that a third party authentication is installed and Pluggable Authentication Module 
is not selected.
If Idle Screen is disabled, then redeploy Translation Assistant or Cloud Scan Management 
with the pluggable authentication module disabled.
Reboot your printer.

Note: For more information on limitations, see Cloud Authentication ReadMe.

Print Management troubleshooting

Cannot install the Lexmark Print Management Client

Uninstall the previous versions of the Lexmark™ Universal Print Driver Contact your administrator

Cannot access the Print Management web portal

Make sure that the user roles are assigned appropriately
For more information, contact your organization administrator.
Contact the Lexmark Customer Support Center

Printing error

Make sure that the user exists in the Account Management web portal
For more information, see Managing users on page 69.

Make sure that the Print Release Management User role is granted to the user
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For more information, see Assigning organization roles on page 67.

Make sure that the Lexmark Print Management Client is configured correctly
For more information, see Downloading the Lexmark Print Management Client.

Some settings are unavailable on the Print Management 
web portal

Make sure that you have sufficient permission.

For more information on assigning roles, see "User accounts" chapter.

Cannot send e-mail to the print queue server

Make sure that the e‑mail address is correct Make sure that you have sufficient permission
For more information on assigning roles, see "Account Management" chapter.

An error appears when sending print jobs using the 
Lexmark Cloud Print Management for Chrome extension

Make sure that your credentials are correct In Microsoft 365, use Ctrl + P instead

Sending print jobs using  is not supported in Microsoft 365. Use Ctrl + P to print instead.

A warning appears when downloading the Lexmark 
Print Management Client

Accept the warning
Some browsers warn users of the risk associated with downloading EXE files.

For Windows 10, disable the SmartScreen® feature temporarily
For more information, see the documentation for your operating system.

CSV-formatted reports show incorrect UTF-8 or have 
missing non-ASCII characters

For Microsoft Excel, import the file to a new document, and then specify its file origin to UTF-8
For more information, see the documentation for the application.

For Notepad, save the document as a new file, and then specify the encoding menu to UTF-8
For more information, see the documentation for the application.

Custom settings from a LPMC installation do not appear

For versions 3.4.0 or earlier—Make sure that you have created a configuration.xml file.
For versions 3.5.0 or later—Make sure that you have created a configuration.json file.

Make sure that you have created an configuration.xml file Make sure that the installer and the configuration files 
are in the same folder
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Download the installer (EXE) file from the Print Management portal.

Custom print driver settings do not appear

Make sure that you have created an external LDC file
Create the LDC file from the Printer Driver Configuration Utility.

Make sure that the installer and the configuration files are in the same folder

Download the installer (EXE) file from the Print Management portal.
Make sure that the installer and the LDC files are in the same directory.

Lexmark Cloud Print Management print queues do not 
appear on client workstations

Make sure that the C:\ProgramData\LPMC\configuration.xml file has the correct modes Uninstall, and then install 
the package
Lexmark Print Management Client only enables modes defined in the configuration file during installation.

Installation with an LDC file is not working (Windows 
only)

Make sure to use the correct file names
During installation, the system looks for specific file names for the LDC files.

Use the following file names:

LPMSaaSPrintQueueConfiguration.ldc for the Cloud Print Management print queue
LPMServerlessPrintQueueConfiguration.ldc for the Hybrid Print Management print queue
Make sure to use the correct names for the print queue
The LDC configuration must use the following value for the print queue:

<PrinterObject value="Cloud Print Management - PCLXL"></ 

PrinterObject>

Note: If a custom name is used for the print queue, then the value in PrinterObject must be the custom name 
of the print queue.

You can also use the following generic values for the printer profile and printer model:

<PrinterProfile name="Lexmark Universal v2" version="1.0"> 

<PrinterModel value="Lexmark Universal v2"></PrinterModel>

No analytics or configuration data for Detail Printer 
activity for Offline print

In macOS, analytics data is not available for Detail Printer activity for Offline print

For certain users, printer configuration data is not available for Detail Printer activity for Offline print
Make sure the communication between the printer and the cloud server is working to ensure transmission of 
Device Usage data.
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To make sure that the LPMC features are functioning properly, check for the corresponding printer icon in the 
system tray.

Scan Management troubleshooting

Cannot access the Scan Management web portal

Make sure that the user roles are assigned correctly
For more information, contact your organization administrator.
Contact the Lexmark Customer Support Center

Some settings are unavailable on the Scan Management 
web portal

Make sure that you have sufficient permission.

For more information on assigning roles, see "User accounts" chapter.

Cannot save Scan Management settings

Make sure that the user roles are assigned correctly
For more information on assigning roles, see "Account Management" chapter.
Refresh your web browser Contact the Lexmark Customer Support Center

Cannot communicate with Lexmark Cloud Services

Sign in to your Microsoft account again Contact your system administrator

Cannot connect to your Microsoft account

Make sure that your Microsoft account domain is supported in your organization
For more information, see Configuring the Scan Management settings on page 238
Refresh your web browser Make sure that you have a stable network connection Contact the Lexmark Customer 
Support Center

Cannot access the Cloud Scan application

Make sure that the user roles are assigned correctly
For more information on assigning roles, see "Account Management" chapter.
Make sure that you have a stable network connection Contact the Lexmark Customer Support Center

Error in scanning documents

Make sure that the file size of your scanned documents does not exceed 20MB
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Cloud Authentication settings do not reflect after 
deploying Cloud Scan Management

If Cloud Scan Management and Cloud Print Management are deployed together, then two Cloud Authentication 
settings appear. Make sure that the two configurations are the same. If Cloud Print Management is already 
deployed, then make sure that you follow the same Cloud Authentication settings for Cloud Scan Management.

Printer shows Invalid user error

Make sure that the Device Quotas application is uninstalled or disabled
If the Device Quotas application is already installed in a printer, then you cannot install the Cloud Scan and 
Translation Assistant applications.

Analytics troubleshooting

Report shows no data available

Change the date range to include more days Select a different group, department, cost center, or user Release a 
print job from the Lexmark Cloud Services queue, and then generate the report for the last 30 days

Bookmarked reports do not show

Make sure that you are logged in to Lexmark Cloud Services Make sure that you have access to the reports
Depending on your user role, some reports may not be available. For more information, contact your organization 
administrator.
See the documentation that came with your web browser

Reports do not show properly when printed

Make sure that the paper size used is either Letter or A4 Make sure that the page orientation is set to portrait

Cannot find users

Make sure that the user is not deleted Use the user name when searching

Cannot remove departments and cost centers from the 
reports

Select another date range where the department or cost center is not included

Reports do not show the correct period

Make sure that the specified period is based on local time
The reports are generated on a 24-hour midnight to midnight frequency in local time. The local time is based on 
the date and time settings of the web browser and operating system.
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Report does not show the correct file name

Select Notepad++ to open the CSV file Select Microsoft Excel to open the CSV file
To open the file correctly using Microsoft Excel, do the following:

From Microsoft Excel, click Data > From Text/CSV.
Browse to the CSV file.
Click Open.

Report shows invalid date range

Select a start date not preceding 2 years from the current date

Direct Print A4 submissions reported as Letter in 
Analytics

Change the Scale Content settings in Microsoft Word
To report the correct paper size, do the following:

Open Microsoft Word, and then click File > Options > Advanced.
In the Print section, disable the Scale content for A4 or 8.5 x 11” paper sizes option.

Note: By default, the Scale content for A4 or 8.5 x 11” paper sizes is enabled.

Click OK.

Solution Center troubleshooting

Cannot access the Solution Center eSF application

Try one or more of the following:

Make sure that the user roles are assigned correctly.
Make sure that the Solution Center application is enabled for your organization.
For more information, contact your organization administrator.

Cannot run some of the solutions

Try one or more of the following:

If you are running a solution that contains Footer or Redact steps, the printer must have a 
valid OCR license and a printer hard disk is installed.
Make sure that you have sufficient quota.
Make sure that the user roles are assigned correctly.
For more information, contact your organization administrator.
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Integrating Cloud Fleet Management to 
third‑party software
The integration API provides endpoints to facilitate integrations with third‑party software. Use the following 
methods and keys to integrate Lexmark Cloud Fleet Management to your system:

Retrieve Asset Counters

This call retrieves the counters, such as meters, for the assets in an organization and its child organizations. The 
organization is determined from the token specified in the Authorization header, which must be retrieved from the 
Retrieve Token call.

Note: This endpoint is now deprecated with the introduction of the API version 1.0 endpoints.

Method URL

GET <INTEGRATION_SERVICE_URL>/assets/ 
inventory/counters

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

None.

Return schema

{ 

    "type": "array", 

    "items": { 

        "type": "object", 

        "required": [ "serialNumber", "dateCollected", "counters" ], 

        "properties": { 

            "serialNumber": { "type": "string" }, 

            "dateCollected": { "type": "integer" }, 

            "counters": {  

                "type": "object", 

                "properties": { 

                    "lifetimeCount": { "type": "integer" }, 

                    "colorPrintSideCount": { "type": "integer" }, 

                    "colorPrintSheetCount": { "type": "integer" }, 

                    "monoPrintSideCount": { "type": "integer" }, 

                    "monoPrintSheetCount": { "type": "integer" }, 

                    "printSideCount": { "type": "integer" }, 

                    "printSheetCount": { "type": "integer" }, 

Appendix



Appendix

311

                    "colorCopySideCount": { "type": "integer" }, 

                    "colorCopySheetCount": { "type": "integer" }, 

                    "monoCopySideCount": { "type": "integer" }, 

                    "monoCopySheetCount": { "type": "integer" }, 

                    "copySideCount": { "type": "integer" }, 

                    "copySheetCount": { "type": "integer" }, 

                    "colorFaxSideCount": { "type": "integer" }, 

                    "colorFaxSheetCount": { "type": "integer" }, 

                    "monoFaxSideCount": { "type": "integer" }, 

                    "monoFaxSheetCount": { "type": "integer" }, 

                    "faxSideCount": { "type": "integer" }, 

                    "faxSheetCount": { "type": "integer" }, 

                    "colorSideCount": { "type": "integer" }, 

                    "colorSheetCount": { "type": "integer" }, 

                    "monoSideCount": { "type": "integer" }, 

                    "monoSheetCount": { "type": "integer" }, 

                    "totalSideCount": { "type": "integer" }, 

                    "totalSheetCount": { "type": "integer" }, 

                    "largeSideCount": { "type": "integer" }, 

                    "largeSheetCount": { "type": "integer" }, 

                    "duplexSideCount": { "type": "integer" }, 

                    "duplexSheetCount": { "type": "integer" }, 

                    "coverageTierBusinessSideCount": { "type": 

"integer" }, 

                    "coverageTierBusinessSheetCount": { "type": 

"integer" }, 

                    "coverageTierGraphicsSideCount": { "type": 

"integer" }, 

                    "coverageTierGraphicsSheetCount": { "type": 

"integer" }, 

                    "coverageTierHighlightSideCount": { "type": 

"integer" }, 

                    "coverageTierHighlightSheetCount": { "type": 

"integer" }, 

                }, 

            }, 

        }, 

    }, 

    "minItems": 0 

}

Sample response

[ 

  { 

    "serialNumber": "14", 

    "dateCollected": 1557259523000, 

    "counters": { 

      "monoPrintSideCount": 262, 

      "printSideCount": 262, 

      "printSheetCount": 262, 

      "monoCopySideCount": 40, 

      "copySideCount": 40, 

      "copySheetCount": 40, 

      "monoFaxSideCount": 0, 

      "faxSideCount": 0, 

      "faxSheetCount": 0, 
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      "monoSideCount": 302, 

      "totalSideCount": 302, 

      "totalSheetCount": 302, 

      "duplexSheetCount": 0 

    } 

  }, 

  { 

    "serialNumber": "29", 

    "dateCollected": 1557259523000, 

    "counters": { 

      "lifetimeCount": 139, 

      "monoPrintSideCount": 139, 

      "printSideCount": 139, 

      "printSheetCount": 136, 

      "copySideCount": 0, 

      "monoSideCount": 139, 

      "totalSideCount": 139, 

      "totalSheetCount": 136, 

      "duplexSheetCount": 3 

    } 

  }, 

  { 

    "serialNumber": "36", 

    "dateCollected": null, 

    "counters": { 

    } 

  } 

]

Retrieve Token

This call generates a token that is suitable for use with the Retrieve Asset Counters call.

Method URL

POST <IDP_URL>oauth/token

Note: <IDP_URL> is either https://idp.eu.iss.lexmark.com for an organization in the EU data center or https:// 
idp.us.iss.lexmark.com/ for an organization in the U.S. data center.

Key Value

Content-Type application/json

Body

{ 

    "grant_type": "client_credentials", 

         "client_id": "<CLIENT_ID>", 

         "client_secret": "<CLIENT_SECRET>" 

}

Return schema

https://idp.eu.iss.lexmark.com/
https://idp.us.iss.lexmark.com/
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•

•

{ 

    "properties" : { 

        "access_token": {"type": "string"}, 

        "token_type": {"type": "string"}, 

        "expires_in": {"type": "integer"}, 

        "created_at": {"type": "integer"} 

    }, 

    "required": ["access_token", "token_type", "expires_in", 

"created_at"] 

}

Sample response

{ 

    "access_token": "abcd1234", 

    "token_type": "bearer", 

    "expires_in": 7200, 

    "created_at": 1572633120 

}

Integrating Cloud Fleet Management to 
third‑party software for version 1.0

The integration API provides endpoints to facilitate integrations with third-party software. API version 1.0 provides 
methods for getting all data from Cloud Fleet Management related to all assets in a partner organization and all of 
its children. In addition, it provides unique endpoints to retrieve subset of data such as supplies, alerts, and 
diagnostics events. This new API version is paged with default page size of 50 assets and a maximum page size 
of 200 assets at a time. A caller can specify a smaller page size if necessary. It is expected to be used by 
integration connectors, and therefore requires client credential tokens. Use the following methods and keys to 
integrate Lexmark Cloud Fleet Management to your system:

URL Method Description

/v1.0/assets/supplies GET Retrieve supplies data for a 
page of assets.

/v1.0/assets/diagnostics GET Retrieve diagnostics data 
for a page of assets.

/v1.0/assets/alerts GET Retrieve alert data for a 
page of assets.

/v1.0/assets/counters GET Retrieve counter data for a 
page of assets.

/v1.0/assets GET Retrieve all data for a page 
of assets.

<INTEGRATION_SERVICE_URL> is as follows:

https://apis.eu.iss.lexmark.com/cfm/fleetmgmt-integration-service for an organization in the 
EU data center.
https://apis.us.iss.lexmark.com/cfm/fleetmgmt-integration-service for an organization in the 
U.S. data center.

https://apis.eu.iss.lexmark.com/cfm/fleetmgmt-integration-service
https://apis.us.iss.lexmark.com/cfm/fleetmgmt-integration-service
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Retrieve Asset Supplies

This call retrieves the supplies containing the supply subresource in the organization and child organizations of 
the calling application. The organization is determined from the token specified in the Authorization header, which 
must be retrieved from the "Retrieve Token" section.

Method URL

GET <INTEGRATION_SERVICE_URL>/v1.0/ 
assets/supplies

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

              None.

Return Schema

{ 

    "type": "object", 

    "properties": { 

        "content": {  

            "type": "array", 

            "items": { 

                "type": "object", 

                "properties": { 

                    "manufacturer":  { "type": "string" }, 

                    "modelName":  { "type": "string" }, 

                    "serialNumber":  { "type": "string" }, 

                    "accountId":  { "type": "string" }, 

                    "name":  { "type": ["null", "string"] }, 

                    "description":  { "type": ["null", "string"] }, 

                    "dateCreated": { "type": "number" }, 

                    "dateModified": { "type": "number" }, 

                    "lastCommunication": { "type": ["null", 

"number"] }, 

                    "lastDataRefresh": { "type": "number" }, 

                    "communicating": { "type": ["null", "boolean"] }, 

                    "authenticated": { "type": ["null", "boolean"] }, 

                    "baseFirmwareLastModifiedDate": { "type": 

["null", "number"] }, 

                    "counters":  { "type": "null" }, 

                    "diagnosticEvents": { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "supplies":   { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 
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                            "properties": { 

                                "serialNumber": { "type": ["null", 

"string"] }, 

                                "currentLevel": { "type": ["null", 

"integer"] }, 

                                "color": { "type": ["null", 

"string"] }, 

                                "description": { "type": ["null", 

"string"] }, 

                                "maximumCapacity": { "type": ["null", 

"number"] }, 

                                "type": { "type": ["null", 

"string"] }, 

                                "capacityUnit": { "type": ["null", 

"string"] }, 

                                "percentRemaining":  { "type": 

["null", "integer"] }, 

                                "supplyState": { "type": ["null", 

"string"] }, 

                                "status":  { "type": ["null", 

"string"] }, 

                                "coverage":  { "type": ["null", 

"number"] }, 

                                "installDate":  { "type": ["null", 

"number"] }, 

                                "coverageLifetime":  { "type": 

["null", "number"] }, 

                                "coverageLastJob":  { "type": 

["null", "number"] }, 

                                "sidesOnSupply":  { "type": ["null", 

"number"] }, 

                                "timestamp": { "type": ["null", 

"number"] }, 

                                "prebate":  { "type": ["null", 

"boolean"] }, 

                                "genuine":  { "type": ["null", 

"boolean"] }, 

                                "daysLeft":  { "type": ["null", 

"number"] }, 

                                "daysLeftLastUpdated":  { "type": 

["null", "number"] } 

                            } 

                        } 

                    }, 

                    "alerts":   { 

                        "type": "array", 

                        "maxItems": 0 

                    } 

                } 

            }, 

            "minItems": 0 

        }, 

        "pageable": { 

            "type": "object", 

            "properties": { 

                "sort": { 

                    "type": "object", 

                    "properties": { 



Appendix

316

                        "sorted":  { "type": "boolean" }, 

                        "unsorted":  { "type": "boolean" }, 

                        "empty":  { "type": "boolean" } 

                    } 

                }, 

                "pageNumber":  { "type": "integer" }, 

                "pageSize":  { "type": "integer" }, 

                "offset":  { "type": "integer" }, 

                "paged":  { "type": "boolean" }, 

                "unpaged":  { "type": "boolean" } 

            } 

        }, 

        "totalElements":  { "type": "integer" }, 

        "totalPages":  { "type": "integer" }, 

        "last":  { "type": "boolean" }, 

        "sort":  { 

            "type": "object", 

            "properties": { 

                "sorted":  { "type": "boolean" }, 

                "unsorted":  { "type": "boolean" }, 

                "empty":  { "type": "boolean" } 

            } 

        }, 

        "first":  { "type": "boolean" }, 

        "numberOfElements":  { "type": "integer" }, 

        "size":  { "type": "integer" }, 

        "number":  { "type": "integer" }, 

        "empty":  { "type": "boolean" } 

    } 

}

Sample response

{ 

"content": [ 

{ 

  "manufacturer": "Lexmark",  

   "modelName": "X792e",  

   "serialNumber": "123SERIALNUMBER", 

   "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", "name": null, 

   "description": null, "dateCreated": 1568139701472, 

   "dateModified": 1621677697123, 

   "lastCommunication": 1621686886903, 

   "lastDataRefresh": 1621677697129,  

   "communicating": false,  

   "authenticated": true,  

   "baseFirmwareLastModifiedDate": null,  

   "counters": null, 

   "diagnosticEvents": [],  

   "supplies": [ 

       { 

        "serialNumber": null,  

         "currentLevel": 100,  

         "color": "none", 

         "description": "Waste Toner Bottle",  
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         "maximumCapacity": 200000, 

         "type": "Waste Toner",  

         "capacityUnit": "Sides",  

         "percentRemaining": null,  

         "supplyState": "UNKNOWN",  

         "status": "Ok",  

         "coverage": null,  

         "installDate": null,  

         "coverageLifetime": null,  

         "coverageLastJob": null,  

         "sidesOnSupply": null, 

         "timestamp": 1621674025052,  

         "prebate": null, 

         "genuine": null,  

         "daysLeft": null,  

         "daysLeftLastUpdated": null 

      }, 

      { 

        "serialNumber": null,  

                 "currentLevel": 100,        

                 "color": "none", 

                 "description": "Separator Roll and Pick Assembly", 

                "maximumCapacity": 120000, 

                "type": "Other", 

                "capacityUnit": "Other", 

                "percentRemaining": null, 

                "supplyState": "UNKNOWN", 

                "status": "Ok",  

                "coverage": null, 

                "installDate": null, 

                "coverageLifetime": null, 

                "coverageLastJob": null, 

                "sidesOnSupply": null, 

                "timestamp": 1621674025053,  

                "prebate": null, 

                "genuine": null, 

                "daysLeft": null,     

                "daysLeftLastUpdated": null 

               } 

               { 

                 "serialNumber": "SUPPLYSERIAL1",  

                 "currentLevel": 50, 

                 "color": "none", 

                 "description": "Fuser", 

                 "maximumCapacity": 150000, 

                 "type": "Fuser", 

                 "capacityUnit": "Sides", 

                 "percentRemaining": null, 

                 "supplyState": "UNKNOWN", 

                 "status": "Intermediate", 

                 "coverage": null, 

                 "installDate": null, 

                 "coverageLifetime": null, 

                 "coverageLastJob": null, 

                 "sidesOnSupply": null, 

                 "timestamp": 

                 1621674025055, "prebate": null, 

                 "genuine": null, 
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                 "daysLeft": null, 

                 "daysLeftLastUpdated": null 

               }, 

               { 

                "serialNumber": "SUPPLYSERIAL2", "color": "Yellow", 

                "description": "Yellow Cartridge", 

                "maximumCapacity": 20000, 

                "type": "Toner", 

                 "capacityUnit": "Sides", 

                 "percentRemaining": null, 

                 "supplyState": "UNKNOWN", 

                 "status": "Low", 

                 "coverage": 0.028, 

                 "installDate": 1568701948000, 

                 "coverageLifetime": 6.198895, 

                 "coverageLastJob": 15, 

                 "sidesOnSupply": 31355, 

                 "timestamp": 1621674025056,  

                 "prebate": true, 

                 "genuine": null, 

                 "daysLeft": null, 

                 "daysLeftLastUpdated": null 

                }, 

                { 

                 "serialNumber": "SUPPLYSERIAL3",  

                 "currentLevel": 100, 

                 "color": "none", 

                 "description": "Transfer Module",  

                 "maximumCapacity": 200000, 

                 "type": "Other", 

                 "capacityUnit": "Other", 

                 "percentRemaining": null, 

                 "supplyState": "UNKNOWN", 

                 "status": "Ok", 

                 "coverage": null, 

                 "installDate": null, 

                 "coverageLifetime": null, 

                 "coverageLastJob": null, 

                 "sidesOnSupply": null, 

                 "timestamp": 1621674025057, 

                 "prebate": null, 

                 "genuine": null, 

                 "daysLeft": null, 

                 "daysLeftLastUpdated": null 

                }, 

                { 

                 "serialNumber": "SUPPLYSERIAL4",  

                 "currentLevel": 80, 

                 "color": "Magenta", 

                 "description": "Magenta Cartridge",  

                 "maximumCapacity": 6000, 

                 "type": "Toner", 

                 "capacityUnit": "Sides", 

                 "percentRemaining": null, 

                 "supplyState": "AUTHENTIC",  

                 "status": "Intermediate", 

                 "coverage": 2.872, 

                 "installDate": 1568701948000, 
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                 "coverageLifetime": 4.0110497, 

                 "coverageLastJob": 11, 

                 "sidesOnSupply": 177, 

                 "timestamp": 1621674025073, "prebate": true, 

                 "genuine": null, 

                 "daysLeft": null,  

                 "daysLeftLastUpdated": null 

                }, 

                { 

                 "serialNumber": "SUPPLYSERIAL6", 

                 "currentLevel": 20, 

                 "color": "Cyan", 

                 "description": "Cyan Cartridge",  

                 "maximumCapacity": 12000,  

                 "type": "Toner", 

                 "capacityUnit": "Sides", 

                 "percentRemaining": null,  

                 "supplyState": "UNKNOWN",  

                 "status": "Intermediate",  

                 "coverage": 0.194, 

                 "installDate": 1568701948000, 

                 "coverageLifetime": 7.331492, 

                 "coverageLastJob": 21, 

                 "sidesOnSupply": 4688, 

                 "prebate": true,  

                 "genuine": null,  

                 "daysLeft": null, 

                 "daysLeftLastUpdated": null 

                      } 

   ], 

   "alerts": [] 

 }, 

  { 

   "manufacturer": "Lexmark",  

   "modelName": "CX825",  

   "serialNumber": "12345SERIALNUMBER", 

   "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

   "name": null, "description": null, 

   "dateCreated": 1568139300179, 

   "dateModified": 1617891557869, 

   "lastCommunication": 1617891642361, 

   "lastDataRefresh": 1627605287407,  

   "communicating": false,  

   "authenticated": true,  

   "baseFirmwareLastModifiedDate": null,  

   "counters": null, 

   "diagnosticEvents": [],  

   "supplies": [], 

   "alerts": [] 

  } 

 ], 

 "pageable": { 

   "sort": { "sorted": false,  

   "unsorted": true,  

   "empty": true 

  }, 

   "pageNumber": 0, 

   "pageSize": 50, 
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   "offset": 0, 

   "paged": true,  

   "unpaged": false 

  }, 

  "totalElements": 2, 

  "totalPages": 1,  

  "last": false, 

  "sort": { 

  "sorted": false,  

  "unsorted": true,  

  "empty": true 

 }, 

  "first": true,  

  "numberOfElements": 50, 

  "size": 50, 

  "number": 0, "empty": false 

} 

"timestamp": 1621674025075,

Retrieve Asset Diagnostics

This call retrieves a page of assets containing the diagnostic subresource in the organization and child 
organizations of the calling application. The organization is determined from the token specified in the 
Authorization header, which must be retrieved from the "Retrieve Token" section.

Method URL

GET <INTEGRATION_SERVICE_URL>/v1.0/ 
assets/diagnostics

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

        None.

Return Schema

{ 

    "type": "object", 

    "properties": { 

        "content": {  

            "type": "array", 

            "items": { 

                "type": "object", 

                "properties": { 

                    "manufacturer":  { "type": "string" }, 

                    "modelName":  { "type": "string" }, 

                    "serialNumber":  { "type": "string" }, 

                    "accountId":  { "type": "string" }, 
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                    "name":  { "type": ["null", "string"] }, 

                    "description":  { "type": ["null", "string"] }, 

                    "dateCreated": { "type": "number" }, 

                    "dateModified": { "type": "number" }, 

                    "lastCommunication": { "type": ["null", 

"number"] }, 

                    "lastDataRefresh": { "type": "number" }, 

                    "communicating": { "type": ["null", "boolean"] }, 

                    "authenticated": { "type": ["null", "boolean"] }, 

                    "baseFirmwareLastModifiedDate": { "type": 

["null", "number"] }, 

                    "counters":  { "type": "null" }, 

                    "diagnosticEvents": { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 

                            "properties": { 

                                "dateCreated": { "type": "number" }, 

                                "alert": { "type": ["null", 

"string"] }, 

                                "alertDttm": { "type": ["null", 

"number"] }, 

                                "alertId": { "type": ["null", 

"string"] }, 

                                "alertType": { "type": ["null", 

"string"] }, 

                                "collectorId": { "type": ["null", 

"string"] }, 

                                "errorCode": { "type": ["null", 

"string"] }, 

                                "errorReason":  { "type": ["null", 

"string"] }, 

                                "errorType":  { "type": ["null", 

"string"] }, 

                                "expirationDttm":  { "type": 

"number" }, 

                                "hostname": { "type": ["null", 

"string"] }, 

                                "ipAddress":  { "type": ["null", 

"string"] }, 

                                "lpc":  { "type": ["null", 

"number"] }, 

                                "model":  { "type": ["null", 

"string"] }, 

                                "serialNumber":  { "type": ["null", 

"string"] } 

                            } 

                        } 

                    }, 

                    "supplies":   { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "alerts":   { 

                        "type": "array", 

                        "maxItems": 0 

                    } 

                } 
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            }, 

            "minItems": 0 

        }, 

        "pageable": { 

            "type": "object", 

            "properties": { 

                "sort": { 

                    "type": "object", 

                    "properties": { 

                        "sorted":  { "type": "boolean" }, 

                        "unsorted":  { "type": "boolean" }, 

                        "empty":  { "type": "boolean" } 

                    } 

                }, 

                "pageNumber":  { "type": "integer" }, 

                "pageSize":  { "type": "integer" }, 

                "offset":  { "type": "integer" }, 

                "paged":  { "type": "boolean" }, 

                "unpaged":  { "type": "boolean" } 

            } 

        }, 

        "totalElements":  { "type": "integer" }, 

        "totalPages":  { "type": "integer" }, 

        "last":  { "type": "boolean" }, 

        "sort":  { 

            "type": "object", 

            "properties": { 

                "sorted":  { "type": "boolean" }, 

                "unsorted":  { "type": "boolean" }, 

                "empty":  { "type": "boolean" } 

            } 

        }, 

        "first":  { "type": "boolean" }, 

        "numberOfElements":  { "type": "integer" }, 

        "size":  { "type": "integer" }, 

        "number":  { "type": "integer" }, 

        "empty":  { "type": "boolean" } 

    } 

}

Sample response

{ 

   "content": [ 

      { 

        "manufacturer": "Lexmark", 

        "modelName": "X792e", 

        "serialNumber": "123SERIALNUMBER", 

        "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

        "name": null, 

        "description": null, 

        "dateCreated": 1568139701472, 

        "dateModified": 1621677697123, 

        "lastCommunication": 1621686886903, 

        "lastDataRefresh": 1621677697129, 
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        "communicating": false, 

        "authenticated": true, 

        "baseFirmwareLastModifiedDate": null, 

        "counters": null, 

        "diagnosticEvents": [], 

        "supplies": [], 

        "alerts": [] 

      }, 

  

      { 

        "manufacturer": "Lexmark", 

        "modelName": "CX825", 

        "serialNumber": "12345SERIALNUMBER", 

        "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

        "name": null, 

        "description": null, 

        "dateCreated": 1568139300179, 

        "dateModified": 1617891557869, 

        "lastCommunication": 1617891642361, 

        "lastDataRefresh": 1627605287407, 

        "communicating": false, 

        "authenticated": true, 

        "baseFirmwareLastModifiedDate": null, 

        "counters": null, 

        "diagnosticEvents": [ 

          { 

           "dateCreated": 1639077580134, 

           "alert": "202.03 PAPER JAM: repeated 25 time(s) in 500 

pages", 

           "alertDttm": 1639077580134, 

           "alertId": "61b25b2cc036774096bbef91", "alertType": 

"Prescriptive", 

           "collectorId": "CBR01", 

           "errorCode": "202.03", "errorReason": 

           "HC_REP", "errorType": "%202.03%", 

           "expirationDttm": 1313123, 

           "hostname": "10.99.0.60", 

           "ipAddress": "10.99.0.60", 

           "lpc": 505535, 

           "model": "LEXMARK CX825", 

           "serialNumber": "12345SERIALNUMBER" 

          }, 

          { 

           "dateCreated": 163907758999, 

           "alert": "Other alert", 

           "alertDttm": 163907758999, 

           "alertId": "61b25b2cc036774096bbef99", 

           "alertType": "Prescriptive", 

           "collectorId": "CBR01", 

           "errorCode": "202.03", 

           "errorReason": "HC_REP", 

           "errorType": "%202.03%", 

           "expirationDttm": 1313123, 

           "hostname": "10.99.0.60", 

           "ipAddress": "10.99.0.60", 

           "lpc": 505535, 

           "model": "LEXMARK CX825", 

           "serialNumber": "12345SERIALNUMBER" 
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          } 

       ], 

       "supplies": [], 

       "alerts": [] 

      } 

   ], 

   "pageable": { 

     "sort": { " 

        sorted": false, 

   "unsorted": true, 

   "empty": true 

     }, 

     "pageNumber": 0, 

     "pageSize": 50, 

     "offset": 0, 

     "paged": true, 

     "unpaged": false 

   }, 

    "totalElements": 2, 

    "totalPages": 1, "last": false, 

    "sort": { 

    "sorted": false, 

    "unsorted": true, 

    "empty": true 

   }, 

    "first": true, 

    "numberOfElements": 50, 

    "size": 50, 

    "number": 0, "empty": false 

}

Retrieve Asset Alerts

This call retrieves the supplies containing the alerts subresource in the organization and child organizations of the 
calling application. The organization is determined from the token specified in the Authorization header, which 
must be retrieved from the "Retrieve Token" section.

Method URL

GET <INTEGRATION_SERVICE_URL>/v1.0/ 
assets/alerts

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

      None.
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Return Schema

{ 

    "type": "object", 

    "properties": { 

        "content": {  

            "type": "array", 

            "items": { 

                "type": "object", 

                "properties": { 

                    "manufacturer":  { "type": "string" }, 

                    "modelName":  { "type": "string" }, 

                    "serialNumber":  { "type": "string" }, 

                    "accountId":  { "type": "string" }, 

                    "name":  { "type": ["null", "string"] }, 

                    "description":  { "type": ["null", "string"] }, 

                    "dateCreated": { "type": "number" }, 

                    "dateModified": { "type": "number" }, 

                    "lastCommunication": { "type": ["null", 

"number"] }, 

                    "lastDataRefresh": { "type": "number" }, 

                    "communicating": { "type": ["null", "boolean"] }, 

                    "authenticated": { "type": ["null", "boolean"] }, 

                    "baseFirmwareLastModifiedDate": { "type": 

["null", "number"] }, 

                    "counters": { "type": "null" }, 

                    "diagnosticEvents": { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "supplies":   { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "alerts":   { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 

                            "properties": { 

                                "status": { "type": ["null", 

"string"] }, 

                                "issue": { "type": ["null", 

"string"] } 

                            } 

                        } 

                    } 

                } 

            }, 

            "minItems": 0 

        }, 

        "pageable": { 

            "type": "object", 

            "properties": { 

                "sort": { 

                    "type": "object", 

                    "properties": { 
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                        "sorted":  { "type": "boolean" }, 

                        "unsorted":  { "type": "boolean" }, 

                        "empty":  { "type": "boolean" } 

                    } 

                }, 

                "pageNumber":  { "type": "integer" }, 

                "pageSize":  { "type": "integer" }, 

                "offset":  { "type": "integer" }, 

                "paged":  { "type": "boolean" }, 

                "unpaged":  { "type": "boolean" } 

            } 

        }, 

        "totalElements":  { "type": "integer" }, 

        "totalPages":  { "type": "integer" }, 

        "last":  { "type": "boolean" }, 

        "sort":  { 

            "type": "object", 

            "properties": { 

                "sorted":  { "type": "boolean" }, 

                "unsorted":  { "type": "boolean" }, 

                "empty":  { "type": "boolean" } 

            } 

        }, 

        "first":  { "type": "boolean" }, 

        "numberOfElements":  { "type": "integer" }, 

        "size":  { "type": "integer" }, 

        "number":  { "type": "integer" }, 

        "empty":  { "type": "boolean" } 

    } 

}

Sample response

{ 

   "content": [ 

      { 

         "manufacturer": "Lexmark", 

         "modelName": "X792e", 

         "serialNumber": "123SERIALNUMBER", 

         "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

         "name": null, 

         "description": null, 

         "dateCreated": 1568139701472, 

         "dateModified": 1621677697123, 

         "lastCommunication": 1621686886903, 

         "lastDataRefresh": 1621677697129, 

         "communicating": false, 

         "authenticated": true, 

         "baseFirmwareLastModifiedDate": null, 

         "counters": null, 

         "diagnosticEvents": [], "supplies": [], 

         "alerts": [] 

      }, 

      { 

         "manufacturer": "Lexmark", 
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         "modelName": "CX825", 

         "serialNumber": "12345SERIALNUMBER", 

         "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

         "name": null, 

         "description": null, 

         "dateCreated": 1568139300179, 

         "dateModified": 1617891557869, 

         "lastCommunication": 1617891642361, 

         "lastDataRefresh": 1627605287407, 

         "communicating": false, 

         "authenticated": true, 

         "baseFirmwareLastModifiedDate": null, 

         "counters": null, 

         "diagnosticEvents": [], 

         "supplies": [], 

         "alerts": [ 

            {    

               "status": "ERROR", 

               "issue": "Remove paper from Standard Output Bin" 

            }, 

            { 

               "status": "ERROR", 

               "issue": " [145.80A]" 

            }, 

            { 

               "status": "WARNING", 

               "issue": "Standard Bin Full" 

            } 

        ] 

     } 

 ], 

 "pageable": 

  "sort": { 

  "sorted": false, 

  "unsorted": true, 

  "empty": true 

 }, 

 "pageNumber": 0, 

 "pageSize": 50, 

 "offset": 0, 

 "paged": true, 

 "unpaged": false 

 }, 

 "totalElements": 2, 

 "totalPages": 1, "last": false, 

 "sort": { 

    "sorted": false 

    "unsorted": true, 

    "empty": true 

 }, 

 "first": true, 

 "numberOfElements": 50, 

 "size": 50, 

 "number": 0, 

 "empty": false 

}
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Retrieve Asset Counters

This call retrieves a page of assets containing the counters subresource in the organization and child 
organizations of the calling application. The organization is determined from the token specified in the 
Authorization header, which must be retrieved from the "Retrieve Token" section.

Method URL

GET <INTEGRATION_SERVICE_URL>/v1.0/ 
assets/counters

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

     None.

Return schema

{ 

    "type": "object", 

    "properties": { 

        "content": {  

            "type": "array", 

            "items": { 

                "type": "object", 

                "properties": { 

                    "manufacturer":  { "type": "string" }, 

                    "modelName":  { "type": "string" }, 

                    "serialNumber":  { "type": "string" }, 

                    "accountId":  { "type": "string" }, 

                    "name":  { "type": ["null", "string"] }, 

                    "description":  { "type": ["null", "string"] }, 

                    "dateCreated": { "type": "number" }, 

                    "dateModified": { "type": "number" }, 

                    "lastCommunication": { "type": ["null", 

"number"] }, 

                    "lastDataRefresh": { "type": "number" }, 

                    "communicating": { "type": ["null", "boolean"] }, 

                    "authenticated": { "type": ["null", "boolean"] }, 

                    "baseFirmwareLastModifiedDate": { "type": 

["null", "number"] }, 

                    "counters": { 

                        "type": ["null", "object"], 

                        "properties": { 

                            "lifetimeCount": { "type": ["null", 

"integer"] }, 

                            "lifetimeCountUnit": { "type": ["null", 

"string"] }, 

                            "colorPrintSideCount": { "type": ["null", 

"integer"] }, 



Appendix

329

                            "colorPrintSheetCount": { "type": 

["null", "integer"] }, 

                            "monoPrintSideCount": { "type": ["null", 

"integer"] }, 

                            "monoPrintSheetCount": { "type": ["null", 

"integer"] }, 

                            "printSideCount": { "type": ["null", 

"integer"] }, 

                            "printSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorCopySideCount": { "type": ["null", 

"integer"] }, 

                            "colorCopySheetCount": { "type": ["null", 

"integer"] }, 

                            "monoCopySideCount": { "type": ["null", 

"integer"] }, 

                            "monoCopySheetCount": { "type": ["null", 

"integer"] }, 

                            "copySideCount": { "type": ["null", 

"integer"] }, 

                            "copySheetCount": { "type": ["null", 

"integer"] }, 

                            "colorFaxSideCount": { "type": ["null", 

"integer"] }, 

                            "colorFaxSheetCount": { "type": ["null", 

"integer"] }, 

                            "monoFaxSideCount": { "type": ["null", 

"integer"] }, 

                            "monoFaxSheetCount": { "type": ["null", 

"integer"] }, 

                            "faxSideCount": { "type": ["null", 

"integer"] }, 

                            "faxSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorSideCount": { "type": ["null", 

"integer"] }, 

                            "colorSheetCount": { "type": ["null", 

"integer"] }, 

                            "monoSideCount": { "type": ["null", 

"integer"] }, 

                            "monoSheetCount": { "type": ["null", 

"integer"] }, 

                            "totalSideCount": { "type": ["null", 

"integer"] }, 

                            "totalSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorLargeSideCount": { "type": ["null", 

"integer"] }, 

                            "monoLargeSideCount": { "type": ["null", 

"integer"] }, 

                            "largeSideCount": { "type": ["null", 

"integer"] }, 

                            "largeSheetCount": { "type": ["null", 

"integer"] }, 

                            "duplexSideCount": { "type": ["null", 

"integer"] }, 

                            "duplexSheetCount": { "type": ["null", 

"integer"] }, 
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                            "coverageTierBusinessSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierBusinessSheetCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierGraphicsSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierGraphicsSheetCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierHighlightSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierHighlightSheetCount": 

{ "type": ["null", "integer"] }, 

                            "paperCounts": { 

                                "type": "array", 

                                "items": { 

                                    "type": "object", 

                                    "properties": { 

                                        "paperSheetPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSheetSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideColorPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideColorSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideMonoPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideMonoSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSize": { "type": 

["null", "string"] }, 

                                        "paperType": { "type": 

["null", "string"] } 

                                    } 

                                } 

                            }, 

                            "blankCopySideCount": { "type": ["null", 

"integer"] }, 

                            "adfScanCount": { "type": ["null", 

"integer"] }, 

                            "flatbedScanCount": { "type": ["null", 

"integer"] }, 

                            "scanToLocalhostScanCount": { "type": 

["null", "integer"] }, 

                            "copyScanCount": { "type": ["null", 

"integer"] }, 

                            "faxScanCount": { "type": ["null", 

"integer"] }, 

                            "simplexAdfScanCount": { "type": ["null", 

"integer"] }, 

                            "duplexAdfScanCount": { "type": ["null", 

"integer"] }, 

                            "monoScanCount": { "type": ["null", 

"integer"] }, 

                            "colorScanCount": { "type": ["null", 

"integer"] }, 

                            "totalScanCount": { "type": ["null", 

"integer"] }, 
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                            "blankFaxSideCount": { "type": ["null", 

"integer"] } 

                        } 

                    }, 

                    "diagnosticEvents": { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "supplies":   { 

                        "type": "array", 

                        "maxItems": 0 

                    }, 

                    "alerts":   { 

                        "type": "array", 

                        "maxItems": 0 

                    } 

                } 

            }, 

            "minItems": 0 

        }, 

        "pageable": { 

            "type": "object", 

            "properties": { 

                "sort": { 

                    "type": "object", 

                    "properties": { 

                        "sorted":  { "type": "boolean" }, 

                        "unsorted":  { "type": "boolean" }, 

                        "empty":  { "type": "boolean" } 

                    } 

                }, 

                "pageNumber":  { "type": "integer" }, 

                "pageSize":  { "type": "integer" }, 

                "offset":  { "type": "integer" }, 

                "paged":  { "type": "boolean" }, 

                "unpaged":  { "type": "boolean" } 

            } 

        }, 

        "totalElements":  { "type": "integer" }, 

        "totalPages":  { "type": "integer" }, 

        "last":  { "type": "boolean" }, 

        "sort":  { 

            "type": "object", 

            "properties": { 

                "sorted":  { "type": "boolean" }, 

                "unsorted":  { "type": "boolean" }, 

                "empty":  { "type": "boolean" } 

            } 

        }, 

        "first":  { "type": "boolean" }, 

        "numberOfElements":  { "type": "integer" }, 

        "size":  { "type": "integer" }, 

        "number":  { "type": "integer" }, 

        "empty":  { "type": "boolean" } 

    } 

}
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Sample response

{ 

    "content": [ 

      { 

         "manufacturer": "Lexmark", 

         "modelName": "X792e", 

         "serialNumber": "123SERIALNUMBER", 

         "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

         "name": null, 

         "description": null, 

         "dateCreated": 1568139701472, 

         "dateModified": 1621677697123, 

         "lastCommunication": 1621686886903, 

         "lastDataRefresh": 1621677697129, 

         "communicating": false, 

         "authenticated": true, 

         "baseFirmwareLastModifiedDate": null, 

         "counters": { 

            "lifetimeCount": 6436, 

            "lifetimeCountUnit": "Sides", 

            "colorPrintSideCount": 464, 

            "colorPrintSheetCount": null, 

            "monoPrintSideCount": 2636, 

            "monoPrintSheetCount": null, 

            "printSideCount": 3100, 

            "printSheetCount": 3067, 

            "colorCopySideCount": 175, 

            "colorCopySheetCount": null, 

            "monoCopySideCount": 50, 

            "monoCopySheetCount": null, 

            "copySideCount": 225, 

            "copySheetCount": 217, 

            "colorFaxSideCount": 99, 

            "colorFaxSheetCount": null, 

            "monoFaxSideCount": 2994, 

            "monoFaxSheetCount": null, 

            "faxSideCount": 3093, 

            "faxSheetCount": 3093, 

            "colorSideCount": 738, 

            "colorSheetCount": null, 

            "monoSideCount": 5680, 

            "monoSheetCount": null, 

            "totalSideCount": 6418, 

            "totalSheetCount": 6377, 

            "colorLargeSideCount": null, 

            "monoLargeSideCount": null, 

            "largeSideCount": null, 

            "largeSheetCount": null, 

            "duplexSideCount": null, 

            "duplexSheetCount": 41, 

            "coverageTierBusinessSideCount": null, 

            "coverageTierBusinessSheetCount": null, 

            "coverageTierGraphicsSideCount": null, 

            "coverageTierGraphicsSheetCount": null, 

            "coverageTierHighlightSideCount": null, 
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            "coverageTierHighlightSheetCount": null, 

            "paperCounts": [ 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 5370, 

                "paperSideColorPickedCount": 586, 

                "paperSideColorSafeCount": 700, 

                "paperSideMonoPickedCount": 2377, 

                "paperSideMonoSafeCount": 4711, 

                "paperSize": "Letter", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 3, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 1, 

                "paperSideMonoSafeCount": 3, 

                "paperSize": "Letter", 

                "paperType": "Custom Type 2" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 23, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 23, 

                "paperSize": "Oficio",  

                         "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 24, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 24, "paperSize": "Legal", 

"paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 110, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 7, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 103, 

                "paperSize": "Executive", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 56, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 56, 
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                "paperSize": "Folio", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 52, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 52, 

                "paperSize": "JIS B5", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 685, 

                "paperSideColorPickedCount": 3, 

                "paperSideColorSafeCount": 30, 

                "paperSideMonoPickedCount": 178, 

                "paperSideMonoSafeCount": 655, 

                "paperSize": "A4", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 45, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 45, 

                "paperSize": "A5", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 4, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 4, 

                "paperSize": "A6", 

                "paperType": "Plain" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 1, 

                "paperSideColorPickedCount": 0, 

                "paperSideColorSafeCount": 0, 

                "paperSideMonoPickedCount": 0, 

                "paperSideMonoSafeCount": 1, 

                "paperSize": "A4", 

                "paperType": "Custom Type 2" 

               }, 

               { 

                "paperSheetPickedCount": null, 

                "paperSheetSafeCount": 4, 

                "paperSideColorPickedCount": 1, 

                "paperSideColorSafeCount": 1, 
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                "paperSideMonoPickedCount": 3, 

                "paperSideMonoSafeCount": 3, 

                "paperSize": "Letter", 

                "paperType": "Transparancy" 

               } 

             ], 

               "blankCopySideCount": 1, 

               "adfScanCount": 377, 

               "flatbedScanCount": 722, 

               "scanToLocalhostScanCount": null, 

               "copyScanCount": 101, 

               "faxScanCount": 815, 

               "simplexAdfScanCount": null, 

               "duplexAdfScanCount": null, 

               "monoScanCount": null, 

               "colorScanCount": null, 

               "totalScanCount": 1099, 

               "blankFaxSideCount": 0 

           }, 

             "diagnosticEvents": [], 

             "supplies": [], 

             "alerts": [] 

         }, 

{ 

            "manufacturer": "Lexmark", 

            "modelName": "CX825", 

            "serialNumber": "12345SERIALNUMBER", 

            "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

            "name": null, 

            "description": null, 

            "dateCreated": 1568139300179, 

            "dateModified": 1617891557869, 

            "lastCommunication": 1617891642361, 

            "lastDataRefresh": 1627605287407, 

            "communicating": false, 

            "authenticated": true, 

            "baseFirmwareLastModifiedDate": null, 

            "counters": { 

                "lifetimeCount": 30932, 

                "lifetimeCountUnit": "Sides", 

                "colorPrintSideCount": 27268, 

                "colorPrintSheetCount": null, 

                "monoPrintSideCount": 3196, 

                "monoPrintSheetCount": null, 

                "printSideCount": 30464, 

                "printSheetCount": 28872, 

                "colorCopySideCount": 447, 

                "colorCopySheetCount": null, 

                "monoCopySideCount": 2, 

                "monoCopySheetCount": null, 

                "copySideCount": 449, 

                "copySheetCount": 284, 

                "colorFaxSideCount": 0, 

                "colorFaxSheetCount": null, 

                "monoFaxSideCount": 0, 

                "monoFaxSheetCount": null, 

                "faxSideCount": 0, 

                "faxSheetCount": 0, 
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                "colorSideCount": 27715, 

                "colorSheetCount": null, 

                "monoSideCount": 3198, 

                "monoSheetCount": null, 

                "totalSideCount": 30914, 

                "totalSheetCount": 29156, 

                "colorLargeSideCount": null, 

                "monoLargeSideCount": null, 

                "largeSideCount": null, 

                "largeSheetCount": null, 

                "duplexSideCount": null, 

                "duplexSheetCount": 1758, 

                "coverageTierBusinessSideCount": 11373, 

                "coverageTierBusinessSheetCount": null, 

                "coverageTierGraphicsSideCount": 5013, 

                "coverageTierGraphicsSheetCount": null, 

                "coverageTierHighlightSideCount": 11327, 

                "coverageTierHighlightSheetCount": null, 

                "paperCounts": [], 

                 "blankCopySideCount": null, 

                 "adfScanCount": null, 

                 "flatbedScanCount": null, 

                 "scanToLocalhostScanCount": null, 

                 "copyScanCount": null, 

                 "faxScanCount": null, 

                 "simplexAdfScanCount": null, 

                 "duplexAdfScanCount": null, 

                 "monoScanCount": null, 

                 "colorScanCount": null, 

                 "totalScanCount": null, 

                 "blankFaxSideCount": null 

             }, 

             "diagnosticEvents": [], 

             "supplies": [], 

             "alerts": [] 

          } 

       ], 

        "pageable": { 

           "sort": { 

           "sorted": false, 

           "unsorted": true, 

           "empty": true 

           }, 

            "pageNumber": 0, 

            "pageSize": 50, 

            "offset": 0, 

            "paged": true, 

            "unpaged": false 

        }, 

         "totalElements": 2, 

         "totalPages": 1, 

         "last": false, 

         "sort": { 

            "sorted": false, 

            "unsorted": true, 

            "empty": true 

        }, 

         "first": true, 
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         "numberOfElements": 50, 

         "size": 50, 

         "number": 0,  

              "empty": false 

}

Retrieve Assets

This call retrieves a page of assets containing the subresource in the organization and child organizations of the 
calling application. The organization is determined from the token specified in the Authorization header, which 
must be retrieved from the "Retrieve Token" section.

Method URL

GET <INTEGRATION_SERVICE_URL>/v1.0/ 
assets

Key Value Description

Authorization Bearer <TOKEN> The Retrieve Token call 
returns the token.

Body

     None.

Note: This API returns all data sets for all assets. It has an optional parameter to return all data for a single 
serial number.

Return schema

 { 

    "type": "object", 

    "properties": { 

        "content": {  

            "type": "array", 

            "items": { 

                "type": "object", 

                "properties": { 

                    "manufacturer":  { "type": "string" }, 

                    "modelName":  { "type": "string" }, 

                    "serialNumber":  { "type": "string" }, 

                    "accountId":  { "type": "string" }, 

                    "name":  { "type": ["null", "string"] }, 

                    "description":  { "type": ["null", "string"] }, 

                    "dateCreated": { "type": "number" }, 

                    "dateModified": { "type": "number" }, 

                    "lastCommunication": { "type": ["null", 

"number"] }, 

                    "lastDataRefresh": { "type": "number" }, 

                    "communicating": { "type": ["null", "boolean"] }, 

                    "authenticated": { "type": ["null", "boolean"] }, 

                    "baseFirmwareLastModifiedDate": { "type": 
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["null", "number"] }, 

                    "counters": { 

                        "type": ["null", "object"], 

                        "properties": { 

                            "lifetimeCount": { "type": ["null", 

"integer"] }, 

                            "lifetimeCountUnit": { "type": ["null", 

"string"] }, 

                            "colorPrintSideCount": { "type": ["null", 

"integer"] }, 

                            "colorPrintSheetCount": { "type": 

["null", "integer"] }, 

                            "monoPrintSideCount": { "type": ["null", 

"integer"] }, 

                            "monoPrintSheetCount": { "type": ["null", 

"integer"] }, 

                            "printSideCount": { "type": ["null", 

"integer"] }, 

                            "printSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorCopySideCount": { "type": ["null", 

"integer"] }, 

                            "colorCopySheetCount": { "type": ["null", 

"integer"] }, 

                            "monoCopySideCount": { "type": ["null", 

"integer"] }, 

                            "monoCopySheetCount": { "type": ["null", 

"integer"] }, 

                            "copySideCount": { "type": ["null", 

"integer"] }, 

                            "copySheetCount": { "type": ["null", 

"integer"] }, 

                            "colorFaxSideCount": { "type": ["null", 

"integer"] }, 

                            "colorFaxSheetCount": { "type": ["null", 

"integer"] }, 

                            "monoFaxSideCount": { "type": ["null", 

"integer"] }, 

                            "monoFaxSheetCount": { "type": ["null", 

"integer"] }, 

                            "faxSideCount": { "type": ["null", 

"integer"] }, 

                            "faxSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorSideCount": { "type": ["null", 

"integer"] }, 

                            "colorSheetCount": { "type": ["null", 

"integer"] }, 

                            "monoSideCount": { "type": ["null", 

"integer"] }, 

                            "monoSheetCount": { "type": ["null", 

"integer"] }, 

                            "totalSideCount": { "type": ["null", 

"integer"] }, 

                            "totalSheetCount": { "type": ["null", 

"integer"] }, 

                            "colorLargeSideCount": { "type": ["null", 

"integer"] }, 
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                            "monoLargeSideCount": { "type": ["null", 

"integer"] }, 

                            "largeSideCount": { "type": ["null", 

"integer"] }, 

                            "largeSheetCount": { "type": ["null", 

"integer"] }, 

                            "duplexSideCount": { "type": ["null", 

"integer"] }, 

                            "duplexSheetCount": { "type": ["null", 

"integer"] }, 

                            "coverageTierBusinessSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierBusinessSheetCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierGraphicsSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierGraphicsSheetCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierHighlightSideCount": 

{ "type": ["null", "integer"] }, 

                            "coverageTierHighlightSheetCount": 

{ "type": ["null", "integer"] }, 

                            "paperCounts": { 

                                "type": "array", 

                                "items": { 

                                    "type": "object", 

                                    "properties": { 

                                        "paperSheetPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSheetSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideColorPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideColorSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideMonoPickedCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSideMonoSafeCount": 

{ "type": ["null", "integer"] }, 

                                        "paperSize": { "type": 

["null", "string"] }, 

                                        "paperType": { "type": 

["null", "string"] } 

                                    } 

                                } 

                            }, 

                            "blankCopySideCount": { "type": ["null", 

"integer"] }, 

                            "adfScanCount": { "type": ["null", 

"integer"] }, 

                            "flatbedScanCount": { "type": ["null", 

"integer"] }, 

                            "scanToLocalhostScanCount": { "type": 

["null", "integer"] }, 

                            "copyScanCount": { "type": ["null", 

"integer"] }, 

                            "faxScanCount": { "type": ["null", 

"integer"] }, 
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                            "simplexAdfScanCount": { "type": ["null", 

"integer"] }, 

                            "duplexAdfScanCount": { "type": ["null", 

"integer"] }, 

                            "monoScanCount": { "type": ["null", 

"integer"] }, 

                            "colorScanCount": { "type": ["null", 

"integer"] }, 

                            "totalScanCount": { "type": ["null", 

"integer"] }, 

                            "blankFaxSideCount": { "type": ["null", 

"integer"] } 

                        } 

                    }, 

                    "diagnosticEvents": { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 

                            "properties": { 

                                "dateCreated": { "type": "number" }, 

                                "alert": { "type": ["null", 

"string"] }, 

                                "alertDttm": { "type": ["null", 

"number"] }, 

                                "alertId": { "type": ["null", 

"string"] }, 

                                "alertType": { "type": ["null", 

"string"] }, 

                                "collectorId": { "type": ["null", 

"string"] }, 

                                "errorCode": { "type": ["null", 

"string"] }, 

                                "errorReason":  { "type": ["null", 

"string"] }, 

                                "errorType":  { "type": ["null", 

"string"] }, 

                                "expirationDttm":  { "type": 

"number" }, 

                                "hostname": { "type": ["null", 

"string"] }, 

                                "ipAddress":  { "type": ["null", 

"string"] }, 

                                "lpc":  { "type": ["null", 

"number"] }, 

                                "model":  { "type": ["null", 

"string"] }, 

                                "serialNumber":  { "type": ["null", 

"string"] } 

                            } 

                        } 

                    }, 

                    "supplies":   { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 

                            "properties": { 

                                "serialNumber": { "type": ["null", 

"string"] }, 
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                                "currentLevel": { "type": ["null", 

"integer"] }, 

                                "color": { "type": ["null", 

"string"] }, 

                                "description": { "type": ["null", 

"string"] }, 

                                "maximumCapacity": { "type": ["null", 

"number"] }, 

                                "type": { "type": ["null", 

"string"] }, 

                                "capacityUnit": { "type": ["null", 

"string"] }, 

                                "percentRemaining":  { "type": 

["null", "integer"] }, 

                                "supplyState": { "type": ["null", 

"string"] }, 

                                "status":  { "type": ["null", 

"string"] }, 

                                "coverage":  { "type": ["null", 

"number"] }, 

                                "installDate":  { "type": ["null", 

"number"] }, 

                                "coverageLifetime":  { "type": 

["null", "number"] }, 

                                "coverageLastJob":  { "type": 

["null", "number"] }, 

                                "sidesOnSupply":  { "type": ["null", 

"number"] }, 

                                "timestamp": { "type": ["null", 

"number"] }, 

                                "prebate":  { "type": ["null", 

"boolean"] }, 

                                "genuine":  { "type": ["null", 

"boolean"] }, 

                                "daysLeft":  { "type": ["null", 

"number"] }, 

                                "daysLeftLastUpdated":  { "type": 

["null", "number"] } 

                            } 

                        } 

                    }, 

                    "alerts":   { 

                        "type": "array", 

                        "items": { 

                            "type": "object", 

                            "properties": { 

                                "status": { "type": ["null", 

"string"] }, 

                                "issue": { "type": ["null", 

"string"] } 

                            } 

                        } 

                    } 

                } 

            }, 

            "minItems": 0 

        }, 

        "pageable": { 
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            "type": "object", 

            "properties": { 

                "sort": { 

                    "type": "object", 

                    "properties": { 

                        "sorted":  { "type": "boolean" }, 

                        "unsorted":  { "type": "boolean" }, 

                        "empty":  { "type": "boolean" } 

                    } 

                }, 

                "pageNumber":  { "type": "integer" }, 

                "pageSize":  { "type": "integer" }, 

                "offset":  { "type": "integer" }, 

                "paged":  { "type": "boolean" }, 

                "unpaged":  { "type": "boolean" } 

            } 

        }, 

        "totalElements":  { "type": "integer" }, 

        "totalPages":  { "type": "integer" }, 

        "last":  { "type": "boolean" }, 

        "sort":  { 

            "type": "object", 

            "properties": { 

                "sorted":  { "type": "boolean" }, 

                "unsorted":  { "type": "boolean" }, 

                "empty":  { "type": "boolean" } 

            } 

        }, 

        "first":  { "type": "boolean" }, 

        "numberOfElements":  { "type": "integer" }, 

        "size":  { "type": "integer" }, 

        "number":  { "type": "integer" }, 

        "empty":  { "type": "boolean" } 

    } 

}

Sample response

{ 

     "content": [ 

        { 

          "manufacturer": "Lexmark", 

          "modelName": "X792e",  

               "serialNumber": "123SERIALNUMBER", 

          "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

          "name": null, 

          "description": null, 

          "dateCreated": 1568139701472, 

          "dateModified": 1621677697123, 

          "lastCommunication": 1621686886903, 

          "lastDataRefresh": 1621677697129, 

          "communicating": false, 

          "authenticated": true, 

          "baseFirmwareLastModifiedDate": null, 

          "counters": { 
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             "lifetimeCount": 6436, 

             "lifetimeCountUnit": "Sides", 

             "colorPrintSideCount": 464, 

             "colorPrintSheetCount": null, 

             "monoPrintSideCount": 2636, 

             "monoPrintSheetCount": null, 

             "printSideCount": 3100, 

             "printSheetCount": 3067, 

             "colorCopySideCount": 175, 

             "colorCopySheetCount": null, 

             "monoCopySideCount": 50, 

             "monoCopySheetCount": null, 

             "copySideCount": 225, 

             "copySheetCount": 217, 

             "colorFaxSideCount": 99, 

             "colorFaxSheetCount": null, 

             "monoFaxSideCount": 2994, 

             "monoFaxSheetCount": null, 

             "faxSideCount": 3093, 

             "faxSheetCount": 3093, 

             "colorSideCount": 738, 

             "colorSheetCount": null, 

             "monoSideCount": 5680, 

             "monoSheetCount": null, 

             "totalSideCount": 6418, 

             "totalSheetCount": 6377, 

             "colorLargeSideCount": null, 

             "monoLargeSideCount": null, 

             "largeSideCount": null, 

             "largeSheetCount": null, 

             "duplexSideCount": null, 

             "duplexSheetCount": 41, 

             "coverageTierBusinessSideCount": null, 

             "coverageTierBusinessSheetCount": null, 

             "coverageTierGraphicsSideCount": null, 

             "coverageTierGraphicsSheetCount": null, 

             "coverageTierHighlightSideCount": null, 

             "coverageTierHighlightSheetCount": null, 

             "paperCounts": [ 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 5370, 

                  "paperSideColorPickedCount": 586, 

                  "paperSideColorSafeCount": 700, 

                  "paperSideMonoPickedCount": 2377, 

                  "paperSideMonoSafeCount": 4711, 

                  "paperSize": "Letter", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 3, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 1, 

                  "paperSideMonoSafeCount": 3, 

                  "paperSize": "Letter", 

                  "paperType": "Custom Type 2" 
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                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 23, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 23, 

                  "paperSize": "Oficio", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 24, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 24, 

                  "paperSize": "Legal", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 110, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 7, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 103, 

                  "paperSize": "Executive", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 56, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 56, 

                  "paperSize": "Folio", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 52, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 52, 

                  "paperSize": "JIS B5", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 685, 

                  "paperSideColorPickedCount": 3, 

                  "paperSideColorSafeCount": 30, 

                  "paperSideMonoPickedCount": 178, 

                  "paperSideMonoSafeCount": 655, 
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                  "paperSize": "A4", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 45, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 45, 

                  "paperSize": "A5", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 4, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 4, 

                  "paperSize": "A6", 

                  "paperType": "Plain" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 1, 

                  "paperSideColorPickedCount": 0, 

                  "paperSideColorSafeCount": 0, 

                  "paperSideMonoPickedCount": 0, 

                  "paperSideMonoSafeCount": 1, 

                  "paperSize": "A4", 

                  "paperType": "Custom Type 2" 

                }, 

                { 

                  "paperSheetPickedCount": null, 

                  "paperSheetSafeCount": 4, 

                  "paperSideColorPickedCount": 1, 

                  "paperSideColorSafeCount": 1, 

                  "paperSideMonoPickedCount": 3, 

                  "paperSideMonoSafeCount": 3, 

                  "paperSize": "Letter",  

                           "paperType": "Transparancy" 

                } 

              ], 

               "blankCopySideCount": 1, 

               "adfScanCount": 377, 

               "flatbedScanCount": 722, 

               "scanToLocalhostScanCount": null, 

               "copyScanCount": 101, 

               "faxScanCount": 815, 

               "simplexAdfScanCount": null, 

               "duplexAdfScanCount": null, 

               "monoScanCount": null, "colorScanCount": null, 

               "totalScanCount": 1099, 

               "blankFaxSideCount": 0 

            }, 

             "diagnosticEvents": [ 

              { 
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                "dateCreated": 1639077580134, 

                "alert": "202.03 PAPER JAM: repeated 25 time(s) in 

500 pages", 

                "alertDttm": 1639077580134, 

                "alertId": "61b25b2cc036774096bbef91", 

                "alertType": "Prescriptive", 

                "collectorId": "CBR01", 

                "errorCode": "202.03", 

                "errorReason": "HC_REP", 

                "errorType": "%202.03%", 

                "expirationDttm": 1313123, 

                "hostname": "10.99.0.60", 

                "ipAddress": "10.99.0.60", 

                "lpc": 505535, 

                "model": "LEXMARK CX825", 

                "serialNumber": "12345SERIALNUMBER" 

              } 

            ], 

             "supplies": [ 

                { 

                 "serialNumber": "SUPPLY123", 

                 "currentLevel": 50, 

                 "color": "none", 

                 "description": "Fuser", 

                 "maximumCapacity": 150000, 

                 "type": "Fuser", 

                 "capacityUnit": "Sides", 

                 "percentRemaining": null, 

                 "supplyState": "UNKNOWN", 

                 "status": "Intermediate", 

                 "coverage": null, 

                 "installDate": null, 

                 "coverageLifetime": null, 

                 "coverageLastJob": null, 

                 "sidesOnSupply": null, 

                 "timestamp": 1621674025055, 

                 "prebate": null, 

                 "genuine": null, 

                 "daysLeft": null, 

                 "daysLeftLastUpdated": null 

                } 

              ], 

               "alerts": [] 

            }, 

            { 

               "manufacturer": "Lexmark", 

               "modelName": "X792e", 

               "serialNumber": "123SERIALNUMBER", 

               "accountId": "bf899e52-b026-46f3-9715-fe54b5dd7637", 

               "name": null, 

               "description": null, 

               "dateCreated": 1568139701472, 

               "dateModified": 1621677697123, 

               "lastCommunication": 1621686886903, 

               "lastDataRefresh": 1621677697129, 

               "communicating": false, 

               "authenticated": true, 

               "baseFirmwareLastModifiedDate": 1621686886903, 
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               "counters": { 

                  "lifetimeCount": null, 

                  "lifetimeCountUnit": null, 

                  "colorPrintSideCount": 104, 

                  "colorPrintSheetCount": null, 

                  "monoPrintSideCount": 201, 

                  "monoPrintSheetCount": null, 

                  "printSideCount": 305, 

                  "printSheetCount": 305, 

                  "colorCopySideCount": 77, 

                  "colorCopySheetCount": null, 

                  "monoCopySideCount": 0, 

                  "monoCopySheetCount": null, 

                  "copySideCount": 77, 

                  "copySheetCount": null, 

                  "colorFaxSideCount": 0, 

                  "colorFaxSheetCount": null, 

                  "monoFaxSideCount": 0, 

                  "monoFaxSheetCount": null, 

                  "faxSideCount": 0, 

                  "faxSheetCount": null, 

                  "colorSideCount": 181, 

                  "colorSheetCount": null, 

                  "monoSideCount": 201, 

                  "monoSheetCount": null, 

                  "totalSideCount": 382, 

                  "totalSheetCount": null, 

                  "colorLargeSideCount": 0, 

                  "monoLargeSideCount": 0, 

                  "largeSideCount": 0, 

                  "largeSheetCount": null, 

                  "duplexSideCount": 0, 

                  "duplexSheetCount": null, 

                  "coverageTierBusinessSideCount": null, 

                  "coverageTierBusinessSheetCount": null, 

                  "coverageTierGraphicsSideCount": null, 

                  "coverageTierGraphicsSheetCount": null, 

                  "coverageTierHighlightSideCount": null, 

                  "coverageTierHighlightSheetCount": null, 

                  "paperCounts": [], 

                  "blankCopySideCount": null, 

                  "adfScanCount": null, 

                  "flatbedScanCount": null, 

                  "scanToLocalhostScanCount": null, 

                  "copyScanCount": null, 

                  "faxScanCount": null, 

                  "simplexAdfScanCount": null, 

                  "duplexAdfScanCount": null, 

                  "monoScanCount": null, 

                  "colorScanCount": null, 

                  "totalScanCount": null, 

                  "blankFaxSideCount": null 

                }, 

                "diagnosticEvents": [], 

                "supplies": [ 

                   { 

                    "serialNumber": null, 

                    "currentLevel": 100, 
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                    "color": "none", 

                    "description": "Waste Toner Bottle", 

                    "maximumCapacity": 200000, 

                    "type": "Waste Toner", 

                    "capacityUnit": "Sides", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Ok", 

                    "coverage": null, 

                    "installDate": null, 

                    "coverageLifetime": null, 

                    "coverageLastJob": null, 

                    "sidesOnSupply": null, 

                    "timestamp": 1621674025052, 

                    "prebate": null, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                   }, 

                   { 

                    "serialNumber": null, 

                    "currentLevel": 100, 

                    "color": "none", 

                    "description": "Separator Roll and Pick 

Assembly", 

                    "maximumCapacity": 120000, 

                    "type": "Other", 

                    "capacityUnit": "Other", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Ok", 

                    "coverage": null, 

                    "installDate": null, 

                    "coverageLifetime": null, 

                    "coverageLastJob": null, 

                    "sidesOnSupply": null, 

                    "timestamp": 1621674025053, 

                    "prebate": null, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY1", 

                    "currentLevel": 50, 

                    "color": "none", 

                    "description": "Fuser", 

                    "maximumCapacity": 150000, 

                    "type": "Fuser", 

                    "capacityUnit": "Sides", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Intermediate", 

                    "coverage": null, 

                    "installDate": null, 

                    "coverageLifetime": null, 

                    "coverageLastJob": null, 

                    "sidesOnSupply": null, 
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                    "timestamp": 1621674025055, 

                    "prebate": null, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY2", 

                    "currentLevel": 5, 

                    "color": "Yellow", 

                    "description": "Yellow Cartridge", 

                    "maximumCapacity": 20000, 

                    "type": "Toner", 

                    "capacityUnit": "Sides", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Low", 

                    "coverage": 0.028, 

                    "installDate": 1568701948000, 

                    "coverageLifetime": 6.198895, 

                    "coverageLastJob": 15, 

                    "sidesOnSupply": 31355, 

                    "timestamp": 1621674025056, 

                    "prebate": true, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY3", 

                    "currentLevel": 100, 

                    "color": "none", 

                    "description": "Transfer Module", 

                    "maximumCapacity": 200000, 

                    "type": "Other", 

                    "capacityUnit": "Other", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Ok", 

                    "coverage": null, 

                    "installDate": null, 

                    "coverageLifetime": null, 

                    "coverageLastJob": null, 

                    "sidesOnSupply": null, 

                    "timestamp": 1621674025057, 

                    "prebate": null, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY4", 

                    "currentLevel": 80 

                    "color": "Magenta", 

                    "description": "Magenta Cartridge", 

                    "maximumCapacity": 6000, 

                    "type": "Toner", 

                    "capacityUnit": "Sides", 



Appendix

350

                    "percentRemaining": null, 

                    "supplyState": "AUTHENTIC", 

                    "status": "Intermediate", 

                    "coverage": 2.872, 

                    "installDate": 1568701948000, 

                    "timestamp": 1621674025073, 

                    "prebate": true, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY5", 

                    "currentLevel": 80, 

                    "color": "Black", 

                    "description": "Black Cartridge", 

                    "maximumCapacity": 20000, 

                    "type": "Toner", 

                    "capacityUnit": "Sides", 

                    "percentRemaining": null, 

                    "supplyState": "AUTHENTIC", 

                    "status": "Intermediate", 

                    "coverage": 0.514, 

                    "installDate": 1568701948000, 

                    "coverageLifetime": 6.0445027, 

                    "coverageLastJob": 74, 

                    "sidesOnSupply": 1957, 

                    "timestamp": 1621674025074, 

                    "prebate": true, 

                    "genuine": null, 

                    "daysLeft": null, "daysLeftLastUpdated": null 

                  }, 

                  { 

                    "serialNumber": "SUPPLY6", 

                    "currentLevel": 20, 

                    "color": "Cyan", 

                    "description": "Cyan Cartridge", 

                    "maximumCapacity": 12000, 

                    "type": "Toner", 

                    "capacityUnit": "Sides", 

                    "percentRemaining": null, 

                    "supplyState": "UNKNOWN", 

                    "status": "Intermediate", 

                    "coverage": 0.194, 

                    "installDate": 1568701948000, 

                    "coverageLifetime": 7.331492, 

                    "coverageLastJob": 21, 

                    "sidesOnSupply": 4688, 

                    "timestamp": 1621674025075, 

                    "prebate": true, 

                    "genuine": null, 

                    "daysLeft": null, 

                    "daysLeftLastUpdated": null 

                  } 

              ], 

               "alerts": [ 

                 { 

                  "status": "WARNING", 
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                  "issue": "Yellow cartridge low " 

                 }, 

                 { 

                  "status": "WARNING", 

                  "issue": "Tray 1 Low " 

                 } 

            ] 

        } 

], 

"pageable": { 

   "sort": { 

      "sorted": false, 

      "unsorted": true, 

      "empty": true 

       }, 

        "pageNumber": 0, 

        "pageSize": 50, 

        "offset": 0, 

        "paged": true, 

        "unpaged": false 

}, 

"totalElements": 2, 

"totalPages": 1, 

"last": false, 

"sort": {  

   "sorted": false, 

   "unsorted": true, 

   "empty": true 

}, 

"first": true, 

"numberOfElements": 50, 

"size": 50, 

"number": 0,  

"empty": false 

}
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